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1: Introduction

About this Guide

Welcome to PAC Manager, the configuration and inspection tool for working with the SNAP PAC
system. This guide shows you how to configure and work with the following Opto 22 devices using
the PAC Manager software tool

»  SNAP PAC S-series controllers

»  SNAP PACR-series controllers

+  SoftPAC controllers

«  SNAP PACEB brains

«  SNAP PAC SB brains

NOTE on Allen-Bradley: If you are using SNAP PAC EB brains or SNAP PAC controllers with Allen-Bradley
Logix PLC systems, do not use PAC Manager. Instead, use the EtherNet/IP Configurator. See form 1770, the

EtherNet/IP for SNAP PAC Protocol Guide, for instructions. Both the software and the quide are available on
our website, www.opto22.com.

NOTE on legacy hardware: If you are using PAC Manager with legacy hardware (SNAP Ultimate, Ethernet,
or Simple I/0), use Opto 22 form 1714, PAC Manager User's Guide, Legacy Edition, instead of this guide.
For more information on using legacy systems with the SNAP PAC system, see Opto 22 form 1688, SNAP
PAC System Migration Technical Note.

PAC Manager is available for download from our website, www.opto22.com.

Contents

This guide assumes that you have some familiarity with TCP/IP, UDP/IP, and Ethernet networking. If
you are not familiar with these subjects, we strongly suggest you consult commercially available
resources to learn about them before attempting to use these systems.

This user’s guide includes the following sections:

Chapter 1: Introduction—information about the guide and how to reach Opto 22 Product
Support. Also includes product comparison charts.

Chapter 2: Configuring Devices—how to assign an IP address to your hardware, how to
configure 1/0 units and 1/0 points, how to use I/O point features such as counters, watchdogs, and
analog scaling; and how to send configuration data to I/O units.
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ABOUT THIS GUIDE

Chapter 3: Configuring Optional Functions—information on configuring security,
communication protocols like SNMP and PPP, streaming, the Scratch Pad area, and other optional
functions.

Chapter 4: Setting Up Events and Reactions—if you are not using PAC Control, information on
configuring local reactions to local events.

Chapter 5: Reading and Writing to Specific Devices—how to read data directly from a specific
controller or I/O unit or write directly to a controller, brain, or I/0 points.

Chapter 6: Maintaining Devices—changing IP addresses, upgrading firmware, and working with
files on the device.

Chapter 7: Troubleshooting—tips for resolving difficulties you may encounter while working in
PAC Manager.

Appendix A: Menus—Iists and describes PAC Manager menu commands.
Appendix B: Dialog Boxes—describes the features of PAC Manager dialog boxes.

Related Documentation

You may also need some of the following documentation, depending on the system you are using
and how you expect to communicate with it:

To use this See this Opto 22

form #
. SNAP PAC R-Series Controller User’s Guide 1595
SNAP PAC R-series controllers OptoMMP Protocol Guide 1465
) SNAP PAC S-Series Controller User’s Guide 1592
SNAP PAC S-series controllers OptoMMP Protocol Guide 1465
SoftPAC controllers SoftPAC Software-based Controller for PC-based Control 2020

Data Sheet

. SNAP PAC Brain User’'s Guide 1690
SNAP PAC EB and SBbrains | 1 ivp Protocol Guide 1465
PAC Control User’s Guide 1700
PAC Control strategies PAC Control Command Reference 1701
PAC Control Commands Quick Reference Card 1703
Serial communication modules | SNAP Serial Communication Module User’'s Guide 1191
High-density digital modules SNAP High-Density Digital Module User's Guide 1547

All forms are available for download from our website, www.opto22.com. The easiest way to find
one is to search on the form number.

PAC Manager User's Guide


http://www.opto22.com/
http://www.opto22.com/site/documents/drilldown.aspx?aid=3165
http://www.opto22.com/site/documents/drilldown.aspx?aid=3164
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4302
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4302
http://www.opto22.com/site/documents/drilldown.aspx?aid=3166
http://www.opto22.com/site/documents/drilldown.aspx?aid=1875
http://www.opto22.com/site/documents/drilldown.aspx?aid=3162
http://www.opto22.com/site/documents/drilldown.aspx?aid=2668
http://www.opto22.com/site/documents/drilldown.aspx?aid=1875
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=1751
http://www.opto22.com/site/documents/drilldown.aspx?aid=1928
http://www.opto22.com/site/documents/drilldown.aspx?aid=2772
http://www.opto22.com/site/documents/drilldown.aspx?aid=1875

CHAPTER 1: INTRODUCTION

For Developers: SNAP PAC REST API

If you're a developer who'd like to use PAC Control strategy tags in communications with other
devices, the Opto 22 SNAP PAC REST APl 'is a secure and powerful way to do just that. The APl is
available in SNAP PAC R-series and S-series controllers with PAC firmware R9.5a and higher. To
configure HTTPS access to your PAC's RESTful server and learn how to call the API, visit
developer.opto22.com.

Product Support

If you have problems installing or using PAC Manager and cannot find the help you need in this
guide or on our website, contact Opto 22 Product Support.

Phone: 800-TEK-OPTO (800-835-6786 NOTE: Email messages and phone
toll-free in the U.S. and Canada) calls to Opto 22 Product Support
951-695-3080 are grouped together and
Monday through Friday, answered in the order received.

7 a.m.to 5 p.m. Pacific Time

Fax: 951-695-3017
Email: support@opto22.com
Opto 22 website: WwWw.0pto22.com

When calling for technical support, you can help us help you faster if you can provide the following
information to the Product Support engineer:

+  Opto 22 hardware part numbers or models that you're working with

«  Software version (available by clicking Help > About in the application’s menu bar)
«  Firmware version

»  Specific error messages you saw

»  Version of your computer's operating system
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OPTO 22 PROCESSOR COMPARISON CHART

Opto 22 Processor Comparison Chart

This table compares SNAP PAC controllers and brains using version 9.5 firmware and 9.5 PAC Project software (or higher).

FEATURE SNAP PAC Controllers SNAP PAC Brains
S Standalone Rack-mounted Ethernet Serial
w
= =
= = L oS
B (33| S Eziz]-HadZ(a]e (o
R L R R SR EEEE B
2 s|22lsdgls8 22|82 == |2
Qleelz|e ||z iaaealagage ale &
alaca|ajajana|janlajajanana|ala |
e A A I I I I I d I e i d I (I B a4
clZzZ|Zz(Z|Z|Zz2Z 2| 2222|2222 |22 |2
NDjonon onlonjloojnlonn onljlonosnn | onlo |»
Two independent Ethernet network interfaces (two IP
addresses) for Ethernet link redundancy or segmenting net- %@ay e 0 0/0] 06 0 0 o0 0O
works
Wireless LAN interface (802.11a, b, or g) aa LA e o LA
Two switched Ethernet network interfaces (one IP address) for ° ol ol o
multi-drop (daisy-chain) network configuration
Works with PAC Project software o] ©6 ©0/0 6] 0 0 © o0 0] 0 © 0 00 0
Runs PAC Control strategies °
Maximum PAC Control charts running at once (plus host task) | 64} 32 | 32| 32| 32] 16 é 16 | 16| 16
SNAP PAC EB brains o] ©¢ 0o 0/0] 06 0 0 o0 0
Compatible brains® SNAP PAC SB brains
Onboard 1/O processor (brain) o 0 o 0 0o
Ethernet (UDP/IP, 10/100 Mbps) o] 6 o/ 0 o
_to-brai - n/a
Controller-to-brain com- o1 C AN (802.11a, b, or g) aa oo oo
munication
Serial (RS-485) LA
Ethernet (TCP/IP, 10/100 Mbps) o] ¢ 00/ 0] 06 O O o0 0
Controller-to-PC com- | Wireless LAN (802.11a, b, or g) aa LA
munication - -
PPPoverdlaI—u_pmodem,th hard- o olo/ol ool © | 0| @
ware handshaking
Eth t (10/100 Mb, ° o o o0
Brain-to-host (PC or ernet ( Ps)
controller) communica- | Wireless LAN (802.11a, b, or g) n/al n/a n/a
i
on Serial (RS-485) oo
Total number of RS-232 serial ports oo 2 [4°| 204°] 2 [ 2| 2 | 1] 2] -0-| -0- | -0-| -0 -0-] -0-
Number of RS-232 serial ports usable for PPP (on dial-up ol qc | 1¢f 1¢] 1¢] 1c | 1¢] 1¢ | 1¢| 1) -0- | -0- | -0-| -0- -0-] -o-
modem)
Total number of RS-485 serial ports bbl 1 | 4P| 1| 4°] -0- 'f) -0- 'fJ 0] -0-| -0-|-0-|-0-] 1] 1
EtherNet/IP™ (Allen-Bradley® RSLogix® systems and others)
Modbus®TCP (slave; maximum 8 master connections)®® © 00 00 0 0 06 00 o oo
o o
OPC driver support o] ©6 0/0 0] 0|0 O 0 0] 06 O 0 0 ,
RESTful API o 06 0o/ 0] 0 o0 o0 o o0
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CHAPTER 1: INTRODUCTION

FEATURE SNAP PAC Controllers SNAP PAC Brains
S Standalone Rack-mounted Ethernet Serial
w
= =
= = L oS
g o133 T Fzz]l-Hadi(a]e (o
‘-‘-N‘-N‘-‘-‘—NN‘-Qmmmmmmmm
| | G G B ) G B B | A O ||
S HHHEEREE HE EEEEEIEIERE:
Qlzga|zia|zaa|aaiaa]laaiaaia|a)s &
alaca|ajajaaa|janajajanana|ala |a
<K €< <LK (LK ([ <
clZzZ|Z2|Z2|Z|lzZ 2222|222 =222 (2|2 |2
Do onlonjloojnlonnn onlonosnn | onlo o
HTTP/HTTPS ®© 0 0 0] 0 0 o 000
OptoMMP memory-mapped protocol © 06 0 0] 06 0 0 0/ 0|0 O 0 00 0
SNMP (network management) o 06 0o/ 0j 0 o0 0 o0 o0
FTP server, file system o 0 0 0] 06 0 0 00| 0 o o0 0
ETP client o] o (oo o] ©o [0 o (0] @
PPP (for use with dial-up modems) ® o6 0 0] 06 o0 0o o0 o
Email (SMTP client with authentication and attachments) o] 6 0 0 0] 06 0 0 o0 0] 0 o o0 0o
Scratch Paq area for peer-tq—peer data (bits, floats, 32-bit inte- o olo/lo]l o0l o | 0| o] o ol o/ oleo!lo
gers, 64-bit integers, and strings)
Security for wireless network (WPA2-AES, WPA-TKIP, WEP) | a2 LA o o o 0
Security for wired Ethernet network (IP filtering, port access) | 8@ LA ° e o LA
Realtime clock aa o o ° e o o o
Backup battery (recharges when brain has power)f ° ° o0 o o
Physical RAM (MB) aafl 3 128 16 32 16
RAM available for Strategy (MB) 64 16 64 4 10 --
Battery-backed RAM (MB) 8 8 8 2 2 --
Flash memory (MB) 9 16 16 8 8 8
32-bit processor aa o [ A A J o o [} [ A J [} (] o 0] 060 o
Floating-point unit (FPU) aj o |0 O o o
Removable data storage (microSD card slot) aa 32 GB max.P 32 GB max.n
— i
Power requirements aa 1(? V?lglle?f:W 5.0105.2 VDC 50105.2VDC
q v @ 1.2-1.5 AK @ 750 mA-1.0 A
max
Operating Temperature in degrees C aa -20 to 60 -20to 60 -20 to 60
Storage Temperature in degrees C -40 to 85 -40 to 85 -40 to 85
Humidity (non-condensing) aa 0-95% 0-95% 0-95%
Uses SNAP PAC mounting rack (4, 8, 12, or 16 modules) n/a o o o o] 0 o o 0]j0 0
Uses SNAP B-series mounting rack (4, 8, 12, or 16 modules) | n/a n/a °
Maximum number of modules allowed on largest rack: n/a °! r ololel ol o/l 0/l ®|®
Any mix of 16 digital, 16 analog, and 8 serial m.m
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FEATURE SNAP PAC Controllers SNAP PAC Brains

S Standalone Rack-mounted Ethernet Serial

SNAP-PAC-EB1-FM
SNAP-PAC-EB2
SNAP-PAC-EB2-FM

SNAP-PAC-S1
SNAP-PAC-S1-FM
SNAP-PAC-S2
SNAP-PAC-S1-W
SNAP-PAC-S2-W
SNAP-PAC-R1-FM
SNAP-PAC-R2
SNAP-PAC-R2-FM

SoftPAC

Input latching

On/off status

o| o | SNAP-PAC-R2-W
o| o/ e SNAP-PAC-EB2-W

o o/ eo| SNAP-PAC-SB2

Watchdog timer

High-speed counting (up to 20 kHz)"

Quadrature counting®
Digital I/0 point fea-

tures On-pulse & off-pulse measurement” nfa nfa

Frequency & Period measurement”

TPO (time-proportional output)

o o o o o o o o o SNAPPACRI

o o o o o o o o o SNAP-PACRI-B
o o o o o o o o o SNAP-PACRI-W
ol o ol ol o o o o o SNAP-PAC-EB1
o o o o o o o o ofSNAP-PACEBI-W
o o o o o/ o/ o/ o e| SNAP-PAC-SB1

Digital totalizing"

Pulse generation (continuous square
wave, N pulses, on-pulse, off-pulse)

Thermocouple linearization (32-bit
floating point for linearized values)

Minimum/maximum values

Offset and gain

Scaling

Analog I/0 pointfea- | TPO (Time-proportional output)

n/a n/a
tures

Output clamping

Filter weight

Watchdog timer

Analog totalizingP

RampingP

PID logic (maximum 96 PID loops per controller or brain)

Data logging

=

Digital events, alarm events, serial events
n/a

Event messaging

UDP streaming of I/O data to host

I/O point data mirroring and memory map copying
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CHAPTER 1: INTRODUCTION

aa As provided by the Microsoft Windows computer the software runs on.
bb SoftPAC cannot communicate through serial ports on the PC.
cc With firmware R9.4b & higher, 8 max connections. Lower firmware, 2 max. connec-

a
b
c

tions

For compatibility with legacy Opto 22 hardware, see form #1693.

Serial ports are software configurable for RS-232 or RS-485.

One port on SNAP-PAC-S1 supports DTR, DSR, and CD signals and bidirectional
flow control on RTS and CTS. All ports on SNAP-PAC-S2 support DTR and DCD
signals and bidirectional flow control on RTS and CTS. The port on SNAP-PAC-R1
and -R2 supports DTR and CD signals, and bidirectional flow control on RTS and
CTS.

Available with OptoOPCServer and PAC Control, through a SNAP PAC controller.
SoftPAC includes Status Read, Status Write, and Scratch Pad memory map areas.
Models manufactured before August 2007 and S1s with serial numbers 625653 and
lower have user- replaceable backup batteries. See original user guide.

Function of Flash memory is implemented via a file; size is limited only by disk space.

-~ O T O >

Firmware 9.4a and loader 6.1a or newer. S-series with microSD &
manufacture date older than 06/14 supports max. 2 GB microSD.
Units with serial numbers lower than 500,000 have an 8-24 VDC
input voltage rating. Verify voltage on the unit’s faceplate before
applying power.

Higher requirement applies to -W models.

SNAP-PAC-R1s with serial numbers lower than 600,000, and all
SNAP-PAC-R1-Bs: limited to eight 4-point digital modules per rack.
Not supported: serial, motion control, Profibus, & Wiegand
modules.

Four-channel modules only; not on high-density modules.
Requires a SNAP-IDC5Q quadrature input module.

Requires a SNAP PAC controller and PAC Control commands.
Requires a SNAP analog TPO module (SNAP-AOD-29).

Does not support serial events.
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2: Configuring Devices

Introduction

Follow the steps in this chapter to assign IP addresses to Opto 22 devices on an Ethernet network.
(Addressing information for SNAP PAC SB serial brains is set on the brain itself. See Opto 22

form 1690, SNAP PAC Brains User’s Guide, for instructions.) This chapter also includes steps for
configuring I/0 unit points and features. /0 points must be configured before you can read or write
to them.

This chapter assumes that you have already installed the hardware and software according to steps
in the device’s user's guide. (See "Related Documentation”on page 3.)

If you are using a wireless or modem connection, or if you are using event messages, email,
streaming, the Scratch Pad area for peer-to-peer communication, or SNMP for communicating with
enterprise management systems, also see Chapter 3, which shows you how to set up these optional
functions. All this information goes in the configuration file that PAC Manager uploads to I/0 units.

When to Use PAC Manager and PAC Control

If you will be running a PAC Control strategy on a SNAP PAC System to control I/O units, you may be
wondering when to use PAC Manager versus when to use PAC Control. These two tools serve
different purposes, but some of their functionality overlaps:

PAC Manager Tasks
Assign and change ——y Configure I/0

PAC Control Tasks
‘ =) Configure control == Program and
IP address E‘ O Unit engine (soPCrunning  debug control

an?.ﬂrmvvare icati - A U0 Station_ PAC Control can logic
onfigure communications wr Il

and events Elm Points the controller)

[

i
/0 can be configured in PAC Manager and imported into
PAC Control. I/0 can also be configured in PAC Control.
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ASSIGNING AN IP ADDRESS

Configuring 1/0

I/0 units and points must be configured to match the PAC Control strategy you will run. You can
configure most I/0 units and point functions either in PAC Control or in PAC Manager.

For most I/0 units, if you are already in PAC Control, configuration is easier there and you can use the
loopback IP address for SNAP PAC R-series I/O units controlling themselves. However, some
functions for I/0 units cannot be configured in PAC Control.

If you use PAC Manager, you can save your configuration to a file, load it to multiple I/0 units at
once, and use it for referencing points in OPC. However, you cannot use the loopback address in PAC
Manager.

Choose your configuration tool based on what you need to do:

Use PAC Control for I/0 configuration if Use PAC Manager for I/O configuration if
* You have only one I/O unit or I/O unit configurations | « You have multiple /O units whose configurations
are different. are exactly the same or similar.
* The strategy will run on SNAP PAC R-series 1/0 * You are using a modem connection (PPP) or SNMP.
units that are controlling themselves using the  You are using event messages or email.
loopback IP address, 127.0.0.1 « You are configuring events and reactions on the 1/O
* You are using an Ethernet network for unit in addition to strategy logic.

communications (or using a SNAP PAC controller | « you are not using PAC Control.
with an SB brain).

The strategy handles all logic; you are not also
configuring events and reactions on 1/O units.

Whichever tool you use for configuring I/0, be aware of the impact if you later change configuration.
For example, if you configure I/0 in PAC Manager, download the configuration file to I/O units, and
then later add a point in PAC Control, remember that your configuration file doesn’t contain that
point.

Assigning an IP Address

NOTE: If you are using redundant controllers with the SNAP PAC Redundancy Option Kit and PAC Project
Professional 9.1, do not use PAC Manager to assign IP addresses. Instead, use the PAC Redundancy Manager.

About IP Addresses

Each Ethernet-based device (controller or brain) ships from the factory with a unique hardware
Media Access Control (MAC) address and with a default IP address of 0.0.0.0, which is invalid. Each
device must have a valid IP address and subnet mask so that it can communicate on the network.

When installed and first turned on, a SNAP PAC controller or brain sends out a BootP broadcast
requesting an IP address. You respond to the broadcast by using PAC Manager to assign a static
(non-changing) IP address. These devices must be given a fixed, static IP address, because you
communicate with them using the IP address.

Assigning IP Addresses to SNAP PAC

Before using a PC or laptop computer to assign IP addresses, perform the following checks:
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+  Will'your controller or brain run on a network that has a DHCP server? Dynamic Host
Configuration Protocol (DHCP) servers can automatically respond to BootP requests and assign
a "dynamic” (changeable) IP address to the requesting device, but SNAP PAC controllers and
brains must have static IP addresses. If your network has a DHCP server, Opto 22 recommends
you connect the device directly to your computer with a network cable (even if the device is a
Wired+Wireless model), and then assign the IP address. After the device has a static IP address,
you can connect it to the network.

« Ifthe computer has an active wireless network connection, disable the wireless connection
and connect to your Opto 22 device via a wired connection. If you are connecting to a wireless
Opto 22 device, you will configure the wireless connection later.

«  Ifthe computer has multiple network interface controller (NIC) cards, disable all of them except
for the one that will be connecting to your Opto 22 device. You can re-enable them after you
complete these steps.

+  Ifyou need to modify the computer's network interface settings, you must be logged in with
administrative rights.

«  Temporarily disable firewalls on the computer running PAC Manager. If disabling firewalls is not
an option, configure a firewall exception for PAC Manager.

«  Firewalls, such as the ones that come with some anti-virus software programs and the built-in
firewall in Windows, can prevent PAC Manager from receiving BootP broadcasts. (Firewalls in a
router should not be a problem.)

— To configure a firewall exception in your system’s anti-virus software, see the
manufacturer’s instructions.

- To configure a firewall exception in Windows, open Control Panel > System and Security >
Windows Firewall > Allow an app or feature through Windows Firewall and add PAC
Manager to the list of allowed programs.

You can reenable the firewall (or remove the firewall exception) after you have assigned the IP
addresses.

SNAP PAC controllers and brains must be assigned a unique, static IP address. If the network you're
using has a Dynamic Host Configuration Protocol (DHCP) server, either assign a static IP address
before connecting the device to the network (preferred), or disable the server. (These servers may
respond to BootP requests and assign a dynamic address.)

Wired+Wireless models: These devices have a wireless LAN interface as well as wired interfaces,

but they send a BootP request only on the wired interface. First, follow the steps below to connect

to them over a wired network and assign their primary IP address. Later, you can configure the

wireless interface.

If you are adding an I/0O segment to an existing Ethernet network, your network administrator must

provide static IP addresses and subnet masks for the I/O units. If you are creating an independent,

dedicated Ethernet network just for I/O, you can choose your own addresses.

1. Make sure that the Opto 22 hardware is installed according to directions in its user's guide, and
that the PAC Manager software is installed on the computer.

2. Make sure you know the IP address, subnet mask, and MAC address of each device that will
receive an IP address.

The MAC address is on a label on the side of the controller or brain.
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SNAP PAC S-series and R-series controllers each have two separate Ethernet network interfaces;
wired+wireless models have an additional wireless interface. Each interface has its own MAC
address and must be on a separate logical network. The interface’s logical network is
determined by its IP address and subnet mask. For details, see Opto 22 form 1362, Simplified IP
Addressing, or get help from your system administrator.

Only Ethernet 1 sends a BootP request. Once you have assigned this primary IP address, you
can assign Ethernet 2 (the secondary address) and the wireless address, if applicable. See
page 21 for assigning an address to Ethernet 2 and page 26 for wireless configuration.

SNAP PAC brains are different. Since their two Ethernet network interfaces act as an Ethernet
switch and share the same IP address, it doesn’t matter which interface is attached to the
network. The BootP broadcast comes through both. On a wired+wireless EB brain, the wireless
interface has a separate IP address. After you assign the primary IP address for the wired
network, see page 26 for wireless configuration.

3. Turnonthe Opto 22 device(s).

4. Toopen PAC Manager:

- InWindows 7 and Windows Vista, press the Windows Start key E and then click
Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

- InWindows 10 and Windows 8.1, press the Windows Start key E type PAC Manager
9.5 and then press the Enter key.

The PAC Manager main window opens.

8] PAC Manager - O X
File Tools View Help 4——Menu bar

PE LRI <«—|—Toolbar

Ready A

5. Inthe menu bar, click Tools > Assign IP Address.
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CHAPTER 2: CONFIGURING DEVICES

The Assign IP Address dialog box opens. Any Opto 22 Ethernet-based devices without IP
addresses that are on the computer's network segment appear in the list of units requesting IP
addresses.

If

=

Units Requesting IP Addresses

Status MAC Address IP Address Subnet Mask Hostname Gateway Addr...
Discovered  00-CC-CC-00LC-CC
Discovered  00-CC-3D-00-9E-CC

£ >
Listening for DHCP Discovers and BootP Requests

L

MAC To IP Address Mappings - (MacToIP.map)
MAC Address IP Address Subnet Mask Hostname Gateway Addr... | DNS Addre Add...

Load List...

Ll
v

JLEE

Close | Help |

no MAC address appears, check the following:
Is the Opto 22 device turned on?

Is it correctly connected to the computer using a crossover cable or correctly connected to
an Ethernet switch using a straight-through cable?

Is the computer’'s network card configured with the same subnet mask as the device? See
the computer’s user’s guide for networking information.

Does the device already have an IP address? If you want to change the IP address, see
page 219.

Is the device booting to the loader rather than the firmware? If so, see the device's user’s
guide for more information on STAT LED blink codes.

Does the computer have firewall software that blocks network broadcasts? If so, disable the
firewall software.

Have you performed all of the checks listed in the NOTE on page 10?

Double-click the MAC address of the device in the list that matches the device you are
assigning the IP address to.

CAUTION: PAC Manager lists ALL Opto 22 devices sending BootP broadcasts. Assign IP addresses only

(o

the devices that are yours.
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The Mapping dialog box opens.

=] Add MAC To IP Mapping >
MAC Address: [pocccocoococe
IP Address: f o .0 .0 .0
Subnet Mask: f o .0 .0 .0
Gateway Address: I 0o .0 .0 .0
DNS Address: f o .0 .0 .0
Host Mame: I

0K I Cancel |

7. Enterthe IP Address and the Subnet Mask for the device. If the device will be communicating
with a device on another subnet, enter the Gateway (router) address. If it will communicate
only on the local subnet, leave the gateway address all zeros (0.0.0.0).

Leave the DNS address at 0.0.0.0 and the Host Name field blank.
WARNING! Each device on your network, including computers, routers, controllers, brains, and so
on, must have a unique IP address. Failure to assign unique IP addresses may cause catastrophic

network or hardware failures. If you don’t know which IP addresses are safe to use, check with your
system administrator.

8. When the IP address, subnet mask, and other fields are correct, click OK.

The new IP address information appears in the upper list in the dialog box, and the device's
status changes to Mapped. The address information also appears in the lower list to show that
this device has been mapped to this address.

Status changes to Mapped

5 Asfign IP Address *
Units Requesting IP Addresses
| Statup | MAC Address | IP Address sk | Hostname | Gateway Addr... | Assign |
([Mapped I 39,0 0.0.00
Dizcovered Sef Static IP |
Assign All |
£ >
An IP Address has been Mapped ta this Unit, but not yet Azsigned Set All Static IPs |
MAC To IP Address Mappings - (MacToIP.map) Test
MAC address data MAC Address | 1P Address | subnet Mask | Hostname | Gateway Addr... | DS Addre Add...
. ——O0CCLC-01LCCC 10.193.93.119 255.285.199.0 0.0.00 0.0.00
appearsin lower pane Modify. .. |
Delete |
Save List... |
< > Load List... |
Close | Help |

9. With the device still highlighted, click Assign.
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The address is saved to flash memory, and the status changes to IP Address Assigned.

Status changes to IP Address Assigned.

A *
MAC Address | IP Address | Subnet Mask | Hostname | Gateway Addr Assign |
gned NOCCLC-MCCLC 10.199.99.119 255.266.199.0 0.0.0.0
Discovered 00-CC-30-00-98-CC Set Static IP |
Assign All |
£ >
Unit has been permanently assigned an P Address Set Al Static IPs |
MAC To IP Address Mappings - (MacToIP.map) Test
MAC Address | IP Address | Subnet Mask | Hostname | Gateway Addr... | DNS Addre Add...
00CCLC-mLCCCo 10.199.95.119 255.2585.195.0 0.0.0.0 0.0.0.0
Modify... |
Delete |
Save List... |
< > Load List... |
Close | Help

Once a device's status becomes Assigned or Static, you can no longer change its IP address
information from this dialog box. To change the address, use Tools > Change IP Settings.
(See page 219.)

If the device's status changes from Mapped to IP Address Assigned, and then back to
Mapped, and the STAT LED on the device continues to flash (instead of steadily glowing
green) this means the IP address was not successfully assigned. This often happens when
you try to assign the IP address by using a wireless connection, rather than a wired
connection. Connect to the device with a cable and try again, and verify that you've
performed all of the checks listed in the NOTE on page 10.

10. To verify that the IP address has been assigned successfully, highlight the device in the upper

list and click Test.

PAC Manager User’s Guide



ASSIGNING AN IP ADDRESS

A command prompt window opens and the IP address is automatically tested using the PING
command. You should see a reply similar to the following:

BN C:\Windows\system32\cmd.exe EI@

Pinging 18.192.54.118 with 32 hytes of data:

Reply from 18.192.54.118: bytes=32 time=1ms TTL=255
Reply from 18.192.54.118: b =32 time{ims TTL=255
Reply from 18.192.54_.118: hy 32 time<{ims TTL=255
Reply from 18.192.54.118: hyte.,—32 time<ims TTL=255%

Ping statistics for 18.192.54.118:

Packets: Sent = 4, Received = 4, Lost = @ (Bx loss>.
Approximate round trip times in milli-seconds:

Minimum = Bms. Maximum = ims. Average = Bms

Press any key to continuwe . . . _

If you don't see a reply, make sure the subnet mask you've assigned matches the subnet mask
on your computer.

11. For future reference, write the IP address next to the MAC address on the white sticker provided
on the device.

12. Repeat steps 6 through 11 for any other devices in the list that you are responsible for.

13. To save the list of IP address and MAC address mappings (the lower list in the dialog box) for
future reference, click the Save List button. Navigate to the folder where you want to save the
file, enter a filename, and then click Save.

The address information is saved. You can load this information into PAC Manager later if you
need to see it.

What's Next?
«  ForaSNAP PACR-series controller, continue to page 21 to assign an IP address to Ethernet 2.

- For a Wired+Wireless model, configure the wireless LAN interface (page 26). Then
continue with “Creating an I/0 Unit Configuration File” on page 29.

«  ForaWired+Wireless EB brain, configure the wireless LAN interface on page 26. Then
continue with “Creating an 1/O Unit Configuration File”on page 29.

«  ForaSNAP PACEB brain, continue with “Creating an I/0 Unit Configuration File”on page 29.
«  ForaSNAP PAC S-series controller, choose from the following:

— Toset up security on the wired network, see page 90.

— Toassign an IP address to Ethernet 2 on a wired network, see page 21.

- (Wired+Wireless models only) To configure the wireless LAN interface, see page 26.

«  To create PAC Control strategies to run on the controller, see Opto 22 form 1700, the
PAC Control User's Guide, and form 1701, the PAC Control Command Reference. Information on
peer-to-peer communication using the Scratch Pad area of the controller can be found in the
PAC Control User’s Guide; see the “peer-to-peer communication”in the index.

+  To work with the controller’s file system, microSD card, and FTP, see page 235.
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In Windows 7 and Windows Vista, press the Windows Start key (&)
Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

In Windows 10 and Windows 8.1, press the Windows Start key (&)
9.5 and then press the Enter key.

Assigning IP Addresses to Multiple Devices

NOTE: In order to assign IP addresses, you must be logged in with administrative rights.

If you are an OEM, integrator, or customer who has a large number of Opto 22 devices to work with
at once, you may find it easier to first create a file of MAC-to-IP address mappings, and then assign IP
addresses from the file.

Creating the Map File

1.

2.

Make sure you have the MAC addresses for all Opto 22 devices in front of you. Also make sure
you know what IP addresses and subnet masks you are going to use for them.

The MAC address for each device appears on a white sticker or space on the device itself. To
determine the IP addresses and subnet masks to use, work with the network administrator for
the Ethernet network on which the devices will be used.

NOTE: On a SNAP PAC controller, you can assign only the primary IP address using these steps. To
assign the secondary IP address (Ethernet 2), follow steps on page 21.

Before installing the Opto 22 devices, open PAC Manager as follows:

In Windows 7 and Windows Vista, press the Windows Start key ::5"" and then click
Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

In Windows 10 and Windows 8.1, press the Windows Start key &
9.5 and then press the Enter key.

type PAC Manager
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ﬂ PAC Manager
File Tools View Help

bS] #|%el R 6 el

Ready

LN

3. From the Tools menu, click Assign [P Address.

The Assign IP Address dialog box opens.

Units Requesting IP Addresses
Upper SeCtiOﬂ iS Used for Statuz | MALC Address | IP Address | Subnet Mask | Hosthame | Gateway Addre: Azzign |
live assignment to devices. set StaticIP_|
Azzign Al |
Set &l Static IF'sl
< n »
Listening for DHCP Discovers and BootP Requests Test |
MALC To IP Address Mappings - [MacT ol P.map)
Lower section shows MAC Address | IF Address | SubnetMask | Hosthame | Gateway Address | DNS Address Add... |
contents of afile containing Modiy.._|
lists of addresses. These b |
addresses may or may not
be actual assignments. _savelin |
< i | Load List.. |
Cloze | Help |

The upper section of this dialog box lists all Opto 22 devices on the same network that send a
BootP or DHCP broadcast while the dialog box is open. When you are ready to assign IP
addresses, this is where you do so. For now, ignore anything that appears here.

The lower section shows the contents of a mapping file you create, either while assigning
actual addresses or in advance of assigning them. This file can be saved, changed, and reloaded
at a later time for reference or to quickly assign addresses using the upper section—but the
actual addresses on devices cannot be assigned or changed here. The important thing to
remember about this lower section is that the list does not necessarily reflect actual addresses on
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devices. The IP addresses in the list may not have been assigned yet, or a device's address might
have been changed at some point and the list not updated.

4. Inthelower section of the dialog box, click Add.

| Add MAC To IP Mapping (=23

MaC Address: all-3d

IF Address: W
Subnet Mask: W
Gateway dddress: W

DMS Address: oo, 0.

Host Mame:
ak. | Cahicel |

L) (R e | S e |

=

5. Forthefirst Opto 22 device, type the correct MAC address (the first six digits are entered for
you; they are the same for all Opto 22 devices). Enter the IP address and subnet mask. Enter the
Gateway address if needed. Leave the DNS address at 0.0.0.0 and the Host Name field blank.

6. Double-check all numbers. When all are correct, click OK.
The device's address information is listed in the lower section of the dialog box.

| Assign IP Address =
Units Requesting IP Addresses
Statuz MALC Address IP Address Subnet Mask Hosthame Gateway Addre:
4 | i b
Listening for DHCP Discovers and BootP Requests
MALC To IP Address Mappings - [MacT ol P.map)
MALC Address IP Address Subnet Mask Hostname Gateway Address | DNS Address Add... |
00-40-30-01-85-9C  10.192.54.110 285.285.192.0 0.0.00 0.0.00
'l 1 3 Load List...
Cloze Help
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7.

8.

o.

10.

Click Add again and add additional addresses until all of them are listed in the lower section.

| Assign IP Address =
Units Requesting IP Addresses
Statuz MALC Address IP Address Subnet Mask Hosthame Gateway Addre:
] 1 ¢
Listening for DHCP Discovers and BootP Requests
MALC To IP Address Mappings - [MacT ol P.map)
MALC Address IP Address Subnet Mask Hostname Gateway Address | DNS Address Add... |
00-a0-3d-00-d4-eb  10.192.54.37 285.285.192.0 0.0.00 0.0.00
00-a0-3d-00-9d-d3  10.192.56.230 285.285.192.0 0.0.00 0.0.00
00-a0-3d-00-d5-ed  10.192.55.110 285.285.192.0 0.0.00 0.0.00
00-a0-3d-00-c1-48  10.192.54.115 285.285.192.0 0.0.00 0.0.00
00-a0-3d-00-c1-40  10.192.54.70 285.285.192.0 0.0.00 0.0.00
00-a0-3d-00-c7-22  10.192.54.156 285.285.192.0 0.0.00 0.0.00
00-a0-3d-00-9d-c5  10.192.56.229 285.285.192.0 0.0.00 0.0.00
'l 1 3 Load List...
Cloze | Help |

Double-check the addresses. If one is incorrect, click it to highlight it, click Modify, and make
the necessary changes.

To save the mapping file, click Save List. In the Save dialog box, navigate to the folder where
you want to place the file, enter a filename, and click Save.

The .map file is saved as a simple text file. This allows it to be modified in text editors such as
Notepad.

Continue with the next section to assign the addresses.

Assigning Addresses from the Map File

NOTE: BootP broadcasts cannot get through a firewall in the computer where PAC Manager is running.
Make sure any firewall in the computer is disabled before you try to assign IP addresses. Firewalls in a router
should not be a problem.

1.

IMPORTANT: Disable all DHCP servers on the Ethernet network you are using to assign IP
addresses.

If a DHCP server is enabled on the network, it may assign IP addresses before PAC Manager has
a chance to do so. If that happens, turn off power to the devices, disable all DHCP servers, and
turn the devices back on. They should broadcast again.

Make sure that each Opto 22 device is installed according to directions in its user's guide. Make
sure the computer you use is on the same network segment as the devices.

Turn on all the Opto 22 devices.

If PAC Manager isn't already open, start it:

—
- InWindows 7 and Windows Vista, press the Windows Start key , and then click
Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

o
- InWindows 10 and Windows 8.1, press the Windows Start key , type PAC Manager
9.5 and then press the Enter key.
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5. Inthe PAC Manager menu bar, click Tools > Assign IP Address.

6. Ifthe .map file you want does not appear in the lower section of the Assign IP Address dialog
box, click Load List, locate the file, and open it.

The Opto 22 devices begin to appear in the upper section of the dialog box. IP address
information from the map file is copied to the corresponding MAC address in the upper
section, and the status of each device changes to Mapped.

Status changes to Mapped. IP address information is filled in.
| Adsign IP Address =

Unit} Requesting IP Addresses
Stdtus MALC Address IP Address Subnet Mask Hostname Gateway Address | DME
M apped 00-a0-3d-00-d4-eb | 10.192.54.37 285.285.192.0 0.0.00 0.l
M apped 00-a0-3d-00-9d-d3 | 10.192.56.230 285.285.192.0 0.0.00 0.l
M apped 00-a0-3d-00-d5-ed | 10.192.55.110 285.285.192.0 0.0.00 0.l
M apped 00-a0-3d-00-c1-48 | 10.192.54.115 285.285.192.0 0.0.00 0.l
M apped 00-a0-3d-00-c1-40 | 10.192.54.70 285.285.192.0 0.0.00 0.l
M apped 00-a0-3d-00-c7-22 | 10.192.54.156 285.285.192.0 0.0.00 0.l
M apped 00-a0-3d-00-9d-c5 | 10.192.56.223 255.285.192.0 0.0.0.0 0.l

LI Li

Liztening for DHCP Discovers and BootP Requests

MAC To [P Address Mappings - (MacTolP.map)
MALC Address IP Address Subnet Mask Hostname Gateway Address | DNS Address Add...
00-a0-3d-00-d4-eb  10.192.54.37 285.285.192.0 0.0.00 0.0.00
00-a0-3d-00-9d-d3  10.192.56.230 285.285.192.0 0.0.00 0.0.00
00-a0-3d-00-d5-ed  10.192.55.110 285.285.192.0 0.0.00 0.0.00
00-a0-3d-00-c1-48  10.192.54.115 285.285.192.0 0.0.00 0.0.00
00-a0-3d-00-c1-40  10.192.54.70 285.285.192.0 0.0.00 0.0.00
00-a0-3d-00-c7-22  10.192.54.156 285.285.192.0 0.0.00 0.0.00
00-a0-3d-00-9d-c5  10.192.56.229 285.285.192.0 0.0.00 0.0.00

Cloze | Help |

7. Check the address information. If anything is incorrect, double-click the device in the lower list
and change it. Click Save List to save the change to the file.

The change is automatically made to the upper section.
8. When all addresses are correct, click Assign All.
The address is saved to flash memory, and the status changes to Static IP

The devices now have their IP addresses. If you need to change an address, use Tools > Change IP
Settings (see ). To assign an IP address to Ethernet 2 on a SNAP PAC controller, see the steps in the
next section.

Assigning an IP Address to Ethernet 2 (SNAP PAC Controller
Only)

NOTE: This section does not apply to SNAP PAC brains; the two Ethernet network interfaces on a SNAP PAC
brain have the same IP address.

For Wired+Wireless models, see page 26 to configure the wireless LAN interface.

SNAP PAC R-series and S-series controllers have two independent Ethernet network interfaces,
labeled on the top of the controller as Ethernet 1 and Ethernet 2. The controller sends its initial
BootP request from Fthernet 1, and the IP address you assign to the controller is for this primary
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interface. To communicate through Ethernet 2, you must assign it a separate IP address following
the steps below.

IMPORTANT: The two Ethernet interfaces will work only if they are on separate IP subnets, so the control
engine can clearly determine where to direct communication. (The subnet masks can be the same or
different, but when you perform a logical AND on the IP address and subnet mask for each interface, the
two results must be different.) For example:

Ethernet 1

Ethernet 2

IP Address:

192.168.0.12

10.0.0.5

Subnet Mask:

255.255.255.0

255.255.255.0

NOTE: If you need to configure or modify settings for the network interface cards on your computer, you
must be logged in with administrative rights.
1. If PAC Manager isn't already open, start it:

- InWindows 7 and Windows Vista, press the Windows Start key &)
Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

- InWindows 10 and Windows 8.1, press the Windows Start key
9.5 and then press the Enter key.

2. Inthe PAC Manager main window, click the Inspect button @

##| Inspect Opto 22 Device - *

Device Name: j Options »

Status Read

=L Error reading area: Timeout

Status Read

Status Write lﬁl

Wireless LAN  »

Point Config
Digital Bank
Digital Point

Analog Bank

Analog Point

High Density
System »
ScratchPad
Datalog
PID 3
Events 3
Communications ¥
Other 3

[ AutoRefresh | 15000  msec

If this is the first time you have used the Inspect button, the Device Name field will be blank, as
shown above. If you have used the Inspect button before, the last Device Name you used is
shown, and the most recently used names are available in the drop-down list.

3. Inthe Device Name field, type the name for the SNAP PAC controller (or choose it from the
drop-down list).

PAC Manager User's Guide



CHAPTER 2: CONFIGURING DEVICES

If the controller has not been defined in PAC Manager, the Add New Device dialog box appears.
Choose Direct Connection to Ethernet Device and enter the IP address of the primary Ethernet
interface (Ethernet 1). Leave the Ethernet port at 2001 unless you have changed it on the
controller.

4, C(lick Status Read.

Status information for the controller is shown in the window. Scroll down till you see ETHERNET
2 Interface. If the IP address for Ethernet 2 has not been assigned yet, the IP address information
will show all zeros.

] Inspect Opto 22 Device — X
Device Name: | INBEFRTNF) - Options # Status: | Status Read area last read at 07/05/16 09:55:07
Status Read
Status Read

Status Write 0xFFFF F030 0018 Loader Version R5.1c A Refresh |
0xFFFF F030 0000 Memory Map Version 1
. 0xFFFF F030 0230 Current Boot Device Flash Memory
Wireless LAN  »
O0XFFFF FO030 001C Firmware Version A9.5a
OXFFFF FO30 00RO Firmware Version Date 05/03/72016
Paint Config 0xFFFF F030 00B0 Firmware Version Time 15:29:32
Tl [ 0xFFFF FO30 0020 Unit Type 0x0000007A
Digital Point 0xFFFF FO30 0080 Unit Description SNAP-PAC-R1 NS
0xFFFF F030 0024 I/0 Unit Hardware Revision (Month) 4
Analog Bank: 0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
OXFFFF F030 0026 I1/0 Unit Hardware Revision (Year) 2008
Analog Paint 0xFFFF F030 024C I/0 Coprocessor Firmware Version 20.0a
. - O0xFFFF F030 0028 Installed Ram 33554432
ETHERNET 1 Interface
F=en O 0xFFFF F030 002E MAC Lddress 00-A0-3D-01-85-9C
saatchpad  » 0xFFFF F030 0034 IF RAddress 10.192.55.67
0xFFFF F030 0038 Subnet Mask 255.255.192.0
Data Log » O0XFFFF FO030 003C Gateway 10.-192.51.51
oD R OXFFFF FO30 0040 DS 10.192.60.31
ETHERNET 2 Interface
Secondary IP address v 0xFFFF FFFF FO&0 MAC Address 00-AD-3D-01-85-9D
information. Events OxFFFF FFFE FO50 IP Addreas 0.0.0.0
Communications 0xFFFF FFFF FO58 Subnet Mask 0.0.0.0
I 0xFFFF FFFF FOG8 Gateway 0.0.0.0
Other D‘ 0xFFFF FFFF FO70 DNS 0.0.0.0

Help [ AutoRefresh | 15000  msec
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5. Click Status Write. Scroll down to see all the IP address fields for Ethernet 2.

5| Inspect Opto 22 Device - >
Device Name: | 10.192.55.67 j Options * Status: | Status Write area last read at 07,/05/16 09:58:59
Status Write
Status Read
Status Write Address | Description | Value |A Refresh |

Wirgless LAN  »

0xFFFF FO38 0280
OxFFFF FO38 0054
0xFFFF FO38 0154
OxFFFF FO38 0194

Out Of Range Value (32-Bit)
Scanner Flags

Host Name

Domain Name

-2147483648.000
0 00000000

Apply

Point Config OxFFFF F408 0004  Strategy Download Method MNormal 1|
0xFFFF F700 2000 Turn-Around Delay for Port 0 {msec) Q
Digital Bank ETHERNET 2 Interface
— || || oerre e FOs) 1P Address 0.0.0.0
Ethernet 2 IP Digital Point OXFFFF FFFFF0S8  Subnet Mask 0.0.0.0 N
; o e— OxFFFF FFFF 088 Gateway 0.0.0.0
address fields g 0xFFFF FFFFFO70 DNS 0.0.0.0 .

Analog Point
High Density

Operation

OptoMMP Device

Restart command Tystem ¥

ScratchPad b
Data Log 3
FID 3
Events 3
Communications b
Other 3

microsD

Other

Close Help

Restart Device from powerup )
Store configuration fo flas!

Erase configuration from flash

Reset to defaults and Restart Device

Store configuration and IP settings to microSD
Erase configuration and IP settings from microSC
Erase firmware from microsD

Erase strategy from microSD

Switch to loader mode
Clear Digital Events - Expanded configuration
Clear D!gita\ Events - O\[:I configuration W

~ Send Command

[ AutoRefresh | 15000  msec

6. Click the Value field for IP Address under Ethernet 2 Interface and type in the IP address. Enter
the Ethernet 2 Subnet Mask the same way. If necessary, change the Gateway. Leave the DNS
asis.

7. When all the secondary IP address fields are correct, click Apply.

The information is sent to the SNAP PAC, but it cannot communicate on the Ethernet 2
interface until it is restarted.

8. Inthe Operation Commands section, highlight Restart Device from powerup. Then click Send
Command.

The SNAP PAC is restarted.
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9. Check to make sure the controller is back on line by clicking Status Read again. Click OK at the
message. Scroll down a little to see all the IP address information for Ethernet 2.

= Inspect Opto 22 Device

- x

Device Name: | 10,192.55.57

Status Read
Status Read |

Status:

j Options »

Status Read area last read at 07/05/16 10:07:17

information

Ethernet 2 IP address
information

Status Write 0xFFFF F030 0000 Memory Map Version 1 - Refresh |
0xFFEFEF FO30 0230 Current Boot Device Flash Memory
) 0xFFFF FO30 001C Firmware Version 19.5a
wEESA D OxFFFF F030 00A0 Firmware Version Date 05/03/2016
0xFFFF F030 OOBO Firmware Version Time 15:29:32
Point Config
Digital Bank 0xFFFF F030 0020 Unit Iype 0x0000007A
0xFFFF F030 0080 Unit Description SHRF-FAC-R1
Digital Point 0xFFFF F030 0024 I1/0 Unit Hardware Revision (Month) 4
0xFFFF F030 0025 I1/0 Unit Hardware Revision (Day) 21
Analog Bank 0xFFFF FO30 0026 I1/0 Unit Hardware Reviasion (Year) 2008
0xFFFF F030 024C 1/0 Coprocessor Firmware Version 10.0a
Anilog Point OxFFFF FO30 0028 Installed Ram 33554432
% ETHERNET 1 Interface
0xFFFF F030 00ZE MRC Rddress 00-A0-3D-01-85-9C
iEEn b 0xFFFF F030 0034 IP Address 10.192.55.67
cqatchPad b 0xFFFF FO30 0032 Subnet Mask 255.255.192.0
_— 0xFFFF F030 003C Gateway 10.192.53.57
Data Log 4 0xFFFF F030 0040 \__ DNS 10.192.60.31
(ETHERNET 2 Interface
PID > 0xFFFF FFFF FO&0 MAC Lddress 00-A0-3D-01-85-9D
Events Y (.35 3 5 e 0 L IF Rddress 10.10.10.7
0XFFFF FEFF FO58 Subnet Mask 255.255.255.0
Communications » 0xFFFF FEFF FOG8 Gateway 0.0.0.0
0xFFFF FEFF FO70 \__ DNS 0.0.0.0
Other 4 v

Close Help

™ AutoRefresh | 15000  msec

10. To verify that the secondary IP address (Ethernet 2) is also communicating, make sure
Ethernet 2 is attached to the correct network. On a computer on the same subnet as Ethernet
2, open the PAC Manager Inspect window. Enter the Ethernet 2 IP address (or a different name)
in the Device Name field and click Status Read.
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The controller now shows the same information, but through the secondary interface:

IP address for secondary 8] Inspect Opto 22 Device - X
interface (Ethernet 2) Device Name: | 10.10.10.7 j Options ¥ Status: | Status Read area last read at 07/05/16 10:07:17
Status Read
Status Read |
Status Virite 0xFFFF FO30 0000 Memory Map Version 1 ~ Refresh |
0xFFFF F030 0230 Current Boot Device Flash Memory
— 5 0xFFFF F030 001C Firmware Version A9.5a
sl OXFFFF FO30 00A0 Firmware Version Date 05/03/2016
0xFFFF F030 00BO Firmware Version Time 15:29:32
Point Config
T 0xFFFF F030 0020 Unit Type 0x00000078
grtal Ban 0xFFFF FO30 0080 Unit Description SNAB-FAC-R1
Digital Point O0xFFFF FO30 0024 1/0 Unit Hardware Revision (Month) 4
OxFFFF FO30 0025 1/0 Unit Hardware Revision (Day) 21
Analog Bark 0xFFFF FO30 0026 I1/0 Unit Hardware Revision (Year) 2008
= 0xFFFF FO030 024C 1/0 Coprocessor Firmware Version A0.0a
Analog Point 0xFFFF F030 0028  Installed Ram 33554432
ERCIDaE ETHERNET 1 Interface
Ethernet 1 IP address R 0xFFFF FO30 002E MAC Address 00-A0-3D-01-85-9C
. . HEED 0xFFFF F030 0034 1P Address 10.192.55.67
information SoratchPad b OxFETE F030 0038 Subnet Mask 255.255.192.0
0xFFFF F030 003C Gateway 10.192.51.51
Datalog * 0xFFFF FO30 0040 NS 10.192.60.31
ETHERNET 2 Interface
Ethernet 2 IP address PID 4 0xFFFF FFFF F060 MAC Address 00-20-3D-01-85-3D
Informatlon Fvents 3 ] (xFEEFEF FEEE EFOSO IP Rddress 10.10.10.7
0xFFFF FFFF FOS8 Subnet Mask 255.255.255.0
Communications ¥ 0xFFFF FFFF FO&2 Gateway 0.0.0.0
0xFFFF FFEF FOT0 NS 0.0.0.0
Other 3 Y]
e ‘ Er | [” AutoRefresh | 15000  msec

Configuring Wireless LAN Communication (Wired+Wireless
Models Only)

This section applies only to SNAP PAC controllers and EB brains with wireless LAN interfaces (models
ending in -W). These devices send their initial BootP request from Ethernet1, and the IP address you
assign to them is for this primary interface. To communicate through the wireless LAN interface, you
must assign it a separate IP address and configure communication following the steps below.

IMPORTANT: The wireless LAN interface will work only if it is on a separate IP subnet, so the device can
clearly determine where to direct communication. (The subnet masks can be the same or different, but
when you perform a logical AND on the IP address and subnet mask for each interface, the two results

must be different.) For example, on a SNAP-PAC-ST-W you might use the following addresses and subnet
masks:

Ethernet 1

Ethernet 2

Wireless LAN

IP Address:

11.192.55.162

10.10.10.7

146.87.12.250

Subnet Mask:

255.255.255.0

255.255.255.0

255.255.255.0

NOTE: If you need to configure or modify the settings for the network interface cards on your computer, you

must be logged in with administrative rights.

1. If PAC Manager isn't already open, start it:

PAC Manager User's Guide
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— InWindows 10 and Windows 8.1, press the Windows Start key
9.5 and then press the Enter key.

2. Inthe PAC Manager main window, click the Inspect button Ql

Z, type PAC Manager

¥ Inspect Opto 22 Device — X

| _options ¢

Device Mame: I [Pl Error reading area: Timeout

[~ Status Read
Status Read |

Status Write
Wireless LAN ¥ |

Point Config
Digital Bank
Digital Paint
Analog Bank
Analog Point
High Density
System 13
SaatchPad
Datalog F
PID 13
Events 3
Communications ¥
Other 3

[~ AutoRefresh | 15000 msec

If this is the first time you have used the Inspect button, the Device Name field will be blank, as
shown above. If you have used the Inspect button before, the last Device Name you used is
shown, and the most recently used names and IP addresses are available in the drop-down list.

3. Inthe Device Name field, type the device’s name or IP address (or choose it from the
drop-down list).

4. C(lickWireless LAN and choose Wireless LAN Configure from the popup menu.

=3 BCh <

Status: |"wiFi Configuration area last read at 01/06/12 11:47.32

| Inspect Opto 22 Device

j Optiong » |

Device Mame: |1 01925020

—wireless LAM Confiquration
Status Fead

Address

Description Walue

5.
6.

Status Write
Wireless LAN b

Paint Config
Digital Bank.
Digital Paint
Analog Bank
Analog Point

High Density

R

0FFFF F200 0000
0FFFF F200 0004
0FFFF F200 0003

OFFFF F700 4004
0=FFFF F700 4008
0-FFFF F700 400C
0FFFF F700 4010
0FFFF F700 4014
0FFFF F700 4018
0<FFFF F700 401C
0FFFF F700 4048

WLAN Configuration
WLAN Enable Disabled
WLAN Logging
Fix Inactivity Reaszociation Timeout [sec)

Metwork Block Configuration
IP Address 0.0.0.0
Subret Mask 0.0.0.0
Frimary Gateway 0.00.0
Secondary Gateway 0.0.0.0
Primary DNS 0.0.0.0
Secondary DMS 0.0.0.0
Metwork Mame [S51D)
Encryption Type None

T s P s S G i e e~ el ety

In the WLAN Enable line, click the arrow next to Disabled and choose Enable.
Leave WLAN Logging disabled and Rx Inactivity Timeout at the default of 300.

Logging Disabled
300

Refresh |
ﬂ Apply |

Wiew Status |

=l
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8.

o.
10.

11.

12.

13.

14.
15.

Under Network Block Configuration, enter the IP address and subnet mask for the wireless
network. Remember that it must be on a separate network segment from the wired interfaces
on the device.

If necessary, enter the Primary and Secondary Gateway addresses. Leave the Primary and
Secondary DNS fields blank.

Type in the name of the wireless network (SSID).
For Encryption Type, click the arrow next to None.

=] Inspect Opto 22 Device (=] = [ =]
Device Mame: ]1 0.19250.20 j Options » Status: WPl Configuration area last read at 01/06/12 11:47:32
1 Wwireless LAN Configuration -
Status Fead
= Address ] Drescription ] Walle ] Refresh
M WLAM Configuration
: 0xFFFF FBOO 0000 LA Enable Disabled jd| Apply
plice s e DAFFFFFB000004  ‘WLAN Looging Logging Disabled |
0«FFFF FEO0 0003 Fix Inactivity Reaszzociation Timeout [zec) 300
Faint Canfig Wiew Status
— Metwork Block Configuration
Digital Bank 0FFFF F700 4004 IP &ddress 1722060
T = 0=FFFF F700 4003 Subnet Mask 255.265.192.0
DigiskGoint O-FFFF F700 4000 Primary Gateway 0.00.0
Ao bok 0«FFFF F700 4010 Secondary Gateway 0.ooo
AEIEEREET) O:FFFFF7004014  Primary DNS 0.0.0.0
0«FFFF F700 4018 Secondary DNS 0.0.0.0
_A_“ﬂig_'ﬂ_l DWFFFF F7O0401C  Metwork Name (S51D) \Faior
High Density 0«FFFF F700 4048 Encryption Tupe Moke -
None
Spatem (3 WEP [B4-bit]
WEP [128-bit)
Scratch Pad  » il 'I
Ratatog | et FmaE, P, p

From the dropdown list, choose the security used on the wireless network.
Additional fields appear.

Choose the Network Key Input Type, either Hexadecimal or ASCII (WEP is normally Hex; WPA
and WPA2 are normally ASCII).

Enter the Network Key (the password for the network).

This field will show the password when you enter it; however, if you inspect the device later, the
field will show only asterisks.

When all fields are complete, click Apply.

At the message asking whether you want to restart the device, click Yes.

The configuration information is sent to the device and stored to flash memory, and the device

is restarted. The WLAN LED turns orange to indicate that the interface is searching for or
authenticating the wireless network. Once the network is found, the LED turns solid green.
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16. To see connection status and signal strength, click the View Status button. (You can also see

this screen by clicking Wireless LAN > Wireless LAN Status.)

| Inspect Opto 22 Device EI B @

Options » Status: |Wireless LAN Status area last read at 09/01/17 15:18:07

Device Name: |[IEEEE

‘wireless LAN Status
Status Fead

Status Wiite Connection Status: Connected
wilessLAN b | Signal Quality: Good (30 dB)

Paint Canfig
—ppase | = D
Digital Paint
»=10 »=20 »=30 »=40

Analog Bank
= Address ‘ Description ‘ Walue -
ety (et WIRELESS ETHERNET INTERFACE 0
High Density 0<FFFF F700 4004 P Address 10.192.55.35
0=FFFF F700 4008 Subnet Mask 285.255.192.0
0=FFFF F700 3002 MAC Address 00-40-17-1E-83-47 E
Syztem 3
WIRELESS LAM
_SoathPad v| | | o o0 Stee Cannected 4
Datalog  » DAFFFFF700 3040 Signal To Noise Riatin (48] 3
0=FFFF F700 3014 Network Mame [S510] 22-wifi
FID » 0=FFFF F700 4054 Encryption Type WRAZ [AES)
0=FFFF F700 300E BSSID 00-14-01-C5-8C-88
Ewents 3 0xFFFF F700 3034 Channel / Frequency 11/ 2462
0<FFFF F700 3033 Feceive Rate (kbps) 48000
Communications ¥
0=FFFF F700 3044 Signal Level (dBm) -B5
Other  » 0+FFFFF700 3048 Noise Level (dBml a7 -
Help [T Auto Refresh |15000  msec

Connecting with a SNAP PAC SB Brain

Most devices you communicate with using PAC Manager are Ethernet-based. That is, they have at
least one Ethernet network interface and can be reached directly over an Ethernet network that
includes the computer where PAC Manager is installed.

SNAP PAC SB brains are an exception: they have no Ethernet interface and instead communicate
over a serial network. PAC Manager can communicate with SB brains in two ways, however.

Through a SNAP PAC controller, via an Ethernet connection to the controller and then a serial
connection from the controller to the brain. This method is easy and does not require the brain
to be located near the computer.

Directly from the computer to the brain, using the computer’s serial port via a serial cable and
an RS-485 adapter, such as an Opto 22 PCI-AC48 adapter card. This method is useful for
configuring points and features before brains are deployed to the field, or if you are not using a
SNAP PAC controller.

For connections, see wiring instructions in Opto 22 form 1690, the SNAP PAC Brains User’s Guide.

Creating an I/0 Unit Configuration File

Before you create a control strategy using PAC Control, or before you read or write to I/0 units, you
need to configure the I/O points and features the strategy or other application will use. You can use
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PAC Manager to copy a configuration or to configure all points, save the configuration to a file, and
then upload the configuration to one I/0 unit or to several at once. You do not need to be attached
to the I/0 unit while you are creating the configuration file and configuring its points.

NOTE: If you are using OPC to communicate with the I/O unit, you can use the configuration file (tag file)
that PAC Manager produces as an easy way to reference points for OPC. See Opto 22 form 1439, the
OptoOPCServer User's Guide, for more information about using OPC.

You can start configuration in one of three ways:

If this is a new configuration, you can create a new configuration file (page 30).

If an existing I/0 unit has the exact configuration you want, you can copy it directly to another
I/0 unit (page 32).

If you have a PAC Control strategy with similar I/0 units configured, you can save them as a
configuration file (page 35) and modify the configuration. Note that this method transfers 1/0
unit and point information only; any event messages, email or SNMP settings, and so on are not
included when a configuration file is exported from or imported to PAC Control. Also,
4-channel digital module and point information is generic; you will need to reenter specific
digital configurations.

Creating a New Configuration File

1.

If PAC Manager isn't already open, start it:

- InWindows 7 and Windows Vista, press the Windows Start key :5/" and then click

Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

(&)

- InWindows 10 and Windows 8.1, press the Windows Start key &, type PAC Manager
9.5 and then press the Enter key.

In the PAC Manager main window, click the New button ﬂ or click File > New.

In the Create New Tag Database dialog box, navigate to the location where you want the file to
be. Type a filename. Click Open.
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A new configuration tree appears. (If you are familiar with PAC Control, you'll notice that this
window looks like part of a Strategy Tree.)

=
File Edit Tools View Help

EEEEEO)

o e ) |

C:\Program Files (x86)\Opto22\PAC Project 9.0\SNAP PAC Learning Center\Mair MNUM v

You can expand and collapse the folders to see or hide the I/0 units and points in them.
Closing the configuration tree is the same as closing the configuration file.

To save the configuration file, click the Save button El (or in the menu bar, click File > Save).
5. Once thefile is saved, continue with “Adding an 1/0 Unit”on page 36.

Copying an I/0 Unit Configuration

If you have an 1/0 unit or a previously saved I/O unit image file with exactly the configuration you
want to use, you can copy the configuration information to another 1/0 unit or to an I/O unit image
file. This works with all SNAP PAC Ethernet and serial brains.
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1. Inthe PAC Manager menu bar, click Tools > Import/Copy 1/0 Unit.
| /O Unit Import/Copy @
Source ————Image Source
{+ Existing IO Unit Flash Memory Read
1/0 Unit Name: | 10,192.54.110 ~| options »
" Previously Saved IfO Unit Image File
| L]
Destination —— Image Destination
* Send Image To Ij0 Unit Flash Memory
1/ Unit Name: | j Options #
" Save To IfO Unit Image File
| L]
=
Close
2. Forthe source, choose one of the following:
Existing I/0 Unit Flash Memory: Choose an existing I/0 unit. If you want to add or modify an 1/0
unit, click Options. For help, see “Add/Modify New Device”on page 264.
Previously Saved I/0 Unit Image File: Enter the name of the 1/0 image file you want to use, or
click the browse button to find the file.
3.  When the source is correct, click Read.
A success message appears when the data has been read. Click OK.
4. Forthe destination, choose one of the following:
Send Image To I/O Unit Flash Memory. Choose an existing I/O unit. If you want to add or modify
an I/0 unit, click Options. For help, see “Add/Modify New Device” on page 264.
CAUTION: Make sure you have entered the correct IP address. The configuration will overwrite
anything currently in the I/O unit’s flash memory.
Save To I/O Unit Image File. Enter the name of the I/O image file you want to write to, or click the
browse button to find the file.
Create New I/0 Unit: Select this option to copy all the point information from a brain to create a
new I/0 unit in PAC Manager. You will be prompted to enter an I/0 unit name. For more
information, see “Creating a New /0 Unit from an Existing One” on page 32.
5. When the destination is correct, click Send, Save, or Create depending on the destination type.

A success message appears when the operation has completed.

Creating a New I/O Unit from an Existing One

The Create New I/0 Unit option on the I/O Unit Import/Copy dialog box allows you to create a new
I/0 unit by importing point information from the flash memory of an existing I/0 unit directly into
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the tree structure of a configuration file (also known as a tag database). You can then configure, add,
or delete points in the new I/O unit just as you would with an 1/0 unit created from scratch.

1.

Make sure to save the existing I/O unit's configuration information to flash memory. See
“Saving Configuration to a Device’s Flash Memory” on page 204.

Open an existing configuration file on the File menu, or create a new one. For information, see
“Creating a New Configuration File”on page 30.

In the PAC Manager menu bar, click Tools > Import/Copy I/0 Unit.
For the Image Source, choose Existing I/0 Unit Flash Memory.
Enter the IP address of the existing I/O unit, and click Read.

A success message appears when the data has been read. Click OK.

For the destination, choose Create New 1/0 Unit, and click Create.

Image Destination

" Send Image To IjO Unit Flash Memory M Click Create

0.0 .0.0 Port: | 2001 Timeout: | 10000

" save To IO Unit Image File

| L

In the Add I/0 Unit dialog box that appears, enter a name for the new I/0 unit, and click OK.
The new /0 unit is added to the open tag database and a success message appears. Click OK.

Close the I/0 Unit Import/Copy dialog box.
Expand the new /0 unit to see the imported points.

Main_Process*® EI@
&[5 Main_Process Tag database (configuration file)
En—’}‘l;‘l .Cookie.s New I/O unit
55 Paints Imported points

----- OM_, aoOvenTemperatureControl
----- D% aolConveyorspeedControl
----- I% ailvenTemperature

..... A

----- I% ailloughVesselPressure

..... L4 diChipLevelSwitch

----- I“'%“_' dilnspectionPassFailSwitch

..... HY diEStop

----- B"’—_“,' doDoughPressureControlValve
----- B"’—_“J doDoughDispenseValve

----- I doChipDispenseValve

----- 1 doRejectValve

10. Before you can save the new I/O unit, the digital points must be assigned specific modules as

follows:

PAC Manager User’s Guide



CREATING AN 1/0O UNIT CONFIGURATION FILE

a. Right-click a digital point and select Configure from the popup menu.
b. Double-click a generic digital module.

i»| Configure /O Points EI
1/0 Unit: | Cookies Type: | SNAP-PACR1 (analog/digital)
Modules and Points Type Features / Subty... Add...
Generic dlgltal = ij [00] Generic Digital Input Digtal Input Modify |
dul I § diDoughLevelSwitch None
moaule L
1 1 diChipLevelSwitch None | pelte |
LU 2 dilnspectionPassFailSwitch None
L 3 diEStop None Mave Ta... |
Bl [01] Generic Digital Output Digital Output
ﬁ [02] SNAP-AQV-27 Analog Output Expand Al |
- [03] SNAP-AICTD Analog Input
- [04] SNAP-AIV Analog Input Collapse All |
[05] Not Used -
< | »
Close I Help | Calibrate, .. |

C. Inthe Edit Module dialog box, select a digital module to match the existing I/0 unit, and
then click OK.

| Edit Module

Type:

Digital Output
Analog Input
Analog Output

Module:

SNAP-IDCS: 10 - 32 VDC/VAC -
SMAP-IDCS-FAST: 2.5 - 16 VDC il
SMAP-IDC5FAST-A: 18 - 32VDC ..
SNAP-IDCSD: 2.5 - 28 VDC Select a digital module
SNAP-IDCSMA: 10 - 32 VDC/VAC Man/auto Switch
SMAP-IDC5-5W: Dry Contact Switch
SMAP-IDCSQ): 4 - 24VDC

SNAP-IDCSG: 35 - 75 VAC/VDC

SMAP-IDC5HT: 15-32VDC

SNAP-IDC5-5W-NC: Dry Contact Switch
SMAP-IDCSFM: 10 - 32VDC

SMAP-IDCSDFM: 2.5 - 28 VDC

SMAP-IDC-32: 10 - 32VDC

SMAP-IDC-32M: -10 - 32VDC

SMAP-IDC-32D: 2.5 - 12VDC

SMAP-IDC-32DM: -2.5 - -12VDC

SMAP-IDC-16: 10 - 32VDC

SNAP-IDC-HT-16: 15 - 28 VDC/VAC —
Generic Digital Input

SNAP-TACS: 90 - 140 VDC/VAC

SNAP-TACSA: 180 - 230 VDC/VAC

SNAP-TACSMA: 90 - 140 VDC/VAC Man/auto Switch
SNAP-TACSFM: 90 - 140 VDC/VAC -

oK I Cancel |

m

d. Repeat steps b and ¢ for each generic module on the new I/0 unit.
e. (lose the Configure I/0 Points dialog box.

11. Save the new I/O unit.
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Creating a Configuration File from Another Strategy

If you use PAC Control and have a strategy with SNAP PAC I/O units already configured, you may
want to export that file and use it as a starting point, rather than creating a configuration file from
scratch. The exported file will contain all the I/0 units in the strategy. However, note the following:

I/0 unit and point data is transferred; optional functions such as event messages are not.

Four-channel digital modules and points do not retain specific configurations but revert to
generic ones. Specific data will have to be reentered.

You cannot save changes you make in PAC Manager back to the strategy file. Instead, you save
them to a configuration file, which can then be imported into PAC Control.

Follow these steps to create a configuration file from an existing strategy:

1.

7.

In PAC Control, open the strategy that contains the I/O units whose configurations you want to
export.

In the configuration tree, right-click the I/0 Units folder and choose Export from the pop-up
menu.

In the Export I/0 Units to an Opto Tag Database dialog box, navigate to the location where you
want to save the configuration file. Enter a name for the file, and click Save.

If PAC Manager isn't already open, start it:

- InWindows 7 and Windows Vista, press the Windows Start key E and then click
Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

- InWindows 10 and Windows 8.1, press the Windows Start key E type PAC Manager
9.5 and then press the Enter key.

In the PAC Manager main window, click the Open button El or click File > Open.

In the Open Tag Database dialog box, locate the file you just saved and openit.

File Edit Tools View Help

_BIEIEIiIEIEI_I_I_I

C:\Program Files (x86)\Opto22\PAC Project 9.0\SNAP PAC Learning Center\Mair MNUM v

Expand the I/0 units folder in the configuration tree to see the units and points that are already
configured.

8. Continue with the next section to add or change 1/0 units.
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Adding an I/0O Unit

An 1/0 unit consists of a SNAP I/0 mounting rack, plus the I/0 processor (brain or on-the-rack
controller) and I/0 modules mounted on it. Racks used with SNAP PAC I/O units can hold up to 16
modules.

You must add an 1/0 unit before you can configure its modules and points.

1. Make sure the configuration file is open. On the configuration tree, double-click the I/O Units
folder to open the Configure I/0 Units dialog box:

| Configure I/O Units @

Mame Tupe Fort Addrezs W atchdog Drescription Add...

Cloze | Help |

2. To configure a new I/0 unit, click Add or double-click anywhere in the box below any listed
units.
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The Add I/0 Unit dialog box appears.

A__
B__

Address List area —|

3.

Add 1/0 Unit (=23
Mame: [
Dezcription: |
Type: |SHAP-PAC-R1 ~
Temp: f* Fahlrenheit " Celzius
Part: 20M
Address:  [0.0.0.0
Secondary: |
Address List

QK. | Cancel | Help |

Add

il

Wwhatchdog: & Mo 7 Yes

For a SNAP PAC SB brain, skip to step 5. For an Ethernet-based unit, complete the fields as
follows:

a.

P onyoT

-h

Name. Enter a name for the I/0 unit. The name must start with a letter and may contain
letters, numbers, and underscores. Spaces are converted to underscores.

Description. (Optional) Enter a description of the unit.

Type. Select the type of I/O unit from the drop-down list.

Temp. Choose whether temperatures will be handled in Fahrenheit or Celsius.

Port. Specify the communication port to use (2001, unless you have changed it for security
purposes according to instructions starting on page 90).

Address. Enter the IP address for the I/0 unit.

Secondary. If it's a SNAP PAC R-series I/O unit with a secondary IP address, enter the
secondary IP address.

Watchdog. Select whether you want a Watchdog on the unit. The default is No (disabled).
If you select Yes, a new field appears; enter the Watchdog timeout value in seconds. The
default timeout is 0.5 seconds. For information on watchdogs, see page 80.

The Address List area shows IP addresses of the I/0 units that should receive this configuration.
If this is the only I/O unit to receive the configuration, don't add any addresses here. However, if
you have I/0 units that are exactly alike, list all of them here. That way you can download the
configuration file to all the I/0 units at once.

a.

To add an IP address, click Add.
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In the dialog box, you can add a single IP address or a range of addresses.

| Add IP Address =]

(¢ Add one [P Address / Host Name
& Paddess: | [ . 0. 0.0
- —
" Add arange of IP Addreszes

ok | Cancel | Help |

b. Enter the IP address(es) and click OK.
The addresses appear in the Address List area.
¢. Skip tostep 6.
5. Fora SNAP PAC SB brain, complete the dialog box as follows:

Add /O Unit =]
A —— Hame: || J_
B—— Description: |
C—— In= |SHAP-PAC-SB1 -
F
D—— Temp * Fahrenheit ™ Celgiuz G
E ——— Connection: ¢ Seyial Direct * Ethemet Passthiough : o
_ Connection: & Senial Diregt” © Ethermet Pazsthrough
Contraller N
Computer
Address:  [0.0.0.0 Port: | 2001 ] __
Serial Port: | [EEl5H] -
Serial Part: |Serial 2 -
Baud Rate: |115200 -
Baud Rate: |230400 -
Device -
evice
Serial Address: |0 v 2hdire )
) Serial Addreszs: |0
H——1— ®atchdog @ No (7 Yes
0K | Cancel | Help |

a. Name. Enter a name for the I/0O unit. The name must start with a letter and may contain
letters, numbers, and underscores. Spaces are converted to underscores.

b. Description. (Optional) Enter a description of the unit.

c. Type. Select the type of I/0 unit from the drop-down list.

d. Temp. Choose whether temperatures will be handled in Fahrenheit or Celsius.
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e. Connection. Choose whether you are connecting to the SB brain through a SNAP PAC
controller or directly from the computer (for more information, see “Connecting with a
SNAP PAC SB Brain”on page 29).

f. Ethernet Passthrough
—  Enter the controller’s IP address. Leave the port at 2001 unless you have changed it.

—  Enter the controller’s serial port where the brain is connected. On a SNAP-PAC-S1, it's
Serial 2. On a SNAP-PAC-S2, it could be any port.

—  The baud rate on the controller must match the rate set on the brain.
—  Enter the serial address of the brain.
g. Serial Direct

—  Enter the serial port on the computer where the brain is connected. The baud rate on
the controller must match the rate set on the brain.

—  Enter the serial address of the brain.

h. Watchdog. Select whether you want a Watchdog on the unit. The default is No (disabled).
If you select Yes, a new field appears; enter the Watchdog timeout value in seconds. The
default timeout is 0.5 seconds. For information on watchdogs, see page 80.

6. When information in the Add I/0 Unit dialog box is complete, click OK.
The new I/0 unit appears in the Configure I/O Units dialog box.

| Configure I/O Units @

Mame Tupe Fort Addrezs W atchdog Drescription Add...
Freprocess SHAP-PAC.. Ethemet 1019254, Enabled

Todify...
Delete

Import/Copy...

170 Points. ..
PID Loops...
Modules 3
Events r
Scratch Pad
Cammunications »
Cloze | Help | Others 4

7. Continue with the next section, “Configuring I/O Modules and Points.”
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Configuring I/0 Modules and Points

Once you have added an I/0 unit, you can configure its modules and points. See the following
pages for configuration steps. For motion control modules (SNAP-SCM-MCH16), see Opto 22 form
1673, the SNAP PAC Motion Control User’s Guide.

Digital points page 40
Analog points page 45
Serial modules (RS-232 & RS-485/422) page 52
Wiegand modules page 56
Profibus modules page 58

SSI(Serial synchronous interface ) modules  page 59
CAN modules page 61

HART modules page 65

Configuring SNAP Digital Points

Use the following steps to configure digital points on all digital modules supported by the brain or
on-the-rack controller.

1. Inthe Configure I/O Units dialog box, make sure the 1/0 unit for the point you are adding is
highlighted. Click the 1/O Points button.
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The Configure I/0 Points dialog box appears. The dialog box shown here is for a SNAP 1/0 unit.

| Configure I/0 Points El
140 Unit: Type: ISNAF’-F’AE-FH [analoag/digital]
Modules and Points Type | Features / Subty... « Add.. |

[00] Mot Used
[071] Mot Used
0Z] Not Used
[03] Not Used
[04] Mot Used
[05] Mot Used
[06] Mot Used
[07] Mot Used
[08] Mot Used
03] Not Used

1| |
Cloze I Help |

todify...

Delete

fdowve To...

Expand All

Collapze Al

o

FORELEL

Calibrate. ..

Double-click the number that represents the digital module’s position on the rack. (For help,

see the diagrams starting on page 171)

For a SNAP 1/0 unit, choose the module type and then the exact module part number from the

list.

| Add Module

Tupe:

Digital Input
Dvigital Output
Analog Input
Analog Output

todule:

SHAP-IDCE; 11 C
SMAP-IDCEFAST: 25-16WDC
SMNAP-IDCEFAST-A 18 - 32VDC
SMAP-IDCED: 25 - 28WDC
SMNAP-IDCEMA; 10 - 32 WDEAAL Manlbuto Switch
SMAP-IDCE-S'W: Dy Contact Switch
SHAP-IDCEQ: 4 - 24VDC

SMAP-IDCEG: 35 - 75 WACADC
SNAP-IDCE-HT: 15 - 32VDC
SHAP-IDCE-SW-MC: Dry Contact Switch
SMAP-IDCEFM: 10 - 32 VDT
SMAP-IDCEDFM: 25 - 28%DC
SMAP-IDC-32: 10 - 32vDC
SMAP-IDC-32M: -10 - 32%DC
SMNAP-IDC-32D; 25-12VDC
SMAP-IDC-32DN: -25-12VDC
SMNAP-IDC-16: 10 - 32vDC
SMAP-IDC-HT-16: 15 - 28 WDCAAL
EMU-ID-8: Input

EMU-ID-4: Input

Generic Digital nput

SHAP-IACE: 90 - 140 VDCAAL
SHAP-IACHRS, 180 - 280 VDL AL

[ o |

Cancel

m
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4. Click OK.

5. Backin the Configure I/O Points dialog box, click the plus sign next to the new module to
expand it. Notice that the module icon is color-coded to reflect the type of module being
configured: white for digital DC input, red for digital DC output, yellow for digital AC input, and

black for digital AC output.

=»| Configure I/0 Points E’
140 Unit: IF'leprncess Tupe: |SMAP-PAC-R1 [analog/digital)
Module icon
Modules and Points Type Features / Subty... «

Expand or collapse points
on the module by clicking
the + or - sign in the box.

(SN ] [00] SNAP-IDC5: 10 - 32 VDC/VAC
L Not Used
L {1 Not Used

Digital Input

Todify...

Lelete

L L4 2 Not Used
Points ~ IL,EI 3 Not Used e To...
[01] Not Used
[02] Mot Used Expand &l
[03] Not Used
04] Mot Used Collapze Al

[05] Mot Used

< |
Cloze I

o

Calibrate...

PR g

Help |

6. Double-click the point you want to configure.

Add Digital Point
Mame: I A
Deszcription: I B
Tvpe: Input - C
Tope npu | _—
Module:  [SNAPIDCS: 10 - 32VDCAAC |
Features: I Mone ;i D
Watchdog: & No (7 es E

0K I Cancel | Help

7. Complete the fields as follows:
a. Name. Enter a name for the point. The name must start with a letter and may contain
letters, numbers, and underscores. Spaces are converted to underscores.
b. Description. (Optional) Enter a description of the point.
Type, Module. For a SNAP I/0 unit, the type and module are already filled in for you.
. Features. To use a feature of the module, choose it from the drop-down list. (See “Using
I/0 Point Features” on page 76 for explanations of point features. Note that some features,

n
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such as pulsing and totalizing, can be configured in PAC Manager but require PAC Control
to use them.)

e. Watchdog. (Output modules only) To configure a status the point should be set to if the
Watchdog timer on this I/0 unit expires, click Yes and choose On or Off from the
drop-down list.

8. When you have completed the fields, click OK.
The new point appears in the list.

| Configure I/0 Points El
140 Unit: |Preprocess Type: |SMAP-PACRI (analog/digital)
Modules and Points | Type | Features / Subty... « Add.. |
= [ [00] SNAP-IDC5: 10 - 32 VDC/VAC Digital Input Modiy..
fo=] 0 Pump_i_Siatus _ (Couner

L {1 Not Used Delete
L 2 Not Used

L 3 Not Used —
[01] Net Used

[02] Net Used

tove Ta..

Expand All
[03] Not Used
04] Mot Used Collapze Al
05] Mot Used -
< | ﬂJ

| REE R

Cloze | Help | Calibrate...

9. To configure more digital points, repeat the steps. To configure analog points, see page 45.

Configuring Digital Points for a G4EB2

Use the following steps to configure digital points on all G4 or Quad Pak digital modules supported
by the G4EB2 brain. The G4EB2 replaces a 32-channel brain in a mistic or Pamux system with an
Ethernet-based 32-channel digital brain that uses OptoMMP protocol. The G4EB2 brain is
functionally similar to a SNAP-PAC-EB2 brain without analog I/0 functionality. Input and output
modules can be placed in any order.
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1. Inthe Configure 1/0 Units dialog box, highlight the digital I/O unit the points are on, and click
/0 Points.

The Configure I/0 Points dialog box appears.

] Configure /0 Points EIIEI
ERNTTA (54 Digital Unit Type: |G4EE2 [G4 zimple digil
Channel | Mame Type Featurezs | Enable Ref Co... | Descrp... - Add..
00 Mot Used
m Mot Used E
0z Mot Uzed —
IX] Mot Uzed
04 Mt Uged
05 Mot Uzed
0g Mot Uzed
a7 Mt Uged
I Mot Uzed
03 Mot Uzed -

Cloze | Help |

Points that have not been configured yet show as Not Used.

For G4 modules, there is one channel per module. For Quad Pak modules, there are four
channels per module which must be grouped together as shown.

Module Position | Channels Used

First 0-3 A
.}

Second 4-7 23

Third 8-11 S
il

Fourth 12-15 e

Fifth 16-19

Sixth 20-23 First module (channels 0-3)

Seventh 24-27

Eighth 28-31
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2. Double-click the channel number for the point you want to add.

The Add Digital Point dialog box appears.

Add Digital Point [23m]
Mame: | ——A
Description: | — 1B
Type: IrpLt —r1 C
Modue  |G4IDCE 10-32WDCA232WeC  — =t L D
Eeatures: |None _L“,—_ E
“Watchdog: & No F
0k | Cancel | Help |
[

Complete the fields as follows:

a.

P ongoT

Name. Enter a name for the point. The name must start with a letter and may contain
letters, numbers, and underscores. Spaces are converted to underscores.

Description. (Optional) Enter a description of the point.

Type. Select the type, either Input or Output.

Module. Select a module from the drop-down list.

Features. To use a feature of the module, choose it from the drop-down list. (See “Using
I/0 Point Features” on page 76 for explanations of point features. Note that some features,
such as pulsing and totalizing, can be configured in PAC Manager but require PAC Control
to use them.)

Watchdog. (Output modules only) To configure a status the point should be set to if the
Watchdog timer on this I/0 unit expires, click Yes and choose On or Off from the
drop-down list.

When you have completed the fields, click OK.

The new point is added.

5. To configure more digital points, repeat the steps.

Configuring Analog Points

To configure points on analog modules supported by the brain or on-the-rack controller:

In the Configure /O Points dialog box, double-click the number that represents the analog
module’s position on the rack. (For help, see the diagrams starting on page 171.)

For a SNAP 1/0 unit, choose the module type and then the exact module part number from the

1.

list.
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| Add Module

Tupe:

Drigital [nput
Digital Output

Analog Output

TModule:

SMAP-ALARMS-i:
SMAP-AICTD: ICTD Temp. Probe
SMAP-AICTD-4: ICTD Temp. Probe
SMAP-AICTD-E ICTD Temp. Probe
SMAP-AILE: -2 - +2 i A Fast
SHNAP-AILC-Z: -4 - +4 mv M Fast
SHAP-AIMA: -20 - +20 md,
SHAP-AIMA-: -20 - +20 ma
SHAP-AIMAGSHC: -20 - +20 ma
SHNAP-AIMA-4: -20 - +20 ma,
SHAP-AIMA-S: -20 - +20 ma,
SHAP-AIMA-32 -20 - +20 ma,
SHAP-AIMAZE -1 - +1 ma,
SHAP-aIMY-4: 150 - +150 m\
SHAP-AIMYZ-4: -B0 - +50 ml'
SHAP-aIPM: O - 250WACADC
SMAP-AIPM-3: 0 - 300 VACADC
SHAP-AIPM-3 [ONd]: 0 - 260VACADC
SHAP-AIPM-3v: 0 - 300 WACADC
SHAP-AIPM-3 [O1d]: 0- 250 VaCADC
EMU-AIPM-3V: 0 - 400 WACADC
SHAP-AIRATE: Rate [Frequency]

[ o |

m

Cancel

3. (ickOK.
4. Inthe Configure I/O Points dialog box, click the plus sign next to the new module to expand it.
Notice that the module icon is color-coded to reflect the type of module being configured:
blue for analog input, green for analog output.
| Configure /O Points EI
140 Unit: |Preprocess Type: |SMAP-PACFRI [analog/digitsi)
Modules and Points Type | Features / Subty. .. « fdd... |
= [} [00] SNAP-IDCS: 10 - 32 VDC/VAC Digital Input ;
Modify...
IL,E' 0 Pump_1_5Status Courter ;l
=1 1 Not Used Delete |
. I4+— &
Module icon 8 2 Not Used ]
T+ 3 Mot Used Move Ta.. |
Expand or collapse points SN | [D1] SMAP-AIV- |Angloginput | ]
on the module by clicking 72 0 Not Used Expand Al |
h -signinthe b 241 Not Used
the + or - sign in the box. T colaoeo Al
T [02] Mot Used ollapze |
Points <7 [03] Nt Used -
4| | |

Help

Cloze I
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5. Double-click the point you want to configure.

Add Analeg Point (=23
Mame: | —A
Dezcription: | — 1B
Tupe: Input =l C
Modde:  |SMAP-&IV -10- +10VDC |
| units: VDL

QK. | Cancel | Help |

_ Detsut §—7—1—E

Zero Scale: |-10
— | Do

FullScale: |10

Wiatchdog, & Mo G

6. Complete the fields as follows:

a.

b.
C.

g.

Name. Enter a name for the point. The name must start with a letter and may contain
letters, numbers, and underscores. (Spaces are converted to underscores.)

Description. (Optional) Enter a description of the point.

Type, Module. For a SNAP /0 unit, the type and module are inserted for you, but you may
be able to choose a different range or module from the drop-down list.

Units, Scale. Units and scaling for this module. See “Using Custom Scaling” on page 48.
Scaling Default. To return the units, zero-scale value, and full-scale value to the defaults
for the module, click Default.

Scaling Custom. To assign custom units and values to the module, click Custom. For
example, you could scale the voltage range of a -10 to +10 VDC module to be interpreted
as engineering units of liters per second instead of volts. See “Using Custom Scaling”on
page 48.

Watchdog. (Outputs only.) To configure a value this point should be set to if the Watchdog
timer on this I/0 unit expires, click Yes and enter the value.

7.  When you have completed the fields, click OK.

PAC Manager User’s Guide



CONFIGURING 1/O MODULES AND POINTS

The new point is added. This image shows a SNAP I/0O unit.

| Configure I/0 Points El
140 Urit: |Preprocess Type: |SMAP-PACHI [analog/digital)
Modules and Points Type | Features / Subty... « Add.. |
=[] [00] SNAP-IDCS: 10 - 32 VDCAVAC Digital Input Modify... |
IL‘El 0 Pump_1_Status Courter
T 1 Not Used Delete |
T 2 Not Used _
Iﬂd— 3 Not Used Move To... |
= gl [01] SNAP-AIVA Analog Input
femy 0 Fowmeter A |.10-+10VDC_ |
= [ Flowmeter_A 10-+10VDC Expand &1
24 1 Not Used
[02] Mot Used Collapse &l |
[03] Not Used -
4| | ’
Cloze I Help | Calibrate. .. |

Point types and features are shown in the Features/Subtype column.

8. Toadd more analog points, repeat the steps. To add digital points, see page 40.

Using Custom Scaling

Analog modules can be set to show something other than the actual inputs or outputs. For
example, you could scale the readings of a -10 to +10 VDC input point to measure its input as zero
liters per second when the real-world reading is zero VDC, and 1000 liters per second when the

real-world reading is five VDC.

Thermocouple values are not linear and cannot be scaled.

NOTE: Custom scaling has no effect on the resolution or accuracy of the module.

1. Inthe Add Analog Point dialog box, click the Custom button in the Scaling area to open the

Scale Analog Readings dialog box.

Scale Analog Readings

A — Scaled Uritg: ILiters per second

r Lower Value
B Actuak |10 [vDC
C Scaled: |D |Liters PET ZEc0

— Upper Value
D Agtusl |5 fvDC
E Scaled: I'I aoo ILiters PEr SECO

QK. I Cancel | Help |

PAC Manager User's Guide

This example shows units scaled to liters
per second. At an actual input of 0 VDC,
the point will show 0 liters per second. At
an actual input of 5 VDG, the point will
show 1000 liters per second.
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Custom scaled values are floating point values:

For analog input points, with firmware R8.0a and higher, you can use inverted scaling.
Inverted scaling means the lower value is greater than the upper value; inverted scaling
can accommodate a sensor, for example, that is wired to the SNAP module in a way that
produces a negative current or voltage.

For analog output points you cannot use inverted scaling. The upper value must be greater
than the lower value.

Complete the fields as follows:

a.

b.

Scaled Units. Enter new engineering units for the module. The example uses liters per
second.

Actual Lower Value. Enter the actual real-world lower value that the scaled lower value
corresponds to. Note that inputs typically have under-range capability, which means you
can specify a lower actual value that is less than the zero-scale value. Outputs do not have
under-range capability.

Scaled Lower Value. Enter the new scaled lower value. This value can be any floating
point value.

Actual Upper Value. Enter the actual real-world upper value that the scaled upper value
corresponds to. For inputs, you can specify an upper actual value greater than the full-scale
value.

Scaled Upper Value. Enter the new scaled upper value. For outputs, this value can be any
floating point value greater than the scaled lower value. For inputs, it can be greater than or
less than the scaled lower value. This example uses 1000, which scales the output to

1000 liters per second when its actual reading is 5 VDC.

Click OK.
The new custom-scaled units appear in the Add Analog Point dialog box.

Notice the new units of liters per second and

Add Analog Point

= the new minimum-scale ("Zero Scale”) and
maximum-scale (“Full Scale”) values of -2000
and 4+2000. The example connects a sensor

Gere N with a range of 0-1000 liters per second, but
Descriptian: | an output of only 0-5 volts, to a SNAP-AIV
module with an output of -10to +10volts. The
Tupe: Irput figures shown reflect the total possible range
Module: |5N.-'3.F'-.-'3.|\-"-i: A0-+10%0C j of the module, not the sensor.
- = - Seeltis Cust(l)m Modulle‘s
Lnits: iters per secon scale scale
Zero Scale: |-2000 QDEHU“ (Liters/sec) (VDC)
i | Cosfam ™ possible |
Full Scale: |00 s ossibie low —2000 ~10
value for module
Watchdog & Mo -1000 -
Upper & lower 0 = 0
values entered
ok Cancel Help in dialog box 1000 =] 5
4 Possible high 2000 10

value for module
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Calibrating Offset and Gain

This section describes how you can manually set offset and gain or have them automatically
calculated and set for you. However, before you begin, see “Calculating Offset and Gain Using the
Two-Point Method” on page 192 for a newer method that is more flexible and easier to use.

The SNAP PAC I/0 unit can calibrate analog input points. If a -50 mV to +50 mV input receives
signals that are slightly off (not exactly -50 mV at the lowest point, for example), the offset and gain
can be calculated so that values will appear accurately when read.

Offset and gain values affect engineering units (EU). For a temperature input, engineering units are
in degrees C or F, depending on how the I/O unit is configured.

IMPORTANT: To calibrate the point, the I/O unit must be turned on and attached to the network, and
you must have access to it to use the calibrator. For points on a SNAP PAC SB brain, connect directly via
serial or through the controller via Ethernet (see page 29 for details).

Save the configuration to flash so that it will not be lost when power is turned off. Since each calibration is
for a specific point on a specific [/0 unit, the result cannot be saved to the configuration file and cannot be
sent to any other I/0 unit.

Calculate offset first, and then calculate gain. The offset must be calculated at the signal
corresponding to zero engineering units (EU), and the gain must be calculated at the signal
corresponding to the point’s maximum nominal value (not its overrange).

1. Inthe Configure I/0 Points dialog box, highlight the analog input point you want to calibrate.

| Configure I/0 Points E'
140 Urit: |Preprocess Type: |SMAP-PACHI [analog/digital)
Modules and Points | Type | Features / Subty... « Add.. |
[ [00] SNAP-IDC5: 10 - 32 VOCAVAC Digital Input Mo,
= gl [01] SNAP-AIVA Analog Input
e 0 Fowmeter A | |.10-+10VIC Delete

24 1 Not Used
[02] Not Used
[03] Not Used
04] Mot Used
05] Mot Used
[06] Mot Used Collapse &l

[07] Mot Used -
1| | >

Cloze I Help | Calibrate. ..

tove To...

Expand All

P
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2. (lick the Calibrate button in the lower-right corner of the dialog box.

Automatically Calculate

(v 4 Uze a calibrator to input the zignal

" comesponding to zero Engineering Units

- Use a calibrator to input the signal
cormezponding to the paint's masimurm
nominal value

MOTE: Yiou must set the Offzet first.

P Calibrate Analog Input - Flowmeter_A (Meodule 1, Point 0)

=3

Set Offzet
Cloze

Mare »»

3. Tohave the offset and gain calculated for you, do the following:
a. Use a calibrator to input the signal corresponding to zero EU on the analog input point (for
example, 0 degrees F or C for a temperature input). Click Offset, then click the Set Offset

button.

NOTE: On a bipolar module (for example, -10 VDC to +10VDC), the minimum scale is always zero EU,

not a negative number.

b. Use the calibrator to input the signal corresponding to the point’s maximum nominal value
(not overrange; not scaled. To find out its maximum nominal value, see the module’s data

sheet). Click Gain, then click the Set Gain button.
To manually set offset and gain, do the following:
a. C(lick the More button.

| Calibrate Analeg Input - Flowmeter_A (Module 1, Point 0)

Set Offzet
o
Cloze

g

MOTE: ou must set the Offset first, << Less
tanually Set
Offset: |0 Gairc |0

[l

b. Enter the Offset value. Click the Set Offset button.
c. Enter the Gain value. Click the Set Gain button.

points.

5.  When you have finished calibrating the point, close the dialog box to return to configuring I/0

NOTE: To store offset and gain values permanently, you must save the change to flash when you send

the configuration data to the I/0 unit (see page 75).
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Configuring RS-232 and RS-485/422 Serial Communication
Modules

(Not applicable to SB brains) RS-232 and RS-485/422 serial communication modules do not require
configuration unless you need to change communication parameters such as port numbers or baud
rates. Because these serial modules require no configuration, they do not appear in the Configure
/0 Points dialog box in PAC Manager; you have to remember which positions on the I/0 unit are
filled with serial modules. For more information on these modules, see Opto 22 form 1191, the form
SNAP Serial Communication Module User’s Guide.

NOTE: For information on connecting a Windows serial application to a remote serial device through a
SNAP Ethernet-based system, see form 1191, the SNAP Serial Communication Module User's Guide.

Default port numbers are shown on page 172. Default communication parameters are:
« 1 start bit (not configurable)

+ 9600 baud
«  No parity
«  8databits
« 1stopbit

«  No handshaking

«  Send a test message when the module is turned on.
«  SNAP-SCM-232: No flow control

+  SNAP-SCM-485-422: 2-wire mode

Port numbers and all parameters except the last two (flow control and 2- or 4-wire mode) can be

changed in the 1/0 unit's configuration file using the following steps. For flow control and 2- or

4-wire mode, see the steps on page 53.

1. With the configuration file open, right-click the name of the I/O unit the serial module is on.
From the pop-up menu, choose Configure.

The Configure I/0 Units dialog box opens.

=»| Configure I/O Units @

Mame Type Port Address ‘Wwatchdog De Add...

Preprocess SHAP-PAC...  Ethernet 10.192.54.110 Enabled

Modify...
Delete

Import/Copy...

1/0 Paints...
PID Loops...
Modules :,——— Modules
N button
Scratch Pad  »
4| 1 L2
Communications »
Cloze | Help Others 3
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http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=1751
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=1751

CHAPTER 2: CONFIGURING DEVICES

2. Make sure the correct I/0 unit is highlighted. Click the Modules button and choose Serial
Modules from the pop-up menu.

p| Configure Serial Modules @
Statuz | Module | Pt | IP Port | Baud Rate | Parity Data Bits | Stop Bits | EOM Chars | Test Message | -
Dizabled 0 A
Dizgabled 0O B
Dizabled 1 A
Dizabled 1 B E
Disabled 2 A,
Dizabled 2 E
Dizgabled 3 &
Dizabled 3 B
Dizabled 4 &
Disabled 4 B
Dizabled & A
Dizgabled & B
Dizabled B A
Dizabled B B
Disabled 7 A,
Dizabled 7 B v
ak | Catricel | Help |

3. (lick the status cell for the module number and port number whose parameters you want to
change. From the pop-up menu, choose Enabled.

The Status changes to Enabled.

4. Tochange a communication parameter, click the cell you want to change within the
highlighted line. Choose from the drop-down list, if there is one, or type the new value in the
cell.

NOTE: The start bit is not configurable. To set flow control and 2- or 4-wire mode, see the steps on
page 53.

NOTE: EOM (end-of-message) characters apply only when using the serial module port with serial
events (see page 154). The device can check any one of up to four characters as the EOM indicator,
and you enter them in the field in hex. Example: 0xODOA0OOO looks for a 13 (hex 0D) or 10 (hex 0A).

5. When you have finished changing parameters for serial modules, click OK to close the dialog
box and return to configuring I/0 units.

IMPORTANT: If you have changed a TCP port number, you must save the change to flash and restart the
1/0 unit when you send the configuration data to the /O unit (see page 75).
Configuring Flow Control and 2- or 4-Wire Mode

IMPORTANT: You can configure flow control on a SNAP-SCM-232 and 2- or 4-wire mode on a
SNAP-SCM-485-422 using PAC Manager. However, these configurations cannot be saved to the
configuration file. The I/0 unit that contains the serial module must be on the same network as your
computer, and the configuration is sent directly to the I/O unit.

PAC Manager User’s Guide
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1.

In the PAC Manager main window, click the Inspect button Ql

=] Inspect Opto 22 Device — X

Device Name: I LI Options » | BieilH Error reading area: Timeout

—Status Read

Status Read |

Status Write |
Wireless LAN  » |

Point Config |
Digital Bank |
Digital Point |
Analog Bank |
Analog Point |
High Density |
System r |
Scratch Pad  » |
Data Log 3 |
FID »
Events 3 |
Communications » |
Other ] |

Close I Help | [ Auto Refresh |15000 msec

If this is the first time you have used the Inspect button, the Device Name field will be blank, as
shown above. If you have used the Inspect button before, the last name you used is shown,
and the most recently used device names are available in the drop-down list.

In the Device Name field, type the name of the I/O unit (any unique name, usually the name
configured in PAC Control) or choose it from the drop-down list. (You can also enter the IP
address.) Then click Refresh.

If the I/0 unit has not been defined in PAC Manager, the Add New Device dialog box appears.
Choose Direct Connection to Ethernet Device and enter the IP address of the device. Leave the
Ethernet port at 2001 unless you have changed it on the device.

Click the Communications button and choose Serial Modules from the pop-up menu.

PAC Manager User's Guide




4. C(lick the Serial Module Number drop-down list and choose the module’s position number on

5.

CHAPTER 2: CONFIGURING DEVICES

Information from the I/0 unit is displayed in the window.

| Inspect Opto 22 Device

Device Mame: |1D_1 5254110

Senial Modules
Status Read

Senial Module Number:

L] Options »

[=][&@ =]

Status ]Serial Module area last read at 011712 1217:28

0 | Module Diz NOT a Serial Module

Other 4
Cloze Help

Status Write I
; Address ] D escription ] Walue ] Befresh
B & MODULE INFORMATION
0«FFFF FOCO 0000 Module Type Diig/none [0x00) PRl
Paint Config 0«FFFF FO34 7FO0 Module Subtype 1]
= OxFFFF FO34 FFO2 Hardware Revision D ate M2
Digital Bank. 0xFFFF FO34 7FOG Loader Yersion M/&
OxFFFF FO34 7FO&  Firnware Yersion (AP
Digital Point PORT A
Analog Bank OxFFFF FO34 8000 IP Port Number 22500
g 0:FFFF FO34 8004  Baud Rate 9600
0«FFFF FO34 8003 Parity Mone
__ Angoafont | OWFFFF FO34.8009  Data Bits 8
High Dersity OxFFFF FO34 8004 Stop Bits 1
0«FFFF FO34 800C Power-up Test Message? Yes
5 OxFFFF FO32 8200 EOM Character List 0= 00020000
Lt PORTE
0xFFFF FO34 8010 IP Port Number 22501
Scratch Pad  »
_ SeichPad 1+ O4FFFFFO34.801¢  BaudRate 5600
Datalog * 0:FFFF FO34 8018 Parity Mone
OxFFFF FO34 8019 Data Bits g
PID > 0xFFFF FO34 8014 Stop Bits 1
0«FFFF FO34 801C Power-up Test Message? Yes
Ewvents L4 0xFFFF FO34 5210 EOM Character List [ 0D 0&0000
Communications ¥

I” Auto Refresh (15000 mssc

the rack to see the module’s communication parameters.

To change a parameter, click its value in the Value column and choose from the drop-down list
or enter a new value.

NOTE: This is the only way to change hardware flow control for a SNAP-SCM-232 or 2- or 4-wire mode
for a SNAP-SCM-485-422. You can also change other parameters in this dialog box if necessary.
However, parameters changed in this dialog box are NOT saved to the configuration file.
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This example shows how to change Hardware Flow Control on a SNAP-SCM-232:

=#| Inspect Opto 22 Device
Device Name: “I 01325410 L] Options » Status: |Serial Module area last read at 01/17/12 12:17:28
7 e Senal Modules
tatus Hea
Serial Module Number. |0 + | Module 01z NOT a Serial Module
Status WWrite I
Addiess I Description Walue I Befresh |
ptcles i MODULE INFORMATION
OxFFFF FOCO 0300 tModule Type 0w FO PRl
Puoint Config 0<FFFF FO3& FF30 Module Subtype 3
- OxFFFF FO34 7F32 Hardware Revizion D ate 2003-06-08
Digital Bank O+FFFF FO34 7F36  Loader Version A1.0e
= 0=FFFF FO34 7F34 Firmweare Yersion Ri1e
Digital Paint PORT &
Analon Bank OxFFFF FO34 8060 IP Port Mumber 22506
feefibel O<FFFFFO34 5064 Baud Rate 9500
. 0FFFF FO34 8068 Parity Nane
_ AnaogPoint ||| G A0S Data Bt g
High Dersity OxFFFF FO34 8064  Stop Bits 1
0FFFF FO34 S0EB Hardware Flow Contral? |NU ﬂ
S < OxFFFF FO34 B0RC Power-up Test Message?
YStEm 0FFFF FO34 6260 EOM Character List P
PORT B
seatchPad ||| ufrer 0348070 IP Port Number 2507
Datalog  » O«FFFF FO34 8074 Baud Rate 9500
O«FFFF FO34 8072 Parity Mone
PID » OxFFFF FO34 8079 DataBits 3
O«FFFF FO34 8074  StopBits 1
Events 4 OwFFFF FO34 807E Hardware Flow Control? No
— 0FFFF FO34 807C Power-up Test Message? Yes
Communications OxFFFF FO34 8270 EOM Character List 0x 0D 040000
Other 3
Cloze Help I” Auto Refresh |15000

msec

6. When you have finished changing parameters for this module, click Apply.

The configuration changes are sent to the I/0 unit.

Configuring Wiegand Modules

(Not applicable to SB brains) Wiegand modules are a type of serial module. Before configuring a
Wiegand module, see Opto 22 form 1191, the SNAP Serial Communication Module User’s Guide, for
more information about these modules.

1. With the configuration file open, right-click the name of the I/O unit the Wiegand module is on.
From the pop-up menu, choose Configure.
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The Configure I/0 Units dialog box opens.

=»| Configure I/O Units

==l

Mame Type

4

SHAP-PAC...

Part Address
10.192.54.110

Ethernet

I

Cloze | Help |

‘Wwatchdog
Enabled

De Add...

Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules :,—— Modules
Events 3 b utton
Scratch Pad  »
: Communications »
Others 3

2. Make sure the correct I/0 unit is highlighted. Click the Modules button and choose Wiegand
Modules from the pop-up menu.

] Configure Wiegand Modules @
Wiegand Module
Mumber: |0 - [ Uszed
Address | D escription | Walue
MODULE INFORMATION
O«FFFF FOCO 0000 Module Type Diig/more [0x00]
(«FFFF FOZA 23501 todule Subtype i]
0=FFFF FO3& 8502 Hardware Revision Date REC
0=FFFF FO3& 8506 Loader WVersion REC
0=FFFF FO3& 8504 Firrmwware Version REC
PORT &
0=FFFF FO3& 8600 IP Port Number 22500
0=FFFF FO3& 8604 Format ] |
0=<FFFF FO3& 8608 Data Length kr)
0=FFFF FO3& 8E0C Site Position g
0=FFFF FO3& 8610 Site Length g
(«FFFF FOZA 3614 Badge Pozition 13
0=<FFFF FO3& 8618 Badge Length 15
0=FFFF FO3& 8E1C Parity Check Mo
OxFFFF FOZA 3620 Ewen Parity Poszition i]
0=FFFF FO3& 8624 0dd Parity Pogition ]
PORT B
0=FFFF FO3& 8640 IP Port Number 22501
0=FFFF FO3& BE44 Format ] |
0=FFFF FO3& BE48 Data Length kr)
0=FFFF FO3& BE4C Site Position g
0=FFFF FO3& 8650 Site Length g
(«FFFF FOZA 3654 Badge Pozition 13
0=FFFF FO3& BE5E Badge Length 15
0=FFFF FO3& 8ERC Parity Check Mo
(«FFFF FOZA 3660 Ewen Parity Poszition i]
0=FFFF FO3& BEE4 0dd Parity Pogition ]
0K, | Cancel Help
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In the Number field, choose the Wiegand module’s position from the drop-down list. Click to
If you need to change port numbers, enter the new numbers for each port in the TCP port

Click the Format/Value cell, and from the drop-down list, choose a standard data format

NOTE: O is the 37-bit Opto 22 format used in a sample PAC Control strategy available for use with
Wiegand modules. See the Serial Communication Module User's Guide for more information.

of data in the transmission

Change the following fields if necessary to match your Wiegand hardware device:

Badge Position—first bit of the badge code (should be the next bit after the site code)

3.
put a check mark in the Used box.
4,
Number fields.
5.
(shown by its total data length) or choose C for custom.
6.
Data Length—total length
Site Position—first bit of the site code
Site Length—Iength of the site code, in bits
Badge Length—Ilength of the badge code, in bits
7.
8.

configuring I/0 units.

When data for both ports is correct, repeat from step 3 for additional Wiegand modules.
When all Wiegand modules are configured, click OK to close the dialog box and return to

IMPORTANT: If you have changed a TCP port number, you must save the change to flash and restart the
I/0 unit when you send the configuration data to the I/0 unit (see page 75).

9. When you are ready to send all configuration data to the I/0 unit, see “Sending Configuration
Data to the I/0 Unit"on page 75.

Configuring Profibus Modules

1.

From the pop-up menu, choose Configure.

The Configure I/0 Units dialog box opens.

=»| Configure I/O Units

Part
Ethernet

Mame Type

SHAP-PAC...

Preprocess

Address
10.192.54.110

‘Wwatchdog De

Enabled

Cloze |

Help

I 2

==l

Add...

Modify...
Delete

Import/Copy...

1/0 Paints...

FID Loops...
Modules :,—
Events 3

Scratch Pad  »
Communications »
Others 3
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2. Make sure the correct I/0 unit is highlighted. Click the Modules button and choose Profibus
Modules from the pop-up menu.

| Configure Profibus Modules @

Frofibus Module
Mumber: |0 | [ Used

Address | D escription | Walue
MODULE INFORMATION
O«FFFF FOCO 0000 Module Type Diig/more [0x00]
O«FFFF FOZA FFOO todule Subtype i]
0=FFFF FO3& 7FO2 Hardware Revision Date REC
0=FFFF FO3& 7FOG Loader WVersion REC
0xFFFF FO3& 7FO& Firrmwware Version REC
PORT &
0xFFFF FO3& 8000 IP Port Number 22500
0=FFFF FO3& 8004 Baud Rate 15200 |
(«FFFF FOZA 2003 Parity Ewven
0xFFFF FO3& 8009 Data Bits a
0=<FFFF FO3& 8002, Stop Bits 1
(0=FFFF FO3& 800B Hardware Flow Contral? Mo
(wFFFF FOZA 2000 Poveer-up Test Meszage? es =1
0=FFFF FO3& 8200 EOM Character List (= 0D Q0000

Cancel | Help |

3. Inthe Number field, choose the Profibus module’s position from the drop-down list. Click to
put a check mark in the Used box.

4. Ifyou need to change port numbers, enter the new numbers for each port in the TCP port
Number field.

5. Change the Baud Rate and EOM Character List fields if necessary to match your Profibus
devices. Choose whether to have the module automatically send a Test Message when turned
on (the default is Yes).

6. When data is correct, repeat from step 3 for additional Profibus modules.

7. When all Profibus modules are configured, click OK to close the dialog box and return to
configuring I/0 units.

IMPORTANT: If you have changed a TCP port number, you must save the change to flash and restart the
I/0 unit when you send the configuration data to the I/0 unit (see page 75).

Configuring SSI (Serial Synchronous Interface) Modules

Serial synchronous interface (SSI) modules (part number SNAP-SCM-SSI) are a special type of serial
module. Unlike other serial modules, these can be used with SNAP PAC serial brains.

Before configuring an SSI module, see Opto 22 form 1931, the SNAP SSI (Serial Synchronous Interface)
Module User’s Guide, for information you will need to configure it.

1. With the configuration file open, right-click the name of the 1/0 unit the SSI module is on. From
the pop-up menu, choose Configure.
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The Configure I/0 Units dialog box opens.

=»| Configure I/O Units

==l

Address
10.192.54.110

‘Wwatchdog
Enabled

Add...

Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules >j—— Modules
_ Eens o] button
Scratch Pad  »
: Communications »
Others 3

Ethernet

4 I

Cloze |

Help |

2. Make sure the correct I/O unit is highlighted. Click the Modules button and choose SSI Modules
from the pop-up menu.

] Configure S5 Modules

551 Module

Mumber: |0 | [ Used

Cancel

Address | D escription | Walue
PORT O
O«FFFF FOZA 1000 [1ata Frame Length i]
0xFFFF FO3& 1004 Clock Divider ]
(«FFFF FOZA 1003 Data Delay, Clock Cycles i]
(wFFFF FOZA 100C ozt Significant Diata Bit Offget i]
0=FFFF FO3& 1010 Data Bits in the Data Frame 0 »» 24 Max <<
0=FFFF FO3& 1074 Error Bit Qffzet in the Data Frame ]
O«FFFF FOZA 1013 Error Bit Lewel High EBit Indicates Eror = |
(wFFFF FOZA 1010 [1ata Encoding Binary =1
OxFFFF FOZA 1020 Enable Scanning Dizabled =1
PORT 1
OxFFFF FOZA 1040 [1ata Frame Length i]
0=FFFF FO3& 1044 Clock Divider ]
(«FFFF FOZA 1043 Data Delay, Clock Cycles i]
(wFFFF FOZA 1040 ozt Significant Diata Bit Offget i]
0=FFFF FO3& 1080 Data Bits in the Data Frame 0 »» 24 Max <<
0=FFFF FO3& 1054 Error Bit Qffzet in the Data Frame ]
(xFFFF FOZA 1053 Error Bit Lewel High EBit Indicates Eror = |
(wFFFF FOZA 1080 [1ata Encoding Binary =1
O«FFFF FOZA 1080 Enable Scanning Dizabled =1
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3. Inthe Number field, choose the SSI module’s position from the drop-down list. Click to put a
check mark in the Used box.

4., Configure all parameters for each port used. See the SNAP SSI Module User’s Guide (form #1931)
to obtain the data for these fields. For each port, choose Enabled in the Enable Scanning field.

5. Repeat for additional SSI modules.

6. When all SSI modules are configured, click OK to close the dialog box and return to configuring
/0O units.

7. When you are ready to send all configuration data to the I/0 unit, see “Sending Configuration
Data to the I/0 Unit"on page 75.

Configuring CAN Modules

The SNAP-SCM-CAN2B provides an interface to a Controller Area Network (CAN) that allows your
SNAP PAC system to receive data from CAN devices. Before configuring a CAN module, see Opto 22
form 1191, the SNAP Serial Communication Module User’s Guide, for more information about these
modules.

Configuration for the SNAP-SCM-CAN2B module is normally done in a PAC Control strategy using
the example subroutine from the CAN RX/TX Integration Kit for PAC Project, part number
PAC-INT-CAN-RXTX, a free download available on our website, www.opto22.com. As described
below, you can also use PAC Manager to change the IP Port Number, Baud Rate, Data Masks, or
Filters for the SNAP-SCM-CAN2B serial module. However, the settings in your strategy will override
the settings in PAC Manager for each module.

1. With the configuration file open, double-click the I/O Units folder.
The Configure I/0 Units dialog box opens.

=»| Configure I/O Units @

Mame Type Port Address ‘Wwatchdog De Add...
Preprocess SHAP-PAC.. Ethemnet 1019254110 Enabled

Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules >:|—— Modules
_Eews | | button
Scratch Pad  »
4 [l | +
Communications »
Cloze | Help | Others 3

2. Highlight the 1/0 unit the CAN module is on. Click the Modules button and choose CAN
Modules from the pop-up menu.

Information from the I/0 unit is displayed in the window.
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CONFIGURING 1/O MODULES AND POINTS

3. (lickthe CAN Module number dropdown list and choose the module’s position number on the
rack to see the module’s communication parameters.

] Configure CAN Modules @
CAN Module
CAN module
——— Mumber: |0 v| [ Used
number
Address | Desciption Value |
PORT INFORMATION
OxFFFF FO34 9000 Port Number 22500
0xFFFF FO34 9004  Baud Rate 250000 =
OxFFFF FO34 9008  Data Mask 0 0x 00000000
0xFFFF FO3A 900C  Filter 0 0x 00000000
OxFFFF FO34 9010 Filter 1 0x 90000000
OxFFFF FO34 9014  Data Mask 1 0x 00000000
0xFFFF FO34 9018 Filter 2 0x 00000000
0xFFFF FO3A 901C  Filter 3 0x 00000000
OxFFFF FO3A 9020 Filter 4 0x 00000000
OxFFFF FO3A 9024  Filter 5 0x 00000000

4. Tochange a parameter, click its value in the Value column.
To change the Baud Rate on a SNAP-SCM-CAN2, choose from the drop-down list

OxFFFF FO34 9004 Baud Rate
OxFFFF FO34 9003 Data Mask 0
OxFFFF FO34 900C  Filter 0
OxFFFF FO34 9010 Filter 1
(OxFFFF FO34 9014 Data Mask 1
(OxFFFF FO34 9013 Filter 2 100000
OxFFFF FO34 901C  Filter 3 50000
OxFFFF FO34 9020 Filter 4 20000
OxFFFF FO34 9024 Filter 5 10000

250000

1000000 k
500000

To change the Filter or Data Mask values, see the next section below.

5. When you have finished changing parameters for this module, click OK.
6. Repeat the previous step for additional CAN modules.

7. When all CAN modules are configured, click OK to close the dialog box and return to
configuring I/0 units.

8. When you're finished configuring I/0 units, close the dialog box. Choose File > Save to save the
configuration file.

9. When you are ready to send all configuration data to the I/0 unit, see “Sending Configuration
Data to the I/0 Unit"on page 75.

SNAP-SCM-CANZ2B Filters and Data Masks

The filters and data masks for each CAN2B module are normally configured in a PAC Control strategy
using the sample subroutines provided in the CAN RX/TX Integration Kit for PAC Project, part
number PAC-INT-CAN-RXTX. You can also use PAC Manager to configure these settings. However,
the filter and data mask settings in your PAC Control strategy will override the settings in PAC
Manager for each module.
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In PAC Manager the Data Masks and Filters are all set to 0 by default, which means that all CAN
packets will be received. If you want the SNAP-SCM-CAN2B module to provide filtering, then
configure the Data Masks and Filters.

Always start with the highest priority mask and filter, Data Mask 0 and Filter 0. Mask 0 uses Filter O
and Filter 1, in that order. Then Data Mask 1 uses Filters 2-5, in that order.

Address

| D escription

| Walue

(OxFFFF FO34 9000
OxFFFF FO34 9004
(OxFFFF FO34 9003
OxFFFF FO34 900C
OxFFFF FO34 9010
OxFFFF FO34 9014
OxFFFF FO34 9013
OxFFFF FO34 901C
(OxFFFF FO34 9020
OxFFFF FO34 9024

PORT INFORMATION
Fart Mumber
Baud Rate
Data Mask 0
Filter 0
Filter 1
D ata Mazk 1
Filter 2
Filter 3
Filter 4
Filter &

Ll

i T e S R

22500
250000

(x 00000000
(x 00000000
(x 00000000
(x 00000000
(x 00000000
(x 00000000
(x 00000000
(x 00000000

Masks and filters each consist of 32 bits; in PAC Manager these are entered in hex. The mask
determines how broadly or narrowly the filter will be applied, that is, which bits of the CAN ID to pay
attention to when deciding to accept or reject a CAN packet. The following table shows how the
mask and filter work together.

Mask Bit Filter Bit CAN ID Bit Accept/Reject
0 X* X* Accept
1 0 0 Accept
1 0 1 Reject
1 1 0 Reject
1 1 1 Accept

* X = Don't Care

The configuration examples below show how to build the masks and filters.

These examples assume you are using module firmware 2.0b or higher.

Example 1

Suppose many CAN frames are placed on the bus at regular intervals (in no particular order). Some
are standard CAN frames; others are extended CAN frames. You are interested in only one frame, an

extended CAN frame with an Arbitration ID of: 0x14613A2C

This is the only frame you want to capture. How do you configure the Mask and Filter fields to

capture it?

Parameter Value Description

Mask 0 Ox1FFFFFFF | A mask with all bits set means the module should consider each bit of the
arbitration ID for acceptance. This makes the filter more stringent.

Filter O 0x54613A2C | Since this is an extended CAN frame, you want the filter to apply to extended
CAN frames received. So bitwise OR the Arbitration ID with the Extended ID
Enable (EXIDE) flag. This flag tells the brain that the filter should apply to
extended CAN frames. The value of this flag is 0x40000000.

Filter 1 0x0 Not used, since you are interested in only one CAN frame.
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Parameter Value Description
Mask 1 0x0 Not used
Filters 2 -5 | Ox0 Not used

Here are representations of the 32-bit mask and the 32-bit filter for this example:
Mask 0

Bits:{31|30(29|28|27|26|25|24|23(22|21|20(19|18|17|16|15|14|13|12{11|10|9 |8 |7 |6 [5 |4 |3 |2 (1 |0

Bitvalues:|O(O|O|21(1(1|1f1}21|1f1f1|21|2f1j21|12|2 (1|2 |1 f1f1f1f2j1|1|2|1f1f1|12

Mask in hex: 1 F F F F F F F

Filter 0

For data in an extended frame, set the EXIDE flag, which is bit 30. The Arbitration ID of 0x14613A2C
becomes 0x54613A2C when bit 30 is set:

Arbitration ID

Not used
Not used

28(27|26|25|24|23|22|21|20({19(18|17|16|15|14|13|12(11{10(9 |8 (7 |6 [5 |4 (3|2 (1|0

w
g
N
©

Bits:

~ | & |EXIDE flag

o
o
=
o
=
o
o
o
[
=
o
o
o
o
=
o
o
[
=
[
o
=
o
o
o
=
o
[
[
o
o

Bit values:

ol
IN
o
=
w
>
N
(@]

Filter in hex:

Example 2

Building on Example 1, suppose now you decide that in addition to the extended CAN frame with
Arbitration ID 0x14613A2C you also want to capture a standard CAN frame with Arbitration ID
Ox1EC.

For this second frame you have two options:
«  You could put the standard frame at Filter 1 so that both frames are using Mask 0.
+  Youcould use a different mask, Mask 1, and use Filter 2.

In either case you need to map the 11-bit (standard) Arbitration ID to the 32-bit value the module is
expecting. The module expects the 11-bit standard ID to be in bits 28—18 of the 32-bit filter. So, in
terms of math: mask the desired 11-bit Arbitration ID with 0x7FF and then left-shift by 18 bits:
((11-bit Arbitration ID) & Ox7FF)<<18

Using Mask 0. Mask O is already considering each bit in the Arbitration ID, and since we only want
to look at these two CAN frames, we could use Filter 1.

Parameter Value Description

Mask 0 Ox1FFFFFFF | A mask with all bits set means the module should consider each bit of the
arbitration ID for acceptance. This makes the filter more stringent.

Filter O 0x54613A2C | Since this is an extended CAN frame, you want the filter to apply to extended
CAN frames received. So bitwise OR the Arbitration ID with the EXIDE flag.
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Parameter Value Description

Filter 1 0x07B00000 | Value of standard Arbitration ID filter after mapping it to its 32-bit value. Do not
set the EXIDE flag. In this case the lower 18 bits (the extended arbitration bits)
are excluded from the acceptance check, even though the mask would indicate
otherwise, since this is a standard CAN frame filter.

Mask 1 0x0 Not used

Filters 2 - 5 | Ox0 Not used

Using Mask 1. If Mask 0 were less stringent (fewer set bits) so it would not cause acceptance of just
the Ox1EC Arbitration ID, then you could use the Mask 1 and Filter 2.

Parameter Value Description

Mask 0 0x1C63FFFF | A Mask with much less stringent acceptance criteria. The set mask bits are used
in the comparison with the filter, while the cleared bits are don't care.

Filter O 0x54613A2C | Since this is an extended CAN frame, we want the filter to apply to extended
CAN frames received. So bitwise OR the Arbitration value with the EXIDE flag.
(Depending on the Arbitration IDs of other CAN frames on the bus, other
extended CAN frames will also be accepted, for example 0x15613A2C,
0x16613A2C, 0x17613A2C, 0x14713A2C, and so on.)

Filter 1 0x0 Not used

Mask 1 O0x1FFCO0000 | A mask stringent on the standard arbitration bits but allowing all the extended
arbitration bits.

Filter 2 0x07B00000 | Value of standard Arbitration ID filter after mapping it to its 32-bit value. Do not
set the EXIDE flag. This filter captures only the OxX1EC standard CAN frame.

Filter 3-5 | Ox0 Not used

Configuring HART Modules

HART® SNAP 1/0 are a special type of serial module that provides communication with other
Highway Addressable Remote Transducer (HART) current loop devices. For more information, see
form 2080, the HART SNAP I/0 Data Sheet.

1. With the configuration file open, right-click the name of the I/0 unit the HART module is on.
From the pop-up menu, choose Configure.
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The Configure I/0 Units dialog box opens.

=»| Configure I/O Units

| Address

| ‘Wwatchdog

|DE

Add...

| Type | Port
SHAP-PAC..  Ethemet

Mame
Frepi

10.192.54.110

Enabled

4 1

Cloze I

Help |

Modify... |
Delete |

Import/Copy... |

1/0 Paints... |

FID Loops... |
Modules >:|—

Events 3 |

Scratch Pad  » |

: Communications » |

Others 3 |

— Modules
button

2. Make sure the correct I/0 unit is highlighted. Click the Modules button and choose HART

Modules from the pop-up menu.

| Inspect HART Medule
—HART Module
Mumber: Io vi [ Used

Address | Description | Value
PORT A

0xFFFF FO3A 9400 Port Mumber 22500

0xFFFF FO3A 9404 Primary Master o]

OxFFFF FO3A 24038 Retry Limit 2

OxFFFF FO3A 940C Burst Message o]

0xFFFF FO3A 9410 Promiscuous Mode 4]

OxFFFF FO3A 9414 Preambles Count ]
PORTE

0xFFFF FO3A 9430 Port Mumber 22501

0xFFFF FO3A 9434 Primary Master o]

OxFFFF FO3A 9438 Retry Limit 2

OxFFFF FO3A 943C Burst Message o]

OxFFFF FO3A 9440 Promiscuous Mode 0

OxFFFF FO3A 9444 Preambles Count 5

OK I Cancel |

3.

In the Number field, choose the HART module’s position from the drop-down list. Click to put a
check mark in the Used box.

4. Configure all parameters for each port used.
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- Port Number: If you need to change port numbers, enter a new number for each port in
the Port Number field.

- Primary Master: 0 = Secondary Master, 1 = Primary Master
A master is a device that is in control of the HART Bus. Either master (Primary or Secondary)
can initiate a transaction with a slave field device attached to the bus.
If you want a permanent master connected to the HART bus, use Primary Master = 1. This
allows you to temporarily attach another master device to configure a device or
troubleshoot the HART bus.

— RetryLimit:0,1,2,3,4,0r5
If the module does not receive a valid message from the slave device it is talking to, it will
automatically send up to the configured number of retries until it gets a valid response. If it
does get a valid response after the maximum number of retries, it will report back that an
error occurred.

— Burst Message: 0 = Don't report burst messages, 1 = Report burst messages

A burst message occurs in a special mode where one slave device on the HART Bus is
periodically sending data without a request generated by a master device. Burst messages
can be retrieved using the Receive HART Burst Response command in your PAC Control
strategy. For more information, see the Analog group of commands in form 1701, the PAC
Control Command Reference.

—  Promiscuous Mode: 0 = Don't report other master requests/responses, 1 = Report other
master requests/responses.
When enabled (1), the module reports transactions initiated by the other master on the
bus, including requests generated by the other master and responses to those requests by
the addressed slave. You can retrieve Promiscuous Mode messages using the Receive HART
Burst Response command in your PAC Control strategy. For more information, see the
Analog group of commands in Opto 22 form 1701, the PAC Control Command Reference.

- Preambles Count: 5 to 20

Preamble characters are sent with every message to indicate that data is about to be
transmitted. The default of 5 should work in most situations. However, you might need to
increase the number if the slave device requires more preamble characters, which is
generally true of older HART devices and can be determined using HART command 0.

5. Repeat the previous step for additional HART modules.

6. When all HART modules are configured, click OK to close the dialog box and return to
configuring I/0 units.

7. Whenyou are ready to send all configuration data to the I/0 unit, see “Sending Configuration
Data to the I/0 Unit"on page 75.

Moving a Configured 1/0 Point

You can move a configured I/0 point to an empty position on the same I/0 unit or on a different I/0
unit.

1. Inthe Configure I/O Unit dialog box, highlight the unit the point is on and click I/0 Points.
The Configure I/0 Points dialog box opens.
2. If necessary, expand the modules by clicking Expand All.
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COPYING AND PASTING I/O UNITS

3. Highlight the point you want to move and click Move To.

-_';] Movwve Point To

10 Urikg:

Preprocess

o |

Cancel | Help |

Pointz:

(007 [00] :
[00][01]:
[00] [02]:
[00][03]:
[0 [00]:
[][01]:
[027[00]:
[02][01]:
[02][02]:
[027[03]:
[03][00]:
[03][01]:

[ Iata LI

Mot Uszed
Mot Uszed
Mot Uszed

Mot Uzed
Mot Uszed
Mot Uszed
Mot Uszed
Mot Uszed
Mot Uszed
Mot Uszed

Ri_til._ 1

Pump_1_5tatuz

Flowmeter_a,

o | »

4. Inthe Points area of the Move Point To dialog box, highlight the location you are moving the
point to. Then click OK.

You return to the Configure I/0 Points dialog box, and the point has been moved.

Copying and Pasting I/O Units
You can copy configured I/O units and paste them into the same configuration file or into another
configuration file.
1. Inthe configuration tree, right-click the name of the I/0O unit. On the submenu, click Copy.
2. (Choose one of the following:

To paste the I/0 unit into the same
configuration file, right-click the I/O
Units folder and click Paste on the
submenu. The I/0 unit is pasted. As
shown in the graphic at right, the
names of the pasted I/0 unit and
points are the same as the originals,
except with an underscore and a
number added.

To paste the I/0 unit into a different
configuration file, close the first file,
and then open the file into which
you want to paste the I/0 unit.
Right-click the 1/0 Units folder in
the configuration tree. On the

Original unit

MainProcess [ = |[ & [l
=-IC) MainProcess
El-IC /0 Units
ER==] Preprocess
| B~ Points

and points

Pasted unit

..... IL‘EI Pump_1_Status
- IM‘_ Flowmeter &

L e S Memary Map Values
KE'"?TFI Preprocess_1 h
|_:_|[E| Points

- IL‘EI Purnp_1_Status_1

and points

- IM‘_ Flowmeter A 1

submenu, click Paste. The I/0 unit is pasted. To see it in the configuration tree, you can click

the plus sign to expand the folder.

3. Tochange the name or configuration of the pasted I/O unit, double-click it. Make the changes
in the Edit I/0 Unit dialog box and then click OK.
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4. To change the name or configuration of a point on the pasted unit, double-click the point’s
name. Make changes in the dialog box and then click OK.

Configuring PID Loops

What is a PID?

PID loops (or simply PIDs) are used to drive an input (process variable) toward a particular value (the
setpoint) and keep the input very close to that value by controlling an output. For example, consider
temperature control, where the input is a measurement of ambient temperature, the setpoint is the
desired temperature, and the output is a heater. A PID will use a mathematical formula (algorithm)
that controls the output to maintain a desired temperature, efficiently adjust to changes in setpoint,
and compensate for changes in load, such as the influx of cold air. In this example, a temperature
sensor (analog input), a thermostat (analog input), and a heater control (analog output) are
components of one system, controlled by a PID loop.

This guide assumes that you are already familiar with using PIDs. PID calculations are complex and
the physical qualities of systems suitable for PID control differ greatly. This guide includes only basic
information for configuring PIDs on SNAP PAC 1/0 units.

SNAP PAC R-series I/0 units support 96 PID loops per I/0 unit; SNAP PAC EB and SB 1/0 units support
32 PID loops per I/0 unit. These PIDs can control isolated systems or be part of cascaded systems
where one loop controls the setpoints or input variables of others.

NOTE: On SNAP PAC R-series, PID loops run on the I/O side, independent of any PAC Control strategy. Once
it starts running, a PID continues running until the I/O unit loses power or the PID is set to Manual. If you
subsequently download a different strategy to the control engine, you'll receive an error message (-700)
reminding you that a PID loop is still running and that it may conflict with the new strategy. To turn off the
PID loop, use Inspect mode in PAC Manager to change the PID’s algorithm to None.

Each PID must be configured with essential parameters and then individually tuned for efficiency.
You can configure PIDs through either PAC Manager or PAC Control. For tuning PIDs, it's easier to use
the graphic tuning tools in PAC Control (see Opto 22 form 1700, the PAC Control User’s Guide).

If you are not using PAC Control, it is possible to configure and tune PIDs through the I/O unit’s
memory map. The memory map is in Opto 22 form 1465, the OptoMMP Protocol Guide.

For additional help with PIDs, see Opto 22 form 1641, OptoTutorial: SNAP PAC PID.

Algorithm Choices

When you configure a PID loop, choose one of these algorithms":

The following obsolete algorithms support PID loops configured before PAC Project R9.5 (for details, see Opto-
KnowledgeBase article KB82058):

« Velocity (Type B) Obsolete

«ISA (Obsolete)

- Parallel (Obsolete)

- Interacting (Obsolete)
You can continue to use these obsolete algorithms, but Opto 22 recommends you use the new algorithms
when configuring new PID loops.
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«  Velocity (Type C)
« ISA

«  Parallel

« Interacting

Velocity (Type Q) is typically used to perform velocity control. The ISA, Parallel, and Interacting
algorithms are derived from the article “A Comparison of PID Control Algorithms”by John P. Gerry in
Control Engineering (March 1987). These three equations are the same except for the tuning
coefficients; converting from one equation to another is merely a matter of converting the tuning
coefficients.

Key to Terms Used in Equations

. . . Derivative tuning parameter. In units
Process variable; the input to the ) .
PV PID TuneD of seconds. Increasing magnitude
increases influence on output.
SP Setpoint Output Output from the PID
InLo . - i-
0, Range of the input Err 1 The Error (PV — SP) from the previ
InHi1 - ous scan
outLo Integrator. Anti-windup is applied
OutHi ’ Range of the output Integral after the output is determined to be
uthe within bounds.
Gain Prqpomonal tuning pargmeter. PVL, PV2 PV from the previous scan and the
Unitless. May be negative. scan before that.
Integral tuning parameter. In units . . . .
. . - Actual scan time (time since previ-
Tunel of seconds. Increasing magnitude ScanTime
. . ous scan)
increases influence on output.

Equations Common to All Algorithms

Err = PV - SP

Span = (OutHi - OutLo) / (InHi - InLo)
Output = Output + FeedForward * TuneFF
Equations Common to ISA, Parallel, and Interacting

Integral = Integral + Err

TermP = Err

Terml =Tunel * ScanTime * Integral
TermD = (TuneD / ScanTime) * (PV - PV1)

Velocity (Type C) Algorithm

TermP = ( PV - PV1 )

Terml = Tunel * ScanTime * Err

TermD = TuneD / ScanTime * ( PV - 2 * PV1 + PV2 )
AOutput = Span * Gain * ( ATermP + ATerml + ATermD )

ISA (or “Ideal”) Algorithm
Output = Span * Gain * ( TermP + Terml + TermD )O

Parallel (or “Independent”) Algorithm
Output = Span * ( Gain * TermP + Terml + TermD )

Interacting (or “Classic”) Algorithm
Output = Span * Gain * ( TermP + Terml ) * ( 1 + TermD )
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NOTE: In SNAP PAC PIDs, the derivative is applied only to the process variable (the input) and not to the
setpoint. This means you can change the setpoint without causing spikes in the derivative term. These PIDs
also prevent integral windup by back calculating the integral without the derivative term. The feed forward
term (“bias”) is added before output clamping and has a tuning factor.

Steps for Configuring PIDs

1. With the configuration file open, right-click the name of the I/O unit the PID will be on. From
the pop-up menu, choose Configure.

The Configure I/0 Units dialog box opens.

=»| Configure I/O Units

| Part | Address | ‘Wwatchdog | De
SMAP-PAC...  Ethemet 10.192.54.110 Enabled

Add...

Modify... |
Delete |

Import/Copy... |

1/0 Paints... |

EID Loops.. ———— PID Loops
_Mosies | | button

Events 3 |

Scratch Pad  » |

4 1 +
Communications » |
Cloze I Help Others 3 |
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2. Make sure the correct I/0 unit is highlighted. Click the PID Loops button.

| Configure PID Loops EI@
10 Unit: j Type: |SHAP-PACH1 [analon
# Mame | Input Setp... | Output | Mode | Enable| Ref... | Descr Add..
oo Mat ...
m Mat ...
0z Mat ...
JIK] Mat ...
04 Mat ...
1L Mat ...
113 Mat ...
in Mat ... -
4 T 3

Cloze | Help |

3. Double-click the lowest unused PID number.

Add PID Loop 23]
A —— Name: ||
B—— Deszcription: |
C | Input: ||;|j Paint j |Flowmeter_A j [ SquareRoot L1 D
E—— Low Range: |0 High Range: |10
F — 1 | Setpoint |I£D Pairt ﬂ |F|Dwmeter_.t’-‘-. ﬂ
G | | Output: |I£D Prairt ﬂ | ﬂ
H—1— Lowwer Clamp: |0 Upper Clamp: |0
I | Min Change: |0 Max Change: |0
Output options for when the input iz out of range
J I Switch ta manual mode when input goes out of range
1 I Force output when input iz out of range [auto mode only]
1] 1]
N
K—— Algonthm; | Velocity - Type © » | Gain: |1 Feed Fiwd Initial: |0 o
L —f—- Mode: |.&utn ﬂ Tune |: |EI } Feed Fwd Gain: |0 i
M—— ScanBate: |1 gec, [ TuneD: |0 J P

0K | Cancel | Help |

4. Complete the fields as follows:
a. Name. Type a unique, descriptive name for the PID.
b. Description. (Optional) Enter a description of the PID.
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Input. Select the type of input: I/0 Point, Host, or PID Output.

If the PID’s process variable comes from an 1/0 point on the same unit, select 1/0 Point.
Choose the point from the dropdown list or type a point name to configure a new point.

If the PID's process variable comes from a PAC Control strategy, select Host. Enter an initial
value for the input.

If the PID’s process variable is the output of another PID on this I/0 unit (a cascading
control loop), select PID Output. Choose the PID from the dropdown list.

. Square Root. (Optional) If you chose I/O Point or PID for step C, check this box if the error
should be calculated based on the square root of the process variable (applies to flow
control systems where volumetric flow is proportional to the square root of a signal from a
flow transducer).

. Low/High Range. Set the valid range of the process variable by entering the low range
and the high range. (See J for optional responses to out-of-range input.)

Setpoint. Choose the source for the setpoint: 1/0 Point, Host, or PID Output.

To control the setpoint using a device such as a potentiometer, select 1/0 Point; choose an
I/0 point from the dropdown list or type a new point name.

To control the setpoint using PAC Control or PAC Display, select Host and enter an initial value.

If another PID loop will control the setpoint, select PID Output and choose the PID from the
dropdown list.

. Output. Choose the destination for the PID output: /0 Point or Host. (To use the output
for controlling the setpoint or input of another PID, choose Host.)

. Lower/Upper Clamp. Enter upper and lower clamp values to prevent the output from
exceeding a desirable range. These values should equal the range of the output point, if
used. Or choose values to make sure that the output device doesn't shut off (for example,
keeping a circulation pump running regardless of the PID output) or that the output never
reaches a destructively high setting (for example, keeping a motor below maximum).
Min/Max Range. (Optional) Enter minimum and maximum change values. The output
won't respond until the minimum change is reached (for example, you may not want a
heater to turn on to correct a 1 degree error). Maximum change prevents too drastic a
change in output (for example, you could limit the increase in a pump's output to prevent
pipe breakage). The default for both minimum and maximum is zero, which disables the
feature.

Output Options. Choose how the PID should respond if the input goes out of range. If no
boxes are checked, the PID will freeze output at the current value. To have PAC Control logic
or an operator respond, check Switch to manual mode. To force the output to a specific
value, check Force output and type the output values. NOTE: If both boxes are checked
(forced output and manual mode), the output will be forced and the PID put into manual mode;
but ifthe PID is already in manual mode, the output will not be forced.

. Algorithm. Choose algorithm: Velocity-Type C, ISA, Parallel, or Interacting. See page 69 for
more information.

Mode. Choose Mode. Auto activates the PID. Manual requires that PAC Control logic or an
operator control the PID output.

. Scan Rate. Enter a scan rate to determine how often the input is scanned and the
controller output is calculated. Minimum value is 0.001 (1 millisecond). Scan time should
be greater than system lag (the time it takes for the controller output to have a measurable
effect on the system). Also consider other PIDs and tasks on the I/0 unit competing for
processing power.
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n. Gain. Enter a positive or negative value for Gain. Heating systems usually require a
negative value and cooling systems a positive value. NOTE: Gain is usually refined during the
tuning process.

0. Fd Fwd Initial and Fd Fwd Gain. (Optional) Enter Feed Forward Initial and Feed Forward
Gain values if you need to offset the controller output in your application. These values are
constants that are multiplied and added to the controller output; often they are not used in
PIDs.

p. Tunel, Tune D. (Optional) Enter Integral and Derivative settings if you know the desirable
settings. However, Integral and Derivative are not essential to basic configuration and are
better determined in the tuning process.

5. C(lick OK.
The new PID appears in the list.

| Configure PID Loops EI@
140 Unit; |F'leprncess j Type: |SN.t’-‘-.F'-F'.t’-‘-.I:-F|1 [analo
# Mame | Input | Setp.. | Output | Mode | Enable| Ref... | Descri »

an Ower.. Owe.. Host Fuel.. Auto.. Ena.. 0O |

m Mot ...

nz Mot ...

03 Mot ...

n4 Mot ...

05 Mot ...

06 Mot ...

ing Mot ... -

i [l 3

Cloze | Help |

6. When you have finished configuring PIDs, click Close.

PIDs appear in the configuration tree under the I/0 unit.

MainProcess* EI@

El-IC5) MainProcess

- IO Units
5 Points
..... IL,E' Pump_1_Status
..... IM,_ Flowmeter_A
24 Oven_A_Temp
o DM_' Fuel_Pump

L= Oven_A_Centrol — PID |OOpS
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Sending Configuration Data to the I/0 Unit

After you have configured I/0 units and set up optional functions such as security, email, and SNMP
from Chapter 3, you must load the configuration file onto the I/0 unit.

You can load the configuration file into RAM only, or you can save it to flash memory at the same
time. If you don't save to flash, the configuration is lost if the 1/0 unit is turned off. When you save to
flash, the new configuration overwrites any configuration already in the flash memory. Note that for
some functions, you must save to flash and restart the 1/0 unit for the configuration to take effect.

1. With the configuration file open, click Tools > Send Configuration to I/0 Unit.
The Send Configuration dialog box appears.

| Send Configuration to Opto 22 Device

M ame | D escription | Fart | Address List | Send
Freprocess 10.192.54.110

Clear Flazh

Cloze

Pl il

Help

¥ Save to Flash Timeout [mzec]
™ Restart Device 10000

The list on the left shows all the I/O units in this configuration file. (In the case of an SB I/0 unit,
there is only one.) When you click a unit, the Address List shows the serial address or IP
addresses for all /0 units associated with the highlighted unit. This is the address list you set up
in the Add I/0 Unit dialog box, shown on page 37.

2. Highlight the 1/0 unit configuration(s) you want to send.
3. Highlight the IP addresses to receive the I/O unit configuration.

If you don't highlight any addresses, the configuration will be sent to the entire list.

NOTE: If you highlighted more than one unit configuration, each unit configuration will
automatically be sent to all the IP addresses associated with it.
4. Ifnecessary, change the Timeout field.

The timeout field shows how long, in milliseconds, PAC Manager will try to communicate with
the I/0 unit before returning a timeout error.

5. To save the configuration file to flash memory as well as to RAM, check Save to Flash. (If you
don't save to flash, the configuration is lost if the I/O unit is turned off.) To also restart the unit,
check Restart 1/0 Unit.
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IMPORTANT: For the following configurations, you must save to flash and restart the unit in order
for configuration to take effect:

Changes in TCP port for serial SNMP configuration
modules PPP configuration
Email configuration

Data logging interval

6. Click Send.

The configuration data is sent to the I/0 units whose IP addresses you chose.

Using PAC Manager to Clear Flash Memory

You can also use PAC Manager to clear configuration data from flash memory in one or more I/0
units. (This action does not affect brain or controller firmware, strategy files, or files from the I/0
unit’s file system that may be stored to flash.)

1. With the configuration file open, click Tools > Send Configuration to I/0 Unit.

2. Inthe Send Configuration dialog box, highlight the I/O unit configuration and addresses for the
/0 units you want to clear.

3. C(lick Clear Flash.

Configuration data in flash memory is cleared.

Using I/O Point Features

The 1/0 point features available on 1/0 units depend on the combined capabilities of the I/0
processor (brain or on-the-rack controller), the module, and in some cases, the protocol used. See
page 9 to determine which features are available for the processor you are using. Note that some
features (such as pulsing and totalizing) can be configured in PAC Manager but are currently
available for use only through PAC Control. See the PAC Control User’s Guide for more information.

The following table defines the features. Some have referenced pages for more information.

Feature Description See

(digital input and output)—A digital point is either on or off. You can read the

States current state of a digital input or write an on/off state to a digital output.

page 78

(digital input)—When the value of a digital input point changes from off to on, an
on-latch is automatically set. While the value of the point may return to off, the
Latches on-latch remains set, as a record of the change, until you clear it. Similarly, an page 78
off-latch is set when the value of a digital point changes from on to off, and it
remains set until cleared.
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Feature

Description

See

Counters

(digital input)—A counter keeps track of the number of times a digital input
changes from off to on. The count accumulates until it reaches the maximum
count available in the I/O unit or until you reset the counter to zero. For exam-
ple, to count the number of widgets produced per shift, you would clear the
counter at the start of each shift and read it at the end of each shift.

For points on a 4-channel module, the speed of the counter depends upon the
brain or controller’s capabilities and the speed of the module used. For points
on a high-density module, counting is done in the module.

page 79

Quadrature
counters

(digital input)}—A quadrature counter requires a SNAP quadrature input mod-
ule, which is attached to the encoder device. The module sends a pulse to the
I/O unit upon each change in quadrature state, and the 1/O unit counts the
pulses and keeps track of the direction and rotation.

page 79

Frequency
measurement

(digital input)—Frequency is the speed with which a digital point changes state
and is usually measured in counts per second. For example, reading the fre-
guency can help you determine the speed of rotating machinery.

Period
measurement

(digital input)—Period refers to the elapsed time for a complete on-off-on transi-
tion on a digital point. Measurement starts on the first transition (either off-to-on
or on-to-off) and stops on the next transition of the same type.

Time-propor-
tional output
(TPO)

(digital output)—Time-proportional output varies the duty cycle and the percent-
age of on time within that cycle. TPO is often combined with a PID loop and
used to control the output, for example in a heater or oven.

Pulse and
square wave
generation

(digital output)—A pulse turns a digital output on (or off) briefly, either once or
for a specified number of times at a specified interval. A digital square wave is a
specific pattern of on and off states, repeated continuously.

Totalization

(digital and analog input)—For a digital input, a totalizer accumulates the total
amount of time that a digital input is on (or off). The on-time totalizer shows how
long the point has been on; the off-time totalizer shows how long the point has
been off. Totalizers are often used to determine maintenance or use schedules.
For an analog input, a totalizer accumulates readings by sampling the input
point at set intervals and storing the total value, for example to determine total
flow based on a varying flow rate signal.

Watchdog

(digital and analog points)—A watchdog monitors communication on the
OptoMMP port (port 2001, unless you have changed it). If nothing accesses the
port for the length of time set in the watchdog, the 1/O unit automatically sets
designated digital and analog I/O points to the values you have determined.

A watchdog helps make sure that a communication failure doesn’t result in
disaster. If communication fails between the host and the 1/0O unit controlling a
process, the watchdog makes sure the process is automatically brought to a
safe state. For example, a valve could automatically close to avoid completely
emptying a tank.

IMPORTANT: A strategy running on a SNAP PAC R-series controller accesses
the points on its own rack directly, not through the OptoMMP port. Conse-
quently, reads and writes to the local I/O are not seen by the watchdog.

page 80

Scaling

(analog input and output)—Analog input and output points can be scaled as
needed. For example, you can scale a -5 V to +5 V input point to reflect 0% to
100%

page 80

Minimum and
maximum
values

(analog input)—Minimum and maximum values are sometimes called peaks
and valleys. You can read these values at any time, for example, to record min-
imum and maximum temperatures. You can also reset min/max values. For
example, if you want to record the maximum temperature at point 2 in each
24-hour period, you must reset the values after they are read each day.

page 81
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Feature Description See
(analog input)}—The 1/O unit automatically converts the thermocouple junction's
Thermocouple | millivolt values into temperature values, so you don't have to. Choose the
linearization appropriate module and make sure you configure the point as the correct ther- -
mocouple type (E, K, etc.) for your purpose.
(analog input)—Offset and gain calculations are used to calibrate analog
Offset and points. If a -50 mV to +50 mV input receives signals that are slightly off (not
gain exactly -50 mV at the lowest point, for example), the offset and gain can be cal- page 81
culated so that values will appear accurately when read.
(analog output)—Clamping limits values that can be sent to analog output
points so they do not go above or below a specific value. For example, if you
Clamping are using a 0-10 VDC output module, but the device attached to one of its page 81
points can handle a maximum of only 5 VDC, you can set an upper clamp of 5
VDC for that point. The values for upper and lower clamp are set in engineering
units.
(analog output)}—Some devices attached to analog outputs should not be
. abruptly stepped up or down, because a sudden change might damage the
Ramping . *
equipment or cause other problems. Instead, you can gradually ramp the
device up or down to the desired value.
(analog points)—Proportional integral derivative (PID) loops are used to drive
PID loop an input toward a particular value (the setpoint) and keep the input very close to
control that value by controlling an output. PID loops are often used in temperature page 69
control.
Average filter | (analog inputs)—A filter weight smooths analog input signals that are erratic or
. page 81
weight change suddenly.

* Requires PAC Control and a SNAP PAC controller for use. See the PAC Control User’s Guide.

Some 1/0 point features are discussed in the following sections.

States (Digital Points)

You can read the ON or OFF state of a digital input point or write to a digital output point to turn it
on or off. This feature is automatic and needs no configuration.

Latches (Digital Points)

Latching is available on both 4-channel and high-density digital points. It is automatic and needs no
configuration. Using memory map values, you can read the on-latch or off-latch state of a digital
point, and you can clear latches.
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Counters (Digital Points)

Any SNAP digital input can be used as a counter. Note the differences in counting between
4-channel and high-density digital modules:

SNAP 4-channel digital counters

SNAP high-density digital counters

Processor compatibility

SNAP-PAC-R1 (-B, -FM, -W)
SNAP-PAC-EB1 (-FM, -W)
SNAP-PAC-SB1

SNAP-PAC-R1 (-B, -FM, -W)
SNAP-PAC-R2 (-FM, -W)
SNAP-PAC-EB1 (-FM, -W)
SNAP-PAC-EB2 (-FM, -W)
SNAP-PAC-SB1
SNAP-PAC-SB2

Counting is done on...

...the brain

...the module

Counting speed

High speed (depends on speed of mod-
ule; modules available up to 20 KHz)

Low speed (up to 50 Hz)

Configuration and Use

« Each point to be used as a counter
must be configured.

« Counters start as soon as configured.

« Counters can be Started, Stopped,
Read, and Read & Cleared.

« Configure points only if using PAC
Control.

« Counters are always counting.

« Counters can be Read or Read &
Cleared.

Counters cannot be Started or
Stopped.

G4EB2—Any digital input can be used as a counter. Counters must be configured. They start as
soon as they are configured and can be Started, Stopped, Read, and Read & Cleared.

Use PAC Control digital point commands to work with counters.

Quadrature Counters (Digital Inputs)

/0 units with the following I/O processors support quadrature counters for quadrature encoder
devices:

«  SNAP-PAC-R1

«  SNAP-PAC-R1-B
«  SNAP-PAC-EBT
«  SNAP-PAC-SB1

A quadrature counter requires a SNAP quadrature input module (SNAP-IDC5Q), which is attached to
the encoder device. The module sends a pulse to the processor upon each change in quadrature
state, and the processor counts the pulses and keeps track of the direction and rotation. For each
axis, the counter counts up if Phase A leads Phase B; it counts down if Phase A lags behind Phase B.
Each axis can have counts from 0 to 2,147,483,647.

If your encoder device has an index feature, you can use two separate digital input points as indexes,
one for each axis. The index automatically resets the count, and it shows what the count was when
the index was triggered. Counts are sometimes lost, due to noise or encoder problems, for example;
with the index, you can see whether the count varies too much.
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Watchdog (Digital and Analog Points)

To configure a watchdog, set the watchdog when configuring the /O unit. Then when you
configure a digital or analog output point, you can choose the status or value the point should be
set to if the watchdog timer expires.

Scaling (Analog Points)

You can scale analog input or output points to match your needs. For example, you can scale a

-5V to +5 Vinput point to reflect 0% to 100%. Point types may be unipolar or bipolar.

Examples of Unipolar Points

4-20 mA analog output
0-10 A RMS analog input

Unipolar and bipolar points are scaled in the same way, with the lowest reading reflecting the low

Examples of Bipolar Points
-25 mV to +25 mV analog input
-10to +10VDC analog output

scale and the highest reading reflecting the high scale. Here are two examples:

Unipolar Input Point Bipolar Input Point
Low scale High scale Low scale High scale
Actual reading 0 mA 20 mA 5V ov +5V
Scaled for percentage 0% 100% 0% 50% 100%
Scaled for counts* 0 +25,000 -25,000 0 +25,000
*Counts for input points always range -25,000 to +25,000.
Unipolar Output Point Bipolar Output Point
Low scale High scale [Low scale High scale
Actual reading 4 mA 20 mA -10 vDC 0VvDC +10 VDC
Scaled for percentage 0% 100% 0% 50% 100%
Scaled for counts* 0 4,095 0 2,047.5 4,095

*Counts for output points always range 0—-4,095.

NOTE: With firmware version 8.1 and higher, you can also use inverted scaling. For example:

0mA
742 fom

20mA
-27 fom
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Minimum and Maximum Values (Analog Points)

All memory-mapped 1/0 units with analog capability automatically keep track of minimum and
maximum values on analog points. You can read and clear these values using PAC Manager's Inspect
mode.

Offset and Gain (Analog Points)

/0 units with analog capability can calculate offset and gain for analog input points. Calculate offset
first, and then calculate gain. See “Calculating Offset and Gain Using the Two-Point Method"on
page 192.

NOTE: If you are using Modbus/TCR, you will need to calculate the offset and gain yourself. Then you can
write offset and gain values to the I/0 unit. See page 50 for more information.

Clamping (Analog Points)

SNAP 1/0 units with analog capability and SNAP PAC SB brains can clamp values sent to analog
output points so they do not go above or below a specific limit. For example, if you are using a 0-10
VDC output module, but the device attached to one of its points can handle a maximum of only 5
VDG, you can set an upper clamp of 5 VDC for that point. The values for upper and lower clamp are
set in engineering units. (See “Configuring I/0O Modules, Points, and Features”on page 173.)

Average Filter Weight (Analog Points)

SNAP PAC1/0 units and SNAP PAC SB brains can use a filter weight to smooth analog input signals
that are erratic or change suddenly. The formula used for filtering is Y = (X - Y )/W +Y, where Y is the
filtered value, X is the new unfiltered value, and W is the filter weight.
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This graph shows the effect of filter weights (W) 2, 5, and 10 on a step input signal:

Y =(X-Y)W+Y
Filter Response for Different values of 'W'

4 As this graph shows, the
larger the filter weight (W)
you use, the smoother the
analog signal.

—e— Input

Afilter weight of zero turns off the calculation. Values less than or equal to 0.5 are changed to zero,
since those values would cause an unstable signal.

Filtering is applied to values that are in engineering units, including minimum and maximum values.
Filtering does not apply to values that are in counts. Set filter weight when configuring the analog
point. (see “Configuring I/0 Modules, Points, and Features”on page 173)
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3: Configuring Optional
Functions

Introduction

Chapter 2 showed you how to configure I/0O unit points and features. This chapter includes
instructions for setting up the following optional functions:

Setting up network security (wired network) page 90
Logging data page 100

Sending event messages via email, SNMP, a stream packet, or a serial module  page 104

Using SNMP for communicating with enterprise management systems page 109
Configuring DNS Servers page 112
Sending email page 112
Using the Scratch Pad area for peer-to-peer data sharing page 115
Streaming data page 117
Mirroring 1/0 point data page 120
Copying memory map data page 122
Configuring Modbus options page 125
Setting system date and time page 129
Communicating serially with devices attached directly to a controller page 131
Using PPP for communicating via modem with the device page 137

In most cases, you use the same configuration file in PAC Manager to set up optional functions as
you did to configure I/0 units, so the complete configuration information can be uploaded to I/0

units all at once.
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Setting Up Network Security (Wired Network)

For network security on a wireless LAN, see “Configuring Wireless LAN Communication
(Wired+Wireless Models Only)”on page 26.

You can use PAC Manager to set up security on a wired network for an Opto 22 SNAP PAC
Ethernet-based device. You can limit access to specific computers or other devices on the network.
You can also limit access to specific protocols used with the Opto 22 device, such as SNMP (below).
You can require a password for using FTP (see page 93). In addition, you can protect a PAC Control
strategy so that it runs without possibility of interference from a host (page 93).

Limiting Access to Specific Computers

You can limit access to the SNAP PAC controller or I/0 unit based on the IP address of the computer
or other host device attempting to communicate with it. You specify the IP addresses that may
access the controller or I/0 unit. Anyone on a computer or other host device with an acceptable IP
address has access.

Work with your network administrator to make sure you are specifying the correct IP addresses. See
“Configuring Ethernet Security on an I/0 Unit"on page 95 or “Configuring Ethernet Security on a
Standalone Controller”on page 98 for instructions.

Limiting Access to Specific Protocols

You can also limit access to specific protocols the SNAP PAC controller or I/O unit uses. These
protocols can travel simultaneously over the Ethernet/TCP/IP link and set up sessions, or ports, on
the SNAP PAC device:

«  File transfer protocol (FTP), used for exchanging files between the device and a computer
(applies to SNAP PAC R-series, S-series, and SoftPAC only)

+  Modbus/TCP protocol, used by Modbus/TCP software and hardware

+  OptoMMP the IEEE 1394-based memory map protocol, used by most other tools for interfacing
with the SNAP device

«  Simple network management protocol (SNMP), used to communicate with SNMP-based
enterprise management software

For security purposes, you can hide or disable one or more of the protocols by changing the port
number from its default. The following table shows these default ports.

NOTE: If you change any port number, you must restart the device before the changes will take effect.

Protocols for Default Ports:

Protocol Used by Default Port
FTP PCs for file exchange 21
SNMP enterprise management system 161
Modbus/TCP Modbus/TCP software and hardware 502
OptoMMP PAC Manager and most other tools 2001
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Preventing Access. For example, suppose you want to prevent any device from accessing a
controller using FTP. To do so, you would change the port number for the FTP protocol from the
default of 21 to zero. Since zero is an invalid port, no device could access the controller using FTP.

Limiting Access. If you wanted to limit FTP access, you could change the port number from 21 to a
non-reserved number between 1 and 65,535 (see list of reserved port numbers, below). If you
change the number, anyone (or any application) that needs to access the controller using FTP can
do so by adding the changed port number to the controller's IP address. For example, if the
controller's IP address is 10.22.56.3 and the port number is changed to 85, you would enter the
following to access the controller:

10.22.56.3:85

Reserved Port Numbers

If you change port numbers, do not use any number in the following list. These numbers are
reserved for Opto 22 firmware:

Port Used by Port Used by
20 FTP 2222 EtherNet/IP (UDP for I/O)
21 FTP 22000 Reserved
25 SMTP 22001 PAC Control/ioControl Host
67 BootP Server 22002 PAC Control Background Downloading
68 BootP Client 22003 Reserved
161 SNMP 22004 PAC Control User Chart
162 SNMP Traps 22005 PAC Control User Chart
502 Modbus/TCP 22500-22531 | Serial Communication Modules
2001 OptoMMP Host 23567 PAC Controller Redundancy
2002 OptoControl Peer 44818 EtherNet/IP (TCP & UDP Explicit messages)
2003 OptoControl Peer 50000-50999 | PAC controller internal use

For more information, see “Configuring Ethernet Security on an I/0 Unit"on page 95 or “Configuring
Ethernet Security on a Standalone Controller”on page 98.

Configuring the PAC as an HTTP/HTTPS Server

In addition to working as a client (for example, to send email) SNAP PAC R-series or S-series
controllers with PAC firmware R9.5a or higher include a built-in HTTP/HTTPS server and a REST API.
The PAC listens for HTTP and HTTPS requests, and then sends I/O point or strategy variable data to
the client that requested it. The complete SNAP PAC REST APl and instructions to get started are on
developer.opto22.com.

To prevent unauthorized access, the HTTP/HTTPS server feature in PAC R-series or S-series
controllers is disabled by default. To configure the server in your controller, you enable either HTTPS
or HTTP protocol on the controller and configure a listening port for TCP communication.

IMPORTANT: Opto 22 strongly recommends using HTTPS for secure, encrypted access to your controller.
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Use HTTP for testing purposes only.

1. In PAC Manager, click Tools > Inspect, or click the Inspect button B

2. IntheInspect Opto 22 Device window, enter the IP address for the R- or S-series controller you
want to configure, or select it from the list.

3. (lick Communications, and choose Network Security from the pop-up menu.
4. Inthe WEB SERVER section:
a. Change the default value of TCP Listen Port (address OxFFFF FO3A 0014).
Typically, port 443 is used for HTTPS, and port 80 is used for HTTP.
b. Verify the value of HTTPS (address OxFFFF FO3A 0070).
—  For HTTPS, the value should be Enabled.
—  For HTTP, change the value to Disabled.
c. Click Apply to save the changes.

=] Inspect Opto 22 Device

Device Name: ]Opho 22 Controller L] Options » Status: ]Network Security area last readl}

~Metwork Security l
Status Read £
T Address | Description | Value
OxFFFF FO3A 0004  OptoMMP 2001
) OxFFFF FO3A 0008 Modbus 502
mEEEN D J OxFFFF FO3A000C  SNMP 161
OxFFFF FO3A0010  FTP 21

Point Config <,.,, e DTS BT 2EHIE )

WEB SERVER

Digital Bank | OxFFFF FO3A 0014 TCP Listen Port 443
o (OxFFFF FO3A 007C  HTTPS Enabled
Digital Point M e

M-D

5. Toimmediately enable the HTTP/HTTPS server feature in the controller, click Status Write, and
then, in the Operation area:
a. Click Store configuration to flash, and then click Send Command.
b. Click Restart Device from powerup, and then click Send Command.

=] Inspect Opto 22 Device

Device Name: iODtD 22 Controller L] Options ¥ J Status: | Restart Device from DOMI
—Status Write
Status Write Address | Description l
OxFFFF FO38 0004  Always BootP/DHCP On Powerup i
Z OxFFFF FO38 0008 Degrees F/C 1
WirelessLAN ¥ J 0xFFFF FO38 0010  Comm Watchdog Time (msec), 0 = Disable 8
0xFFFF F038 0014 TCP Minimum Retransmission Timeout {msec)
Point Config OxFFFF FO38 0018 TCP Initial Retransmission Timeout {msec)
0xFFFF FO33 001C  TCP Retransmission Attempts
Digital Bank OxFFFF FO38 0020 TCP Idle Session Timeout (msec), 0 = Disable |
= 3 OxFFFF F0O38 0294 Digital Feature Scan Interval (msec) l
Digital Point 0xFFFF F038 0050 Max Analog and High Density Digital Scan Interval (msec) Send Command
Analog Bank 0xFFFF FO38 0298 Out Of Range Value (16-Bit)
OxFFFF F038 02B0  Out Of Range Value (32-Bit)

Analog Point 0xFFFF FO38 0054  Scanner Flaos
High Density EFET
}— Do = ~ Send Command |
Restart Device from powerup
3
% \ Store configuration to flash ’
Sl D Reset to defaults and Restart Device

Data Log >l | miUPSD
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Requiring a Password for FTP

You can configure security so that anyone who wants to access the device using FTP is required to
enter a username and password. If you are using the Opto iPAC app for iPhone, iPod Touch, or iPad,
we strongly recommend you require a password.

See "Configuring Ethernet Security on an I/0 Unit”on page 95 or “Configuring Ethernet Security on
a Standalone Controller”on page 98 for instructions.

Protecting a PAC Control Strategy from Interference

You can set up a standalone or on-the-rack controller to run a stable strategy without the possibility
of interference from a host. This means that no one can alter or stop the strategy using PAC Control
or PAC Terminal; but it also means that PAC Display cannot communicate with the control engine.

To protect a PAC Control strategy from interference, finalize the strategy, download it, save it to flash
memory, and then set the autorun flag. (For the steps, see Opto 22 form 1700, the PAC Control User’s
Guide, for steps.) Then follow steps in the next section to change the Control Engine port number
from the default of 22001 to zero, and save that setting to flash as well. The strategy will
automatically run when power is turned on, but a host cannot communicate with it.

If you need to change the Control Engine port number back to 22001, you can do so in PAC
Manager, because PAC Manager uses the OptoMMP protocol to communicate with the controller.

Turning Off EtherNet/IP

If you are not using the EtherNet/IP protocol on a SNAP PAC device, you can turn the protocol off.
Note that you must restart the device after this change.

Since this procedure sends the configuration directly to the device, the device must be on the same
network as your computer.
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SETTING UP NETWORK SECURITY (WIRED NETWORK)

1. Inthe PAC Manager main window, click the Inspect button El

= Insp pto 22 Device — hed
Device Name: | 10.192.55.67 L| Options ¥ Status: | Status Read area last read at 07/05/16 10:34:58
Status Read
Status Read |
T ADDRESS DESCRIPTION VALUE ~ Refresh I
I 5 0xFFEFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwved (0)

Wireless LAN | OxFFFF FO30 0008 Busy Flag 0

Point Config | 0xFFFF FO030 0018 Loader Version R5.1c

Digital Bank 0xFFFF FO30 0000 Memory Map Version 1

giea! Ban | 0xFFFF FO30 0230 Current Boot Device Flash Memory

Digital Point | 0xFFFF FO30 001C Firmware Version L9.5a

0xFFFF FO30 00RO Firmware Version Date 05/03/2016

Analog Bank | 0xFFFF FO30 00BO Firmware Version Time 15:29:32

Anzlog Point | 0xFFFF F030 0020 Unit Type 0x0000007A

High Density | 0xFFFF F030 0080 Unit Deacription SNAP-PAC-R1

< 0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4

5 0xFFFF FO30 0025 I/0 Unit Hardware Revision (Day) 21

FEE | 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008

Scratch Pad ,l 0xFFFF F030 024C I/0 Coprocessor Firmware Version L0.0a
0xFFFF F030 0028 Installed Ram 33554432

Data Log 3 |

ETHERNET 1 Interface

PID b 0xFFFF F030 002E MAC Address 00-A0-3D-01-85-9C
=== D 0xFFFF F030 0034 IP Address 10.192.55.67
| 0xFFFF F030 0038 Subnet Mask 255.255.192.0
T ,l 0xFFFF F030 003C Gateway 10.192.51.51
| 0xFFFF F030 0040 DNS 10.192.60.31
Other »l ETHERNET 2 Interface v
Close | Help | [~ Auto Refresh |15000 msec

If you have used the Inspect button before, the last Device Name you used is shown and
current Status Read information from that IP address appears. The most recently used devices
are available in the drop-down list.

2. Inthe Device Name field, type the name or IP address of the controller (or choose it from the
drop-down list).
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3. lick Communications and choose Network Security from the submenu. Scroll down till you

see ETHERNET/IP.

Inspect Opto 22 Device
P p

Device Name: | 10.192.55.67

MNetwork Security
Status Read

j Options »

- X

Status: | MNetwark Security area last read at 07/05/16 10:42:05

‘ Description

| Value | ~ Refresh |

m Address
0xFFFF FO3D 0000
w 0xFFFF FO3D 0040

OXFFFF FO3A 0070

OXFFFF FO34 0020

% OXFFFF FO34 0024
= OXFFFF FO34 0028
% OXFFFF FO3A 002C
m OxFFFF FO3A 0030
OxFFFF FO3A 0034

m 0xFFFF FO3A 0033
OxFFFF FO3A 003C

m OXFFFF FO3A 0040
OxFFFF FO3A 0044

OXFFFF FO3A 0048

M OXFFFF FO34 004C
m OXFFFF FO3A 0050
OXFFFF FO3A 0054

m OxFFFF FO3A 0058
OxFFFF FO3A 005C

PID » OXFFFF FO3A 0060
OxFFFF FO3A 0054

Events 4 0xFFFF FO3A 0068
0xFFFF FO3A 006C

Communications »
0xFFFF FO3A 0078

Other 3

FTP Username
FTP Password
BROADCAST FILTER

Apply

Stop incoming broadcasts Mo [
IP FILTERS

Filter 0 - Address 0.0,0.0

Filter 0 - Mask 0.0.0.0

Filter 1 - Address 0.0.0.0

Filter 1 - Mask 0.0.0.0

Filter 2 - Address 0.0.0.0

Filter 2 - Mask 0.0.0.0

Filter 3 - Address 0.0.0.0

Filter 3 - Mask 0.0.0.0

Filter 4 - Address 0.0.0.0

Filter 4 - Mask 0.0.0.0

Filter 5 - Address 0.0,0.0

Filter 5 - Mask 0.0.0.0

Filter 6 - Address 0.0.0.0

Filter & - Mask 0.0.0.0

Filter 7 - Address 0.0.0.0

Filter 7 - Mask 0.0.0.0 %
Filter 8 - Address 0.0.0.0

Filter 8 - Mask 0.0.0.0

Filter 9 - Address 0.0.0.0

Filter 3 - Mask 0.0.0.0

ETHERNET/IP
EtherNet/TP Protocol Enabled 5|

Close | Help |

[~ Auto Refresh | 15000  msec

4, Inthe Value column, click the down arrow and choose Disabled.
To enable EtherNet/IP again, choose Enabled.

5. Click Apply to send the configuration change to the device.
6. Click Status Write. In the Operations Commands section, highlight Store configuration to flash.

Click Send Command.

7. Inthe same section, highlight Restart Device from powerup. Click Send Command.

The change is stored to flash memory and the device restarts.

Configuring Ethernet Security on an I/O Unit

Use these steps for an Ethernet-based I/0 unit on a wired network. For security on a wireless LAN,
see page 26. For a SNAP PAC S-series standalone controller, use the steps on page 98.

1. In PAC Manager, click the Open button Q (or in the menu bar, click File > Open).
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2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to
open it.

5] PAC Manager - Main_Process - O X
File Edit Tools View Help

| Dl ¥ @)

-1 Main_Process

=] /0 Units

-2 Line,_1

-2 Preprocess

Ready [N

3. Inthe configuration tree, right-click the name of the 1/0 unit on which you want to set up
security and choose Configure from the pop-up menu.

= Configure /0 Units *
Name | Type | Part | Address | watchdog | Description Add... |
Line_1 SNAP-PAC... Ethernet 10.192.55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192.55... Disabled Modify... |

Events >|
Scratch Pad >|
communications ~—— Communications

Others  » button

Close I Help
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Click the Communications button and choose Network Security from the pop-up menu.

E Configure Network Security 4
[~ Used

Address | Description | Value A
PORTS

0xFFFF FO3A 0004 OptoMMP 2001

0xFFFF FO3A 0008 Modbus 502

0xFFFF FO3A 000C SNMP 161

0xFFFF FO3A 0010 FTP 21

0xFFFF FO3A 0074 Control Engine 22001
WEB SERVER

0xFFFF FO3A 0014 TCP Listen Port a

OxFFFF FO3A 007C  HTTPS Enabled |
FTP LOGIM

0xFFFF FO3D 0000 FTP Username
0xFFFF FO3D 0040 FTP Password
BROADCAST FILTER

0xFFFF FO3A 0070 Stop incoming broadcasts MNo il
IP FILTERS

OxFFFFFO3A 0020  Filter O - Address 0.0.0.0

OxFFFF FO3A 0024 Filter 0 - Mask 0.0.0.0

OxFFFFFO3A 0028 Filter 1- Address 0.0.0.0

OxFFFF FO3A 0020 Filter 1 - Mask 0.0.0.0

OxFFFFFO3A 0030 Filter 2 - Address 0.0.0.0

OxFFFF FO3A 0034 Filter 2 - Mask 0.0.0.0

OxFFFFFO3A 0038 Filter 3 - Address 0.0.0.0

OxFFFF FO3A 003C  Filter 3 - Mask 0.0.0.0

OxFFFF FO3A 0040 Filter 4 - Address 0.0.0.0

OxFFFF FO3A 0044 Filter 4 - Mask 0.0.0.0

OxFFFFFO3A 0048  Filter 5 - Address 0.0.0.0

OxFFFF FO3A 004C  Filter 5 - Mask 0.0.0.0

OxFFFF FO3A 0050 Filter & - Address 0.0.0.0

OxFFFF FO3A 0054 Filter & - Mask 0.0.0.0 v

oK | Cancel |

If there is no check mark in the Used box, click the box to place a check mark there.
To limit access to a specific protocol, change the Port number in the Value column.

CAUTION: Ifyou change the Control Engine port to zero, a strategy that is already in the control
engine will still run, but PAC Display, PAC Control, and other hosts will not be able to communicate
with it. See “Protecting a PAC Control Strategy from Interference” on page 93.

To use the built-in HTTP/HTTPS server on a SNAP PAC R-series or S-series controller, see
“Configuring the PAC as an HTTP/HTTPS Server”on page 91.

To set up an FTP login, enter the Username and Password to be required from anyone who uses
FTP to access the device.

To limit access to specific computers, set up to ten filter addresses and filter masks.

The filter address is the IP address that is allowed to access the I/O unit; the filter mask indicates
a range of allowed addresses. If only one IP address may access the I/0 unit, enter
255.255.255.255 for the filter mask. If a range of IP addresses may access the I/0 unit, enter a
mask that reflects the subnet range.

For example, if only IP address 1.2.3.4 may access the I/O unit, enter 1.2.34. as the filter address
and 255.255.255.255 as the filter mask. If any IP address that starts with 1.2.3 may access the I/0
unit, enter 1.2.3.4 (or 1.2.3.1, or any address in the range) as the filter address and 255.255.255.0
as the filter mask.
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NOTE: For troubleshooting purposes, you can use the Broadcast Filter value to temporarily turn off
incoming broadcasts to the I/0 unit. Normally you would NOT want to do this; a BootP response, for
example, is an incoming broadcast.

10. When you have finished configuring security, click OK.

11. Configure other optional functions, or return to the PAC Manager main window and click the

Save button g to save the configuration file.

IMPORTANT: If you changed a port number, you must restart the device when you send the
configuration to the I/0 unit. Otherwise the port change will not take effect.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data
to the I/0 Unit"on page 75.

Configuring Ethernet Security on a Standalone Controller

These steps are for a wired network. For security on a wireless LAN, see page 26.

Since this procedure sends the configuration directly to the controller, the controller must be on the
same network as your computer.

NOTE: Ifyou change a port number, you must restart the device in order for the port change to take effect.

1. Inthe PAC Manager main window, click the Inspect button @

@ nspect Opto 22 Device

Device Name: [ 10,192,55.67

Status Read
Status Read

Status Write
| wirgless LAN  »

: Point Config
Digital Bank
Digital Point
Analog Bank
Analog Paint
| High Density
System 3
| Scratch Pad — »
Datalog *
PID 3
Events 3
| Communications »
: Other 3

Close |

Status:

j Options

Status Read area last read at 07/05/16 10:34:58

ADDRESS DESCRIFTION VALUE ~ Refresh | ‘
OxFFFF FO30 0004 Powerup Clear Flag FUC Needed FUC Received (0)
0xFFFF FO30 0008 Busy Flag 0 ‘
0xFFFF F030 0018 Loader Version R5.1c |
OxFFFF FO30 0000 Memory Map Version 1
0xFFFF FO30 0230 Current Boot Device Flash Memory
0xFFFF F030 001C Firmware Version 19.5a
OxFFFF FO30 00RO Firmware Version Date 05/03/2016
0xFFFF F030 00BO Firmware Version Time 15:29:32
0xFFFF FO30 0020 Unit Type 0x0000007R
0xFFFF F030 0080 Unit Description SNAP-FAC-R1
0xFFFF FO30 0024 I/0 Unit Hardware Revision ({Month) 4
0xFFFF FO30 0025 I/0 Unit Hardware Revision (Day) 21
0xFFEFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0z
0xFFFF FO30 0028 Installed Ram 33554432
ETHERNET 1 Interface
0xFFFF FO30 00ZE MAC Address 00-A0-3D-01-85-9C
0xFFFF FO30 0034 IP Rddress 10.192.55.67
0xFFFF FO30 0038 Subnet Mask 255.255.1%2.0
0xFFFF F030 003C Gateway 10.192.51.51
0xFFFF FO30 0040 DNS 10.192.60.31
ETHERNET 2 Interface v
e | ™ AutoRefresh | 15000  msec

If you have used the Inspect button before, the last Device Name you used is shown and
current Status Read information from that IP address appears. The most recently used devices
are available in the drop-down list.
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In the Device Name field, type the name or IP address of the controller (or choose it from the
drop-down list).

Click Communications and choose Network Security from the submenu.

#=#| Inspect Opto 22 Device — X
Device Name: | 10.192.55.67 j Options ¥ Status: |Network Security area last read at 07/05/16 11:11:21
MNetwork Security
Status Read
Status Write Address ‘ Description | Value | ~ Refresh |
g PORTS =
0xFFFF FO3A0004  OptoMMP 2001 2
wEsslE D OxFFFFFD3ADO08  Madbus 502
0xFFFF FO3A 000C  SNMP 151
Paint Config OxFFFF FO3A 0010 FTP 21
0xFFFF FO3A 0074 Control Engine 22001
Digital Bank FTP LOGIN
. ) 0xFFFF FO3D 0000 FTP Username
Eipeat OXFFFFFO03D 0040  FTP Password
Andlog Bank BROADCAST FILTER
0xFFFF FO3A 0070 Stop incoming broadcasts Mo =1
Analog Point P F_ILTERS
OxFFFF FO3A 0020 Filter 0 - Address 0.0.0.0
High Density 0xFFFF FO3A 0024 Filter 0 - Mask 0.0.0.0
OxFFFF FO3A 0028 Filter 1 - Address 0.0.0.0
System b OxFFFF FO3A 002C  Filter 1-Mask 0.0.0.0
OxFFFF FO3A 0030 Filter 2 - Address 0.0.0.0
SoatchPad b OxFFFF FO3A 0034 Filter 2 - Mask 0.0.0.0
OxFFFF FO3A 0038 Filter 3 - Address 0.0.0.0
Datalog * OxFFFF FO3A 003C  Filter 3 - Mask 0.0.0.0
OxFFFF FO3A 0040  Filter 4 - Address 0.0.0.0
FID 3 0xFFFF FO3A 0044 Filter 4 -Mask 0.0.0.0
OxFFFF FO3A 0048 Filter 5 - Address 0.0.0.0
Events 0xFFFF FO3A 004C  Filter 5 - Mask 0.0.0.0
OxFFFF FO3A 0050 Filter & - Address 0.0.0.0
Communications » OxFFFF FO3A 0054 Filter 6 - Mask 0.0.0.0
OxFFFF FO3A 0058 Filter 7 - Address 0.0.0.0
Other ' 0xFFFF FO3A 005C  Filter 7 - Mask 0.0.0.0 v
Close | Help | [~ AutoRefresh | 15000  msec

To limit access to a specific protocol, change the Port number in the Value column.

CAUTION: Ifyou change the Control Engine port to zero, a strategy that is already in the control
engine will still run, but PAC Display, PAC Control, and other hosts will not be able to communicate
with it. See “Protecting a PAC Control Strategy from Interference” on page 93.

To set up an FTP login, enter the Username and Password to be required from anyone who uses
FTP to access the device.

To limit access to specific computers, set up to ten filter addresses and filter masks.

The filter address is the IP address that is allowed to access the controller; the filter mask
indicates a range of allowed addresses. If only one IP address may access the controller, enter
255.255.255.255 for the filter mask. If a range of IP addresses may access the controller, enter a
mask that reflects the subnet range.

For example, if only IP address 1.2.3.4 may access the controller, enter 1.2.3.4. as the filter
address and 255.255.255.255 as the filter mask. If any IP address that starts with 1.2.3 may
access the controller, enter 1.2.3.4 (or 1.2.3.1, or any address in the range) as the filter address
and 255.255.255.0 as the filter mask.

NOTE: For troubleshooting purposes, you can use the Broadcast Filter value to temporarily turn off
incoming broadcasts to the controller. Normally you would NOT want to do this; a BootP response, for
example, is an incoming broadcast.

When all the values are correct, click Apply to send the configuration to the controller. If you
changed a port number, also restart the controller:
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a. C(lick the Status Write button in the upper left.
b. Inthe Operation Command list, highlight Restart Device from powerup.
¢. (lick Send Command.

The device is restarted and a Success message appears.

Logging Data from Memory Map Addresses

You can use a SNAP PAC R-series, EB, or SBI/O unit to log data from up to 64 memory map addresses.
The data from all addresses goes into the same data log file, which you can view from PAC Manager.
For Ethernet-based I/0 units, data from this composite file can also be emailed to someone at a time
interval you set. For a complete list of memory map addresses, see Opto 22 form 1465, the
OptoMMP Protocol Guide.

NOTE: If you are using SNAP PAC-Rwith PAC Control, you may prefer to log data in a different way. See
page 235 and the PAC Control User's Guide for more information about the controller’s file system.

Note that SNAP PAC brains cannot save logged data if power to the unit is cycled.

Configuring Data Logging

1. In PAC Manager, click the Open button El (or in the menu bar, click File > Open).

2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to
open it.

=8| PAC Manager - Main_Process - O *
File Edit Tools View Help

Dles|d| X|we B g el
s E=R =

-1 Main_Process

=M |/ Units

-2 Line,_1

-2 Preprocess

Ready
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3. Inthe configuration tree, right-click the name of the 1/0 unit on which you want to set up data
logging and choose Configure from the pop-up menu.

= Configure /0 Units *

Mame | Type | Port | Address | Watchdog | Description Add... |
Line_1 SMAP-PAC... Ethernet 10,192,55... Disabled

Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify... |

Delete |

Import/Copy... |

1/0 Paints... |
PID Laops... |
Modules b |
Events  * |
ScratchPad  * |
Communications >| Others
__ others—— button

Close I Help |

4. (lickthe Others button and choose Data Logging from the pop-up menu.

@ Configure Data Logging ¥
—Log Point
Mumber: I[J vI [ Used
Since emails
Address | Description | value | include values
EMAL B from all
0xFFFF F300 0700 E-mail Enabled for all data logging Mo -
OxFFFF F300 0704  Mumber of Datalog entries per E-mail 0 memory map
TRIGGER addressessetup
OxFFFF F300 0000 Trigger OM Ox 00000000 00000000 P
OxFFFF F300 0003 Trigger OFF Ox 00000000 00000000 for d,ata.logg.mg'
LOGGING entries in this
0xFFFF F300 0010 Address of value to log 0x FOADDDOD section app|y o
0xFFFF F300 0014 Data Format Float (0x66) | Id | .
OxFFFF FOAD D000 Current Value N/A all data logging
0xFFFF F300 0018 Logging interval in miliseconds (0 = log once) 5000 points.

OK I Cancel | L\\S

5. Choose the lowest empty Log Point number from the drop-down list and click to put a check
mark in the Used box.

NOTE: To reduce scanning time, the I/O unit stops scanning log points when it reaches an unused data
logging number. Make sure you use these numbers in order, starting with the lowest.

6. (Not applicable to SB brains) To have the data log emailed, click the Value column cell and
enable email. Also enter the number of data entries in the log you want each email message to
contain.
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A maximum of 140 log entries can go in each email. Remember that email applies to all points
that are logged, since all the data goes into one file.

7. IntheValue column, click the cell and then enter the Scratch Pad On mask and Off mask to
trigger this data log point. Also enter the memory map address of the data you want to log and
choose the format of data in that address. Finally, enter how often data should be logged for
this address, in milliseconds (to log data just once, enter 0).

8. When all values are correct, click OK. Repeat from step 5 for additional log points.

9. Remember to also configure email to indicate where the data log should be sent. See
page 112.

10. Configure other optional functions, or return to the PAC Manager main window and click the
Save button ﬂ to save the configuration file.

IMPORTANT: If you have changed the data logging interval, you must save the configuration file to
flash memory and restart the I/0 unit for the configuration to take effect.

When you are ready to upload the configuration file to the I/0 unit, see page 75.

Reading the Data Log

The data log is a single file that records data from all the memory map addresses you have
configured to log data from (see steps starting on page 100). The data from up to 64 memory map
addresses can be logged, and all logged data is recorded in one file. The log file holds up to 300 lines
of data; when it is filled, new entries replace the oldest ones.

This composite log file can be viewed through PAC Manager. (On Ethernet-based /0 units, it can
also be emailed to someone at regular intervals you set.) Each line in the log file consists of the date
and time stamp, the memory map address the data is coming from, the type of data, and the data
itself.

1. Toview logged data, click the Inspect button [E, in the PAC Manager main window.

2. Inthe Device Name field, enter the name of the I/O unit or choose it from the drop-down list.
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Click Data Log and choose Data Logging Samples from the pop-up menu.

25 Inspect 10, Unit

Device Mame: JSE brain ﬂ Options » Status: |Data Logging Sample area last read at 10/03/07 16:48:15

Data Logging Samples
Status Read

Status Wile # Addressz  VVVY-MM-DD HH:MM:53.hh  Src Adde  Type Data A Refresh |
. . 0 F3020000 2006-10-09 14:31:35.04 FOAOD300  Float 28.412872
Print Carifig 1 F3020014 2006-10-09 14:31:39.04  F0AN0300  Float 28.379028
Digial Bark 2 F3020028 2006-10-05 14:31:40.04  FOAOD300  Float 28.345215
3 F302003C 2006-10-09 14:31:41.04  FOAOD300  Float 28.277527
Digital Point 4 F3020050 2006-10-09 14:31:42.04 FOA00300  Float 28.277527
5 F3020064 2006-10-08 14:31:43.05  FOA00300  Float 25. 226748
Analog Bank 6 F3020078 2006-10-09 14:31:44.05 FOAD0300  Float 28,209839
7 F302008C 2006-10-09 14:31:45.05 FOAOD300  Float 28.192932
Gii=og ot & F3020040 2006-10-09 14:31:46.05 FOAOD300  Float 28. 159088
High Density 9 F30200B4 2006-10-09 14:31:47.05  FOAOD300  Float 28, 108307
B 10 F30200C8 2006-10-09 14:31:45.05  FOA00300  Float 28.125244
11 Fa0Z00DC  2006-10-09 14:31:49.05  FOAOO300  Float 28. 074493
Scratch Pad  # 12z F30200F0 2006-10-09 14:31:50.05  FOAO0300  Float 28. 057556
13 F3020104 2006-10-09 14:31:51.05  FOAO0300  Float 25.057556
Datalog  » 14 F3020118 2006-10-09 14:31:52.05 FOAD0300 Float 28.023712
e ; 15 F302012C 2006-10-09 14:31:53.05  FOAO0300  Float 28. 006805
16 F3020140 2006-10-09 14:31:54.05  FOAO0300  Float 27.854523
e 17 F3020154 2006-10-09 14:31:55.05  FOAO0300  Float 27.922211
1 F3020168 2006-10-09 14:31:56.05 FOA00300  Float 28.074493
Communications b 19 F302017C 2006-10-09 14:31:57.05  FOAO0300  Float 28. 142151
Other Y 20 F3020190 2006-10-09 14:31:58.05  FOA00300  Float 28.2098339
21 FaNznlad 2006-10-09 14:31:59.05  FOAO0Z00  Float 28.277527

-

Cloze Help

The log includes the following information:

Column Notes

Address Address of the data item within the data log itself. pata is logged in memory
map addresses F3020000-F302175C. Each data item takes 20 bytes.

YYYY-MM-DD Date the data was logged

HH:MM:SS.hh Time the data was logged

Src Addr Memory map address the data came from

Type Format of the data

Data paFa from the mempry mgp address. NOTE: -nan means “not a number” and
indicates that data is not in the form of an IEEE float.

Clearing All Data from the Log

1. Inthe PAC Manager main window, click the Inspect button [ |
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2. Inthe Device Name field, type the name (or IP address) of the I/O unit or choose it from the
drop-down list. Click Status Write.

= Inspect Opto 22 Device - hed
Device Name: | 10.192.55.67 j Options * Status: | Status Write area last read at 07/05/16 11:15:33
Status Write
Address | Description | Value ~ Refresh |
OxFFFF FO33 0004 Always BootP/[DHCP On Powerup Mo hd
Wirdless LAN OxFFFF FO38 0008 Degrees F/C Degrees F = Apply
OxFFFF FO38 0010 Comm Watchdog Time {msec), 0 = Disable 1]
OxFFFF FO38 0014  TCP Minimum Retransmission Timeout (msec) 250
Point Config 0xFFFF FO38 0018 TCP Initial Retransmission Timeout {msec) 3000
OxFFFF FO38 001C  TCP Retransmission Attempts 5
Digital Bank 0xFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000
. i 0xFFFF FO38 0294 Digital Feature Scan Interval {msec) 1
Digital Point OXFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
Analog Bank OxFFFF FO38 0298 Out Of Range Value (16-Bit) -32768.000
OxFFFF FO38 02B0  Out Of Range Value (32-Bit) -2147433648.000

Analog Point OxFFFF F0O38 0054  Scanner Flaos Ox 00000000

High Density eec oy
Store configuration and IP settings to microSD A Send Command
System v Erase configuration and IP settings from microSC
Erase firmware from microsD
ScratchPad  » Erase strategy from microSD
Other
Switch to loader mode
ooy O Clear Digital Events - Expanded configuration

PID v Clear Digital Events - Old configuration
Clear Alarm Events configuration
Clear PPP configuration
3
ErEE Clear E-mail configuration |}

Clear PID Loops configuration

ME——
ST ETTE | Clear Data Logging samples

Clear Data Logging

—
Send powerup dear ]
Othi 4
Samples command _ ot ]
iz | EE | 7 Auto Refresh | 15000  msec

3. Inthe Operation Commands list, scroll down and click to highlight Clear Data Logging
Samples. Click Send Command.

The data log is cleared and a Success message appears.

Configuring Event Messages

(Not available on SNAP PAC SB brains.) You may need to send a message—via email, data
streaming, SNMP, or a serial module—from an I/0 unit or a controller when a specific event occurs.
For example, you could send a message if a digital point is on, if an analog point reaches a certain
value, if a specific string is received through a serial module, or if a variable contains a specific value.
You can send one type of message or more.

NOTE: You must be using a PAC Control strategy or PAC Manager 9.0 or newer to configure event messages
in this way. In the PAC Control strategy, your flowchart monitors the event and triggers the message using
the command Set I/0 Unit Event Message State. Messages must be configured before they can be used in
PAC Control.

If you are NOT using a PAC Control strategy or are using a PAC Manager version less than 9.0, you cannot
configure event messages in a configuration file. You must configure them using Inspect mode. See
page 157.

Follow these steps to configure up to 128 event messages for use with a PAC Control strategy.
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In PAC Manager, click the Open button El (or in the menu bar, click File > Open).

In the Open Tag Database dialog box, navigate to the configuration file and double-click it to
open it.

=8| PAC Manager - Main_Process — O >
File Edit Tools View Help

| Dl ¥ @)

F-wn
:
F-5n Preprocess

Ready [N

In the configuration tree, right-click the name of the I/0 unit on which you want to set up
event messages and choose Configure from the pop-up menu.

For a SNAP PAC S-series or SoftPAC controller, if it does not already appear in the list, add it as an
/0 unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).

= Configure /0 Units *
Name | Type | Part | Address | watchdog | Description Add... |
Line_1 SNAP-PAC... Ethernet 10.192.55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192.55... Disabled Modify... |

iy Everts
scatchPad ¥ | button
Communications ¥ |

Others 3

Close I Help
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4. C(lick the Events button and choose Event Messages from the pop-up menu.

= Configure Event Messages d

£ | Message Name | Message Text | ~ Maodify... |

e i ]
=

Close I Help |

5. Highlight an empty message number in the list and click Modify.

=5 Add Event Message 20 ¥
A Message Name: I |
B Message Text:
C —————— S5cratch Pad Trigger ON Mask: 0x I 00000000 00000000
Scratch Pad Trigger OFF Mask: 0x I 00000000 00000000
D ———— [ Streaming —SNMP Trap

IDisabIed vI Period (sec): I 0 IDisabIed ;I—— H

E —— E-mai Period (sec): IU
IDisabIed vI Period (sec): I 0
Trap Type: I a

F ——— ~Serial Module

Priority: IHi h vI
IDisabIed vI Serial Ports Mask: Ox I g
G —— MemMap Copy Destination

IDisabled vI MemMap Address: Ox I Period (msec): I a
IF Address: I . . . Part: 2001

0K I Cancel | Help |

6. Complete the fields as follows:
a. Message Name. Enter a name for the message.

b. Message Text. For an email or serial message, and optionally for an SNMP message, enter
the message text. Message text is not sent in the streaming packet.

Message text is limited to 127 characters. You can place data from the I/0 unit's memory
map into the message by using a plugin (see page 108). If you are sending a serial
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message, make sure the text is formatted so the serial device that receives it will
understand it.

¢. Scratch Pad. To trigger bits in the Scratch Pad, enter the On and Off masks to set.

d. Streaming.To send a stream of data as the message, choose Enabled from the drop-down
list. Enter how often in seconds to send the stream (0 sends it only once).

e. E-mail. To send an email message, choose Enabled from the drop-down list. Enter how
often in seconds to send the email (0 sends it only once).

f. Serial Module. To send a message through a serial module to a serial device, choose
Enabled from the drop-down list. Enter a mask representing the modules and ports to
receive the message.

g. Mem Map Copy Configuration. To copy memory map data, see page 122.

h. SNMP Trap. To send an SNMP trap as the message, choose Enabled from the drop-down
list. Enter how often to send the trap (0 sends it only once). Also enter the trap type
(determined by your SNMP management software). If you are using SNMP with outgoing
PPP and want the trap stored in the I/0 unit until the next communication, set Priority to
Low. If you want the I/O unit to immediately dial out and send the trap, set Priority to High.

NOTE: SNMP messages must be acknowledged. If the Period is set to more than zero, the alarm will
continue to be sent until the trap is acknowledged and the Scratch Pad trigger is reset to zero.

In PAC Control, you can use the command Set I/0 Unit Event Message State to build the
acknowledgment into the flowchart logic.

In PAC Manager, you can acknowledge the trap and reset the Scratch Pad by using Inspect > Events
> Event Messages (change State to Acknowledged and reset Scratch Pad bits).

When all fields are correct, click OK.
When you have configured all event messages, click Close.
For each type of message you configure, make sure you also set up basic configuration:

Streaming: page 117 Serial:  page 52
Email: page 112 SNMP:  page 109

Configure other optional functions, or return to the PAC Manager main window and click the

Save button ﬂ to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data
to the I/0 Unit"on page 75.
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Using Plugins

Several plugins are available for use in event messages and memory map copying. The following
table guides you in using them.

To do this Use this plugin In these places See
chlu_de the pattern string from a serial commu- $1 str Serial messages page 104
nication module. — -
Show which serial port sent the pattern string. | $!_port_ Serial messages page 104

Include data from a memory map address.

X = type of data (S=string representation of the
data, D=integer, F=float, P=IP address, B=4
binary bytes)

YYYYYYYY = memory map address (see
examples below)

Event messages page 104

1
SIX_YYYYYYYY_ Memory map copying | page 122

Number emails with a sequence 1D $1_seqid_ Email messages page 104

Turn digital points on or off using a bit mask &#x00000000__ Memory map copying page 122

NOTE: For email messages, message text including plugins must be 127 bytes (characters) or less. The
message length after all plugins have been expanded into their data values must be 255 bytes or less.

Examples: Including Data from Memory Map Addresses

See the appendix in the OptoMMP Protocol Guide for the complete list of memory map addresses.

Here are a couple of examples:

To include the on/off state of a switch on module 0, point 3, you would put this in the message:
$1D_FO8000CO_

To include the temperature of an ICTD input on module 4, point 0, you would use:
$1F_FOA00400_

Sending Binary Data in Event Messages

To send binary data in the text of an event message, begin with &#x and end with _.You can
include any number of ASCII hex digits up to the 127-byte limit for the message field. You can also
include multiple &#x plugins. This plugin is resolved after all other plugins have been resolved, and
only just before sending the contents of the message field out of the specified serial ports.
Examples:

To include an embedded null (one binary character):
&#x00_

To include a number of binary characters:
&#x0a0dCF0034
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Configuring SNMP

(Not available on SB brains) The Simple Network Management Protocol (SNMP) is used to
communicate with an SNMP-based enterprise management system, such as Computer Associates’
Unicenter , Hewlett-Packard's Open\/ievv®, or IBM's Tivoli”, over Ethernet. These enterprise
management systems can manage analog, digital, or serial devices through a SNAP PAC controller
or 1/0 unit just as they manage computer equipment on the Ethernet network.

SNMP Traps

You can set up the controller or /O unit to send messages to the management system in the form of
SNMP traps. The device can send three kinds of traps:

«  Authentication trap—sent when a host requests data that is outside its access permissions

»  Cold start trap—sent whenever the I/0 unit is turned on

«  Exception trap—sent in reaction to an event; an exception trap is a type of event message.

Authentication and cold start traps can be enabled using the steps in this section. To configure
exception traps, see “Configuring Event Messages” on page 104.

SNMP Access Privileges

Community groups control access to SNMP information from the controller or I/0 unit. When you set
up a community group, you determine its privileges to read, write to, and receive traps from the
system.

In order to receive traps, a host must be a registered management host and be part of a community
group that has access privileges for traps. Once a registered management host becomes part of a
community group, that group is no longer available to non-registered hosts. It includes only the
hosts registered to it.

To set up community groups, follow the steps in this section. You can define up to eight community
groups.

Configuring the SNMP Agent

1. In PAC Manager, click the Open button g (orin the menu bar, click File > Open).
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2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it.

=8| PAC Manager - Main_Process - O *
File Edit Tools View Help

| Dies|d| *|%alal B
B

:
E-50

e
Preprocess

Ready [ N4

3. Inthe configuration tree, right-click the name of the I/0O unit on which you want to set up
SNMP and choose Configure from the pop-up menu.

For a SNAP PAC S-series or SoftPAC controller, if it does not already appear in the list, add it as an
/0 unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).

= Configure /0 Units *
Name | Type | Part | Address | watchdog | Description Add... |
Line_1 SNAP-PAC... Ethernet 10.192.55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192.55... Disabled Modify... |

Events >|
Scratch Pad ’l
Communications H—— Communications

Others  » button

Close I Help
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4. Make sure the correct I/0 unit is highlighted
choose SNMP from the pop-up menu.

in the list. Click the Communications button and

== Configure SMMP Agent ¥
System Traps
A SysMame: | Version: m —F
B SysLocation: | Destination 162 — G
I Authentication Trap
C SysContact: | [ Cold Start Trap ]7 H

D _ Community Groups

% | string

Read Write | Trap |

Ll R O

E — Management Hosts

=
#

Community String Host IP Address

]

0

LI fd

Cancel | Help

5. Complete the fields as follows:

SysName. Enter the name assigned to the I/O unit as a managed node within the SNMP

a.
management system.

b. SysLocation. Enter the physical location of the I/0 unit.

c. SysContact. Enter the ID of the contact person for the I/0 unit.

d. Community Groups. To set up the Community Groups you need, highlight a line in the
list. Click the String cell within the line and type the name of the group. Then click in the
Read, Write, and Trap cells and choose Yes or No from the drop-down list to indicate
whether that group has privileges to read, write, and receive traps.

e. Management Hosts. To set up Management Hosts, highlight a line in the list. Start with
hosts on the local network first, because the system sends messages to hosts in numeric
order. Click the Community String cell and enter the name of the community group the
host belongs to. Click the Host IP Address cell and enter its IP address, including the dots
(for example, 10.192.55.60).

f. Version. From the drop-down list, choose the version of SNMP you are using.

g. Destination Port. 162 is the default port for SNMP traps. If you know that your application
will use a different port, enter the number of that port here.

h.

Authentication/Cold Start Trap. To enable authentication or cold start traps, click the
box to check it.

When all fields are correct, click OK.

IMPORTANT: For the configuration to take effect, you must upload the configuration file to the I/O
unit, save it to flash memory, and restart the I/0 unit.
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7. Configure other optional functions, or return to the PAC Manager main window and click the

Save button g to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data
to the I/0 Unit"on page 75.

Configuring DNS Servers

If you want to use host names in PAC Control comm handles or in SMTP messaging configuration,
use the DNS Resolver to designate one or two DNS servers to resolve host names into IP addresses.
The servers are queried one at a time in the order listed.

1. InInspect mode, click the Communications button and choose DNS Resolver from the pop-up

menu.

| Inspect Opto 22 Device EF =] '@
Device MName: | 10,192.54.110 j Options * Status: |SSI Module area last read at 06/14/12 13:40:24
—DNS Resolver
Status Read
: Address | Description | value | | """" Aefresh
Status Write DSFFFFFBT00T00  Reties 1
- OxFFFF FE10 0104 Timeout 2 Apply
Wireless LAN ¥ DMS Address Servers In Use
OxFFFF FE10 0300 DNS Address Server #0 0.0.0.0

Point Config 0«FFFF F&10 0304 DMS Address Server #1 0000

Digital Bank 2
. - Y A '_"m““lf"‘.m,'wﬂ o

0.0.0.0 indicates that the DNS
server is not being used.

2. Toadd a DNS server address or to change the Retries or Timeout, click the appropriate value in
the Value column.

3.  When you have finished changing values, click Apply.

The values are sent to the controller and stored to flash memory. Then you are prompted to
restart the controller.

4, Restart the controller to use the new configuration.

Configuring Email

(Not available on SB brains) You can send an email message or page someone in response to an
event. Follow the steps in this section to set up email parameters. See “Configuring Event Messages’
on page 104 to set up the message itself.

4

1. In PAC Manager, click the Open button g (orin the menu bar, click File > Open).
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2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to
open it.

5] PAC Manager - Main_Process - O X
File Edit Tools View Help

Des|d| £%a o b e
= = e e

5
-2 Line,_1

-2 Preprocess

Ready [N

3. Inthe configuration tree, right-click the name of the I/0 unit on which you want to set up email
and choose Configure from the pop-up menu.

For a SNAP PAC S-series or SoftPAC controller, if it does not already appear in the list, add it as an
/0 unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1).

= Configure /0 Units *

Name | Type | Part | Address | watchdog | Description Add... |
|Li

SMAP-PAC... Ethernet 10.192.55... Disabled

ne_1
Preprocess  SMAP-PAC... Ethernet 10.192.55... Disabled Modify... |

Events >|
Scratch Pad >|
communications H—— Communications

Others  » button

Close I Help
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4. Make sure the correct I/0 unit is highlighted in the list. Click the Communications button and
choose E-mail from the pop-up menu.

=5 Configure E-mail d
SMTP Server
A IP Address: | . . . Port: | 25
B Timeout {miliseconds): | 30000
E-mail Header
C—— From: |
D To: |
E Subject: |

0K | Cancel | Help

5. Complete the fields as follows:

a.

IP Address. Enter the IP address and port number of the Simple Mail Transfer Protocol
(SMTP) server the I/O unit will use to send email. You should be able to get this information
from your network administrator.
Timeout. Enter the length of time in milliseconds the I/O unit should wait for a response
from the email server. The default is 30,000.
From. Enter a valid email address that will identify the I/O unit to the person who receives
the email.
To. Enter the email address of the person who will receive the email.
Subject. Enter a phrase that will indicate the purpose of the email to the person receiving
it. Note that this subject line applies to all email messages sent by this I/0 unit. Plugins can
be used in this field. For example, if a similar email will be sent at intervals (such as an email
of the data log), you can use the segid plugin to put a sequence number at the end of each
subject line. This plugin is in the format:

$! seqid_
So, for example, if you enter Process Data Log $!_seqid_ in the subject field, the
first email message will have a subject line of Process Data Log 0, the next message
will have a subject line of Process Data Log 1, and so on. For information on other
plugins, see “Using Plugins”on page 108.

6. When all fields are correct, click OK.

IMPORTANT: For the configuration to take effect, you must upload the configuration file to the I/O
unit, save it to flash memory, and restart the /0 unit.

7. Configure other optional functions, or return to the PAC Manager main window and click the

Save button ﬂ to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data
to the I/0 Unit"on page 75.
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Setting Up Initial Values in the Scratch Pad Area

Before you use this section, read “Event/Reaction Concepts”on page 141.
To set initial Scratch Pad values and save them as part of the configuration file, follow these steps.

(To see Scratch Pad values or change them in real time, see “Reading and Writing to the Scratch Pad
Area”on page 200.)

1. In PAC Manager, click the Open button El (or in the menu bar, click File > Open).

2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to
open it.

=8| PAC Manager - Main_Process — O >
File Edit Tools View Help

DlS|d| X |aa B @5 el
= e |

B Main_Process

Sl /0 Units

=
Line_1

HE e
Preprocess

Ready [ N4
3. Ifyouare using a SNAP PAC S-series or SoftPAC controller, configure an I/O unit to represent the

controller for Scratch Pad purposes. Configure this I/O unit as a Generic OptoMMP Device,
using the loopback address (127.0.0.1). (Do not add any points or configure other features.)
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4. Inthe configuration tree, right-click the name of the I/0 unit on which you want to configure
the Scratch Pad and choose Configure from the pop-up menu.

= Configure /0 Units *

Mame | Type | Port | Address | Watchdog | Description Add... |
Line_1 SMAP-PAC... Ethernet 10,192,55... Disabled

Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify... |

Delete |

Import/Copy... |

1/0 Points... |
PID Loops... |
Modules 3 |
Events 3 |
_ saawhpad +—— Scratch Pad
Communications >| button
Others 3 |

Close I Help |

5. Make sure the correct I/0 unit is highlighted in the list. Click the Scratch Pad button and choose
Bits, Integers, Floats, or Strings from the pop-up menu.

Scratch Pad Bits

= Cenfigure Scratch Pad Bits pd
[ Used

Address | Description | Value |
DIRECT ACCESS

0xFFFF FODE Q000 Scratch Pad Bits Ox Q0000000 Q0000000
MOMO ACCESS

0xFFFF FODE 0400 0N Mask Ox Q0000000 Q0000000

0xFFFF FODE 0403 OFF Mask Ox Q0000000 Q0000000

1. (lickto puta check mark in the Used box.

2. (lick the cell in the Value column to set initial values for either the bits in the Direct Access area
or the MOMO masks in the MOMO Access area.

3. (lickOK.
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Scratch Pad Integers, Floats, or Strings

The Configure Scratch Pad Floats dialog box is shown as an example. The dialog boxes for strings,
32-bit integers, and 64-bit integers are similar.

s

#=#| Configure Scratch Pad Floats

Used | Address | Value | ~ Select Al
o OxFFFFFODS 2000 @

O OxFFFF FODA 2004 Unselect All
Oz 0xFFFF FODS 2008
Os OxFFFF FODA 200C Clear Al
4 0xFFFF FODS 2010
Os OxFFFF FODA 2014
Os 0xFFFF FODS 20183
Oz OxFFFF FODA 201C
s OxFFFF FODE 2020
(] OxFFFF FODA 2024
[ 1w  oxFFFF FODE 2028
[] 11 OxFFFF FODS 202C
[112  0xFFFF FODE 2030
[0 13  OxFFFFFODS 2034
[ 14  oxFFFFFODE 2038
[] 15  0xFFFF FODS 203C
[ 1  0xFFFF FODE 2040

oK | Cancel |

o o o o o o o oo oo oo o oo

1. Foreach integer you want to use, click to put a check mark in its box in the Used column. Click
the cell in the Value column and enter the initial value.

2. Repeat for each integer. When all integers have been set, click OK.

Configuring Streaming

(Not available on SB brains) Most Ethernet communication involves the two-step process of request
and response. A faster way of getting information from the I/O unit, however, is by streaming data.
Streaming does not use TCP/IP; it uses the User Datagram Protocol (UDP/IP) instead.

NOTE: Because Modbus/TCP runs on TCR not UDF, streaming data via Modbus/TCP is not possible.
However, you can stream to a non-Modbus host at the same time you are using the Modbus/TCP protocol
for another purpose.

Streaming is a fast way to get continuous data from the I/0 unit and is ideal for data acquisition
applications. When it streams, the system sends data at regular intervals to specified IP addresses.
You set up the interval, the IP addresses to receive the data, and (optionally) the port number. The
system sends the data at the specified interval. The communication is one-way; the system does not
wait for a response.

CAUTION: If you stream to multiple IP addresses, and one or more of the streaming targets is either offline
or not running the application that receives the stream, delays may occur. If a target is offline, the I/0
system will stop streaming while it tries to resolve the IP address. If the application is not running on the
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computer that receives the stream, the computer will send the I/0 system an error message; if the stream
occurs frequently, the additional error messages can slow down the network.

Streaming involves two steps: setting up parameters on the I/0 unit for streaming, and receiving
data in your application. Follow the steps in this section to set up the parameters. For information on
receiving data in your application, see Opto 22 form 1465, the OptoMMP Protocol Guide.

1. In PAC Manager, click the Open button El (or in the menu bar, click File > Open).

2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to
open it.

=8| PAC Manager - Main_Process — O >
File Edit Tools View Help

D|es(a| #[%ln B B ol
© oo
B Main_Process

=M@Y /O Units

=
Line_1

e
Preprocess

Ready [ N4

3. Inthe configuration tree, right-click the name of the I/O unit on which you want to set up
streaming and choose Configure from the pop-up menu.

= Configure /0 Units *
Name | Type | Part | Address | watchdog | Description Add... |
Line_1 SNAP-PAC... Ethernet 10.192.55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192.55... Disabled Modify... |

Events >|
Scratch Pad >|
communications +—— Communications

Others  » button
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4. Make sure the correct I/0 unit is highlighted in the list. Click the Communications button and
choose Streaming from the pop-up menu.

=5 Configure Streaming ¥
A Enable Streaming: _ - Target Device Information
B Port: 5001 +—E
Enable If0 Mirroring:  |Mo -
Stream Target #1: . . . —  F
Source Memory Map Information Stream Target #2: l—
C Interval (miliseconds): | 1000 Stream Target #3: . . .
Stream Target #4: l—
D —— |  UseDefault Streaming Area

Stream Target #5: . . .
" Specify Streaming Area
Ii Stream Target #6: . . .
Iji Stream Target #7: . . .
|
Stream Target #8: . . .

0K | Cancel | Help |

5. Complete the fields as follows:

a.
b.

f.

Enable Streaming. To enable streaming, choose Yes from the drop-down list.

Enable I/0 Mirroring. |/0O mirroring is a separate function. It's generally not a good idea to
use both streaming and mirroring on the same I/0 unit. See “Mirroring I/0 Point Data”on
page 120 for more information.

Interval. Enter how often in milliseconds you want the 1/0 unit to send the streamed data.
If you are configuring streaming to use only as an event message, set the streaming
interval to 0. Zero means that the stream will be sent only once.

Use Default Streaming Area. To stream all addresses in the Streaming section of the |/O
unit's memory map, click Use Default Streaming Area. See the memory map appendix in
Opto 22 form 1465, the OptoMMP Protocol Guide, for more information. (Note that the
Streaming section does not include data from high-density digital modules.)

To stream only part of the Streaming section, or to stream a different part of the memory
map, click Specify Streaming Area. Enter the starting address in the Memory Map Address
field (the address must be entered in hex), and enter the size in bytes of the data to stream
in the Size Of Data field.

Port. Enter the port on the computers or devices that receive the streamed data. Your
application must refer to this port number. Use the default of 5001 unless you know it is
already being used for another purpose.

Stream Target. Enter the IP addresses of up to eight devices to receive the streamed data.

6. When all fields are correct, click OK.
7. Configure other optional functions, or return to the PAC Manager main window and click the

Save button ﬂ to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data
to the I/0O Unit"on page 75.
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Mirroring 1/O Point Data

(Not available on SB brains) Mirroring I/O point data is a way to automatically change all the points
on one I/0 unit to match all the points on another I/O unit. A simple example of mirroring is
controlling whether lights in one facility are on or off by having them mirror the on or off status of
switches in another facility.

Mirroring reads the current analog bank values (in Engineering Units) and the current digital bank
status (4-channel digital modules only, not high-density digital modules) of the points on a system
and writes the data to the same point numbers on a second system. The reading and writing occurs
as often as you specify. In our lighting system example, the status of switches in Facility A could be
read every minute and automatically written to the lights in Facility B. When someone turns on the
switches in Facility A, the lights in Facility B would automatically be turned on within a minute.

It's generally not a good idea to use both mirroring and streaming on the same I/0 unit. If you do
use both, streaming target #1 will receive both mirroring and streaming packets; the streaming
packets are ignored, but they unnecessarily add to network traffic.

NOTE: Due to the size limit of the mirroring packet, mirroring for digital points occurs on the first 32 points
of the I/0 unit only (points on the modules in positions 0—7). Mirroring cannot be used with high-density
digital modules.

Follow these steps to set up I/O point data mirroring:

1. In PAC Manager, click the Open button EI (or in the menu bar, click File > Open).

2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to
open it.

=8| PAC Manager - Main_Process — O >
File Edit Tools View Help

T TR VeV )

-1 Main_Process

> & ([

-2 Line,_1

-2 Preprocess

Ready
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3. Inthe configuration tree, right-click the name of the I/0 unit on which you want to set up
mirroring and choose Configure from the pop-up menu.

= Configure /0 Units *

| Mame | Type | Port | Address | Watchdog | Description Add... |
Li

ine_1 SMAP-PAC Ethernet 10,192,55... Disabled

Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify... |
Delete |

Import/Copy... |

Events ’l
ScratchPad |
Communications H—— Communications
Others >| button

Close I Help |

4. Make sure the correct I/0 unit is highlighted in the list. Click the Communications button and
choose Streaming from the pop-up menu.

=5 Configure Streaming >

Enable Streaming: Im 'I  Target Device Information
Port: I 5001 — D
Stream Target #1: I . . . —— E
—Source Memory Map Information ——— Stream Target £2: I . ) .
C —— | Interval (miliseconds): W Stream Target #3: I . . .
Stream Target #4: I . . .
Stream Target #5: I . . .
" Spedfy Streaming Area
Stream Target #6: I—
MemMap Address: Elxl
I—U Stream Target #7: I . . .
Stream Target #3: I—

Enable IO Mirroring:  [Na -

&' Use Default Streaming Area

Size of Data:

oK I Cancel | Help |

5. Complete the fields as follows:

a. Enable Streaming. Streaming is a separate function. It's generally not a good idea to use
both streaming and mirroring on the same I/0 unit. See “Configuring Streaming” on
page 117 for more information.

b. Enable I/0 Mirroring. To enable mirroring, choose Yes from the drop-down list.
c. Interval. Enter how often in milliseconds the data should be mirrored.
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d. Port. Enter the port number. This is the primary port number used to communicate with
the 1/0 unit. The default shown is 5001; enter 2001 instead. (Exception: if you changed the
MMP port for security reasons, use the number you changed it to.)

e. Stream Target. Enter the P address of the I/O unit to receive the mirrored data.

CAUTION: Since all digital and analog points are mirrored, make sure that the points on the second
1/0 unit are configured to accept the values that will be written to them.

6. When all fields are correct, click OK.
7. Configure other optional functions, or return to the PAC Manager main window and click the

Save button ﬂ to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data
to the I/0 Unit"on page 75.

Copying Memory Map Data

(Not available on SB brains) You can use memory map copying to do the following:
+  Copy data on the same I/0O unit

»  Copy data to a memory map location on another unit

Copying Binary or Memory Map Data on the Same I/0 Unit

You can copy data on the same I/O unit, for example to write the value of an analog point to another
analog point.
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1. Follow the steps in “Configuring Event Messages” on page 104 until you reach the Add Event
Message # dialog box.

== Add Event Message #0 ¥

Message Name: | |

Message Text:

Scratch Pad Trigger OM Mask: 0x | 00000000 00000000

Scratch Pad Trigger OFF Mask: 0x | 00000000 00000000

Streaming SMNMP Trap

Disabled - Period (sec): | 0 |Disab|ed j
E-mail Period (sec): |0

Disabled - Period (sec): | 0

Trap Type: a

Serial Module

Priority: High
Disabled - Serial Ports Mask: Ox g

MemMap Copy Destination

Disabled »| MemMap Address: Ox Period (msec): |0
IF Address: . . . Part: 2001

0K | Cancel | Help |

2. Complete the fields as follows:
a. Message Name. Enter a descriptive name for the message.
b. Message Text. In the Message Text section, enter a plugin containing a memory map
address to write from (the source address), in the following format:

$!B_FOB00000 _

LT

$! indicates the start of the plugin format Address  _ indicates the end of the plugin

or a four-byte constant, in this format:
&#x00000001_
Constants must be written in exactly four bytes (8 characters).

While the data format indicator in the plugin can be other types (D=integer, F=float, B is
typically used for memory map copying. The other types copy a string representation of the
data, since plugins are primarily used for generating messages and emails.

¢. MemMap Copy Destination. In the MemMap Copy Destination area, choose Enabled
from the drop-down list. Enter the Memory Map Address you are copying to (the
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destination address) as an eight-digit hex number (the last eight digits of the address, for
example, FOB00040). In the Period field, enter how often to send the data, in milliseconds.

Since the points you are copying to are on the same I/O unit, enter 0.0.0.0 for the IP
Address, and ignore the TCP port field.

3. When all fields are correct, click OK.
4. Configure other optional functions, or return to the PAC Manager main window and click the

Save button g to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data
to the I/0 Unit"on page 75.

Copying Binary or Memory Map Data to a Different I/0 Unit

You can also copy data to an address on a different system. Configure the event message in the
source system (the one you are copying from), but make sure that any points you are affecting on
the destination system are configured to accept the data.

1. Follow the steps in “Configuring Event Messages” on page 104 until you reach the Add Event
Message # dialog box.

=5 Add Event Message #0 X
A Message Mame: ||
B Message Text:
Scratch Pad Trigger ON Mask: 0x | 00000000 00000000

Scratch Pad Trigger OFF Mask: 0x | 00000000 00000000

Streaming SMNMP Trap

Disabled - Period (sec): | 0 |Disab|ed j
E-mail Period (sec): |0

Disabled - Period (sec): | 0

Trap Type: a
Serial Module
Priority: High
Disabled - Serial Ports Mask: 0x ty 2

C —  ~MemMap Copy Destination

Disabled »| MemMap Address: 0x Period (msec): |0
IP Address: . . . Port: 2001

0K | Cancel | Help |

2. Complete the fields as follows.
a. Message Name. Enter a descriptive name for the message.
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b. Message Text. In the Message Text section, enter a plugin containing a memory map
address to write from (the source address), in the following format:

$!B_FOB00000 _

LT

$! indicates the start of the plugin fo?nii Address  _ indicates the end of the plugin

or a four-byte constant, in this format:
&#x00000001_
Constants must be written in exactly four bytes (8 characters).

While the data format indicator in the plugin can be other types (D=integer, F=float, B is
typically used for memory map copying. The other types copy a string representation of the
data, since plugins are primarily used for generating messages and emails.

¢. MemMap Copy Destination. In the MemMap Copy Destination area, choose Enabled
from the drop-down list. Enter the Memory Map Address you are copying to (the
destination address) as an eight-digit hex number (the last eight digits of the address, for
example, FOB00040). In the Period field, enter how often to send the data, in milliseconds.

Also enter the IP Address and TCP port for the I/O unit whose point you are copying to (the
destination system). TCP port is usually 2001.

3. When allfields are correct, click OK.
4. Configure other optional functions, or return to the PAC Manager main window and click the

Save button ﬂ to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data
to the I/0 Unit"on page 75.

Configuring Modbus Options

(Not available on SB brains) If you are using Modbus/TCP to communicate with a SNAP PAC device,
see the Modbus/TCP Protocol Guide (form #1678).

Using PAC Manager, you can change the Modbus float format. In addition, if you need to read or
write data in areas of the device’s memory map that are not included in the Modbus memory map
(shown in the protocol guide), you can use PAC Manager to determine the Modbus Unit ID and
Register Address that are equivalent to the memory map address you want to use.

Changing Modbus Float Format

1. In PAC Manager, click the Open button ﬁ (orin the menu bar, click File > Open).
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2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to
open it.

5] PAC Manager - Main_Process - O X
File Edit Tools View Help

Dles|d| X|we B g el
= === )

-1 Main_Process

=] /0 Units

-2 Line,_1

-2 Preprocess

Ready [N

3. Inthe configuration tree, right-click the name of the I/O unit on which you want to change
Modbus float format and choose Configure from the pop-up menu.
For a SNAP PAC S-series or SoftPAC controller, if it does not already appear in the list, add it as an
/0 unit of the type Generic OptoMMP Device with the loopback address (127.0.0.1). (Do not
add any points.)

= Configure /0 Units *

Name | Type | Part | Address | watchdog | Description Add... |
||_|

ine_1 SNAP-PAC... Ethernet 10.192.55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192.55... Disabled Modify... |

Events >|
Scratch Pad ’l
communications +{——— Communications

Others  » button

Close I Help
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4. C(lick the Communications button and choose Modbus from the pop-up menu.

=5 Configure Modbus *
[ Used
Address Description | Value |
MODBUS
0xFFFF FO39 0000 Modbus 32-bit Float Format Big Endian |

OK | Cancel | Advanced

5. (lickto place a check mark in the Used box. In the Value column, click the value shown for float

format. Choose the format you want from the drop-down list.

NOTE: Word swapped is still Big Endian, but places the most significant bit in the most significant
register.

6. When the value you want is shown, click OK.
7. Configure other optional functions, or return to the PAC Manager main window and click the

Save button g to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data
to the I/0 Unit"on page 75.

Determining Modbus Unit ID and Register Address

If you need to read or write data to the device's memory map in areas not included in the Modbus
memory map (see Opto 22 form 1678, the Modbus/TCP Protocol Guide), you can use PAC Manager to
convert memory map addresses to Modbus Unit ID and Register Addresses, or vice versa.

1.

Determine the device’s memory map address (or the Modbus Unit ID and Register Address)
you want to convert.

To find out the memory map address, you can use the memory map appendix in the OptoMMP
Protocol Guide or copy and paste the address from the Inspect dialog box in PAC Manager.

In the PAC Manager main window, with a configuration file open, right-click an /0 unit and
choose Configure from the pop-up menu.

In the Configure /0 Units dialog box, click the Communications button and choose Modbus
from the pop-up menu.

=5 Configure Modbus *
[ Used
Address Description | Value |
MODBUS
0xFFFF FO39 0000 Modbus 32-bit Float Format Big Endian |

OK | Cancel | Advanced
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4. C(lick the Advanced button to see the rest of the dialog box.

= Configure Modbus

*
™ Used
Address | Description | Value |
MODBUS
OxFFFF FO39 0000 Modbus 32-bit Float Format Big Endian =1

r Address Conversion

Opto 22 Memory Map Address (Valid range FOO0 0000 to F1EB FFFE)
To convert to Modbus address

Forexample: FoD&8 1000

|'||1|‘||'||0|0|D|0 ‘l]‘llﬂll 110|010 010|oll 0]0|0ln 010|oln 0]0|0E|
8 bits 16 bits
011011000 000100000000000

5

Convert to decimal Convert to decimal
108
Add2  +2
Medbus: UnitlD 110 Register Address 2048
For applications that use Register Number
instead of Register Address, convert
the address to a Register Number: Add1  +1
Medbus: UnitlD 110 Register Number 2049
N Modbus Regi start at 1, but the ¢ ponding Regi: Add
startat 0. For e, Register Number 2049 is at Register Address 2048.

Register

ModbusUnitm: |
MemMap Address: Ox 4|
<Dl —

x| o |

5. Toconvertan I/O unit memory map address to a Modbus Unit ID and Register Address, type
the last eight digits of the I/O unit's memory map address in the MemMap Address field.

Make sure there are no spaces in the address (for example, type F0300020).
6. Click the right-arrow button I_}l
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The equivalent Modbus address appears. Note that the Modbus numbers are decimal.

= Configure Modbus *
[~ Used
Address Description Value |
MODEBUS
OxFFFF FO39 0000 Modbus 32-bit Float Format Big Endian =1

Address Conversion

Opto 22 Memory Map Address (Valid range FOO0 0000 to F1EB FFFE)
To convert to Modbus address

Forexample: FoD&8 1000

|'||1|‘||'||l]|0|0|0 1|‘I|D|l ‘l|0|0|0 0|0|0|l 0|0|0|0 0|0|0|0 0|0|0|E|
8 bits 16 bits
011011000 000100000000000

Convert to decimal Convert to decimal
108
Add2  +2
Medbus: UnitlD 110 Register Address 2048

For applications that use Register Number
instead of Register Address, convert

the address to a Register Number: Add1  +1 Me m Ory ma p

address (in hex)

Medbus: UnitlD 110 Register Number 2049

Modbus Register Numbers start at 1, but the ¢
start at 0. For example, Register Number 2049 is at

Equivalent Modbus
address (decimal)

Modbus UnitID: |5
4/
Register 45554

oK | Cancel | Basic

@aml\‘lap Address: Ox | FOO753E4

7. To convert from Modbus to a memory map address, type the Unit ID and Register Address and
click the left-arrow button.

The equivalent memory map address appears.

Setting Up System Date and Time

SNAP PAC devices have a built-in clock. The clock is set at the factory before the device is shipped to
you. If necessary, you can set the date and time on an I/0 unit by following these steps. (For a SNAP
PAC S-series controller, see “Reading System Date and Time” on page 200.)

NOTE: If you are using PAC Control and want to synchronize the /O unit's time with your computer’s time,

don’t use these steps; instead, follow instructions in Opto 22 form 1700, the PAC Control User's Guide.

1. In PAC Manager, click the Open button g (orin the menu bar, click File > Open).
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2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to
open it.

5] PAC Manager - Main_Process - O X
File Edit Tools View Help

Des|d| £%a o b e
| = e e

=R

-2 Preprocess

Ready [N

3. Inthe configuration tree, right-click the name of the I/O unit on which you want to set the time
and date and choose Configure from the pop-up menu.

= Configure /0 Units *
Name | Type | Part | Address | watchdog | Description Add... |
Line_1 SNAP-PAC... Ethernet 10.192.55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192.55... Disabled Modify... |

Events 3 |

(o= 7

Communications ¥ | Others
Others j— button

Close I Help
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4. C(lick the Others button and choose Date and Time from the pop-up menu.

#=#| Configure Date And Time bt
[~ Used

Address Description | Value
TIME

0xFFFF FO35 0000 Hours 03

0xFFFF FO35 0000 Minutes o

0xFFFF FO35 0000 Seconds o

0xFFFF FO35 0000 Hundredths of a Second i}
DATE

0xFFFF FO35 0000 Maonth 01

0xFFFF FO35 0000 Day 01

0xFFFF FO35 0000 Year 2003

oK | Cancel |

5. (lickto put a check mark in the Used box. Enter the correct time and date values in the Value
column. Click OK.

6. Configure other optional functions, or return to the PAC Manager main window and click the

Save button @ to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data
to the I/0 Unit"on page 75.

Configuring Direct Communication to Serial Devices

Applies to SNAP PAC controllers only.

Serial connectors are located on the top of SNAP PAC controllers. For the type, number, and
function of serial ports on each device, see the device’s user guide. Depending on the device, these
ports may be used for several purposes:

«  Maintenance, such as loading new firmware (see page 221).
+  Point-to-Point Protocol (PPP) communication via modem (see page 137).
»  Connection to serial I/0 units (PAC-S only).

«  Sending or receiving data directly from a serial device, such as an RFID or barcode reader, a
weigh scale, or any intelligent device with a serial port. For this use, communication occurs
through PAC Control communication handles. (For more information, see “Communication
Commands"in Chapter 10 ofOpto 22 form 1700, the PAC Control User’s Guide.)

NOTE: This section shows you how to configure the controller to talk serially with devices directly connected
to it. Serial devices attached to an I/0 unit through serial communication modules on the rack are
configured differently. See page 52.

Follow steps in the next section for on-the-rack controllers; see page 133 for standalone controllers.
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Configuring Serial Ports on an On-the-Rack Controller
Use these steps for SNAP PAC R-series.

1. In PAC Manager, click the Open button g (or in the menu bar, click File > Open).

2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to
open it.

3. Inthe configuration tree, right-click the name of the I/0 unit on which you want to configure
direct serial communications and choose Configure from the pop-up menu.

= Configure /0 Units X
Mame Type Port Address Watchdog Description Add...
Line_1 SMAP-PAC... Ethernet 10,192.55... Disabled

Preprocess  SNAP-PAC... Ethernet 10.192.55... Disabled Modify. ..
Delete

Import/Copy...

Events 3
ScratchPad
communications H—— Communications
Others  » button

Close | Help |

4. C(lick the Communications button and choose Communication Port Control from the pop-up
menu.

-
@ Configure Communicatien Pert Contrel ¥
[ Used
Address Description | Value |
COMMUNICATION PORT O
0xFFFF FO31 0400 Control Function For Communication Port 0 FFPP =l
0xFFFF FO31 0404  Logging For Communication Port 0 Disabled =l
0xFFFF FO31 1100 Mode For Communication Port 0 R5232 =l
COMMUNICATION PORT 1
0xFFFF FO31 0408 Control Function For Communication Port 1 Mone j
0xFFFF FO31040C  Logging For Communication Port 1 Disabled =l
0xFFFF FO31 1104  Mode For Communication Port 1 R5232 =1
COMMUNICATION PORT 2
0xFFFF FO31 0410 Control Function For Communication Port 2 Mone j

- T Sy

Because a configuration file could be built for any controller or brain PAC Manager supports,
this window shows the possible ports and settings for all devices. Only a few apply to R-series
PACs.
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5. [Ifthereis no check markin the Used box, click the box to place a check mark there.
Ports shown in the window are as follows:

—  Port 0 =RS-232 connector on controller’s top

— Ports 1, 2,and 3 = Not used on the R-series controller
6. If Port Ois used for modem communication, do the following:
a. Inthe Value field for Control Function for Communication Port 0, choose PPP from the
drop-down list.
b. Inthe Logging for Communication Port field, leave logging Disabled unless you are
troubleshooting serial communication (see page 252).

NOTE: Logging adds significant overhead to serial communication, do not enable it unless you
need to.
7. |If Port Ois directly connected to a serial device, do the following:
a. Inthe Control Function for Communication Port O value field, choose None from the
drop-down list.
b. Inthe Logging for Communication Port field, leave the value field set to Disabled.

Although you can use this log file for troubleshooting, when the control function is set to
None, the log file logs only characters received by the PAC Control strategy. It is better to
have PAC Control log the data rather than using the log file. The log file adds significant
overhead to communication. (For more about the log file, see page 252.)

c. Inthe Mode for Communication Port O field, leave the value set to RS232. (The R-series
controller does not support RS-485.)

8. When you have finished configuring the port, click OK.
9. Configure other optional functions, or return to the PAC Manager main window and click the

Save button ﬂ to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data
to the I/0 Unit"on page 75.

Configuring Serial Ports on a Standalone Controller
These steps apply to SNAP PAC S-series controllers.

1. Inthe PAC Manager main window, click the Inspect button @
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The Inspect window opens.

é Inspect Opto 22 Device

Device Name: | 10.152.50.21 Ll Options ¥ Status: | Status Read area last read at 07/05/16 12:03:48
Status Read
Status Read |
RoDRESS DESCRIPTION VALUE - Refresh |

Status Write |

OxFFFF FO30 0004
0xFFFF FO30 0008

Wireless LAN  » |

Paint Config |
Digital Bank |
Digital Point |
Analog Bank |
Analog Point |
High Density |
System 3 |
Scratch Pad >|
Data Log >|
PID 3
Events 3 |
Communications » |
Other 3 |

OXFFFF F030 0018
0xFFFF FO30 0000
OxFFFF F030 0230
OxFFFF F030 001C
OXFFFF FO030 00RO
0xFFFF FO30 00BO

0xFFFF F030 0020
OXFFFF F030 0080
OxFFFF FO30 0024
OxFFFF F030 0025
OxFFFF F030 0026
OXFFFF F030 024C
0xFFFF FO30 0028

0xFFFF FO30 002E
0xFFFF FO30 0034
0xFFFF FO30 0038
O0xFFFF FO30 003C
0xFFFF FO30 0040

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year
I/0 Coprocessor Firmware Version
Installed Ram

ETHERNET 1 Interface
MAC Rddress
IF RAddress
Subnet Mask
Gateway
DNS

ETHERNET 2 Interface

POC Beceived (0)
0

Ré.la

1

Flash Memory
R9.5a
07/05/2016
07:58:52

0x0000007C
SNAP-PRC-51

R0.0&
33554432

00-A0-3D-00-D8-0B
10.192.50.21
255.255.192.0
10.192.51.50
10.192.460.91

Close I

Help |

[~ Auto Refresh |15000 msec

If you have used the Inspect window before, the last device name you used is shown and
current Status Read information appears in the window. The most recently used device names
are available in the drop-down list. If you have not used the Inspect window before, the

window will not show any data.

PAC Manager User's Guide



2.

3.

CHAPTER 3: CONFIGURING OPTIONAL FUNCTIONS

In the Device Name field, type the name (or IP address) of the controller (or choose it from the
drop-down list). Click Communications and choose Communication Port Control from the
submenu.

#=#| Inspect Opto 22 Device

— X

Device Name: | 10.192.50.21 j Options ¥ Status: | Comm Port Control area last read at 07/05/16 12:04:58

Communication Port Control
Status Read

Status Write
Wireless LAN - »

Paint Config
Digital Bank
Digital Point
Analog Bank
Analog Point
High Density
System 3
ScratchPad  »
Data Log 3

Events »
Communications »
Other 3

Close |

Address ‘ Description

| Value

Refresh |

PID »

Help

COMMUNICATION PORT O
0xFFFF FO31 0400 Control Function For Communication Port 0
0xFFFF FO31 0404 Logging For Communication Part O
COMMUNICATION PORT 1
0xFFFF FO31 0408 Control Function For Communication Port 1
0xFFFF FO31 040C Logging For Communication Part 1
COMMUNICATION PORT 2
0xFFFF FO31 0410 Control Function For Communication Port 2
0xFFFF FO31 0414 Logging For Communication Port 2

PPP
Disabled

Mone
Digabled

MNone
Disabled

- Apply

Bl EE EE

™ Auto Refresh | 15000  msec

The Inspect window shows the ports and features that apply to the controller you're
inspecting. The example above is for a SNAP-PAC-S2, which has four ports. The following table

shows how ports are labeled on the top covers of ST and 52 controllers.

Port | = SNAP-PAC-S1 | = SNAP-PAC-S2
0 SO Serial 0
1 S1 Serial 1
2 S2 Serial 2
3 - Serial 3

If you are using a modem, do the following:

a. In the Control Function for Communication Port field for the port the modem is attached
to, choose PPP from the drop-down list. Note that the lowest numbered port with PPP
function configured is the only port that can be used for PPP. See page 137 for more on
setting up PPP.

b. Inthe Logging for Communication Port field, leave logging Disabled unless you are
troubleshooting serial communication (see page 252). Logging adds significant overhead

to serial communication; do not enable it unless you need to.

If you are using ports on a PAC-S2 to connect to serial I/0 units, do the following for each port:

a. Inthe Control Function for Communication Port value field, choose None from the
drop-down list.

b. Inthe Mode for Communication value field, choose the connection type, termination, and
bias from the drop-down list.
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¢. Inthe Logging for Communication Port field, leave the value field set to Disabled.

Although you can use this log file for troubleshooting, when the control function is set to
None, the log file logs only characters received by the PAC Control strategy. It is better to
have PAC Control log the data rather than using the log file. The log file adds significant
overhead to communication. (For more about the log file, see page 252.)

5. Foreach port that is directly connected to a serial device, do the following:

a. Inthe Control Function for Communication Port value field, choose None from the
drop-down list.

b. Inthe Logging for Communication Port field, leave the value field set to Disabled.
Although you can use this log file for troubleshooting, when the control function is set to
None, the log file logs only characters received by the PAC Control strategy. It is better to
have PAC Control log the data rather than using the log file. The log file adds significant
overhead to communication. (See page 252.)

C. (PAC-S2 only) In the Mode for Communication value field, choose the connection type,
termination, and bias from the drop-down list.

6. When you have finished configuring the ports, click Apply.

Configuration data is sent to the controller.

7. C(lick the Status Write button on the left side of the Inspect window. In the Operation
Command list, highlight Store configuration to flash.

= Inspect Opto 22 Device — *
Device Name: | 10.192.50.21 j Options ¥ Status: | Status Write area last read at 07/05/16 12:06:40
Status Write
Status Read
Status Wiite Address | Description | Value ~ Refresh
0xFFFF FO38 0004  Always BootP [DHCF On Powerup Mo Jhd|
. 0xFFFF FO38 0008 DegreesF/C Degrees C =1 Apply
Wireless LAN OXFFFF FO38 0010 Comm Watchdog Time (msec), 0 = Disable 0
0xFFFF FO33 0014 TCP Minimum Retransmission Timeout (msec) 250
Point Config OxFFFF FO38 D018 TCP Initial Retransmission Timeout (msec) 3000
= 0xFFFF FO33 001C TCP Retransmission Attempts 5
Digital Bank. OxFFFF FO38 0020 TCP Idle Session Timeout (msec), O = Disable 240000
= S 0xFFFF FO38 0294 Digital Feature Scan Interval {msec) 1]
Digital Point 0xFFFF FO38 0050 Max Analag and High Density Digital Scan Interval (msec) 0
Analog Bank 0xFFFF FO38 0298 Out Of Range Value (16-Bit) 0.000
g 0xFFFF FO38 02B0  Out Of Range Value (32-Bit) 0.000
Analog Point OxFFFF FO38 0054  Scanner Flaos 0x 00000000 &
High Density Operation
OptoMMP Device ~  Send Command
Restart Device from powerup
System ¥ Store configuration to flash >
Erase configuration from flasl
ZeelEifel O Reset to defaults and Restart Device
» microSD
Ealalug Store configuration and IP settings to microSD
Erase configuration and IP settings from microSC
PID 3 y
Erase firmware from microSD
Events » Erase strategy from microSD
Other
- Switch to loader mode
3
Commnications Clear Digital Events - Expanded configuration
Other ' C!ear D!g\tal Events - OI[:I configuration W
fe= | TES | ™ AutoRefresh | 15000  msec

8. C(lick Send Command.

The port configuration data is stored to flash memory and a Success message appears.
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Configuring PPP

Use this section only if you have SNAP PAC R-series I/O units installed at remote locations or in other
places where an Ethernet network is not available, and you are using modems to communicate
between the device and a computer. You can set up communication so that the device can dial in to
a computer, so that computers can dial into the device, or both.

NOTE: If you are using PPP with a SNAP PAC S-series controller, see instructions in the controller user’s guide.

IMPORTANT: After you have followed the steps in this section to configure PPP on the I/O unit, see the I/0
units user’s guide for information on attaching the modem to the system and setting up Windows dial-up
networking or remote access server on the computer.

Configuring PPP on the I/0O Unit

1. Inthe PAC Manager main window, click the Open button El or choose File > Open.

2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to
open it.

File Edit Tools View Help
EFEELTE
\=
=) MainProcess
- V0 Units
Preprocess
— oM

3. Inthe configuration tree, right-click the name of the I/0O unit on which you want to set up PPP
and choose Configure from the pop-up menu.
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=»| Configure I/O Units

| Address

| Watchdag | De Add..

| Tupe

| Part
... Ethemet

10.192.54.110

Enabled

Modify... |
Delete |

Import/Copy... |

1/0 Paints... |
FID Loops... |
Modules 3 |
Events 3 |
Scratch Pad  » |

4 1

Cloze I |

Help

2
Communications » :l—
Others 3 |

—— Communications
button

4. Make sure the correct I/0 unit is highlighted in the list. Click the Communications button and

choose PPP from the pop-up menu.

-'-_';] Configure PPP
—General PPP — Serial Port
A Local IP Address: .88 . 0 .1 Connection Timeout: I &0
Baud Rate: |19200 VI
Subnet Mask: I . . . Echo Request Period: I 10
B Max Authentication Retries: I 3 Echo Request Retries: I 3 Pz INWIe jv
AModem Strings Data Bits: Is vI
Initizlization: | ATEDO" Mo runs \
D || Stop Bits: |1 vI
Listen: | ATS0=1"M~ J
Hangup: I [T, » X7 T Y R / Flow INone - I
E |
F —Incoming PPP — Outgoing PPP
Incoming Connections: IDisabIed vl Qutgeing Connections: IDisabIed vl Inactivity Timeout: I 30
Set As Default Gateway: INo vl Use Local IP Address: INo vl Max Connect Time: I o]
Inactivity Timeout: I 30 Set As Default Gateway: INo - l Max Dial Retries: I o]
Login: I Login: I Retry Interval: I a
Password: I Password: I Disable Time: I 0
Remote IP Address: | 192 . 166 . 0 . 2 Phone Number: I I~ PPP Link Always Connected
K I Cancel I Help |

5. Complete the fields as follows:
a.

Local IP Address. Enter the Local IP Address for the PPP interface on the I/0 unit. Enter the

local Subnet Mask only if you are using classless IP addressing. If you are not using classless
IP addressing, leave the Subnet Mask at zero, and the I/O unit will calculate the subnet

mask.

IMPORTANT: The network address for the PPP interface must be different from the network ID for the
Ethernet interface. (The network address is obtained by ANDing the IP address and the subnet mask.)
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b. Max Authentication Retries. Enter the maximum number of times a login/password
combination can be retried.

¢. Connection Timeout and Echo Request. Change these values if necessary to establish
and maintain the connection.

d. Modem Initialization String. Change the modem initialization string, listen string, and
hangup string if necessary. Make sure you use the setting to ignore DTR signal in the
modem initialization string:

The default modem initialization string is AT&DO"M~~~~

Consult the command reference that came with your modem to determine the correct

initialization command strings. A sample modem initialization string might look like this:

AT&FMM~~AT&DO&KOMM~~ATEWOMM~~AT&Y O M~~

The &F command sets the modem back to factory defaults. The AM tells the Ethernet I/0

unit to insert a carriage return. The ~ tells it to insert a 500ms pause. The &W0 writes the

current settings to NVRAM profile 0 on the modem. The &Y0 instructs the modem to use

NVRAM profile 0 after resetting.

This initialization string is just a sample; command strings for your modem may differ.

e. Outgoing PPP. If the I/0 unit will send outgoing calls, complete the Outgoing PPP
section:

Choose Enabled from the drop-down list.

In the Use Local IP Address field, choose Yes to have the I/O unit use the Local IP Address

you entered for the PPP link; choose No to have the remote device assign the I/O unitan IP

address for the PPP link. The default is No.

If you want the I/0 unit to use the device the I/O unit s calling as the default gateway for all

communication, choose Yes for Set As Default Gateway. The default is No.

Enter the Login and Password the I/0 unit should use for authentication when it calls the

remote device.

In the Phone number field, enter the number the modem should dial for outgoing calls

from the I/0 unit.

Change the following fields if necessary:

- Inactivity Timeout—If the I/O unit sends no packets and receives no packets for this
number of seconds after the PPP session is negotiated, the modem will hang up. The
default is 30.

- Max Connect Time—The maximum amount of time in seconds an outgoing PPP
connection can stay connected after successful negotiation. Default is zero, which
disables the timer.

—  Max Dial Retries—The number of times the I/0 unit will redial if the first attempt fails.
Default is zero.

- Retry Interval—The number of seconds the I/O unit will wait before trying to redial
after the first attempt fails. Default is zero.

- Disable Time—If the maximum connect time or maximum number of retries has been
reached, the outgoing PPP dialer waits this number of seconds before doing anything.
Default is zero.

- PPP Link Always Connected—If you want outgoing PPP to always be connected, so
there is no need for the 1/0 unit to dial out, check this box.

f. Incoming PPP. If the I/O unit will receive incoming calls via modem, complete the
Incoming PPP section:
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Choose Enabled from the drop-down list so the modem will listen for incoming calls.

If you want the I/0 unit to use the device calling the I/O unit as the default gateway for all
communication, choose Yes for Set As Default Gateway. The default is No.

Change the Inactivity Timeout if necessary. The default is 30.

Enter the Login and Password the I/0O unit should accept for incoming calls.

In the Remote IP Address field, enter the IP address the I/O unit should give to devices that
dial into the I/0 unit and ask for an address. This address must be on the same subnet as
the local IP address.

Enter a modem listen string to make sure the modem automatically answers calls. The
default modem listen string is ATSO=1~M~ , which instructs the modem to answer any
incoming calls on the first ring. Again, refer to your modem’s command reference for the
correct listen string.

6. When all fields are correct, click OK.

IMPORTANT: For the configuration to take effect, you must upload the configuration file to the I/O
unit, save it to flash memory, and restart the I/0 unit.

NOTE: Ifthe serial port you are using for PPP was previously used for a direct connection with a serial
device, you must use PAC Manager’s Inspect window to reset the port configuration from None to PPP
See page 131 for more information.

7. Configure other optional functions, or return to the PAC Manager main window and click the

Save button g to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data
to the I/0 Unit"on page 75.

See Opto 22 form 1460, the SNAP PAC R-Series Controller User’s Guide, for information on attaching
the modem to the system and setting up Windows dial-up networking or remote access server on
the computer.
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4. Setting Up Events and
Reactions

Introduction

Events and reactions are automatic responses to conditions monitored by SNAP PAC1/O units. The
monitored conditions, called events, and the responses to them, called reactions, can be simple or
complex. An example of a simple event/reaction is turning on a fan in response to a rise in
temperature. Complex event/reactions may involve multiple events and multiple reactions, with a
time delay in between. For example, you could set up a temperature limit as an event that triggers a
warning light, and a higher temperature limit as an event that sets off an audible alarm and sends an
email message.

CAUTION: Event/reactions you set up using these instructions in this chapter operate on the I/O side of a
SNAP PAC R-series controller, independently of any PAC Control strategy running on the processor’s control
side. If you are using PAC Control with a SNAP PAC R-series I/O system, do not use this chapter. Instead, use
the flowchart logic in the PAC Control strategy to handle reactions to events. The only reason you might set
up event/reactions that operate independently on the /O side of the controller would be a need for very
fast reactions. If that is the case, be very careful that the event/reactions you set up do not conflict with PAC
Control logic.

The chapter introduces you to the Scratch Pad and other basic event/reaction concepts. It also
shows you how to use PAC Manager to configure the following:

Digital event/reactions see page 145
Alarm event/reactions see page 151
Serial or Wiegand event/reactions see page 154
Event messages see page 157

Event/Reaction Concepts

This section describes using the Scratch Pad to track events and alarms, and types of events, alarms,
and reactions.
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The Scratch Pad

SNAP PAC controllers and brains contain Scratch Pad areas within their memory maps. Scratch Pad
areas can be used for two main purposes:

« asaplace to hold data being transferred from one peer to another on the network
«  asavirtual notebook for keeping track of events and alarms

The Scratch Pad is user-defined, meaning that you define and use its addresses to fit your needs, and
you can redefine them whenever necessary. The Scratch Pad area includes four sections to
accommodate different types of data: bits, strings, floats, and integers.

o The Scratch Pad bits section is a 64-bit mask.

«  The Scratch Pad strings section is a table of 64 elements. Each element can hold 128 characters
or 128 bytes of binary data.

«  The Scratch Pad float section is a table of 10,240 elements; each float is four bytes.
«  The Scratch Pad 32-bit integer section is also a table of 10,240 four-byte elements.
«  The Scratch Pad 64-bit integer section is a table of 1024 eight-byte elements.

NOTE: Scratch Pad float and 32-bit integer tables are not made up of contiguous addresses in the memory
map; each table is in two address sections. You won't notice this if you are using PAC Control Scratch Pad
commands, but if you are addressing these tables in another application, check the memory map
appendix in the OptoMMP Protocol Guide to make sure you have the correct addresses for the table
elements you want.

For more information on using the Scratch Pad for peer-to-peer data transfer, see “I/O Unit—Scratch
Pad Commands”in Chapter 10 of the PAC Control User’s Guide. (You can also use PAC Manager for
one-time reads and writes.) The rest of this chapter shows you how to use the Scratch Pad for
tracking events and alarms.

Using Scratch Pad Bits for Events and Alarms

When Scratch Pad bits are used to track events and alarms, the 64 bits in the mask do not represent
point numbers. Instead, they represent whatever you decide they should be. For example, you
might decide that bit 1 in the Scratch Pad will indicate a temperature level in Vat #12 (if the
temperature reaches 48 °C, bit 1is turned on). Bit 2 might indicate the status of Pump A (if the pump
is off, the bit is off; if the pump is on, the bit is on).

Because you can use Scratch Pad bits to keep track of events and alarms, you can set up reactions
based on a variety of conditions. In the example above, you could set up a reaction on an EB brain
that sends a stream packet if bit 1 is on and bit 2 is off.

Cascading Events, Alarms, and Reactions

Scratch Pad bits are really a way to set up cascading events and reactions (that is, a series of events
and reactions dependent on each other). For example, the first event in the cascade could be the
temperature in Vat #12 reaching 40 degrees, and the reaction to it is setting Scratch Pad bit 1. The
second event in the cascade is that Scratch Pad bit #1 is set, and the reaction to that is some other
action. A cascade of any number of events and reactions can be configured, as needed.
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Types of Events, Alarms, and Reactions

NOTE: SB brains do not support serial events and reactions nor reactions requiring an Ethernet network,
such as sending email.

The event or reaction can consist of one or a combination of the following. The reaction can take
place immediately or after a delay.

Events:

+  On/off state of a digital point on a 4-channel module

«  State of on-latch or off-latch for a digital point on a 4-channel module

«  On/off state of a digital point on an HDD (high-density digital) module

«  State of an on-latch or off-latch fora digital point on an HDD module

«  High or low value of an analog point (in engineering units)

«  Number on a digital counter or high or low number on a quadrature counter
«  Analog point value or quadrature counter that is outside allowable range
«  State of a bit in the Scratch Pad bits area

+  State of a bit in the Scratch Pad integer 64 area

«  Specific string received by a serial module

Reactions:

»  Turn on/off digital point

+  Clear on-latch or off-latch

«  Copy data from one memmap location to another

+ logdata

«  Tumnonoroffa bitin the Scratch Pad bits area

«  Turnonoroffa bitin the Scratch Pad integer 64 area

«  Send a stream packet

«  Send an email message

«  Send a string through a serial module to a serial device

«  Sendan SNMP trap

Note that the memory map section formerly called Timers, which provided digital events with a
delay between an event and the reaction to it, has been expanded in firmware 8.1 to include
additional options such as latches and HDD modules. All new digital events should be configured in
Digital Events - Expanded to take advantage of the new flexibility.

Digital events you already configured still exist in Digital Events - Old. Timers you already configured
still exist in Digital Events - Expanded.
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The following table details steps for configuring events and reactions. See page references for more.
A flowchart following the table summarizes Alarm and Serial event and reaction configuration.

Event Reaction Configuration Steps See
Turn digital point on/off (on Configure Digital Events - Expanded page 145
same /O unit)
Turn digital point on/off (on 1. Configure Digital Events - Expanded—set Scratch Pad bit page 145
different 1/O unit) 2. (Email message only) Configure Email page 112
. . OR (Streaming only) Configure Streaming page 117
If digital point is on/off Log data (SNMP only) Configure SNMP page 109
OR 3. (Except data logging) Configure Event Messages—send
Copy memory map data message or data page 104
OR (Data logging) Configure Data Logging and configure Email page 100
Send message (stream, (optional) page 112
e-mail, serial, or SNMP trap).
Turn digital point on/off (on 1. Configure Alar_m Events (high alarm or low alarm)—set
same |/O unit). ScraFch Pad. b.'t . page 151
2. Configure Digital Events - Expanded—turn on/off point page 145
If analog point value 1. Configure Alarm Events (high alarm or low alarm)—set
(Engineering Units) Turn digital point on/off (on Scrgtch Pad bit ) - page 151
goes above or below a different /0 unit) 2. (Optional for a delay) Conflggre Digital Events - Expanded—
specified value OR use the alarm Scratch Pad bit as the event, set the time delay, | page 145
OR Copy memory map data and s_et a Scratch Pad bit after the del_ay page 112
If digital counter OR 3. (Emall message only) 'Conflgure Emall page 117
reaches a specified Log data (Streaming only) Configure Streaming page 109
value OR (SNMP only) Configure SNMP
4. (Except data logging) Configure Event Messages—send page 104
Send message (stream, . .
email, serial, or SNMP trap). message or data ba_sed on alarm blt_ or delay bit _ page 100
(Data logging) Configure Data Logging based on alarm bit or page 112
delay bit and configure Email (optional)
. . 1. Configure Alarm Events (deviation alarm)—set Scratch Pad bit
Turn digital point on/off (on ) - -
same 1/O unit) 2. Configure Digital Events - Expanded—turn on/off point page 151
page 145
1. Configure Alarm Events (deviation alarm)—set Scratch Pad bit
If analog point value Turn digital point on/off (on 2. (Optional for a delay) Configure Digital Events - Expanded— page 151
(Engineering Units) or | different I/O unit) set time delay and set a Scratch Pad bit after the delay
quadrature counter OR 3. (Email message only) Configure Email page 145
goes outside an allow- | Copy memory map data (Streaming only) Configure Streaming page 112
able range OR (SNMP only) Configure SNMP page 117
Log data 4. (Except data logging) Configure Event Messages—send page 109
OR message or data immediately or based on delay bit
Send message (stream, (Data logging) Configure Data Logging immediately or based page 104
email, serial, or SNMP trap). on delay bit and configure Email (optional) page 100
page 112
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Event Reaction Configuration Steps See
Turn digital point on/off (on Configure Serial Events—set Scratch Pad bit page 154
same |/O unit) Configure Digital Events - Expanded—turn on/off point page 145
Configure Serial Events—set Scratch Pad bit page 154
(Optional for a delay) Configure Digital Events - Expanded—
set time delay and set a Scratch Pad bit after the delay page 145
Send SNMP trap Configure SNMP page 109
Configure Event Messages—send trap immediately or based page 104
on delay bit
Iifa specific string' is Send one-time email Configure Serial Events—send email page 154
received by a serial Configure Email
module
Turn digital point on/off (on Configure Serial Events—set Scratch Pad bit page 154
different 1/O unit) (Optional for a delay) Configure Digital Events - Expanded—
OR set time delay and set a Scratch Pad bit after the delay page 145
Copy memory map data (Email message only) Configure Email page 112
OR (Streaming only) Configure Streaming page 117
Log data (Except data logging) Configure Event Messages—send
OR message or data immediately or based on delay bit page 104
Send message (stream, (Data logging) Configure Data Logging immediately or based page 100
serial, or multiple emails) on delay bit and configure Email (optional) page 112

The following flowchart summarizes Alarm and Serial event and reaction configuration.

Configure Event Message
or Data Logging.
» Eventis Alarm or Serial
Scratch Pad bit, or delay
Scratch Pad bit.

Configure Alarm Event or
Serial Event details.
Reaction is Scratch Pad bit.

ves | (If used) Configure
» Email, Streaming,
or SNMP.

“Should reaction ™
“~occur immediately?

A
No
A 4

Configure Digital Events — Expanded.
Trigger is Alarm or Serial Scratch Pad bit.
Set delay time.

Set a new Scratch Pad bit as the reaction.

Configuring Digital Events and Reactions

In a digital event, the I/0 unit monitors one or more inputs, outputs, and Scratch Pad bits for a match
to a specific pattern (the event). When the pattern is matched, the I/0 unit reacts in a predetermined
way. The reaction can turn digital points on or off and can also set bits in the Scratch Pad. You can
configure up to 512 digital events and reactions for SNAP PAC controllers and brains.

Digital event/reactions can be as simple as turning on a light (reaction) when a door opens (event).
They can also be very complex, depending on your needs. For example, suppose you need to
monitor a critical group of switches. If switches 1, 2, and 3 are all off at once, you want to turn on an
emergency light and sound an alarm. You can set up a digital event for the state of the three
switches, and a reaction that automatically turns on the emergency light and alarm.

PAC Manager User’s Guide



CONFIGURING DIGITAL EVENTS AND REACTIONS

In addition to digital states, events can include alarm or other conditions noted in the Scratch Pad.
For instance, to regulate the temperature of a room, you might set up an alarm event that turns on a
bit in the Scratch Pad when the temperature reaches 78° F (see “Configuring Alarms and Reactions”
on page 151). Then you would set up a digital event/reaction to turn on a fan when that Scratch Pad
bit is on.

NOTE: If you want to turn on or off digital points that are located on a different /O unit, you can do so by
using the memory map copying feature. See “Copying Memory Map Data” on page 122 for details.

Digital Point and Scratch Pad Masks

Both events and reactions are in the form of a mask. Digital point masks represent 64 possible digital
states; you choose whether these are point states or on-latch or off-latch states. Scratch Pad masks
represent whatever you decide each bit should be.

For each digital event/reaction, you set up two to eight masks: up to four for the event and up to
four for the reaction.

For the event: The table below shows possible triggers for the event, in the form of four masks.
You can configure only Trigger #1, only Trigger #2, or both. If you configure both, both must be true
for the event to be true. Choose the trigger(s) you want to use; then set up the masks.

Digital Point State Digital Point State Digital Point State Digital Point State

Digital Point On Latch
Digital Point Off Latch
HDD Point State

HDD Point On Latch
HDD Point Off Latch
Scratch Pad Bits
Scratch Pad Integer 64

Digital Point On Latch
Digital Point Off Latch
HDD Point State

HDD Point On Latch
HDD Point Off Latch
Scratch Pad Bits
Scratch Pad Integer 64

Digital Point On Latch
Digital Point Off Latch
HDD Point State

HDD Point On Latch
HDD Point Off Latch
Scratch Pad Bits
Scratch Pad Integer 64

Digital Point On Latch
Digital Point Off Latch
HDD Point State

HDD Point On Latch
HDD Point Off Latch
Scratch Pad Bits
Scratch Pad Integer 64

For the reaction: This table shows possible reactions, again in the form of four masks. You can
configure only Reaction #1, only Reaction #2, or both. When the event occurs, all configured
reactions will take place. Choose the reaction(s) you want to occur, and then set up the masks.

Digital Point States

Clear Digital Point On/Off Latches

HDD Point States

Clear HDD Point On/Off Latches

Scratch Pad Bits
Scratch Pad Integer 64

Digital Point States

Clear Digital Point On/Off Latches
HDD Point States

Clear HDD Point On/Off Latches
Scratch Pad Bits

Scratch Pad Integer 64

Digital Point States

Clear Digital Point On/Off Latches
HDD Point States

Clear HDD Point On/Off Latches
Scratch Pad Bits

Scratch Pad Integer 64

Digital Point States

Clear Digital Point On/Off Latches
HDD Point States

Clear HDD Point On/Off Latches
Scratch Pad Bits

Scratch Pad Integer 64

NOTE: Trigger #1 does NOT control Reaction #1, Trigger #2 does not control Reaction #2. Instead, all the
masks work as a group. All the event masks must be a match for the I/O unit to set the reaction(s), and if
the event occurs, any and all reactions will be set. If it doesn’t matter whether a specific point or bit is on or
off, leave its value at zero in both the on mask and the off mask.
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When you configure events and reactions, the masks are in hex notation. If you are setting up a
Digital On mask for points 0—7, for example, you might do so as follows:

Module position: 1 0
Point number:| 3 2 1 0 3 2 1 0
State:) On| -- | On | On | -- -- - | On
Binary notation:| 1 0 1 1 0 0 0 1
Hex notation: B 1

For more information on mask data format, see page 211. See the following pages for a step-by-step
example to set up event/reactions.

You can also configure the I/0 unit to send a message as a reaction to digital events. See page 104.

How Digital Events Trigger Reactions

Reactions to digital events can be level-triggered (occur continuously) or edge-triggered (occur
once). The I/0 unit continually checks the digital state to see if it matches the event, and the I/O unit
sends the reaction as soon as the state matches the event. If you configure the reaction to occur
continuously, the 170 unit continues to send the reaction until the state changes. If you configure it
to occur once, the reaction is sent only once.

In either case, however, if the state changes so that it no longer matches the event, the 1/0 unit does
NOT reverse the reaction.

Example: Digital Event/Reaction

For example, suppose you have set up an event/reaction to turn on a light when a door is open. As
soon as the event occurs (the door opens), the I/0 unit sends the reaction (turn on the light).

When the door is shut, the I/0 unit stops turning on the light, but it does NOT turn the light off. To
turn off the light when the door is shut, you need to set up a second event/reaction.

Suppose the input for the door’s status is on point 0 on the module in position 0, and the output for
the light is on point 1 on the module in position 1. Here are the two event/reactions to turn on the
light when the door is open, and turn off the light when the door is shut:

Event #0: IF Mod 0 Pt 0 (Door) is OFF (Open)

Reaction #0: THEN Turn Mod 1 Pt 1 (Light) ON
Event #1: IF Mod 0 Pt O (Door) is ON (Closed)
Reaction #1: THEN Turn Mod 1 Pt 1 (Light) OFF

Since this example is a simple one-to-one correspondence, it is pretty easy to set up.
1. If PAC Manager isn't already open, start it:

\

_ and then click

— InWindows 7 and Windows Vista, press the Windows Start key
Programs > Opto 22 > PAC Project 9.5 > PAC Manager.
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- InWindows 10 and Windows 8.1, press the Windows Start key E type PAC Manager
9.5 and then press the Enter key.

The PAC Manager main window opens.

=8| PAC Manager - O *
File Tools View Help

ols@| £[%lal @ Bl o

Ready [ N4

2. Clickthe Open button El or choose File > Open.

3. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to
open it.

=8| PAC Manager - Main_Process - O *
File Edit Tools View Help

Dies|d| *|%alal B

& = OR ===
B Main_Process
ol /O Units
-2 Line 1
Preprocess
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In the configuration tree, right-click the name of the 1/0 unit on which you want to set up
digital events and choose Configure from the pop-up menu.

= Configure /0 Units

| Port | Address

MName | Type
Line_1 SMAP-PAC...
Preprocess SNAP-PAC...

Close I Help

10.192.55... Disabled
10.192.55... Disabled

Ethernet
Ethernet

*

| Watchdog | Description Add... |

Modify... |
Delete |

Import/Copy... |

10 Points... |
PID Loops... |
Modules 4 |
— Events
ScratchPad  # | button
Communications ¥ |
Others 4 |

For processors with firmware 8.1 or higher, click the Events button and choose Digital
Events - Expanded from the pop-up menu.

If your processor has firmware 8.0 or lower, expanded digital events are not available; choose
Digital Events - Old. Choices are more limited with older firmware; see tables on page 91.

IMPORTANT: If you configured digital events in a version of PAC Manager prior to 8.1, you will find
them in Digital Events - Old. Ifyou configured timed events in a PAC Manager version prior to 8.1, you'll
see them here in Digital Events - Expanded.

é Configure Digital Events - Expanded *
—Event
Mumber: I[J vI [ Used
Address | Description | Value |
EVENT
0xFFFF FOD<4 004C Event Enable/Disable Enabled =1
0xFFFF FOD4 0044 Use which data for trigger #17 Digital Point State =1
OxFFFF FOD4 0000 0N Mask Ox Q0000000 Q0000000
OxFFFF FOD4 0008 OFF Mask Ox Q0000000 Q0000000
0xFFFF FOD4 0044 Use which data for trigger #27 Digital Point State =1
OxFFFF FOD4 0010 0N Mask Ox Q0000000 Q0000000
0xFFFF FOD4 0018 OFF Mask Ox Q0000000 Q0000000
0xFFFF FOD<4 0040 Length of Delay Before Reaction (msec.) 0
REACTION
0xFFFF FOD4 0044 Reaction Occurs Continuously ;I
0xFFFF FOD4 0044 Use which data for reaction #17 Digital Point State =1
OxFFFF FOD4 0020 0N Mask Ox Q0000000 Q0000000
OxFFFF FOD4 0028 OFF Mask Ox Q0000000 Q0000000
0xFFFF FOD4 0044 Use which data for reaction #27 Digital Point State =1
OxFFFF FOD4 0030 0N Mask Ox Q0000000 Q0000000
0xFFFF FOD4 0038 OFF Mask Ox Q0000000 Q0000000
oK I Cancel
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6.

In the drop-down list, choose the lowest unused Event Number. Click to place a check markiin

the Used box.

NOTE: To reduce scanning time, the I/0 unit stops scanning digital events when it reaches an unused
event. Make sure you use event numbers in order, starting with the lowest.

Configure the Event by clicking in the Value column and entering a value or choosing from the

drop-down list.
a. Choose Enabled.

b. Choose which digital data to use as the trigger; in this example it is Digital Point State.
C. Leave the Digital ON mask all zeros. Enter the Digital OFF mask for the open door.
Remember that the masks are in hex notation. Here's how you might figure out the Digital

ON mask to turn on the light:

Hex notation: 0

Module position: 15 —» 1 0
Digital point:| 3 2 1 0 — > 3 2 1 0 3 2 1 0
State:| - | - | - | - | —p | = | - |On| - | - | - | - | -
Binary notation:| 0 0| o0 0| —»p 0 0 1 (0] O0 0 0| o0
—>

You don't need to enter anything for Trigger #2, because the open door is the only

dependency for this event.

d. If youwanta delay between the event and the reaction, enter the delay in milliseconds.

Configure the Reaction.

a. Choose whether the reaction should occur once or continuously; for this example, it's

continuously.

b. Choose the digital data and/or Scratch Pad bits to use for the reaction, and enter the masks.

Here’s how the Event and Reaction sections might appear for the door/light example.

=% Configure Digital Events - Expanded

Event

Mumber: |0 ~| W Used

*

%I Event: Digital
j‘f OFF mask—
=1

0xFFFF FOD4 0040

REACTION
OXFFFF FOD4 0044 Reaction Occurs

OxFFFF FOD4 0044

Use whirh data for reaction £12

Length of Delay Before Reaction (msec.)

O 00000000 00000000
0

Continuausly
Digital Point State

dooron mod 0
pt O is open.

Address | Description Value |
EVENT

0xFFFF FOD4 004C Event Enable Disable Enabled

OxFFFF FOD4 0044 Use which dats for trigger 212 Digital Point State

0xFFFF FOD4 0000 OM Mask 0x 00000000 00000000

0xFFFF FOD4 0008 OFF Mask 0x 00000000 00000001

0xFFFF FOD4 0044 Use which data for frigger 27 Digital Point State

0xFFFF FOD4 0010 OM Mask 0x 00000000 00000000

0xFFFF FOD4 0018 OFF Mask

=l

0xFFFF FOD4 0020
0xFFFF FOD4 0028

OM Mask
OFF Mask

0x 00000000 00000020
Ox 00000000 00000000

Reaction: Digital

OxFFFF FOD4 0044

0xFFFF FOD4 0030 OM Mask
0xFFFF FOD4 0038 OFF Mask
OK | Cancel
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9. Now choose Event Number 1 from the drop-down list and click Used. In the Event and
Reaction sections, enter the Digital ON mask for the closed door and the Digital OFF mask to
turn off the light.

=% Configure Digital Events - Expanded X
Event
Mumber: |1 | [ Used
Address | Description Value |

EVENT
0xFFFF FOD400CC  Event Enable/Disable Enabled =1 M
0%FFFF FOD400C4  Use which data for tringer £17 Digital Point State | Event: Digital
0xFFFF FOD4 0080 OM Mask 0x 00000000 00000001 ON mask—
OxFFFF FOD4 0083 OFF Mask 0y 00000000 00000000
0xFFFF FOD400C4  UUse which data for trigger 227 Digital Point State =1 dooron mod 0
0xFFFF FOD4 0030 OM Mask 0x 00000000 000D0000 pt 0 s closed
OxFFFF FOD4 0098 OFF Mask 0y 00000000 00000000 ’
0xFFFF FOD4 00C0 Length of Delay Before Reaction (msec.) 0
REACTION
OxFFFF FOD4 00C4 Reaction Ocours Continuausly ;l
OxFFFF FOD4 00C4 Use which data for reaction #12 Digital Point State -
0xFFFF FOD4 00AD OM Mask 0x 00000000 00000000 . MNiA
OXFFFF FOD4 00AS OFF Mask 0x 00000000 00000020 Reaction: Digital
0xFFFF FOD400C4  Use which data for reaction #27 Digital Point State =1 OFF mask—turn
0xFFFF FOD4 00BO OM Mask 0x 00000000 000D0000 f ligh d
0xFFFF FOD4 0088 OFF Mask 0x 00000000 00000000 ofrflightat mo
Tptl
0K | Cancel

10. Click OK.

Both event/reactions are configured.
11. Configure other event/reactions, or return to the PAC Manager main window and click the Save

button ﬂ to save the configuration file.

Configuring Alarms and Reactions

A reaction can also be set up as a response to an alarm. You can configure alarms for analog points
or digital counters. For example, you could monitor the pressure in a tank and set up an alarm if it
rises above a certain level, or you could trigger an alarm when a specific number of boxes on a
conveyor have passed through a beam sensor. For each alarm, you configure a suitable reaction.

For analog points, alarms are based on the analog input value. For digital points, alarms are based on
the counter value (applies to points on 4-channel digital modules only). For each point, you can
configure any or all of the following alarms:

«  Deviation alarm—sets a range on either side of the current value that is acceptable; beyond
that range, the reaction occurs. For example, suppose you are monitoring temperature. If the
current value is 80 and you set a deviation limit of 6, the reaction will not occur unless the value
drops below 74 or rises above 86.

If you have an Alarm Event that is configured as a deviation alarm, in order to capture that an
alarm occurred you need to set a scratch pad bit (such as bit 0) as the reaction of the alarm
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event. Also, you need to create another event, such as a Digital Event - Expanded, that triggers
based on that scratch pad bit. The Digital Event would set a different scratch pad bit (such as
bit 1) to be used for other logic or events. For example, digital event 0 sees set bit 0 and sets bit
1. Now bit one remains set until cleared. Set bit 1 can be used to start a timer that clears bit 1
when it expires. Bit T could also trigger an event message that requires acknowledgement.

NOTE: When a reaction occurs, the deviation limit stays the same, but the value that set off the
reaction becomes the new deviation value. In this example, if the temperature drops to 73, the
reaction occurs. Six is still the deviation limit, but now 73 is the deviation value; another reaction will
not occur unless the value drops below 67 or rises above 79.

«  High-limit alarm—sets a fixed upper limit. If the analog value or counter is higher than the
high limit, the reaction occurs.

«  Low-limit alarm—sets a fixed lower limit. If the analog value or counter is lower than the low
limit, the reaction occurs.

How Alarms Trigger Reactions

Reactions to alarms are edge-triggered, not level-triggered, and when the alarm state changes, the
reaction is automatically reversed. The I/O unit sends the reaction just once, as soon as the alarm
occurs (at the “edge” of the alarm). The I/O unit does not send the reaction again until the alarm
occurs again. If the alarm stops, however, the I/O unit reverses the reaction.

For example, suppose you set up a high-limit alarm that turns on a Scratch Pad bit that will turn on a
fan if the temperature goes over 70°. As soon as the alarm state occurs (the temperature goes over
70°), the I/0 unit sends the reaction (turns on the bit to turn on the fan). If the temperature remains
above 70°, the I/0 unit does not continue to turn on the fan bit; the bit just stays on.

When the temperature falls back below the high limit (70° minus whatever deadband you have set),
the I/0 unit automatically reverses the reaction by turning the Scratch Pad bit off. (To turn the fan off,
you would have to set up a reaction for the off bit, turning the fan off))

Notice that the reaction and its reversal are absolute; they do not depend on the pre-alarm
condition. For example, if the bit to turn on the fan was already on at the time the temperature rose
above 70°, the reaction would turn the bit on even though it was already on. When the temperature
fell back below 70°, the I/0 unit would not return the fan bit to its pre-alarm condition (on); it would
turn the bit off.
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Example: Alarms Event/Reaction

1. Inthe PAC Manager main window, with a configuration file open, right-click the name of the
/0 unit on which you want to set up alarm events. Choose Configure from the pop-up menu.

= Configure /0 Units

*

| Port | Address

MName | Type
Line_1 SMAP-PAC...
Preprocess SNAP-PAC...

Ethernet

Ethernet

| Watchdog | Description Add... |

10.192.55... Disabled
10.192.55... Disabled

Modify... |
Delete |

Import/Copy... |

10 Points... |
PID Loops... |
Modules 3 |

— Events

ScratchPad | bUtton
Communications # |
Others 3 |
Close I Help |
2. (lick the Events button and choose Alarm Events from the pop-up menu.
@ Configure Alarm Events ¥
— Alarm
Number: I[J vI [~ Used

Address | Description | Value |
DEVIATION ALARM

0xFFFF F110 0000 In Alarm State? MN/A

0xFFFF F110 0004 Enable Disable Alarm Disabled |

0xFFFF F110 0003 Middle of deviation range 0.000000

0xFFFF F110 000C Deviation Amount (Scaled Units) 0.000000

OxFFFF F110 0010 Scratch Pad Bits ON Ox 00000000 00000000

OxFFFF F110 0013 Scratch Pad Bits OFF Ox 00000000 00000000
HIGH ALARM

OxFFFF F110 0020 In Alarm State? MN/A

0xFFFF F110 0024 Enable Disable Alarm Disabled |

0xFFFF F110 0023 Limit (Scaled Units) 0.000000

OxFFFF F110 002C Limit Deadband (Scaled Units) 0.000000

0xFFFF F110 0030 Scratch Pad Bits ON Ox 00000000 00000000

OxFFFF F110 0033 Scratch Pad Bits OFF Ox 00000000 00000000
LOW ALARM

OxFFFF F110 0040 In Alarm State? MN/A

OxFFFF F110 0044 Enable Disable Alarm Disabled |

OxFFFF F110 0043 Limit (Scaled Units) 0.000000

0xFFFF F110 004C Limit Deadband (Scaled Units) 0.000000

0xFFFF F110 0050 Scratch Pad Bits ON Ox 00000000 00000000

0OxFFFF F110 0058 Scratch Pad Bits OFF Ox 00000000 00000000
ADVAMCED VALUE SELECTION

0xFFFF F110 0060 Address of value to check Ox FOAQDDOO 3|

0xFFFF F110 0064 Iz Value a Float? ‘fes b
CURRENT VALUE

0xFFFF FOAQ 0000 Value being alarmed MN/A

o]

Cancel
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3. Inthedrop-down list, choose the Alarm Number you want to use (by default, it is the same
number as the point the alarm will monitor). Click Used.
The alarm number can be any unused number, but it is best to use the point number, since by
default that point's memory map address and value are shown in the Value Being Alarmed
field.

If you need to set two or more alarms on the same point, however, you can do so. For
additional alarms, choose a different alarm number, configure the alarm, and enter the
memory map address for the point in the Advanced Value Selection section. (A complete list of
memory map addresses is in the OptoMMP Protocol Guide.)

4. Find the section for the type of alarm you want to use (deviation, high, or low). In the Value
column, click the Enable/Disable Alarm cell and choose Enabled from the drop-down list. Click
in other cells to set deviation or alarm limits. For high and low alarms, also set the deadband for
the limit.

A deadband is an allowable variation in the limit to account for signal noise. If the signal
fluctuates slightly, the deadband limit keeps the I/0 unit from sending out another alarm.

5. Foreach alarm, also configure the reaction in two parts:
- Scratch Pad bits that should be turned on
- Scratch Pad bits that should be turned off
See “The Scratch Pad”on page 142.

6. (Optional) If you are setting two or more alarms on the same point, use the Advanced Value
Selection area to enter the memory map address for the point to monitor, and indicate
whether the value on that point is a float.

7. Repeat from step 3 for additional alarms. When you have finished configuring alarms, click OK.

8. (lickthe Save button ﬂ to save the configuration file.

Configuring Serial or Wiegand Events and Reactions

If you are using Opto 22 serial communication modules—RS-232, RS-485/422, or Wiegand—with
SNAP PAC /0 units, you can configure a serial or Wiegand event to send a serial message, to send an
SNMP trap, or to turn bits in the Scratch Pad on or off when a specific string is received from one or
more modules.

Before you configure serial events and reactions, make sure you have configured the serial modules
(page 52).
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1. Inthe PAC Manager main window, with a configuration file open, right-click the name of the
/0 unit on which you want to set up serial or Wiegand events and choose Configure from the

pop-up menu.

= Configure /0 Units *

Mame | Watchdog | Description Add... |

Line_1 Disabled

Preprocess Disabled Modify... |
Delete |

Import/Copy... |

10 Points... |
PID Loops... |
Modules 3 |
Events
Communications » |
Others 3 |

| Address
10.192.55...
10.192.55...

| Type | Port
SMAP-PAC...

SMAPPAC. ..

Ethernet
Ethernet

Events
button

Close I

Help |

2. (lick the Events button and choose Serial Events from the pop-up menu, or if you are
configuring events for a Wiegand serial communication module, choose Wiegand Events.

=8| Configure Serial Events *

—Event

Mumber: I[J vI [ Used

Address

| Description | Value |

EVENT

0xFFFF F154 0000
0xFFFF F154 0010

0xFFFF F154 0038

0xFFFF F154 0060
0xFFFF F154 0068
0xFFFF F154 0070

Serial Ports Mask

Pattern String (wildcards allowed - e.g. *,7)
REACTION

Resulting String (plug-ins allowed)

Scratch Pad Bits ON
Scratch Pad Bits OFF
Enable E-mail Message

0x 00000000

OxFFFF F154000C  SNMP Trap Period (seconds) 0
O:FFFF F1540008  SNMP Specific Trap Type 0
OXFFFF F1540E80  SNMP Trap Priority High =
ONFFFF F154 0F00  Disable SNMP Trap No =

Ox 00000000 00000000
Ox 00000000 00000000
Disabled =1

[ x 1|

Cancel |

The example above shows the Configure Serial Events dialog box; the Wiegand Events dialog
box is similar.

In the drop-down list, choose the lowest unused Event Number. Click Used.

NOTE: To reduce scanning time, the I/O unit stops scanning serial events when it reaches an unused
event. Make sure you use event numbers in order, starting with the lowest.
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4. Inthe Event section, enter a mask in hex notation indicating the serial ports to monitor.

The I/0 unit monitors all ports set as “on”bits in the mask (on = 1; off = 0). If the string is
received from any of those serial ports, the event triggers the reaction. For example, suppose
you have serial modules in positions 1 and 2 on the rack. (Other kinds of modules are in
positions 0 and 3.) The following table shows how you might figure out the mask to monitor
three of these serial ports:

Module position:| €¢— 3 2 1 0
Serial port: - -- B A B A - -
Default TCP port number: - - | 22505 | 22504 | 22503 | 22502
Monitor? (Y or N): - - Y N Y Y - -
Mask (binary notation): 0 0 1 0 1 1 0 0
Mask (hex notation): 2 C

The complete hex mask you would enter to monitor these ports is: 0000002C.
5. Enter the pattern string the event should match.
The string is limited to 40 characters. Wildcards (* and ?) can be used.

6. In the Reaction section, do any or all of the following:
a. Tosend textin an SNMP trap or a one-time email message, complete the Resulting string
field.

If you send a string, it is limited to 126 characters. You can place data from the serial module
or the 1/0 unit's memory map into the string by using any or all of the following plugins:

$1_str_ Includes the pattern string in the resulting string.
$!1_port_ Shows which serial port sent the pattern string.
SIX_YYYYYYYY_  Includes data from a memory map address. See “Using Plugins”on

page 108 for more information.

For example, a resulting string that includes the pattern string, the serial port that sent it,
and the text Overload would look like this:

$! str_ $! port_ Overload

b. Tosendan SNMP trap, also enter how often in seconds to send the trap (use zero to send it
only once), and enter the trap type. Remember to configure email (page 112).
Trap types are determined by your SNMP management system.

¢. To send a one-time email notification, also enable E-mail Message. Make sure to configure
email (page 112).
To send multiple emails, don't enable email here. Instead, turn on a Scratch Pad bit (step e)
and set up the email when you configure event messages (page 104).

d. To send a serial message out a serial port, don't put the message here. Instead, turn on a
Scratch Pad bit (step e) and set up the serial message when you configure event messages
(page 104).
e. Toset Scratch Pad bits, enter masks for the bits to turn on and the bits to turn off when the
serial event occurs.
7. Repeat from step 3 for other serial events and reactions. When you have finished configuring
serial events and reactions, click OK.
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8. (lickthe Save button ﬂ to save the configuration file.

Configuring Event Messages

If you are using PAC Control or PAC Manager 9.0 or higher, configure event messages in the
configuration file as shown on page 104.

If you are not using PAC Control or are using a PAC Manager version less than 9.0, you
cannot configure event messages in a configuration file. Instead, use PAC Manager’s Inspect mode
and follow the steps below. Note that event messages are not available on SB brains, since
messaging requires an Ethernet connection.

1. Inthe PAC Manager main window, click the Inspect button [ |

= Inspect Opto 22 Device

— X

Device Name: | 10.192.55.67

Status Read
Status Read

Status:

j Options »

Status Read area last read at 07/05/156 13:30:03

Status Write k-\DDRESS DESCRIFTION VALUE ~ Refresh |
WirelessLAN * O0xFFFF F030 0004 Powerup Clear Flag PUC Needed PUC Received (0)
O0xFFFF F030 0008 Busy Flag [u]
Paint Config 0xFFFF F030 0018 Loader Version R5.1c
Digital Bank 0xFFFF F030 0000 Memory Map Version 1
OxFFFF F030 0230 Current Boot Device Flash Memory
Digital Point 0xFFFF F030 001C Firmware Version L9.5a
0xFFFF FO30 00RO Firmware Veraion Date 05/03/2016
Analog Bank O0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Paint 0xFFFF F030 0020 Unit Type 0x0000007A
High Density 0xFFFF FO30 0080 Unit Description SNAP-PAC-R1
O0xFFFF F030 0024 I/0 Unit Hardware Revision (Month) 4
O0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
System  * OxFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
ScatchPad  » OxFFFF F030 024C 1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432
Data Log 3
ETHERNET 1 Interface
PID 4 0xFFFF FO30 002E MAC Rddreas 00-R0-3D-01-85-9C
Events v OxFFFF F030 0034 IF Address 10.192.55.67
OXFFFF F030 0038 Subnet Mask 255.255.192.0
Communications » 0xFFFE FO30 003C Gateway 10.192.51.51
0xFFFF FO30 0040 DNS 10.192.60.31
Other 3 ETHERNET 2 Interface Y]
Close | Help | I Auto Refresh | 15000  msec

If you have used the Inspect button before, the last device name you used is shown and current
Status Read information appears in the window. The most recently used device names are

available in the drop-down list.

drop-down list).

In the Device Name field, type the name (or IP address) of the I/0 unit (or choose it from the
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3. (dlick Events and choose Event Messages from the submenu.

=5 Inspect Opto 22 Device — s

Device Name: | 10,192,55.67 j Options » Status: | Event Message area last read at 07/05/16 13:31:00

Event Message
Status Read

Event Message Mumber: |0 -
Status Write |

T . Address | Description Value | Refresh |
Wireless LAN MESSAGE
OxFFFF F120 0040 Message Text Apply
Paint Config OxFFFF F120 9000 Most Recent Message Sent
— OxFFFFF120 0000 State Inactive =1
Digital Bank 0xFFFF F120 0004  Scratch Pad Trigger ON 0x 00000000 00000000
| . 0xFFFF F120 000C Scratch Pad Trigger OFF 03 00000000 00000000
Digital Point STREAMING
O0xFFFF F120 0014 Enable Stream Packet Disabled Rl
m OXFFFFF120 0018 Stream Period (seconds) 0
Analog Point E-MAL
OxFFFF F120 001C Enable E-mail Message Disabled |
High Density OxFFFF F120 0020 E-mail Period (seconds) 1]
SERIAL MODULE
System N OxFFFF F120 0033 Enable Serial Module Message Disabled |
0xFFFF F120 003C Serial Ports Mask 0x 00000000
ScratchPad  » SNMP
OxFFFF F120 0024 Enable SNMP Trap Disabled |
Data Log » OxFFFF F120 0028 Trap Period (seconds) 1]
OXFFFFF120 002C  Trap Type 0
PID » OxFFFFF120 0030 Priority High JRd |
MEMMAP COPY DESTINATION
Events L4 OxFFFF F120 8000 MemMap Address Ox 00000000
o 0xFFFF F120 3004 IP Address of Destination 0.0.0.0
SrnEmlE b OxFFFFF120 8008 Port 0
P 5 OxFFFF F120 800C Period (miliseconds) 1]
Close | Help | I™ AutoRefresh | 15000  msec

4. From the drop-down list, choose the lowest unused message number.
Unused message numbers have no asterisk.
5. Foranemail or serial message, or optionally for an SNMP message, enter the message text.

Message text is not sent in the streaming packet. Message text is limited to 127 characters. You
can place data from the I/0 unit's memory map into the message by using a plugin (see

page 108). If you are sending a serial message, make sure the text is formatted so the serial
device that receives it will understand it.

6. Enter two masks indicating the Scratch Pad on and off bits that should trigger the message.
For help in figuring out the masks, see “Digital Point and Scratch Pad Masks”on page 146.

7. Streaming section: To send a stream of data as the message, choose Enabled from the
drop-down list. Enter how often in seconds to send the stream (0 sends it only once).

For information on streaming, see page 109.
8. E-mail section: To send an email message, choose Enabled from the drop-down list. Enter how
often in seconds to send the email (0 sends it only once).

9. Serial Module section: To send a message through a serial module to a serial device, choose
Enabled from the drop-down list. Enter a mask representing the modules and ports to receive
the message.

Information in “Configuring Serial or Wiegand Events and Reactions”on page 154 may be
helpful.

10

SNMP section: To send an SNMP trap as the message, change Disabled to Enabled. Enter how
often to send the trap (0 sends it only once). Also enter the trap type (determined by your
SNMP management software). If you are using SNMP with outgoing PPP and want the trap
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stored in the I/0 unit until the next communication, set Priority to Low. If you want the I/O unit
to immediately dial out and send the trap, set Priority to High.

For information on SNMP, see page 109.

NOTE: SNMP messages must be acknowledged. You can do so in your application orin PAC Manager's
Inspect window: in the Message section, change the State to Acknowledge and click Apply.

11. Memmap Copy Destination section: To copy memory map data, complete this section using
information from “Copying Memory Map Data” on page 122.

12. When all fields are correct, click Apply.
13.
14.

Repeat from step 4 to configure additional event messages.
For each type of message you configure, make sure you also set up basic configuration:

Serial:
SNMP:

Streaming:
Email:

page 117
page 112

page 52
page 109

15. When you have finished configuring all event messages and any additional configuration
required for them, in the PAC Manager Inspect window, make sure the IP address shown is the
correct one. Then click the Status Write button in the upper-left part of the window.

16. In the Operation Commands list, highlight Store configuration to flash.

= Inspect Opto 22 Device — x

ﬂ Options ¥

Device Mame: | 10.192.50.11 Status: | Status Write area last read at 05/02/16 16:30:29

Status Write
Status Read

Analog Point
High Density

System 3
Scratch Pad  »
Data Log 3
PID 3
Events 3
Communications »
Other 4

Operation

OptoMMP Device

microSD

Other

Restart Device from powerup

Store configuration to flash

Erase configuration from flash k
Reset to defaults and Restart Device

~ Send Command

Store configuration and IP settings to microSD
Erase configuration and IP settings from microSC
Erage firmware from microSD

Erase strategy from microSD

Switch to loader mode
Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration ]

Status Write Address | Description | Value

OxFFFF FO38 0004  Always BootP/[DHCP On Powerup No =1
T D 0xFFFF FO38 0008 Degrees F/C Degrees F | Apply

OxFFFF FO38 0010 Comm Watchdog Time {(msec), 0 = Disable 0
OxFFFF FO38 0014 TCP Minimum Retransmission Timeout (msec) 250

Point Config 0xFFFF FO38 0018 TCP Initial Retransmission Timeout (msec) 3000
0xFFFF FO33 001C  TCP Retransmission Attempts 5

Digital Bank OxFFFF FO38 0020 TCP Idle Session Timeout (msec), 0 = Disable 240000

> s OxFFFF FO38 0294 Digital Feature Scan Interval {msec) 1

Digital Point OXFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec) 1000

Analog Bank OxFFFF FO38 0298  Out Of Range Value (16-Bit) -32768.000
OxFFFF FO38 0280 Out Of Range Value (32-Bit) -2147433543.000
0xFFFF FO33 0054  Scanner Flaos 0 Q0000000

™ AutoRefresh | 15000  msec

17. Click Send Command.

The configuration data is stored to flash memory and a Success message appears.
Continue on next page.
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IMPORTANT: For the following configurations, you must also restart the unit in order for configuration

to take effect:
Changes in TCP port for serial modules SNMP configuration
Email configuration PPP configuration

Data logging interval

18. If you have configured any of these items, in the Operation Commands list, highlight Restart
/0 Unit from powerup. Click Send Command.

The I/0 unit is restarted and a success message appears.
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Introduction

This chapter shows you how to read and write to a SNAP PAC controller or I/0 unit directly by using
PAC Manager's Inspect window. In addition to reading and writing specific values, you can configure
points and functions using the steps in this chapter. However, these configurations cannot be
saved to a configuration file.

Because all reads and writes using the steps in this chapter are sent directly to the controller or I/O
unit, the device you are reading from or writing to must be on the same network as your PC or
laptop computer. For a SNAP PAC SB brain, you can read or write to the brain through a SNAP PAC
S-series controller, or you can connect the computer directly to the brain using a PCI-AC48 adapter
card and a serial cable. See the SNAP PAC Brain User’s Guide for more information on these
connections.

CAUTION—Ifyou are using PAC Control: When you read and write to specific devices using the
instructions in this chapter , the reads and writes occur independently of PAC Control strategy logic. If you
are using PAC Control, you normally use the flowchart logic in the PAC Control strategy to read and write
to the /O unit. It's not a problem to read directly, but if you use the instructions in this chapter to write to
an I/0 unit, be very careful that your actions do not conflict with PAC Control logic.

As you use PAC Manager’s Inspect window, you'll notice that the starting memory map address for
each item is shown. This can be a handy way to determine addresses you need for programming or
configuration. You can also highlight an address and right-click it to copy it; then you can paste it
where you are using it.

You can also copy and paste part or all of the data you read in the Inspect window. Just highlight the
data you want to copy and use standard Microsoft Windows commands such as Ctrl+C to copy
the data, and Ctrl+V to paste it into a text, email, or other file.
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Reading Basic Device Information

1. IfPAC Manager isn't already open, start it:

- InWindows 7 and Windows Vista, press the Windows Start key B and then click
Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

- InWindows 10 and Windows 8.1, press the Windows Start key B type PAC Manager
9.5 and then press the Enter key.

The PAC Manager main window opens.

=8| PAC Manager - O *
File Tools View Help

bS] #|%el R 6 el

Ready [ N4

2. Inthe PAC Manager main window, click the Inspect button El (orin the PAC Manager menu

bar, click Tools > Inspect).
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% Inspect Opto 22 Device

Device Name: |

~| _cotors » |

Ei=10H Error reading area: Timeout

Status Read |

~Status Read

Status Write |
Wireless LAN |

Point Config |
Digital Bank |
Digital Point |
Anzlog Bank |
Analog Point |
High Density |
System 3 |
ScratchPad |
Data Log 3 |
PID 3
Events 3 |
Communications + |
Other 4 |

o |

™ Auto Refresh |15000 msec

If this is the first time you have used the Inspect window, the device name will be blank, as
shown above. If you have used the Inspect window before, the last device name you used is
shown, and the most recently used names are available in the drop-down list.

In the Device Name field, type the name (or IP address) of the controller or I/O unit (or choose it

from the drop-down list). Click Status Read.
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READING BASIC DEVICE INFORMATION

Information from the device is displayed in the window.

é Inspect Opto 22 Device

Date and time data was last read

!

Click to update data

- X

Device Name: | 10,192,55.67

j Options >|

Status: I Status Read area lastread at 07/05/16 13:30:03

~Status Read v
Status Read |
Status Write | h&DDRESS DESCRIFTION VALUE A Refresh I
. 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwved (0)
Wireless LAN 'l OXFFFT FO30 0008 Busy Flag 0
Point Canfig | 0xFFFF FO030 0018 Loader Version R5.1lc
Digital Bank OxFFFF FO30 0000 Memory Map Version 1
—l 0xFFFF F030 0230 Current Boot Device Flash Memory
Digital Point | 0xFFFF FO30 001C Firmware Version R9.5a
0xFFFF FO30 00R0 Firmware Version Date 05/03/2016
Analog Bank | 0xFFFF FO30 00BO  Firmware Version Time 15z225:32
Analog Point | OxFFFT FO30 0020 Unit Type 0x00000072
High Density | 0xFFFF FO030 0080 Unit Description SNAP-PAC-R1
0xFFFF FO30 0024 I/0 Unit Hardware Bevision (Month) 4
0xFFFF FO30 0025 I/0 Unit Hardware Revision (Day) 21
FEED 'l OXFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
Seratch Pad ,l OxFFFF F030 024C I/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432
Data Log 3 |
ETHERNET 1 Interface
PID b 0xFFFF FO30 002E MAC Rddress 00-A0-30-01-85-9C
0xFFFF F030 0034 IP Rddress 10.192.55.67
M 0xFFFF FO30 0038 Subnet Mask 255-255.192. D
Communications ,l OxFFEF FO30 003C  Gateway 10.192.51.51
0xFFFF FO30 0040 DNS 10.192.60.31
Other >| ETHERNET 2 Interface v
Close I Help | I~ AutoRefresh [ 15000  msec

Scroll down to see all of the information. Data is current as of the date and time shown in the
Status field at the top right corner of the window. (Note that date and time are from the
computer, not from the I/0 unit.) To update data, click the Refresh button. See the next two
pages for help in interpreting data.
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Interpreting Status Data

The following table may help you interpret the information you see in the Status Read window.
Some items may not appear, depending on the Opto 22 device you are using. Some of this
information can be changed (see page 168). Much of it is used only for troubleshooting. If you have
additional questions about status data, contact Product Support (see page 5).

The term “device”is used in this table to refer to a SNAP PAC brain or controller.

Description Explanation

Since a powerup clear (PUC) is automatically sent by the device

Powerup Clear Flag PUC needed whenever it is turned on, this value should show PUC Received.

Busy Flag Zero means the device is not busy and can process your requests.

Revision number of the device’s loader. The loader is like a basic

Loader Version input/output system (BIOS).

Memory Map Version Revision number of the device’s memory map

(PAC-R and PAC-S only) Whether the PAC booted from its Flash

Current Boot Device .
memory or from a microSD card

Firmware Version

) . Revision number of the device’s firmware, and the date and time of
Firmware Version Date

the revision
Firmware Version Time
Unit Type Hex code indicating the device type.
Unit Description Part number of the device (brain or controller)
I/O Unit Hardware Revision (Month)
1/O Unit Hardware Revision (Day) Version date of the device’s hardware
1/O Unit Hardware Revision (Year)
Installed Ram Number of bytes of RAM in the device
Product Serial Number (SB brains only) Barcoded product number inside the brain
Address (SB brains only) Current serial address of the brain
Baud Rate (SB brains only) Current baud rate of the brain

(SB brains only) A serial transmission error; normally zero. If it's not

Number of Framing Errors . . )
9 zero, verify baud rate or check for noise on the serial bus.

(SB brains only) Normally zero. Any value other than zero indicates

Number of FIFO Overrun Errors that serial characters are being dropped.

(SB brains only) A value of 1 indicates that Communication Error

Communications Debug Flag Blink Codes are enabled. See the brain user’s guide for details.

Unique hardware Media Access Control (MAC) identifier for the
MAC Address device, assigned at the Opto 22 factory. MAC addresses for all
Opto 22 devices start with 00-A0-3D.

IP Address

IP address, subnet mask, and default gateway for the device on the

Subnet Mask Ethernet network. You assign these numbers; see page 10.

Gateway
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Description

Explanation

DNS or Name Server

Not currently used; leave at 0.0.0.0

Ethernet 2 MAC Address

(SNAP PAC controllers only) Unique hardware Media Access Con-
trol (MAC) identifier for the second Ethernet interface on the device.

Ethernet 2 IP Address

Ethernet 2 Subnet Mask

Ethernet 2 Gateway

(SNAP PAC controllers only) IP address, subnet mask, and default
gateway for the second

Ethernet interface on the device. You assign these numbers; see
page 21.

Ethernet 2 DNS

(SNAP PAC controllers only) Not currently used; leave at 0.0.0.0

Wireless LAN MAC Address

(Wired+Wireless devices only) Unique hardware Media Access
Control (MAC) identifier for the device’s wireless LAN interface.

WLAN IP Address

WLAN Subnet Mask

WLAN Primary Gateway

WLAN Secondary Gateway

(Wired+Wireless devices only) IP address, subnet mask, and gate-
ways for the wireless LAN interface on the device. You assign these
numbers; see page 26.

WLAN Primary DNS

WLAN Secondary DNS

(Wired+Wireless devices only) Not currently used; leave at 0.0.0.0

Always BootP/DHCP On Powerup

A value of 0 (the normal setting) means the device sends a request
(a BootP or DHCP request) for an IP address only if its IP address
is 0.0.0.0. A value of 1 means the device sends a BootP or DHCP
request every time it is turned on. See page 10 for more informa-
tion.

Degrees F/C!

Whether temperatures on the I/O unit are handled in Fahrenheit or
Celsius. Set when you configure the I/O unit (page 36). Celsius is
the default.

Comm Watchdog Time (msec.)!

If the 1/0 unit has a watchdog, the watchdog timeout in millisec-
onds. Set when you configure the I/O unit (page 36). Default is 0
(no watchdog).

Out of Range Value (16-bit)

Only for SNAP PAC analog input modules that return 16-bit values.
If a value goes out of range, this number appears as the value.
Default is -32,768. Can be changed; see page 168.

Out of Range Value (32-bit)

Only for SNAP PAC analog input modules that return 32-bit values,
such as the SNAP-AIRATE-HFi and SNAP-AIRTD-8U modules. If a
value goes out of range, this number appears as the value. Default
is -2147483648. Can be changed; see page 168.

Scanner Flags

Shows scanner and control engine options. Value can be any of the
following or a combination of them, in hex. See “Scanner Flags” for
more information.

1 = Alarms are being processed in the digital scanner rather than

the analog scanner.!

2 = Analog/HDD scanner is disabled. (Disables scanning of
high-density digital modules as well as analog modules.)*

4 = Digital scanner is disabled.!

8 = (applies to all standalone and on-the-rack controllers) PAC Con-
trol engine is stopped.
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Description

Explanation

4-Channel Digital Scan Count!

Shows the number of times the processor (brain or on-the-rack con-
troller) has scanned the digital points for 4-channel digital modules
on the I/O unit. Can be used for benchmarking.

Analog & High Density Dig Scan Count!

Shows the number of times the processor has scanned the analog
and high-density digital module points on the 1/O unit. Can be used
for benchmarking.

Milliseconds Since Powerup

Milliseconds since the last time the device was turned on. Value
rolls over after 4,294,967,295 ms, which is equal to 49.71 days.

Elapsed Time Since Powerup

Time since the device was last turned on. Time is shown in the for-
mat days:hh:mm:ss

TCP Minimum RTO (msec.)

TCP Initial RTO (msec.)

TCP Retransmits

TCP Idle Session Timeout (msec.)

TCP communication settings; see page 250.

TCP Idle Session Timeout Count

Number of times the device closed the session because it was idle.

Ethernet Errors: Late Collisions

Ethernet Errors: Excessive Collisions

Ethernet Errors: Others

Values other than 0 may indicate network problems. See page 251.

Smart Modules Present!

Mask in hex showing location of analog, serial, and high-density
digital modules on the rack. Module 15 is in bit position 15; module
0 is in bit position 0. (For help in understanding masks, see “Mask
Data” on page 211.)

PID Loops Supported

Maximum number of PID loops possible on the device (96 on
PAC-R, EB, and SB brains). See page 69.

Digital Modules Supported

Number of 4-channel digital modules supported (0, 8, or 16).
Added in firmware 8.1; older firmware doesn't include this address.
Useful for SNAP-PAC-R1 and SNAP-PAC-R1-B.

Due to B-series rack limitations, R1-Bs support 4-channel 1/0O
modules only in the first 8 rack positions.

R1s with serial numbers below 600,000 support 8 digital modules in
the first 8 rack positions; newer R1s support 16.

Arcnet Reconfigs Detected?®

Indicates that a smart module has been added, removed, or reset.

(ARCNET is used on the rack for communication between the pro-
cessor and analog, serial, or high-density digital modules.) NOTE: If
the rack contains only 4-channel digital modules, ignore this value.

Arcnet Reconfigs Initiated by /0O Unit!

Error on the rack’s ARCNET bus. Not a concern unless it happens
frequently.
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Description

Explanation

Arcnet Transmit Attempts Since
Powerup!

Arcnet ACKs?!

Arcnet Timeouts®

Arcnet Other (node not found, etc.)1

Arcnet Timeout Value (msec.)l

Arcnet Receive Interrupts1

Refers to the ARCNET bus on the rack. May be useful in trouble-
shooting communication to analog, serial, or high-density digital
modules.

Ethernet MAC Resets Since Powerup

Dig. Output Point Resets Since
Powerup’?

Caused by EMI, RFI, or other electrical noise.

Dig. Interrupt Failures Since Powerup®

Related to digital counters. May have missed counts. Contact
Opto 22 Product Support.

Analog & High Density Digital Scannert

(milliseconds per scan) Average length of time the processor takes
to scan all analog and high-density digital points on the rack. Based
on the last 100 scans (last 50 scans for points on high-density digi-
tal modules, as they are included in every second scan). A value of
-1 means the scanner is not running.

4-Channel Digital Scanner!

(milliseconds per scan) Average length of time the processor takes
to scan all 4-channel digital points on the rack, based on the last
100 scans. A value of -1 means the scanner is not running.

Module X - Times Discovered?!

How many times the processor has rediscovered a smart module
(analog, serial, high-density digital). Normal value is zero; values
over 1 may indicate that a module is resetting.

1 Does not apply to SNAP PAC S-series and SoftPAC controllers

Changing Status Data

The following items in the Status Read/Status Write windows can be changed in PAC Manager if the

device supports them.

Always BootP/DHCP on Powerup
Degrees F/C

Comm Watchdog Time

TCP Settings

Digital Feature Scan Interval

Max Analog and High Density Digital
Scan Interval

PAC Manager User's Guide
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Strategy Download Method
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1. Inthe PAC Manager main window, click the Inspect button Ql

=] Inspect Opto 22 Device - x
Device Name: I 10.192.55.67 LI Options » | Status: | Status Read area last read at 07/05/16 13:30:03
~Status Read
Status Read |
Status Write | hDDRESS DESCRIFTION VALUE ~ Refresh I
. 5 OxFFFF F030 0004 Powerup Clear Flag PUC Needed PUC Received (0)
\ireless LAN | OxFFFF F030 0008 Busy Flag 0
Paint Config | 0xFFFF F030 0018 Loader Version R5.1c
Digital Bank | OxFFFF F030 0000 Memory Map Version 1
g OxFFFF F030 0230 Current Boot Device Flash Memory
Digital Point | OxFFFF F030 001C Firmware Version A9.5a
0xFFFF FO30 00RO Firmware Version Date 05/03/2016

Analog Bank | OxFFFF F030 00BO Firmware Version Time 15:29:32
Analog Paint | 0xFFFF F030 0020 Unit Type 0x0000007A

High Density | 0xFFFF FO030 0080 Unit Description SNAP-FAC-R1
0xFFFF F030 0024 I/0 Unit Hardware Rewvision (Month) 4
0xFFFF F030 0025 I/0 Unit Hardware Rewvision (Day) 21
System ’l OxFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
Scratch Pad ,l 0OxFFFF F030 024C I/0 Coprocessor Firmware Version L0.0&a
0xFFFF FO30 0028 Installed Ram 33554432

Data Log » |

ETHERNET 1 Interface

PID 4 0xFFFF F030 002E MAC Address 00-A0-3D-01-85-9C
E— 0xFFFF F030 0034 TP Lddress 10.192.55. 467
| 0xFFFF F030 0038 Subnet Mask 255.255.192.0
Communications ,l 0xFFFF F030 003C Gateway 10.192.51.51
0xFFFF F030 0040 DHS 10.192.60.31

Other b| ETHERNET 2 Interface ]
Close I Help | [~ AutoRefresh I 15000  msec

If you have used the Inspect button before, the last device name you used is shown and current
Status Read information appears in the window. The most recently used device names are
available in the drop-down list.

2. Inthe Device Name field, type the name of the device (or choose it from the drop-down list).
3. Click Status Write.
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##] Inspect Opto 22 Device — X
Device Mame: ‘ 10.192.50,12 j Options Status: | Status Write area last read at 05/02/16 16:56:15
Status Write
Status Read
Status Write Address | Description ‘ Value - Refresh
OxFFFF FO38 0004  Always BootP [DHCP On Powerup No =1
Wireless LAN # OxFFFF FO38 0008 Degrees F/C Degrees F =1 Apply
reless OxFFFF FO38 0010 Comm Watchdog Time (msec), 0 = Disable 0
OxFFFF FO38 0014  TCP Minimum Retransmission Timeout (msec) 250
Point Config OxFFFF FO38 0018 TCP Initial Retransmission Timeout {msec) 3000
OxFFFF F0O33 001C TCP Retransmission Attempts 5
Digital Bank OxFFFF F038 0020  TCP Ide Session Timeout (msec), 0 = Disable 240000
i OxFFFF FO38 0294 Digital Feature Scan Interval (msec) 1
Digital Point OxFFFFF038 0050 Max Analog and High Density Digital Scan Interval {msec) 1000
Analog Bank OxFFFF FO38 0298 Out Of Range Value (16-Bit) -32768.000
g OxFFFF FO38 02B0  Out Of Range Value (32-Bit) -2147483648.000
Anzlog Point 0xFFFF FO38 0054  Scanner Flaas 0x 00000000 &7

High Density Operation

4.

OptoMMP Device A Send Command
s »| | Sorctontasaton e
saatchpad »| | e o Restort Device
2EEIEY ' miUS-SJSrE configuration and IP settings to microSD
B N Erase configuration and IP settings from microSC

Erase firmware from microSD

M Erase strategy from microSD
Other

- Switch to loader mode
3
M Clear Digital Events - Expanded configuration
Other » C!ear D!gltal Events - Olfj configuration W
Help I~ AutoRefresh | 15000  msec

ltems that can be changed are listed in the upper section of the dialog box. To change one,
click its Value field and either choose from the drop-down list or enter the new value as
described below:

Always BootP/DHCP on Powerup (All devices): If you change this field to Yes, the current IP
address becomes temporary and the device will send a BootP broadcast the next time it is
turned on. If you change this field to No, the current IP address is saved to flash memory and
becomes a static IP address.

Degrees F/C and Comm Watchdog Time (I/O units only): Changes settings for the whole I/0
unit. IMPORTANT: Set Degrees F/C before configuring temperature inputs. If some inputs are
already configured, reset their Upper and Lower Scaled Units after changing Degrees F/C.

TCP settings: CAUTION: Before changing TCP settings, see page 250.

Digital Feature Scan Interval and Max Analog and High Density Digital Scan Interval
(/0 units only): Default is 1000 msec for analog and 1 msec for digital. You can decrease the
scan interval (to make it scan more frequently) to make sure the scanner isn't slowed or
stopped by heavy communication on the network. You can also shut down the scanner
immediately by changing its scan interval value to -1 (does not require restarting the I/O unit).
As of firmware version 8.1, analog modules with more than 4 points are scanned no faster than
every 30 msec, and analog modules with four or fewer points are scanned no faster than every
6 msec, to maintain synchronization with the module. Note that scan interval changes revert to
default values when power is lost, unless you save your changes to flash.

Out of Range Value (16-Bit) and Out of Range Value (32-Bit): Set the value that an analog
input module returns when a signal is above or below a defined range. If the default
out-of-range value is potentially a valid in-range value, you can enter a different value to
indicate an out-of-range condition. Most SNAP analog input modules use the 16-bit
out-of-range value, which has a default value of -32,768. Analog input modules that return a
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32-bit value (such as the SNAP-AIRATE-HFi and SNAP-AIRTD-8U modules) use the 32-bit
out-of-range value, whose default value is -2147483648.

Scanner Flags: To change the way scanners work or stop/start the control engine, enter one or
a combination of the following values in hex.

—  (I/O units only)To process alarms in the digital scanner rather than the analog scanner,
enter 1.

— (/O units only)To disable the analog scanner, enter 2.
— (/O units only)To disable the digital scanner, enter 4.
- (PAC-R only) To stop the PAC Control engine runtime, enter 8.

For example, if you have a SNAP-PAC-R1 I/O unit with digital I/O only and are not using a PAC
Control strategy, you can get faster reactions to events by entering 1+ 2 + 8, which would be
0x0000000B. NOTE: You must save to flash and restart for this change to take effect.

Strategy Download Method (SNAP PAC controllers only): Choose Background to enable
background downloading. See the PAC Control User's Guide for more information.

Turnaround Delay (controllers or brains with serial ports): Enter how long the controller or
brain should wait to send a response to serial communication. Default is zero (no delay).

Communication Error Blink Codes (SB brains only): For troubleshooting, choose Enabled
from the drop-down list to see communication error blink codes. (See the Troubleshooting
section in the brain user’s guide for details.) Be sure you turn off blink codes after
troubleshooting; they will degrade performance.

Ethernet 2 IP Address information (SNAP PAC controllers only): See “Assigning an IP Address
to Ethernet 2 (SNAP PAC Controller Only)”on page 21 for information.

5. When you have finished entering changes, click Apply.

Most changes take effect immediately. If you change the Scanner Flags, secondary IP address
information, or strategy download method, however, you must store the configuration to
flash and then restart the controller or brain. Also see “Assigning an IP Address to Ethernet 2
(SNAP PAC Controller Only)”on page 21.

Referencing I/0O Points

The following sections show input and output point numbers for /0O units.

For SNAP serial communication modules, see page 172. You will also need Opto 22 form 1191,
SNAP Serial Communication Module User’s Guide.

CAUTION: Make certain you are using the correct rack for the processor. Using an incompatible rack can
cause severe damage to the brain or controller.
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REFERENCING 1/0 POINTS

SNAP PAC Racks

Use any of these racks With any of these processors

SNAP-PAC-RCK4

SNAP-PAC-RCK4-FM SNAP-PAC-R1, SNAP-PAC-R1-FM, SNAP-PAC-R1-W
SNAP-PAC-RCKS8 SNAP-PAC-R2, SNAP-PAC-R2-FM, SNAP-PAC-R2-W
SNAP-PAC-RCK8-FM SNAP-PAC-EB1, SNAP-PAC-EB1-FM, SNAP-PAC-EB1-W
SNAP-PAC-RCK12 SNAP-PAC-EB2, SNAP-PAC-EB2-FM, SNAP-PAC-EB2-W
SNAP-PAC-RCK12-FM SNAP-PAC-SB1

SNAP-PAC-RCK16 SNAP-PAC-SB2

SNAP-PAC-RCK16-FM

SNAP PAC mounting racks can hold up to 4, 8, 12, or 16 Opto 22 SNAP 1/0 modules. Point features
and modules supported vary by processor; see the processor’s data sheet for specifications.

Each module contains 1 to 32 points (channels), depending on the module. Examples of modules
are shown in the following diagram.

Module position 0, 4-ch digital:

Points: n

Module position 6, high-density
digital:

Points:‘31‘<7 ‘ 0 | Module position 8, analog:

Points:‘7‘6’5‘4|3‘2|1’0‘

Module position 12, analog:

Points: n

Module position 14, serial:

Ports:

Serial Modules
NOTE: Serial modules cannot be used with SNAP PAC SB brains.
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SNAP-SCM-232, SNAP-SCM-485, SNAP-SCM-485-422, and SNAP-SCM-W2 modules each have two
serial ports, A and B. Profibus modules (SNAP-SCM-PROFI) have one serial port.

To establish an Ethernet connection between the SNAP PAC /0 unit and a serial module, you use
the IP address of the I/0 unit the module is on, plus the TCP port number for the module’s serial
port. The following table shows default port numbers for each port in each position on the largest
rack. For a Profibus module, use the Port A port number.

Module Port TCP port Module Port TCP port
Position Number Position Number

A 22500 A 22516
0 8

B 22501 B 22517

A 22502 A 22518
1 9

B 22503 B 22519

A 22504 A 22520
2 10

B 22505 B 22521

A 22506 A 22522
3 11

B 22507 B 22523

A 22508 A 22524
4 12

B 22509 B 22525

A 22510 A 22526
5 13

B 22511 B 22527

A 22512 A 22528
6 14

B 22513 B 22529

A 22514 A 22530
7 15

B 22515 B 22531

These port numbers can be changed if necessary. See page 52 for instructions.

Configuring I/0 Modules, Points, and Features

Before you can read or write to /O points, you must configure point types and point features. You
can do so using PAC Manager’s Inspect window. Remember, however, that configurations you set in
the Inspect window cannot be saved to a configuration file. They are sent directly to an individual
I/0 unit. To use a configuration file, see “Chapter 2: Configuring Devices,” especially “Configuring I/0
Modules and Points”on page 40.

Point Types Requiring Configuration

The SNAP PAC I/0 processor can recognize analog, serial, and high-density digital modules, and it
assumes a default configuration for all points on those modules. Any module position not occupied
by an analog, serial, or high-density module is assumed to be a 4-channel digital input module.
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You'll need to configure the following point types:

«  All digital output points on 4-channel digital modules. Use point type 180.

+  Analog points that do not use the default point type for the module. For example, if the points

on a SNAP-AIRTD module are 120 Ohm Nickel 3-wire RTDs (=80 to +260 °C), they must be

configured, because the default for that module is 100 Ohm Platinum 3-wire RTDs (—200 to

4850 °C). Point types for analog modules are shown in the tables beginning on page 176.

Default point types are indicated.

Point Features Requiring Configuration

Point features vary based on the processor and the module. The following point features are not

automatic and must be configured for each point that uses them:

»  High-speed digital input counters and quadrature counters

+  Digital and analog watchdogs

«  Analog scaling, clamping, offset and gain, and average filter weight

See "Using I/0 Point Features”on page 76 for a description of features.

Configuring Analog and Digital Points and Features

1. Inthe PAC Manager main window, click the Inspect button @ .

= Inspect Opto 22 Device

Device Name: | 10.192.55.67

Status Read
Status Read

Status:

j Options »

Status Read area lastread at 07/05/16 13:30:03

s RoDRESS DESCRIPTION VALUE ~ Refresh |
ey 0xFFFF FO30 0004  Fowerup Clear Flag PUC Needed PUC Received (0)
0xFFFF FO30 0008 Busy Flag 0
Point Config O0xFFFF F030 0018 Loader Version E5.1c
. OxFFFF F030 0000 Memory Map Version 1
Digital Bank 0xFFFF FO30 0230 Current Boot Device Flash Memory
Digital Paint 0xFFFF FO30 001C Firmware Version B3.5a
0xFFFF F030 00RO Firmware Version Date 05/03/201&
Analog Bank O0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF F030 0020 Unit Type 0x00000072
High Density OxFFFF FO30 0080 Unit Description SNARE-FAC-R1
0xFFFF F030 0024 I/0 Unit Hardware Revision (Month) 4
OxFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
HeEEa P 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
ScatchPad ¥ OxFFFF F030 024C 1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432
Data Log 4
ETHERNET 1 Interface
PID 4 0xFFFF FO30 002E MAC Rddress 00-R0-30-01-85-9C
0xFFFF FO30 0034 IP Address 10.192.55.67
R 0xFFFF FO30 0038 Subnet Mask 255.255.192.0
o elE b 0xFFFF FO30 003C Gateway 10.192.51.51
0xFFFF FO30 0040 DNS 10.192.60.31
Other 3 ETHERNET 2 Interface W
Close | Help | I AutoRefresh | 15000
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If you have used the Inspect button before, the last device name you used is shown, and
current Status Read information appears in the window. The most recently used device names
are available in the drop-down list.

2. Inthe Device Name field, type the name (or IP address) of the I/0 unit (or choose it from the
drop-down list). Click Point Config.

Module position number #8] Inspect Opto 22 Device - x

yice Name: | 10,192,50.12 j Options » Status: | Point Configuration area last read at 05/02/16 17:00:48
Point numbers for this module

are shown in yellow.

Point Configuration
Status Read

S| : Choose a module
[Modue F0) 1 2 3[4 5 & 7[8 9 10 11[12 13 14 15 Type:r AOV-5(0x85)

Status Write

Wircless LA Step 2: Choose a point on the selected module . .
Pant |0 1 2 2|4 & & 7]8 & 10 11 | 12 13 1% 15 ;zg;re: ﬂ:ﬁ;?o‘i%g)s'”g‘e @5
Point Config 16 17 18 19|20 21 22 23|24 25 26 27(28 29 30 31/ mome:  aol2Vout 0000
Pomt Ze1o 15 Currently belng % Address | Description | Value | Refresh
read here. Since this is N0t an————Digistesine L AL POINTS
. 0xFFFF FO10 0000 Module Type AOQV-5 (0x85) Apply
a nalog pomt, a nalog values are Analog Bank 0xFFFF FO10 0004 Foint Type 0 to 10 VDC Single (0x85) JEa |
- 0xFFFF FO10 0008 Point Feature 0x 00000000
grayed out. Anlog Point 0XFFFF FO10 0024 Watchdog Output Value 0,000
R R 0xFFFF FO10 0028 Watchdog Enabled Disabled JEd |
High Density 0xFFFF FO10 0030 Paint Mame 2012Vout_0000
. ANALOG OMLY
To update val ues, click the System » OxFFFF FO10 000C Offset 0
. OxFFFF FO10 0010 Gain 0.
Refresh button. To mod 'fy Scratch Pad ¥ OxFFFF FO10 0014 Upper Scaled Units 10,
0xFFFF FO10 0018 Lower Scaled Units 0.000
values, change the parameters ol U OXFFFFFO0100020  Filter Weight (0=disable) 0.000
H H H 0xFFFF FO10 00BC Upper Clamp 0.000
(lfappllcable) and Clle Apply HE ' 0xFFFF FO10 00B3 Lower Clamp 0.000
Events 3
Communications
Other 3
Help [ AutoRefresh | 15000  msec

Module position numbers are shown near the top of the page; point numbers for multi-point
modules are shown below. For more information on locating modules and points, see
“Referencing I/0 Points”on page 171.

3. (lick the module position and the point number you want to view or configure.

4. Choose or enter the following as necessary for the point.
a. Choose the point type from the drop-down list.

For help, see “Point Type Configuration Tables” on page 176 and “Using 1/0 Point Features”
on page 76.
b. Configure digital input counters in the Point Feature field as shown below:

0x00000000 Disables all digital point features
0x00000001 Enables and starts counter on digital input
0x00000004 Simple quadrature counter input (requires SNAP quadrature input module)

0x00000041 Quadrature counter input with index (requires SNAP gquadrature input module)

¢. Forautomatic reaction to analog or digital watchdogs, enable the watchdog and enter the
value that the output point should be set to if the watchdog is tripped.
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d. (Analog points only) To set offset and gain for the point manually, enter values in those
fields. (To have the processor compute offset and gain, see “Reading and Writing to Analog
Points” on page 190.)

e. (Analog points only) Set upper and lower scaled units, filter weight, and upper and lower
clamps as necessary. (For help, see “Using I/O Point Features” on page 76.)

5. When all lines are correct, click Apply to send the configuration to the I/0 unit.

All other points on the same module are automatically configured with the same features and
the same point name.

6. Click another point on the same module and change its point name and features as necessary.
7. Repeat steps for each module you need to configure.

To save configuration to flash memory, see “Saving Configuration to a Device's Flash Memory”
on page 204.

Point Type Configuration Tables

The following tables help you configure points by showing the part number, the point type in
decimal and in hex, and the module type in hex (module type is read-only). For analog modules,
tables also include the number of points per module, the unit of measurement for the module, and

its range.

Digital Input and Output Modules page 176
Analog Input Modules page 176
Analog Output Modules page 183

Digital Input and Output Modules

Digital input module* 256 100 00

Digital output module* 384 180 00

* Does not apply to SNAP high-density digital modules, which are
recognized by the processor.

Analog Input Modules

Use this data for configuring point types and features (see page 173). If a module has multiple
listings, the default point type is shaded.

SNAP-AIARMS: 0 - 10 A AC/DC 71 |47 | 71| 2 A 0.0 0.0 10.0 11.0
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Part Nu!nt?er & 5 | g % - o
Description é £ == 3 g c g o o e

2 (g |83 |58 E8 1§ B

151

e a2 |f
SNAP-AIARMS-i: 0 - 10 A AC/DC 71 |47 |1 29| 2 A 0.0 0.0 10.0 11.0
SNAP-AIARMS-i-FM: 0 - 10 A AC/DC 71 [ 47|29 | 2 A 0.0 0.0 10.0 11.0
SNAP-AICTD: ICTD Temp. Probe 4 | 4 |04| 2 | DegreesC -273.0 -40.0 150.0 150.0
SNAP-AICTD-4: ICTD Temp. Probe 42 | 4 Degrees C -273.0 -40.0 150.0 150.0
SNAP-AICTD-8: ICTD Temp. Probe 4 | 4 |4C| 8 | DegreesC -273.0 -40.0 150.0 150.0
SNAP-AILC: -2 - +2 mV/V Fast 34 |22 |0B| 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC: -2 - +2 mV/V Slow 36|24 |0B| 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC: -3 - +3 mV/V Fast 35123 |0B| 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC: -3 - +3 mV/V Slow 37 125 |0B| 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC: Filter of 1st channel 0 0 |0B| 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC-2: -3 - +3 mV/V Fast 35 |23|0C| 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC-2: -3 - +3 mV/V Slow 37 |25 |0C| 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC-2: -4 - +4 mV/V Fast 34 |22 |0C| 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC-2: -4 - +4 mV/V Slow 36 |24 |0C| 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC-2: Filter of 1st channel 0 0 |0C| 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AIMA: -20 - +20 mA 64 |40 | 64| 2 mA -22.0 -20.0 20.0 22.0
SNAP-AIMA: 0 - +20 mA 2 2 164 2 mA -22.0 0.0 20.0 22.0
SNAP-AIMA: 4 - +20 mA 3 3 |64 2 mA -22.0 4.0 20.0 22.0
SNAP-AIMA2-i: -1 to +1 mA 85 |55 |27 | 2 mA -1.1 -1.0 1.0 1.1
SNAP-AIMA-i: -20 - +20 mA 64 (40| 22| 2 mA -22.0 -20.0 20.0 22.0
SNAP-AIMA-i: 0 - +20 mA 2 2 122 2 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-i: 4 - +20 mA 3 3122 2 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-iH: 4 - +20 mA 3 3 [2A]| 2 mA 3.2 4.0 20.0 24.0
SNAP-AIMA-iSRC: -20 - +20 mA 64 |40 | 26| 2 mA -22.0 -20.0 20.0 22.0
SNAP-AIMA-ISRC: 0 - +20 mA 2 2 126 2 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-ISRC: 4 - +20 mA 3 3126 2 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-iSRC-FM: -20 - +20 mA 64 40| 26| 2 mA -22.0 -20.0 20.0 22.0
SNAP-AIMA-iISRC-FM: 0 - +20 mA 2 2 126 2 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-ISRC-FM: 4 - +20 mA 3 3126 2 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-4: -20 - +20 mA 64 |40 |40 | 4 mA -22.0 -20.0 20.0 22.0
SNAP-AIMA-4: 0 - +20 mA 2 2 40| 4 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-4: 4 - +20 mA 3 3140 4 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-8: -20 - +20 mA 64 |40 |4A | 8 mA -22.0 -20.0 20.0 22.0
SNAP-AIMA-8: 0 - +20 mA 2 2 |[4A | 8 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-8: 4 - +20 mA 3 3 |4A| 8 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-32: -20 to +20 mA 64 | 40 | 4D | 32 mA -22.0 -20.0 20.0 22.0
SNAP-AIMA-32: 0 - +20 mA 2 2 |4D | 32 mA -22.0 0.0 20.0 22.0
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Part Nu!'nt?er & 5 | ’g % - o
Description é £ z |3 g g g o o @
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EEEEE £ P

e o (2|2
SNAP-AIMA-32: 4 - +20 mA 3 3 |4D | 32 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-32-FM: -20 to +20 mA 64 | 40 | 4D | 32 mA -22.0 -20.0 20.0 22.0
SNAP-AIMA-32-FM: 0 - +20 mA 2 2 |4D | 32 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-32-FM: 4 - +20 mA 3 3 |4D | 32 mA -22.0 4.0 20.0 22.0
SNAP-AIMV-4: -150 - +150 mV 66 |42 | 44 | 4 mV -165.0 -150.0 150.0 165.0
SNAP-AIMV-4: -75 - 475 mV 68 |44 | 44| 4 mvV -82.5 -75.0 75.0 82.5
SNAP-AIMV2-4: -50 - +50 mV 9|9 |45]| 4 mV -55.0 -50.0 50.0 55.0
SNAP-AIMV2-4: -25 - +25 mV 67 |43 |45 | 4 mvV -27.5 -25.0 25.0 27.5
SNAP-AIPM (point 0 only) 70 |46 [0A | * | ACVRMS 0.0 0 250 275
SNAP-AIPM (point 1 only) 71 | 47 |0A| * | ACARMS 0.0 0 10 11.0
SNAP-AIPM (point 2 only) 82 | 52 | OA | * | True power n/a n/a n/a n/a
SNAP-AIPM (point 3 only) 83 |53 |0A| * Volt/Amps n/a n/a n/a n/a
SNAP-AIPM-3 (points 0, 4, & 8) 70 | 46 | 49 | * AC VRMS 0.0 0 300 330
SNAP-AIPM-3 (points 1, 5, & 9) 71 | 47 | 49 | * AC ARMS 0.0 0 5 55
SNAP-AIPM-3 (points 2, 6, & 10) 82 |52 49| * True power n/a n/a n/a n/a
SNAP-AIPM-3 (points 3, 7, & 11) 83 |53 (49| * Volt/Amps n/a n/a n/a n/a
SNAP-AIPM-3 (points 12 & 13) 86 | 56 | 49 | * | True power n/a n/a n/a n/a
SNAP-AIPM-3V (points 0, 4, & 8) 100 | 64 | 48 | * AC VRMS 0.0 0 300 330
SNAP-AIPM-3V (points 1, 5, & 9) 89 | 59 | 48 | * | VAC from CT 0.0 0 0.333 0.366
SNAP-AIPM-3V (points 2, 6, & 10) 90 | 5A | 48 | * True power n/a n/a n/a n/a
SNAP-AIPM-3V (points 3, 7, & 11) 90 |5A | 48 | * Volt/Amps n/a n/a n/a n/a
SNAP-AIPM-3V (points 12 & 13) 184 | B8 | 48 | * True power n/a n/a n/a n/a
SNAP-AIRATE: Rate (Frequency) 69 |45 |69 | 2 Hz 0.0 0.0 25000.0 | 27500.0
fsrzs'?]':g:'s';ATE'HFi: Rate (0.1sdata | g0 | 4g|0g | 2 Hz 2 2 500,000 | 500,000
fsr'e\'sAhE:eAs'sF;ATE'HFi: Rate (1 s data 69 |45 |28 | 2 Hz 20 20 | 500,000 | 500,000
SNAP-AIRTD: 100 Ohm Pt 3-wire 10 [OA| 10| 2 Degrees C -200.0 -200.0 850.0 850.0
SNAP-AIRTD: 100 Ohm Ni 3-wire 46 |2E |10 | 2 | DegreesC | -60.0 -60.0 | 250.0 | 250.0
(S:'(\)'Q';(;An'sge% 0 - 400 Ohms, Lead 15 |oF|10]| 2 Ohms 0 0 400 440
SNAP-AIRTD: 120 Ohm Ni 3-wire 48 |30 |10 | 2 Degrees C -80.0 -80.0 260.0 260.0
SNAP-AIRTD-10: 10 Ohm Cu 3-wire 14 |OE | OE | 2 Degrees C -180.0 -180.0 260.0 260.0
i?ﬁgéﬁg{;lo; 0-250hms, Lead | 15 | or | og | 2 Ohms 0 0 25 275
SNAP-AIRTD-1K: 1000 Ohm Pt 3-wire | 92 | 5C | OF | 2 Degrees C -200.0 -200.0 850.0 850.0
SNAP-AIRTD-1K: 1000 Ohm Ni 3-wire 93 |5D | OF | 2 Degrees C -60.0 -60.0 250.0 250.0
SNAP-AIRTD-1K: 1000 Ohm Ni 3-wire 94 |5E | OF | 2 Degrees F -50.0 -50.0 275.0 275.0
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Part Nu_ml?er& 5 = % % - o
Description é’, i:,, aq:; E % g é)’ % o e
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ig‘ﬁﬁ;ﬁgﬁm 0-40000hms, Lead | 1| oe | o | 5 Ohms 0 0 4000 4400
SNAP-AIRTD-8U: 0-8000 Ohms - Fixed | 155 | 9B | 55 | 8 Ohms 0 0 8000 8800
S@Nfoi'é'RTD'BU: 1000 Ohm Ni 3-wire | 1 o) | g6 | 55 | 8 | Degrees F -46 -46 1489 | 1489
%Ng':éA'RTD'SU: 1000 Ohm Ni3-wire | 101 | g5 | 55 | 8 | DegreesC | -40 -40 135 135
SNAP-AIRTD-8U: 1000 Ohm Pt @ 0 °C |180 | B4 | 55 | 8 | DegreesC | -200 -200 850 850
SNAP-AIRTD-8U: 120 Ohm Ni @ 0°C | 179 | B3 | 55 | 8 | Degrees C -80 -80 260 260
SNAP-AIRTD-8U: 100 Ohm Ni @ 0°C | 178| B2 | 55 | 8 | DegreesC -60 -60 250 250
SNAP-AIRTD-8U: 100 Ohm Pt @ 0°C |177 | B1| 55| 8 | DegreesC | -200 -200 850 850
SNAP-AIRTD-8U: 10 Ohm Cu 176 B0 | 55 | 8 | DegreescC -60 -60 355 355
SNAP-AIRTD-8U: 0-8000 Ohms - Auto | 171| AB | 55 | 8 Ohms 0 0 8000 8800
SNAP-AIRTD-8U: 0-4000 Ohms - Auto | 170 | AA | 55 | 8 Ohms 0 0 4000 4400
SNAP-AIRTD-8U: 0-2000 Ohms - Auto | 169 | A9 | 55 | 8 Ohms 0 0 2000 2200
SNAP-AIRTD-8U: 0-1000 Ohms - Auto | 168 | A8 | 55 | 8 Ohms 0 0 1000 1100
SNAP-AIRTD-8U: 0-800 Ohms - Auto | 167 | A7 | 55 | 8 Ohms 0 0 800 880
SNAP-AIRTD-8U: 0-400 Ohms - Auto | 166 | A6 | 55 | 8 Ohms 0 0 400 440
SNAP-AIRTD-8U: 0-200 Ohms - Auto | 165 | A5 | 55 | 8 Ohms 0 0 200 220
SNAP-AIRTD-8U: 0-100 Ohms - Auto | 164 | A4 | 55 | 8 Ohms 0 0 100 110
SNAP-AIRTD-8U: 0-80 Ohms - Auto | 163| A3 | 55 | 8 Ohms 0 0 80 88
SNAP-AIRTD-8U: 0-40 Ohms - Auto | 162 | A2 | 55 | 8 Ohms 0 0 40 44
SNAP-AIRTD-8U: 0-20 Ohms - Auto | 161| A1 | 55 | 8 Ohms 0 0 20 22
SNAP-AIRTD-8U: 0-10 Ohms - Auto | 160 | A0 | 55 | 8 Ohms 0 0 10 11
SNAP-AIRTD-8U: 0-4000 Ohms - Fixed | 154 | 9A | 55 | 8 Ohms 0 0 4000 4400
SNAP-AIRTD-8U: 0-2000 Ohms - Fixed |153| 99 | 55 | 8 Ohms 0 0 2000 2200
SNAP-AIRTD-8U: 0-1000 Ohms - Fixed |152| 98 | 55 | 8 Ohms 0 0 1000 1100
SNAP-AIRTD-8U: 0-800 Ohms - Fixed |151| 97 | 55 | 8 Ohms 0 0 800 880
SNAP-AIRTD-8U: 0-400 Ohms - Fixed |150| 96 | 55 | 8 Ohms 0 0 400 440
SNAP-AIRTD-8U: 0-200 Ohms - Fixed |149| 95 | 55 | 8 Ohms 0 0 200 220
SNAP-AIRTD-8U: 0-100 Ohms - Fixed |148| 94 | 55 | 8 Ohms 0 0 100 110
SNAP-AIRTD-8U: 0-80 Ohms - Fixed | 147 | 93 | 55 | 8 Ohms 0 0 80 88
SNAP-AIRTD-8U: 0-40 Ohms - Fixed | 146 | 92 | 55 | 8 Ohms 0 0 40 44
SNAP-AIRTD-8U: 0-20 Ohms - Fixed | 145 91 | 55 | 8 Ohms 0 0 20 22
SNAP-AIRTD-8U: 0-10 Ohms - Fixed | 144 | 90 | 55 | 8 Ohms 0 0 10 11
SNAP-AITM: -150 - +150 mV 66 | 42 | 66 | 2 mv -165.0 | -150.0 | 150.0 | 165.0
SNAP-AITM: -75 - +75 mV 68 | 44 | 66 | 2 mv -82.5 -75.0 75.0 825
SNAP-AITM: Type E Thermocouple 19 |13 |66 | 2 Degrees C -270.0 -270.0 1000.0 1000.0
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Part Number & —~ |= % |2
Description 8 |8 |2 |3 |5¢ o
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SNAP-AITM: Type J Thermocouple 5| 5|66 2 Degrees C -210.0 -210.0 1200.0 1200.0
SNAP-AITM: Type K Thermocouple 8| 8 |66| 2 Degrees C -270.0 -270.0 1372.0 1372.0
SNAP-AITM-i: -150 - +150 mV 66 |42 | 20 | 2 mV -165.0 -150.0 150.0 165.0
SNAP-AITM-i: -75 - +75 mV 68 | 44|20 | 2 mv -82.5 -75.0 75.0 82.5
SNAP-AITM-i: Type E Thermocouple 19 {1320 | 2 Degrees C -270.0 -270.0 1000.0 1000.0
SNAP-AITM-i: Type J Thermocouple 5|5]20| 2 Degrees C -210.0 -210.0 1200.0 1200.0
SNAP-AITM-i: Type K Thermocouple 8| 8|20 2 Degrees C -270.0 -270.0 1372.0 1372.0
SNAP-AITM-4i: -150 - +150 mV 66 |42 |32 | 4 mV -165.0 -150.0 150.0 165.0
SNAP-AITM-4i: -75 - +75 mV 68 | 44|32 | 4 mV -82.5 -75.0 75 82.5
SNAP-AITM-4i: -50 - +50 mV 9119 |32]| 4 mv -55.0 -50.0 50.0 55.0
SNAP-AITM-4i: -25 - +25 mV 67 |43 |32 | 4 mv -27.5 -25.0 25.0 27.5
SNAP-AITM-4i: Type B Thermocouple 24 118 |32 | 4 Degrees C 42.0 42.0 1820.0 1820.0
SNAP-AITM-4i: Type C Thermocouple 3220|132 4 Degrees C 0.0 0.0 2320.0 2320.0
SNAP-AITM-4i: Type D Thermocouple 3312132 4 Degrees C 0.0 0.0 2320.0 2320.0
SNAP-AITM-4i: Type E Thermocouple 19 (13|32 | 4 Degrees C -270.0 -270.0 1000.0 1000.0
SNAP-AITM-4i: Type G Thermocouple 31 |1F | 32| 4 Degrees C 0.0 0.0 2320.0 2320.0
SNAP-AITM-4i: Type J Thermocouple 5| 5|32]| 4 Degrees C -210.0 -210.0 1200.0 1200.0
SNAP-AITM-4i: Type K Thermocouple 8|8 (32]| 4 Degrees C -270.0 -270.0 1372.0 1372.0
SNAP-AITM-4i: Type N Thermocouple 30 |1E | 32| 4 Degrees C -270.0 -270.0 1300.0 1300.0
SNAP-AITM-4i: Type R Thermocouple 17 |11 |32 | 4 Degrees C -50.0 -50.0 1768.0 1768.0
SNAP-AITM-4i: Type S Thermocouple 2317|132 | 4 Degrees C -50.0 -50.0 1768.0 1768.0
SNAP-AITM-4i: Type T Thermocouple 18 12|32 | 4 Degrees C -270.0 -270.0 400.0 400.0
SNAP-AITM-8: -75 - +75 mV 68 |44 | 4F | 8 mV -82.5 -75.0 75.0 82.5
SNAP-AITM-8: -50 - +50 mV 91| 9 |4F| 8 mv -55.0 -50.0 50.0 55.0
SNAP-AITM-8: -25 - +25 mV 67 |43 | 4F | 8 mvV -27.5 -25.0 25.0 275
SNAP-AITM-8: Type B Thermocouple 24 | 18 | 4F | 8 Degrees C 42.0 42.0 1820.0 1820.0
SNAP-AITM-8: Type C Thermocouple 32 |20 | 4F | 8 Degrees C 0.0 0.0 2320.0 2320.0
SNAP-AITM-8: Type D Thermocouple 33 |21 |4F | 8 Degrees C 0.0 0.0 2320.0 2320.0
SNAP-AITM-8: Type E Thermocouple 19 |13 | 4F | 8 Degrees C -270.0 -270.0 1000.0 1000.0
SNAP-AITM-8: Type G Thermocouple 31 |1F | 4F | 8 Degrees C 0.0 0.0 2320.0 2320.0
SNAP-AITM-8: Type J Thermocouple 5| 5 |4F | 8 Degrees C -210.0 -210.0 1200.0 1200.0
SNAP-AITM-8: Type K Thermocouple 8| 8 |4F | 8 Degrees C -270.0 -270.0 1372.0 1372.0
SNAP-AITM-8: Type N Thermocouple 30 | 1IE | 4F | 8 Degrees C -270.0 -270.0 1300.0 1300.0
SNAP-AITM-8: Type R Thermocouple 17 |11 | 4F | 8 Degrees C -50.0 -50.0 1768.0 1768.0
SNAP-AITM-8: Type S Thermocouple 23 |17 | 4F | 8 Degrees C -50.0 -50.0 1768.0 1768.0
SNAP-AITM-8: Type T Thermocouple 18 |12 | 4F | 8 Degrees C -270.0 -270.0 400.0 400.0
SNAP-AITM-8-FM: -75 - +75 mV 68 | 44 | 4F | 8 mV -82.5 -75.0 75.0 82.5

PAC Manager User’s Guide




CHAPTER 5: READING AND WRITING TO SPECIFIC DEVICES
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SNAP-AITM-8-FM: -50 - +50 mV 91| 9 |4F | 8 mVv -55.0 -50.0 50.0 55.0
SNAP-AITM-8-FM: -25 - +25 mV 67 | 43 | 4F | 8 mVvV -27.5 -25.0 25.0 27.5
SNAP-AITM-8-FM: Type B Thermocple | 24 | 18 | 4F | 8 Degrees C 42.0 42.0 1820.0 1820.0
SNAP-AITM-8-FM: Type C Thermocple | 32 | 20 | 4F | 8 Degrees C 0.0 0.0 2320.0 2320.0
SNAP-AITM-8-FM: Type D Thermocple | 33 | 21 | 4F | 8 Degrees C 0.0 0.0 2320.0 2320.0
SNAP-AITM-8-FM: Type E Thermocple | 19 | 13 | 4F | 8 Degrees C -270.0 -270.0 1000.0 1000.0
SNAP-AITM-8-FM: Type G Thermocple | 31 | 1F | 4F | 8 Degrees C 0.0 0.0 2320.0 2320.0
SNAP-AITM-8-FM: Type J Thermocple 5| 5 |4F| 8 Degrees C -210.0 -210.0 1200.0 1200.0
SNAP-AITM-8-FM: Type K Thermocple 8| 8 |4F | 8 Degrees C -270.0 -270.0 1372.0 1372.0
SNAP-AITM-8-FM: Type N Thermocple | 30 | 1E | 4F | 8 Degrees C -270.0 -270.0 1300.0 1300.0
SNAP-AITM-8-FM: Type R Thermocple | 17 | 11 | 4F | 8 Degrees C -50.0 -50.0 1768.0 1768.0
SNAP-AITM-8-FM: Type S Thermocple | 23 | 17 | 4F | 8 Degrees C -50.0 -50.0 1768.0 1768.0
SNAP-AITM-8-FM: Type T Thermocple | 18 | 12 | 4F | 8 Degrees C -270.0 -270.0 400.0 400.0
SNAP-AITM2: -50 - +50 mV 919 |09 2 mV -55.0 -50.0 50.0 55.0
SNAP-AITM2: -25 - +25 mV 67 | 43|09 | 2 mV -27.5 -25.0 25.0 27.5
SNAP-AITM2: Type B Thermocouple 24 118|109 | 2 Degrees C 42.0 42.0 1820.0 1820.0
SNAP-AITM2: Type C Thermocouple 32 120 |09 | 2 Degrees C 0.0 0.0 2320.0 2320.0
SNAP-AITM2: Type D Thermocouple 3312109 | 2 Degrees C 0.0 0.0 2320.0 2320.0
SNAP-AITM2: Type G Thermocouple 31 |1F |09 | 2 Degrees C 0.0 0.0 2320.0 2320.0
SNAP-AITM2: Type N Thermocouple 30 |1IE |09 | 2 Degrees C -270.0 -270.0 1300.0 1300.0
SNAP-AITM2: Type R Thermocouple 17 |11 |09 | 2 Degrees C -50.0 -50.0 1768.0 1768.0
SNAP-AITM2: Type S Thermocouple 2317|109 | 2 Degrees C -50.0 -50.0 1768.0 1768.0
SNAP-AITM2: Type T Thermocouple 18 |12 |09 | 2 Degrees C -270.0 -270.0 400.0 400.0
SNAP-AITM2-i: -50 - +50 mV 9|9 |21]| 2 mV -55.0 -50.0 50.0 55.0
SNAP-AITM2-i: -25 - +25 mV 67 43|21 | 2 mvV -27.5 -25.0 25.0 275
SNAP-AITM2-i: Type B Thermocouple 24 118|121 2 Degrees C 42.0 42.0 1820.0 1820.0
SNAP-AITM2-i: Type C Thermocouple 32 120 |21 2 Degrees C 0.0 0.0 2320.0 2320.0
SNAP-AITM2-i: Type D Thermocouple 33|21 |21 2 Degrees C 0.0 0.0 2320.0 2320.0
SNAP-AITM2-i: Type G Thermocouple 31 |1F |21 | 2 Degrees C 0.0 0.0 2320.0 2320.0
SNAP-AITM2-i: Type N Thermocouple 30 |1E| 21| 2 Degrees C -270.0 -270.0 1300.0 1300.0
SNAP-AITM2-i: Type R Thermocouple 17 |11 |21 | 2 Degrees C -50.0 -50.0 1768.0 1768.0
SNAP-AITM2-i: Type S Thermocouple 23|17 |21 2 Degrees C -50.0 -50.0 1768.0 1768.0
SNAP-AITM2-i: Type T Thermocouple 18 |12 |21 | 2 Degrees C -270.0 -270.0 400.0 400.0
SNAP-AIV: -10 - +10 VDC 12 | C |12 | 2 VDC -11.0 -10.0 10.0 11.0
SNAP-AIV: -5 - +5 VDC 11 | B |12 | 2 VDC -55 -5.0 5.0 5.5
SNAP-AIV-i: -10 - +10 VDC 12 | C | 23| 2 VDC -11.0 -10.0 10.0 11.0
SNAP-AIV-i: -5 - +5 VDC 11 | B | 23| 2 VDC -55 -5.0 5.0 5.5
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Part Nu!nt?er & 5 | g % - o
Description é £ Eq:: E g g :E"’ % o o
8|85 |5 (|28 g % 8 ;
2E e |a |22 g g 3 g
2
e o (2|2
SNAP-AIV-4: -10 - +10 VDC 12 | C |41 | 4 VDC -11.0 -10.0 10.0 11.0
SNAP-AIV-4: -5 - +5 VDC 11 | B |41 | 4 VDC -5.5 -5.0 5.0 5.5
SNAP-AIV-8: -10 - +10 VDC 12 | C |4B | 8 VDC -11.0 -10.0 10.0 11.0
SNAP-AIV-8: -5 - +5 VDC 11 | B |4B| 8 VDC -5.5 -5.0 5.0 5.5
SNAP-AIV-32: -10 - +10 VDC 12 | C | 4E | 32 VDC -11.0 -10.0 10.0 11.0
SNAP-AIV-32: -5 - +5 VDC 11 | B |4E | 32 VDC -5.5 -5.0 5.0 55
SNAP-AIV-32-FM: -10 - +10 VDC 12 | C | 4E | 32 VDC -11.0 -10.0 10.0 11.0
SNAP-AIV-32-FM: -5 - +5 VDC 11 | B |4E | 32 VDC -5.5 -5.0 5.0 5.5
SNAP-AIV2-i: -100 - +100 VDC 72 |48 |24 | 2 VvDC -110.0 -100.0 100.0 110.0
SNAP-AIV2-i: -50 - +50 VDC 7314924 2 VDC -55.0 -50.0 50.0 55.0
SNAP-AIVRMS: 0 - 250 VAC/VDC 70 |46 | 70 | 2 VAC/VDC 0.0 0.0 250.0 275.0
SNAP-AIVRMS-i: 0 - 250 VAC/VDC 70 | 46| 28 | 2 VAC/VDC 0.0 0.0 250.0 275.0
SNAP-AIVRMS-i-FM: 0-250 VAC/VDC | 70 | 46 | 28 | 2 VAC/VDC 0.0 0.0 250.0 275.0
SNAP-AIR40K-4: 0 to 40K Ohms 74 |4A | 43 | 4 Ohms 0 0 40,000 44,000
SNAP-AIR40K-4: 0 to 20K Ohms 75 4B | 43 | 4 Ohms 0 0 20,000 22,000
SNAP-AIR40K-4: 0 to 10K Ohms 76 |4C | 43 | 4 Ohms 0 0 10,000 11,000
SNAP-AIR40K-4: 0 to 5K Ohms 77 |4D | 43 | 4 Ohms 0 0 5000 5500
SNAP-AIR400K-8: 0 to 400K Ohms 105|69 | 54 | 8 Ohms 0 0 400,000 | 440,000
SNAP-AIR400K-8: 0 to 400K Autorange |188 |BC | 54 | 8 Ohms 0 0 400,000 | 440,000
SNAP-AIR400K-8: 0 to 200K Ohms 106 | 6A | 54 | 8 Ohms 0 0 200,000 | 220,000
SNAP-AIR400K-8: 0 to 100K Ohms 107|6B | 54 | 8 Ohms 0 0 100,000 | 110,000
SNAP-AIR400K-8: 0 to 50K Ohms 108 |6C | 54 | 8 Ohms 0 0 50,000 55,000
SNAP-AIR400K-8: 0 to 40K Ohms 74 |4A | 54 | 8 Ohms 0 0 40,000 44,000
SNAP-AIR400K-8: 0 to 20K Ohms 75 |4B | 54| 8 Ohms 0 0 20,000 22,000
SNAP-AIR400K-8: 0 to 10K Ohms 76 |4C | 54| 8 Ohms 0 0 10,000 11,000
SNAP-AIR400K-8: 0 to 5K Ohms 77 |4D | 54 | 8 Ohms 0 0 5000 5500
SNAP-AIR400K-8: 0 to 4K Ohms 38 |26 |54 | 8 Ohms 0 0 4000 4400
SNAP-AIR400K-8: 0 to 2K Ohms 39 |27 |54 | 8 Ohms 0 0 2000 2200
SNAP-AIR400K-8: 0 to 1K Ohms 40 | 28 | 54 | 8 Ohms 0 0 1000 1100
SNAP-AIR400K-8: 0 to 500 Ohms 41 |29 (54 | 8 Ohms 0 0 500 550
SNAP-pH/ORP: -1 - +1 VDC 78 |4E | 25 | 2 VDC -1.1 -1.0 1.0 1.1
SNAP-pH/ORP: 0 - 14 pH 79 |4F | 25| 2 pH -1.4 0.0 14.0 15.4
SNAP-pH/ORP: -0.5 - +0.5 VDC 80 |50 | 25| 2 VDC -0.55 -0.5 0.5 0.55
SNAP-PID-V 99 |63 | DO | 4 Percent 0 0 100.0 110.0

* The SNAP-AIPM module monitors one device from point 0 (volts) and point 1 (amps). Points 2 and 3 return calculated val-
ues. The SNAP-AIPM-3 and SNAP-AIPM-3V monitor three phases from points 0,4, & 8 (volts) and points 1,5, & 9 (amps).
All other points return calculated values. See Opto 22 form 1453, the SNAP AIPM Modules Data Sheet, for details.
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Analog Output Modules
Use this data for configuring point types and features (see page 173).

Part Nu_mt?er & s |= E % - o
Description é £ % é % E qg)’ % o e
g 815 a(zE |8 |8 B |t
C 8 e |a|38 |2 O[3 |3 g
5 15|13 |E|58 |5 - = °
o |a (2 |2
SNAP-AOA-3: 4 - 20 mA 131 (83|83 | 1 mA 4.0 4.0 20.0 20.0
SNAP-AOV-5: 0 - 10 VDC 133 (85| 85 | 1 VDC 0.0 0.0 10.0 10.0
SNAP-AOA-23: 4 - 20 mA 163 | A3 | A3 | 2 mA 4.0 4.0 20.0 20.0
SNAP-AOA-23-iISRC: 4 - 20 mA 163 | A3 | B3 | 2 mA 4.0 4.0 20.0 20.0
SNAP-AOA-23-iISRC-FM: 4-20mA | 163 | A3 | B3 | 2 mA 4.0 4.0 20.0 20.0
SNAP-AOA-23-iH: 4 - 20 mA 163 | A3 | AB | 2 mA 4.0 4.0 20.0 20.0
SNAP-AQOV-25: 0 - 10 VDC 165 |A5| A5 | 2 VDC 0.0 0.0 10.0 10.0
SNAP-AQOV-27: -10 - +10 VDC 167 | A7 | A7 | 2 VDC -10.0 -10.0 10.0 10.0
SNAP-AOA-28: 0 - 20 mA 168 | A8 | A8 | 2 mA 0.0 0.0 20.0 20.0
SNAP-AOVA-8: 0 - 5 VDC 144 {90 | CF | 8 VDC 0.0 0.0 5.0 5.0
SNAP-AOVA-8: 0 - 10 VDC 145 |91 | CF | 8 vDC 0.0 0.0 10.0 10.0
SNAP-AOVA-8: -5to +5 VDC 146 |92 | CF | 8 VvDC -5.0 -5.0 5.0 5.0
SNAP-AOVA-8: -10 to +10 VDC 147 |93 | CF | 8 vDC -10.0 -10.0 10.0 10.0
SNAP-AOVA-8: 4 - 20 mA 148 |94 | CF | 8 mA 4.0 4.0 20.0 20.0
SNAP-AOVA-8: 0 - 20 mA 149 |95 | CF | 8 mA 0.0 0.0 20.0 20.0
SNAP-AOD-29: TPO 5 - 60 VDC 169 | A9 | A9 | 2 | percent n/a 0.0 100.0 n/a
SNAP-AOD-29-HFi: TPO 2.5-24 vDC | 131 | 83 | B9 | 2 | percent n/a 0.0 100.0 n/a

Configuring Serial Modules in the Inspect Window

(Not available on SBbrains) Using the Inspect window you can change many previously configured
parameters for a serial module. However, keep in mind that any changes you make in the Inspect
window are sent directly to the controller or /O unit and cannot be saved to a configuration file.
Therefore, you should save the configuration to flash memory. For instructions, see “Saving
Configuration to a Device's Flash Memory”on page 204. To use a configuration file, see “Chapter 2:
Configuring Devices” on page 9.

1. Inthe PAC Manager main window, click the Inspect button @

2. Inthelnspect Opto 22 Device dialog box, type the IP address of the I/O unit (or choose it from
the drop-down list). Click Communications and then click the type of module from the
submenu.

3. Choose the module’s position number from the drop-down list.
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= Inspect Opto 22 Device — X
Device Mame: | 10.192.55.67 LI Options ¥ Status: |5erial Module area last read at 05/04/16 11:32:19
Data for this module is ~Serial Modules
h . th B d Status Read Ve
snown In the window. Serial Module Mumber: I Module 5 is a Serial Module )
Status Write \ _ ad

. Address | Description | Value | Refresh |
WirslessLAN ¥ MODULE INFORMATION
OxFFFF FOCO 0500 Module Type RS232 (0xFO) Apply |
Point Config |

0xFFFF FO3A 7F50 Module Subtype 1 {Revision A)
= 0xFFFF FO3A 7F52 Hardware Revision Date 2003-06-06
Digital Bark | OXFFFFFO3A 7F56  Loader Version R10e
i . 0xFFFF FO3A 7F5A Firmware Yersion Rl1e
Digital Point | PORT A
0xFFFF FO3A 8040 Port Number 22510
MI OXFFFF FO3AB0A4  BaudRate 3600

Analog Point | 0xFFFF FO3A4 B0AB  Parity None
0xFFFF FO3A B0AS  Data Bits 8

High Density | 0xFFFF FO34 B0AA  Stop Bits 1
0XFFFF FO3A 80AB

Lefofe e e s

Hardware Flow Control? Mo
System > | 0xFFFF FO3A B0AC Power-up Test Message? ‘fes
0xFFFF FO3A 8240 EOM Character List Ox 0DOADDOD

ScratchPad | PORTB
0xFFFF FO3A 80B0 Port Number 22511
Data Log 3 | 0xFFFF FO3A 80B4 Baud Rate 9600
0xFFFF FO3A B0B8 Parity

MNone jna

PID 3 0xFFFF FO3A B0BS Data Bits 8 =]

OxFFFF FO3A 80BA Stop Bits 1 =

Events b | O0xFFFFFO3A B0BB  Hardware Flow Contral? No =

L 0xFFFF FO3A 80BC Power-up Test Message? Yes jna
Communications » | 0xFFFF FO3A 82B0 EOM Character List Ox 0DOADOOD

Other >|
Help ™ AutoRefresh | 15000  msec

For help in understanding or changing data, see the following sections:

- "Configuring RS-232 and RS-485/422 Serial Communication Modules”on page 52
- "Configuring Wiegand Modules”on page 56

- "Configuring Profibus Modules”on page 58

- "Configuring SSI (Serial Synchronous Interface) Modules” on page 59

- "Configuring CAN Modules”on page 61

- “Configuring HART Modules” on page 65

Also see Opto 22 form 1191, the SNAP Serial Communication Module User’s Guide.

4, To save configuration to flash memory, see “Saving Configuration to a Device's Flash Memory”
on page 204.

Configuring, Viewing, or Changing PID Loops

For information about PID loops, see “Configuring PID Loops”on page 69. PIDs are normally
configured in a configuration file following the steps on page 71. However, you can also configure,
view, or change them using PAC Manager’s Inspect window. (Remember that changes made here
cannot be saved to a configuration file.)
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1. Inthe PAC Manager main window, click the Inspect button Ql

=] Inspect Opto 22 Device — *
Device Mame: I 10.192.55.67 LI Options » | Status: | Status Read area last read at 07/05/16 13:30:03
~Status Read

Status Read |

Status Write | pooress DESCRIFTION ALTE . Iﬁl

= . OxFFFF FO30 0004  Powerup Clear Flag PUC Needed FUC Received (0)
ml OXFFFF FO30 0008  Busy Flag 0

Paint Config | OxFFFF FO30 0018  Loader Version RS.lc

e — OxFFFF FO30 0000 Memory Map Version 1

'gital Ban | 0xFFFF FO030 0230  Current Boot Device Flash Memory

Digital Point | OxFFFF F030 001C Firmware Version A9.5a

0xFFFF F030 00RO Firmware Version Date 05/03/2016

Analog Bank | 0xFFFF FO030 00BO Firmware Version Time 15:=29z32
Analog Point | 0xFFFF F030 0020 Unit Type 0x00000074

High Density | 0xFFFF FO030 0080 Unit Description SNAP-FAC-R1
0xFFFF F030 0024 I/0 Unit Hardware Revision (Month) 4
0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
EEy ’l 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
Scratch Pad ’l 0xFFFF FO30 024C I/0 Coprocessor Firmware Version A0.0&a
0xFFFF FO030 0028 Installed Ram 33554432

Data Log 3 |

ETHERNET 1 Interface

PID D 0xFFFF F030 002E MAC Lddress 00-A0-3D-01-85-9C
Cvents » 0xFFFF FO30 0034 IF Lddress 10.192.55.67
| 0xFFFF FO30 0038 Subnet Mask 255.255.192.0
Communications ,l 0xFFFF FO30 003C Gateway 10.192.51.51
0xFFFF FO30 0040 DNS 10.192.60.31

Other >| ETHERNET 2 Interface W
Close I Help | I~ AutoRefresh |1snnn msec

If you have used the Inspect button before, the last device name you used is shown and current
Status Read information appears in the window. The most recently used device names are
available in the drop-down list.

2. Inthe Device Name field, type the name (or IP address) of the I/0 unit (or choose it from the
drop-down list). Click PID and choose PID Loops from the submenu.
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= Inspect Opto 22 Device — X
Device Mame: | 10.192.55.67 LI Options Status: | PID Loop area last read at 05/04/16 11:35:31
Information for this PID loop — -
is shown in the window. Statd
‘GID Loop Number: 0 vl )
Status Write |
. Address | Description | Value | ~ Refresh I
M STATUS
0xFFFF F210 0064 Current Value Of Input 0.000000 Apply |
Point Config | 0xFFFF F210 0063 Current Value Of Setpoint 0000000
> 0xFFFF F210 000C Current Value Of Qutput 0.000000
Digital Bank | OxFFFFF210 0008 Current Value Of Feed Forward 0.000000
- N 0xFFFF F210 0000 Last Scanned Value Of Input 0.000000
Digital Point | OxFFFFF210 0004 Lest Scanned Value OF Setpaint 0.000000
0xFFFF F200 0028 Scan Counter 0
MI OXFFFFF200002C  Status Flags 00000000
Analog Point | OxFFFFF200 0030 Status Flags On Mask 00000000
0xFFFF F200 0034 Status Flags Off Mask 00000000
High Density | 0xFFFF F200 0000 Current Value Of Error 0.000000
0xFFFF F200 0004 Current Value Of P (Gain) 0.000000
System » | 0xFFFF F200 0008 Current Value Of I {Integral) 0.000000
0xFFFF F200 000C Current Value Of D {Derivative) 0.000000
ScratchPad ¢ | 0xFFFF F200 0010 Current Value Of Integral 0.000000
TUNING
Datalog | OxFFFFF210 0010 Gain 0,000000
0xFFFF F210 0014 Tune I {Integral) 0.000000
PID 3 0xFFFF F210 0018 Tune D (Derivative) 0.000000
0xFFFF F210 001C Feed Forward Gain 0,000000
Events b | CONFIGLRATION
. 0xFFFF F210 0050 Algorithm MNaone Ikl
Communications ¥ | OxFFFF F210 0054  Mode Automatic e}
| OxFFFF F210 0038 Scan Time (seconds) 1.000000
Other b NwFFFFE F210 Nn4a4 MamMan Addrecs For Tnmut M ANANNANNN &
Help I AutoRefresh | 15000  msec

3. From the drop-down list, choose the PID loop number you want to configure, view, or change.
Existing PID loops are indicated by an asterisk (*) next to the number.

4. To configure or change the PID, click inside the cell in the Value column and type the new value
or choose it from a drop-down list, if one is available. When you have finished making changes,
click Apply to send them to the I/O unit.

NOTE: If you are using PAC Control, it is easiest to tune PID loops in your PAC Control strategy running
in Debug mode. See the PAC Control User’s Guide for more information.

For information on memory map addresses and what they contain, see Opto 22 form 1465,
OptoMMP Protocol Guide.
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Reading and Writing to Points

You can use PAC Manager to read or change I/0 point values. You must configure points before
you can read or write to them.

CAUTION: Ifyou are using PAC Control, reading and writing is normally done in the PAC Control strategy
logic orin Debug mode. If you use the steps in this section to write to an I/O unit, be very careful you do not

interfere with strategy logic.

1. Inthe PAC Manager main window, click the Inspect button @

=] Inspect Opto 22 Device

- x

Device Name: | 10.192.55.67

Status Read
Status Read

Status:

j Options

Status Read area last read at 07/05/16 13:30:03

m RDORESS DESCRIPTION VALUE ~ m
. OxFFFF F030 0004 Powerup Clear Flag PUC Needed PUC Received (0)
wrEEEA D OXFFFF FO30 0008  Buay Flag 0
Paint Canfig 0xFFFF F030 0018 Loader Version RS.1c
- 0xFFFF FO30 0000 Memory Map Version 1
FlEEEs 0xFFFF FO030 0230 Current Boot Device Flash Memory
Digital Point OxFFFF F030 001C Firmware Version L9.5a
OxFFFF FO30 00RO Firmware Version Date 05/03/201%&
Analog Bank OxFFFF F030 00BO Firmware Version Time 15:29:32
Analog Paint 0xFFFF F030 0020 Unit Type 0x00000074
High Density 0xFFFF F030 0080 Unit Description SNLP-PAC-R1
OxFFFF F030 0024 I/0 Unit Hardware Revision (Month) 4
OxFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
System  * OxFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
SaatchPad  » OxFFFF F030 024C I/0 Coprocessor Firmware Version L0.0a
0xFFFF F030 0028 Installed Ram 33554432
Data Log ]
ETHEBNET 1 Interface
PID 4 0xFFFF F030 002E MAC Rddress 00-A0-3D-01-85-9C
0xFFFF F030 0034 IP Address 10.192.55.67
Emis D 0xFFFF FO30 0038 Subnet Mask 255.255.192.0
T el D 0xFFFF F030 003C Gateway 10.192.51.51
0xFFFF FO030 0040 DNS 10.192.60.31
Other 3 ETHERNET 2 Interface v
Close | Help | [~ AutoRefresh | 15000  msec

If you have used the Inspect button before, the last device name you used is shown and current
Status Read information appears in the window. The most recently used device names are

available in the drop-down list.

drop-down list).

In the Device Name field, type the name (or IP address) of the I/O unit (or choose it from the

Click Digital Point or Analog Point, depending on the type of point you want to read or write to.

For digital points, see “Reading and Writing to Digital Points.” For analog points, see page 190.
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Reading and Writing to Digital Points

NOTE: For points on high-density digital modules, you can read or write to individual points using the steps
in this section. To read or write to all points at one time, see "Reading and Writing to SNAP High-Density
Digital Points” on page 198.

Digi

tal Input Points

Here's an example showing a SNAP digital input point. Module position numbers are shown near
the top of the page, with the point numbers for each module listed just below the position number.
For more information on locating modules and points, see “Referencing I/0 Points”on page 171.

Module position number ____

Point numbers for this
module. Point 1 is
currently being read here. —_

To update values, click the
Refresh button.

Since point 1'is an input
point, you canturn counting -
on and off or clear counters _|

=] Inspect Opto 22 Device

Device Name: | 10,192.55.67

Digital Point
Status Read

j Options ¥

Status: | Digital Point area last read at 05/04/16 11:39:56

Step 1: Choose a module
Status Erl’f._E T

[Modue (D) 1 2
Wireless LAN »|

3|4

Step 2: Choose a point on the selected module

5 6 7|8 9 10 11[12 13 14 15 Type:  Dig/none (0x00)

TPomt—f_0 2

3

Point Config

Digital Bank Read Area

3 )4

20 21 22 23

Type:  Digital Input {0x100)
Feature: Mone (0x00)
Mame:  diChipLevelswitch

5 8

24

9 10 11
25 26 27

12 13
28 29

3
30

Address |

Digital Point

Description

| Value

| Refresh

Analog Bank
Analog Point
High Density

System ¥
ScratchPad  »
Data Log 3

PID 3

OxFFFF FO80 0040

OxFFFF FOS0 0044
OxFFFF FO80 0048

OxFFFF FOB0 004C
OxFFFF FO80 0050

Write Area

Events 3
0xF030 0O Counter Off
Communications b

Other 3

and latches.

1.

Close Help

STATUS

Point State

LATCHES
on-Latch
Offiatch

COUNTER
Active
Data

oo

Counter

0xFOS0 0040 Counter On | 0xFO30 0048

0xFOS0 004C

Clear:

m 0xFOFD 0004

On-Latch 0xFOFD 0104

Off-Latch 0xFOFD 0204

[” AutoRefresh | 15000  msec

Click the point number you want to read or write to.

The current values for that point number appear in the Read Area. The Status data at the top
right corner of the window shows the date and time values were last read. The Read Area and
the Write Area change depending upon the point type.

To turn counting on or off or to clear counters and latches, click the buttons in the Counter

State and Clear areas near the bottom of the window. (For more information on these features,
see page 79.)

Your changes are immediately sent to the I/O unit, and the window is updated to reflect your
changes.
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Digital Output Points

The following example shows a digital output point.

é Inspect Opto 22 Device

- *

Device Name: I 10.192.55.67

LI Options ¥

Status: I Digital Point area last written and read at 05/04/16 11:42:36

Status Read |
Status Write |

Wireless LAN  » |

Point Config |
Digital Bank |

r—Digital Point

Step 1: Choose 3 module

Current values for point
1 on this digital output
module.

Click the Refresh button
to update values.

Change point state on

an output pointby — |
clicking a button in the

Write Area.

1.

DigrtarFoit II
Analog Bank |
Analog Point |
High Density |

System 3 |
ScratchPad  » |
Data Log 3 |

PID 3

Ents »

Communications ¥ |
Other 3 |

[Module JOO 1 2 3[4 5 & 7[8 9 10 11]12 13 14 15 Type:  Dig/none (0x00)
Step 2: Choose & point on the selected module - T T E0)
- - ype: igital Ou %
Pant [0 1 2 3[4 5 & 7|8 0 10 11[12 13 3 15 Eiipre: None (0x00)

16 17 13 19|20 21 22 23|24 25 26 27|28 29 30 31 pame:  doDoughDispenseValve
—Read Area
Address | Description | Value | Refresh |
STATUS
0xFFFF FOB0 0140 Point State ON
~Wirite Area
Output Counter Clear:
| p[ Twnon | oxfos0010 | counieron | 0xF030 0148 Counter | 0xFOFD 0014
Turn Off | 0xF090 0144 Counter OFf | 0xF090 014C On-Latch 0xFOF0 0114
Off-Latch 0xFOFD 0214

™ AutoRefresh | 15000 msec

Click the point

number you want to read or write to.

The current values for that point number appear in the Read Area. The Status data at the top
right corner of the window shows the date and time values were last read. The Read Area and

the Write Area change depending upon the point type.

To turn an output point on or off, click a button in the Write Area.

The change is immediately sent to the I/0O unit, and the window is updated.
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Reading and Writing to Analog Points

Analog Input Points

This example shows an analog input point. Module position numbers are shown near the top
of the page, with the point numbers for each module listed just below the position number.
For more on locating modules and points, see “Referencing I/O Points” on page 171.

]| Inspect Opto 22 Device

BN oR =

Device Name: [R1 Controller ~| _options » Status: | Analog Point area last read at 06/11/12 10:24:02
Analog Point
Status Read -
- Step 1: Choose a module
Module position number Status write_ | [edie— 4 5 6 78 8 10 1112 13 13 15 Type:  AICTD (0x04) o
e — Step 2: Choose a point on the selected o 1 ——
Poi a i 2 3 4 5 B8 B8 9 o 11|12 13 14 15 Feature: None (0x00)
. . = 5 17 18 19|20 21 22 23(24 25 26 27|28 29 30 31 g%
Point numbers for this — IS
. Read Area
d le. Poi t1i Digital Bank
modauie. Foin IS — S -y Address | Description | Value | Refresh |
; i | Digitsleir ] OxFFFF FO26 3040 Scaled Units
currently being read here. — 7, ———- DXEFFF FO26 3044 Counts
OxFFFF FO26 3048 Min. Value (Scaled Units)
Analog Point 0xFFFF FO26 304C  Max. Value (Scaled Units)
. OxFFFF FO26 3064 Raw Counts
Click the Refresh button igh Density
Wirite Ares
to update values. System b s Offsct and Gain
3
2EEENrE Min. Value 0xFO1D 490C Step 1: Use a calibrator to input the signal
Data Log » 150.000 corresponding to zero Engineering Units
Max, Value | OxFO1D
PID 3 Step 2:  Calcand Set Offset

Events 3

Communications P

Other i 3

Since point 1is an input/

point, you can clear
minimum and maximum A
values or set offset and gain.

Step 3: Use a calibrator to input the signal
corresponding to the point's maximum nominal value

Step 4 Calc and Set Gain

Two-Point Method

[ Auto Refresh | 15000  msec

The Two-Point Method for Offset

and Gain allows you to enter a

real-world range of values.

1. Click the point number you want to read or write to.

The current values for that point number appear in the Read Area.

information).

Method and follow the steps on page 192.

To clear minimum and maximum values, click the buttons in the Clear area (see page 81 for

To set offset and gain, use the default method (described below), or click the Two-Point

Your changes are immediately sent to the I/O unit, and the window is updated to reflect your

changes.

Calibrating Offset and Gain Using the Default Method

This section describes how to have the offset and gain automatically calculated and set for you.
However, before you begin, see “Calculating Offset and Gain Using the Two-Point Method” on
page 192 for a newer method that is more flexible and easier to use.
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The SNAP PAC I/0 unit can calibrate analog input points. If a -50 mV to +50 mV input receives
signals that are slightly off (not exactly -50 mV at the lowest point, for example), the offset and gain
can be calculated so that values will appear accurately when read.

Offset and gain values affect engineering units (EU). For a temperature input, engineering units are
in degrees C or F, depending on how the I/O unit is configured.

IMPORTANT: To calibrate the point, the /0 unit must be turned on and attached to the network, and
you must have access to it to use the calibrator. For points on a SNAP PAC SB-series brain, connect directly
via serial or through the controller via Ethernet (see page 29 for details).

Save the configuration to flash so that it will not be lost when power is turned off. Since each calibration is
for a specific point on a specific [/0 unit, the result cannot be saved to the configuration file and cannot be
sent to any other I/0 unit.

Calculate offset first, and then calculate gain. The offset must be calculated at the signal
corresponding to zero engineering units (EU), and the gain must be calculated at the signal
corresponding to the point’s maximum nominal value (not its overrange).

1. InInspect mode, click the Analog Point button.
2. (lickthe module and analog input point you want to calibrate.

= Inspect Opto 22 Device EII = I@
Device Name: | R1 Controller ﬂ Options » Status: | Analog Point area last read at 06/11/12 10:24:02
Analog Point

Status Read -

Step 1: Choose a module E |

e [Modue [0 1 2 BEMl # 5 6 78 & 10 11]12 13 14 15 Type: AICTD (0x04) i

Step 2: Choose a point on the selected

2 SLAN ¥ Paint 0 1 2 3% 5 6 7|8 9 0 11]iz 13 1# 15 ¥p=  ICTD(0x0d)
oin = N . Feature: Mone (0x00)

18 17 18 19|20 21 22 23|24 25 26 27|28 29 30 31 Mame:
M d | Point Cgy .
oaule
— Read Area
Digital Bank

Offset and
Gain buttons

P . / R Address | Description ‘ Value | Refresh I
oint Digital Point 0xFFFF FO26 3040 Scaled Units 1 )
Analog Bank 0xFFFF FO26 3044 Counts -
0xFFFF FO26 3048  Min. Value (Scaled Units)
Analog Paint 0xFFFF FO26 304C  Max. Value (Scaled Units)
0xFFFF FO26 3064 Raw Counts
High Density
Write Area
System > Clear: Offset and Gain

ScratchPad  »
L Min. Value Step 1: Use a calibrator to input the signal

Datalog * o corresponding to zero Engineering Units

P e step 2 _Calcand setOffet |
Ewvents » -1.000 Step 3: Use a calibrator to input the signal
corresponding to the point's maximum nominal value
Communications »
Step 4: Calc and Set Gain
Other 3 0.000
Two-Point Method

Help I~ AutoRefresh | 15000 msec

3. Use a calibrator to input the signal corresponding to zero EU on the analog input point (for
example, 0 degrees F or C for a temperature input).

NOTE: On a bipolar module (for example, -10 VDC to +10VDC), the minimum scale is always zero EU,
not a negative number.

4, C(lick the Calc and Set Offset button.
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5. Use the calibrator to input the signal corresponding to the point’s maximum nominal value
(not overrange; not scaled. To find out its maximum nominal value, see the module’s data
sheet).

6. Click the Calc and Set Gain button.

NOTE: To store offset and gain values permanently, you must save the change to flash when you send
the configuration data to the I/0 unit (see page 75).

Calculating Offset and Gain Using the Two-Point Method

You adjust an analog point’s offset and gain to ensure that the measured values are accurate.

Offset is the difference between the minimum input of an analog input point and the actual
minimum signal received from a field device. For example, if a 4-20 mA input receives a minimum
signal that is slightly off (not exactly 4 mA), the difference between the two minimums is the offset.

For example:

[f Minimum Input = 4,000 mA
and Zero-scale Reading = 4.003 mA
then Offset = -0.003 mA

Gain is the ratio of the analog point’s maximum input to the full-scale reading:
Gain = Maximum Input / Full-scale Reading.

For example:

If Maximum Input = 20.00 mA

and Full-scale Reading = 20.50 mA

then Gain = 0.9756097560976

The two-point method for calculating offset and gain gives you a lot of flexibility. It allows you to use
any real-world range of Engineering Units (including negative values) to calculate offset and gain,
not just the zero Engineering Units used by PAC Manager's default method of calibration. Use the
two-point method when it is not convenient or possible to input a signal that equates to either the
zero-scale or nominal full-scale engineering units for a module’s point type. When using the
two-point method, choose two points that are as far apart as possible.

1. Ifitisnt already open, open the Inspect Opto 22 Device dialog box for the point you want to
calibrate (Tools > Inspect | Analog Point button).

2. (lick the Two-Point Method button in the Offset and Gain area in the bottom-right corner of
the Write Area.
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NOTE: You may have to scroll down to see the button.

e T M —an
{:ffset and Gain
{

1 Step 1: Use a calibrator to input the signal

E corresponding to zero Engineering Units
i

Step 2:  Calcand Set Offset

Step 3: Use a calibrator to input the signal
corresponding to the point's maximum nominal value

Step4:  Calcand Set Gain

Two-Point Method j— — Two-Point Method button

™ AutoRefresh | 15000  msec

3. Use a calibrator to input a signal corresponding to the low end of the desired range.

For example, a SNAP-AIV module has a range of =10 to +10 VDG, so you might choose a range
of 1.0to 8.0 if it's convenient. In that case, you would use the calibrator to input a low end of 1.0
VDC on the input point.

NOTE: It is best to choose two points that are as far apart as possible.

4. Note the signal’s value on the calibrator and type this value in the Expected Value field.

Write Area

Low Values

Step 1: Use calibrator to input a
signal corresponding to the low
end of the desired range.

Step 2: Enter the value the
input should return in response |
to this signal.
Expected Value:
Expected Value —+

Step 3: Read the value the
input is currently returning in
response to this signal.

Actual Value:
Read
For best results, choose a low and high point as far apart as possible. Default Method

Read button

5. (lickthe Read button to read the value that the input point is returning in response to this
signal. This value appears in the Actual Value field.

6. Use the calibrator again to input a signal corresponding to the high end of the desired range.
Using the SNAP-AIV example in step 2, for the high end you would use the calibrator to input
8.0VDC on the input point.

7. Type the Expected Value for the high-end value, and then click Read.

Click the Calculate button to calculate the offset and gain.

9. (lick Send Values to send the offset and gain to the device.

o
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10. Save the settings to flash memory to make sure that the data is not lost when power to the
device is turned off. See “Saving Configuration to a Device's Flash Memory”on page 204.

Analog Output Points

The following example shows an analog output point.

= Inspect Opto 22 Device — X
Device Name: | 10,192.55.67 LI Options * | Status: | Analog Point area last read at 05/04/16 11:46:30
— Analeg Paint
Status Read | - A
. Step 1: Choose a module (i) More Info
Status irite | [Modile [0 1T 2 3[4 5 & 7]8 9 10 11]12 13 14 15 Type:  AOV-27 (0xA7)
Wireless LAN ¥ | Step 2: Choose a point on the selected module
Type: +/- 10 VDC Dual ({0xA
Pont | 0 2 3]% 5 5 7]8 5 © ulz B @5 S L o) (s
Point Config | 16 17 18 19|20 21 22 23[24 25 26 27|28 25 30 31  pame: aoConveyorSpeedControl
—Read Area
Digital Bank
%I Address | Description | Value | Refresh I
H S 1 -
Current values for point BigitatPom—] OxFFFF F026 2040 Scaled Units 5.000
0xFFFF FO26 2044  Counts 204,000
1 on module 2. To Analog Bank | OXFFFF FO25 2048 Min. Value (Scaled Units) Nal

. - OxFFFF FO26 204C  Max. Value (Scaled Units) MaN
update values, click the 0xFFFF FO26 2064 Raw Counts -1
Refresh button. High Dersity |
~Write Area
ﬂl Output Values: Clear: Offset and Gain

ScratchPad  # | i .
Qutput Scaled (0xFO2A 2040): Min, Yalue | 0xFO1D 460C Step 1: Use a calibrator to input the signal

ding ko zero Engineeting Units
Datalog 5.000 corresponding g a
Ly _ronly_| Max, Value | 0FO1D 4610
/_Fr I — Step 2: | Calc and Set Offset |
T L ourn F

Change the value on —
an OUtpUt pomt by Events 3 | 204.000 Apply | Step 3: Use a calibrator to input the signal

corresponding to the masdmunm nominal walue

ing the Write Area. —
using the te Area Commurications ¥ | TPO Petiod (0xFO2A 204C): Step4: | Calc and Set Gain |
Other 2 | | 0.00000 apply | ™

Close | Help | ™ Auto Refresh |1qu0 msec

1. Click the point number you want to read or write to.
The current values for that point number appear in the Read Area.

2. Tochange the value of an output point, enter the value in the Write Area (either Scaled or
Counts) and click Apply.

The change is immediately sent to the /O unit, and the window is updated.
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Reading Analog and Digital Banks

You can use PAC Manager to read a bank of points at one time. (Currently it is not possible to write to
a bank of points using PAC Manager.) You must configure points before you can read them.

NOTE: Bank reading cannot be done on digital or analog modules containing more than four points. To
read or write to all points on a high-density digital module, see page 198.

1. Inthe PAC Manager main window, click the Inspect button @

= Inspect Opto 22 Device

- >

Device Name: |10.192.55.67 j Options ¥ Status: | Status Read area last read at 07/05/16 13:30:03
Status Read
Status Read |
e — RDDRESS DESCRIPTION VALUE ~ Refresh |
T 1 b O0xFFFF F030 0004 Powerup Clear Flag PUC Needed PUC Receiwved (0)
Ireless 0xFFFF FO30 0008 Busy Flag 0
Point Config O0xFFFF F030 0018 Loader Version R5.1c
Digital Bank 0xFFFF F030 0000 Memory Map Version 1
gita) Ban 0xFFFF FO30 0230 Current Boot Device Flash Memory
Digital Point O0xFFFF F030 001C Firmware Version L9.5a
OxFFFF FO30 00R0 Firmware Version Date 05/03/2016
Analog Bank 0xFFFF F030 00BO Firmware Version Time 15:29:=37
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A
High Censity 0xFFFF FO030 0080 Unit Description SNAP-PAC-R1
g OxFFFF F030 0024 I/0 Unit Hardware Revision (Month) 4
E— 5 0xFFFF FO30 0025 I1/0 Unit Hardware Revision (Day) 21
ystem 0xFFFF F030 0026 I/0 Unit Hardware Revision (Year) 2008
ScratchPad  * 0xFFFF F030 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432
Data Log 4
ETHERNET 1 Interface
PID b 0xFFFF FO30 002E MAC Address 00-A0-3D-01-85-9C
E— , 0xFFFF FO30 0034 IF Address 10.192.55.67
ven 0xFFFF FO30 0038 Subnet Mask 255.255.192.0
T EE b 0xFFFF FO30 003C Gateway 10.192.51.51
0xFFFF FO30 0040 DNS 10.192.60.31
Other 3 ETHERNET 2 Interface W
Close | Help | ™ Auto Refresh | 15000  msec

If you have used the Inspect button before, the last device name you used is shown and current
Status Read information appears in the window. The most recently used device names are

available in the drop-down list.

drop-down list). Click Digital Bank or Analog Bank.

In the Device Name field, type the name (or IP address) of the I/O unit (or choose it from the
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Digital Bank Window

Values are current as of the Status date
and time. Click Refresh to update values.

| Inspect Opto 22 Device - *
Device Name: | 10.192,55.67 j Options ¥ Status: | Digital Bank area last read at 05/02/16 16:07:34
Digital Bank Read
Status Read
T LDDRESS DESCRIPTION VALUE ~
el . 0xFFFF F040 0000 State of Digital Points  0x00000000 0000000C
UEEEE OxFFFF FO40 0008  State of On-Latches 000000000 00FCCCEA
_ 0xFFFF F040 0010 State of Off-Latches 0x00000000 00FCCCEA
Point Config 0xFFFF F040 0018 Active Counters 0x00000000 00000000
Digital Bank
Digital Point | ADDRESS MODULE ~ POINT  COUNTER VALUE
Analog Bark 0xFFFF F040 0100 0 0 1
= 0xFFFF F040 0104 0 1 0
Analog Point 0xFFFF FO40 0108 0 2 0
: : 0xFFFF F040 010C ] 3 0
Ao 0xFFFF FO40 0110 1 1 0
= 0xFFFF F040 0114 1 5 0
o 0XFFFF FO40 0118 1 6 0
e 0xFFFF F040 011C 1 7 0
0xFFFF F040 0120 2 8 ]
Datalog * 0xFFFF F040 0124 2 9 0
0xFFFF F040 0128 2 10 0
PID * 0xFFFF FO40 012C 2 11 0
e 0xFFFF F040 0130 3 12 0
ot 0xFFFF F040 0134 3 13 0
T 0xFFFF F040 0138 3 14 ]
0xFFFF F040 013C 3 15 0
Other  » 0xFFFF F040 0140 4 16 ] v
2= | iEE ] ™ Auto Refresh | 15000  msec

Remember that values for points on high-density digital modules are not included.

You can copy part or all of the data in this window and paste it into another file, such as a text file or
email. Just highlight what you want to copy, right-click it, and choose Copy from the pop-up menu
(or use Ctrl+C). To highlight all data in the window, right click in the window and choose Select All.

Data Formats. Most digital bank data is in the form of a mask. For example, the State of Digital
Points value shown in the previous figure is this mask:

0x00000000 0000000C

This mask shows, in hex, the state of all 64 possible points (maximum rack of 16 modules with four
points per module). The lowest points are on the right:

Hex:| O 0 0 0 0 0 0 0 0 0 0 0 0 0 0 c
Binary: | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 1100

Points:{ 3-0 | 30 | 30 | 30 | 30| 30 |30 30| 30|30 |30 (30| 30]|30| 30|30

Modules:| 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

In this case, all points are OFF except for points 2 and 3 on the module in position 0, which are ON.
For more help in interpreting bank data, see page 211.

Bank counter data, however, uses unsigned 32-bit integers; for help in interpreting counter data, see
page 211.
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Analog Bank Window

Values are current as of the Status date and
time. Click Refresh to update values.

=] Inspect Opto 22 Device

Device Name: | 10.192.50.15

Status Read |

Status Write
Wireless LAN  » |

Point Config |
Digital Bank |
Digital Point |
Analog Point |
High Density |

System 3 |
Data Log 3 |
PID »
Events 3 |
Communications |
Other 3 |

Close |

| \
- *
LI Options * | Status: I Analog Bank area last read at 05/02/16 16:00:18
—Analog Bank Read
ADDRESS MODULE POINT VALUE ~
0xFFFF FO26 0000 a a 4.000
OxFFFF FO26& 1000 i a 4.000
0xFFFF FO26 2000 2 a 4.000
OxFFFF FO26 2040 2 1 4.000
0xFFFF FO26& 3000 B a 4.000
0xFFFF FO26 3040 ! ¥ 4.000
OxFFFF FO26 4000 4 a 0.000
OxFFFF FO26 4040 4 il 0.000
0xFFFF FO26 5000 5 a 4.000
0xFFFF FO26& 6000 [ a 4.000
0xFFFF FO26 7000 7 a 4.000
OxFFFF FO26& 7040 7 1 4.000
0xFFFF FO26 8000 g a 4.000
0xFFFF FO26& 9000 g a 0.000
OxFFFF FO26 9040 9 i 0.000
0xFFFF FO26 RO00 10 a 4.000
OxFFFF FO26 R040 10 i1 4.000
0xFFFF FO26& BOOO 1¥ a 4.000
0xFFFF FO26 BO40 g lal 15 4.000
0xFFFF FO26& CO00 12 a 4.000
OxFFFF FO26 DOOO 13 a 4.000
0xFFFF FO26 E000 14 a 4.000
0xFFFF FO26 E040 14 i 4.000
0xFFFF FO26 FOOO als a 4.000
OxFFFF FO26 FO40 15 i 4.000 W
iEE | [™ Auto Refresh I 15000  msec

For help in interpreting analog point data, see “IEEE Float Data” on page 213.
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Reading and Writing to SNAP High-Density Digital Points

In PAC Manager, you can read or write to points on high-density digital modules in two ways: one at
a time using the Digital Point button (see page 188), or all at once as shown below.

1. Toread or write to points on high-density digital modules, click the Inspect button @ in the

PAC Manager main window.

2. IntheInspect Opto 22 Device window, type the Device Name (or IP address) of the I/O unit (or
choose it from the drop-down list). Click High Density.

=5 Inspect Opto 22 Device

Device Mame: |FH contraller LJ Optiohs ¥ Statuz: |High Density Digital Module area last read at 10/04/07 13:08:07

High Density Digital Module
Status Fead

Maodule Mumber: _ | Standard Module Type: Digdnone (0=00]
Status Write ‘

Address ] Diescription ] Walue J Refresh
Point Config

Digitdl Bank 4‘
Digital Paint
Analog Bank
Analog Point Paint ] State ] On-Latch Off-Latch Caunter
System »
Secratch Pad  »
Datalog *
PID r
Events r
Communications ¥
Other 3

Cloze Help

3. (lick the module number for the point you want to read or write to.

SNAP High-Density Digital Input

For an input module, the current states and latches appear, both as bitmasks in hex and individually
for each point. Counter values appear in the Counter column.
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=5 Inspect Opto 22 Device

Status Read

Statug wiite ‘

Device Name: |F|1 contraller l] Dptions »

- High Denzity Digital Module

Module Mumber: ~ | High Density Digital Input Module

Statuz: ]ngh Dengity Digital Module area lazst read at 10/04/07 13:14:40

Type: |DC-32 [OxED)

] Walue ] Refrash

Close |

Help ‘

Address ] D'escription
Faint Config STATUS
Digital Bark 0xFFFF F130 8300 m?%ut;gate Mask 0x 00000000 00000000 Sepli
Dicital Paint D«FFFF FIS08308  Onlatoh Mask 0 DAANOA00 . O00A00N
0xFFFF F180 8310 Off-Latch Mask 0 00000000 00000000
Analog Bank
Analog Point ‘ Paint ] State ] OnLatch J Off-Latch ] Counter
. . ] oif Off u] 1]
i eel 1 of o on 0
2 Off Of Of 1]
shfe 3 On On oif B
Scratch Pad  » g SR grf g;; g
B Off On On 1]
13
QDE“‘" Log 7 0k ok Lt o 8|
FID » 8 oif oif o 0
E] On (f Of il
Events 3 10 Off O On 1]
1l On (f Of E
Communications » 12 off Off Off 0
13 O (f Of 1]
Other ¥ 14 0ff lii Off 0
15 Off (f Off a0
16 Of (f Off 1] ]

[& | Ceartntatch

To clear latches for a point, highlight the point number and click the Clear On-Latch or Clear
Off-Latch button. To clear the counter for a point, highlight the point and click the Clear Counter

button.

The change is immediately sent to the I/O unit, and the window is updated.

SNAP High-Density Digital Output

For an output module, the current states appear, as bitmasks in hex and for each point.
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=3 Inspect Opto 22 Device

Device Mame: |F\1 contraller

LJ Optians *
= i High Density Digital Module
tatuz Rea
Module Mumber: ~| High Density Digital Output Module

Status YWrite ‘

Status: |High Density Digital Module area last read at 10/04/07 13:24:24

Type: ODC-32-5RC (0xE1)

] Diescription

] Value ] Refrach

M_J Address e
M 0xFFFF F180 8340 Fuoint State Mask

(O 00000000 000041 CE

#inalog Paint Faint__| State

]: T

High Density 10 g:

2 Off

Supstem » 3 On

4 Off

Scratch Pad  » 5 it
Datalaog » g On

FID » 8 On

9 Off

Events 2 10 Off

1 off

Commurnications ¥ 12 O
13 On

Other LS 14 Off

15 On
18 off

On

Cloze | Help ‘

£

To turn a point on or off, highlight the point number and click the Turn On or Turn Off button.

The change is immediately sent to the I/O unit, and the window is updated.

Reading System Date and Time

SNAP PAC controllers and brains have a real-time clock. A SoftPAC controller uses the computer’s

clock.

1. Toread the date and time on the device, click the Inspect button @ in the PAC Manager

main window.

2. IntheInspect window, type the name of the device (or choose it from the drop-down list).

Click System > Date And Time.
The device's date and time appear.

200

NOTE: Although you can change the date and time by clicking a cell in the Value column and typing
in the new number, then clicking Apply, there is a slight delay before the time is set on the unit. Other
ways of setting time may be more accurate, for example, using PAC Control to synchronize system
date and time. Also see “Setting Up System Date and Time” on page 129 for another method.

Reading and Writing to the Scratch Pad Area

Before using this section, be sure to read “Event/Reaction Concepts”on page 141. You can read the
current state of Scratch Pad bits and current values in Scratch Pad integers, strings, and floats using
PAC Manager. You can also change these values in real time, which can be useful for testing. If you
are running PAC Control, make sure your changes do not conflict with strategy logic.

PAC Manager User's Guide



CHAPTER 5: READING AND WRITING TO SPECIFIC DEVICES

1. Toread or change the Scratch Pad area, click the Inspect button El in the PAC Manager main

window.

2. Inthelnspect Opto 22 Device dialog box, type the IP address of the I/O unit (or choose it from
the drop-down list). Click Scratch Pad and then choose the area you want from the pop-up

menu.

Scratch Pad Bits

The Scratch Pad bits window shows you the current state of the Scratch Pad bits (as of the Status
date and time) and the current On and Off masks. You can change any of these masks by clicking its
cellin the Value column and typing in the new mask, then clicking Apply.

Values are current as of the Status date and
time. Click Refresh to update values.

8 Inspect Opto 22 Device
|

LI Options >|

! -

Status: | Scratch Pad Bits area last read at 05/04/16 1]\-\48:26

Device Name: | 10.192.55.67

Status Read |

rScratch Pad Bits

Status Write

! Wireless LAN  »
| Point Config
| Digital Bank
|
1

_ Satswie_|
_Wrdess L ) |
__Ponteony_|
_ Ogtaltark |

Digital Point |
| Analog Bank |

Analog Point |
__thoensty |
__Spen |
_Sastthpad )|
_ Oaalog |

High Density

System 3
ScratchPad  »

Data Log 3

FID 3

Events 3

| Communications ¥

Other 3

"

Address

| Description

| Value

0xFFFF FODS 0000

0xFFFF FODS 0400
0xFFFF FODS 0408

DIRECT ACCESS
Scratch Pad Bits
MOMO ACCESS
ON Mask
OFF Mask

0x 00000000 00000000

0x 00000000 00000000
0x 00000000 00000000

Close |

Help |

[ Auto Refresh I 15000  msec
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Scratch Pad Integers, Floats, and Strings

Scratch Pad Floats are used as the example here, but integers and strings are similar. Current values
are shown as of the Status date and time. To update values, click Refresh.

Change the valuein the When all new values are
Value column. entered, click Apply.
= Inspect Opto 22 Device - *
Device Name: I 10,192,55.67 LI Optigns ¥ Status: | Scratch Pad Floats area last read at 05/04/16 11:52:52
—Scratch Pad Floats
Status Read |

Status Write | Apply | Address | value |~ Regesh I
Oo OXFFFF FODE 2000 O -
Wireless LAN  » | O: OXFFFF FODS 2004 |
O: OXFFFF FODB 2008
i Clear all
Paint Config | Os OXFFFF FOD 200C |
O 0xFFFF FODS 2010
Digital Bank | Os OxFFFF FODS 2014 Select Al |
Digital Paint | Cls  oxFFFFFODS 2018 Unselect All |
Oz OxFFFF FODS 201C
ml [1s  oOxFFFFFODS 2020
Analog Paint | Os OXFFFF FODB 2024
10 OxFFFF FODS 2023
High Density | [J11  oxFFFF FODS 202C
[0 12 OxFFFFFODS 2030
ﬂl []13  oxFFFFFODS 2034
SeratchPad  » | [J 14  OxFFFF FODB 2038
O s

0xFFFF FODS 203C

Data Log ’l []15  OxFFFF FODS 2040

PID v [0 17  OxFFFF FODB 2044
118 OxFFFF FODS 2043

M 119  OxFFFF FODB 204C
Communications » | [120  0xFFFF FODS 2050
[J21  oxFFFF FODS 2054

M [J22  oxFFFF FODS 2058
o e | [™ Auto Refresh I 15000  msec

(== = R = = = T = N = Y = = T~ = T = = I = = = = I = =)

The Select All and Unselect All buttons control the check marks in the Apply column boxes. The
Clear All button puts all values at zero.

1. Tochange a value in Scratch Pad integers, floats, or strings, click the cell in the Value column
and type the new value.

A checkmark appears in the Apply column box. If you do not want to send a value, click the box
to uncheck it.

2, (lickthe Apply button to write the new values to the Scratch Pad.
All the checked items are changed.
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Choose the event
number from the

drop-down list, ———__|

This event's
configuration data
is shown here.

Paint Config EVENT
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Data Logging

Data logging is normally configured in a configuration file (see page 100), but you can change itin
the Inspect window. Remember that changes made here cannot be saved to a configuration file,
however. To change configuration, with the I/0 unit's IP address in the Inspect window, click Data
Log > Data Logging Configure. For help, see the information in the steps on page 100.

To read the data in a data log you have set up, use PAC Manager's Inspect window. See instructions
on page 102.To clear all data from a data log, see page 103.

Reading or Changing PID Loops
See the steps in “Configuring, Viewing, or Changing PID Loops”on page 184.

Reading or Changing Events and Event Messages

Digital, alarm, serial, timer, and Wiegand events are normally configured in a configuration file. Event
messages are configured in a configuration file if you are using PAC Control; otherwise, they are
configured in the Inspect window. See “Chapter 4: Setting Up Events and Reactions” for
configuration steps on all events and event messages.

However, you can read current events and also change their configuration in the Inspect window.
Digital Events are shown below as an example.

Current status of the event (as of the
Status date and time) is shown here.

=3 Inspect Opto 22 Device

Device Mame: ]SB brain LJ Options » Status: |Expanded Digital Event arg last read at 10/05/07 18:08:27
Digital Events - Expanded
Stafir
Ewvent Mumber: |0 -
Status Wite ‘
Address ] Dlescription Walue | Refresh |

jDigital = OWFFFF FOD4 0D4C  Event Enable/Disable &J
0«FFFF FOD4 0044 Usze which digital data for tigger?

DigitAl Point State
Diigital Pairt OxFFFF FOD4 0000 Digital OM 0 /0000000 00000000
O«FFFF FOD4 0003 Digital OFF 00000000 00000000
Analog Bank 0«FFFF FOD4 0044 Usze which scratch pad data for trigger? cratch Pad Bitz
O«FFFF FOD4 0010 Scratch Pad ON (x 00000000 00000000
Analog Paint OxFFFF FOD4 0018 Scratch Pad OFF (x 00000000 00000000
0«FFFF FOD4 0040 Length of Delay Before Reaction [msec.] 1]
High Drensity
REACTION
Spstem 3 0«FFFF FOD4 0044 Reaction Occurs Continuously
0«FFFF FOD4 0044 Usge which digital data for reaction”? Digital Point State
SoratchPad  » OxFFFF FOD4 0020 Digital OM (x 00000000 00000000
O«FFFF FOD4 0028 Digital OFF 0 00000000 00000000
Datalog » 0x=FFFF FOD4 0044 Use which scratch pad data for feaction? Scratch Pad Bits
FID 3 OxFFFF FOD4 0030 Scratch Pad ON (x 00000000 00000000
O«FFFF FOD4 0038 Scratch Pad OFF (x 00000000 00000000

Events 3
Communications »

CURRENT 5TATUS |4

Refresh

OxFFFF FOD4 004C  Event State off

Other » 0«FFFF FOD4 0048 Time Remaining [mzec. ] 0
0«FFFF FO40 0000 Current Y alue - Digital Point State 0 00000000 00000000
0=FFFF FODE 0000 Current Y alue - Scratch Pad Bits (0= 00000000 00000000

Cloze | Help |
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For help in understanding or changing event data, see these sections:

Event messages:  page 157 Serial events: page 154
Alarm events: page 151 Wiegand events:  page 154

Digital events: page 145

Reading or Changing Communications and Other Data

Other data on the I/0 unit or standalone controller can also be read and changed using PAC
Manager's Inspect window. The following table shows where to find the data in the Inspect window
and references page numbers in this guide for information to help you understand what you are
reading or how to change it:

To read or change Click this in the Inspect window For help, see
Security Communications > Network Security page 90
PPP Communications > PPP page 137
Streaming Communications > Streaming page 117
Email Communications > E-mail page 112
Modbus Communications > Modbus page 125
SNMP Agent Communications > SNMP page 109
Serial ports on brain Communications > Communication Port Control page 131

or controller

In addition, you can read or write to any memory map address by clicking Other > Generic
Read/Write. See the memory map appendix in Opto 22 form 1465, the OptoMMP Protocol Guide, to
make certain you have the correct address before making any changes.

Writing Commands to the Device

204

NOTE: Ifyou are using the PAC Control Redundancy Kit and redundant controllers, do not use PAC Manager
to work with your controllers. Instead, use the PAC Redundancy Manager that comes with PAC Control
Professional (version 9.0 or newver).

Using OptoMMP Device Commands
CAUTION: These hardware commands directly affect the operation or configuration of the device. Be
careful when you use them, as they cannot be undone.

Saving Configuration to a Device’s Flash Memory

Saving configuration data to the controller or I/0 unit's flash memory makes sure that the data is not
lost when power to the device is turned off.
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If you are using a configuration file (as in most of Chapters 2, 3, and 4), you can choose to save
configuration data to flash memory when the file is loaded to the I/O unit. However, if you are
writing configuration directly to the device (as in this chapter), you'll need to follow these steps to
save to flash.

Note that this command saves to flash the things you can configure in PAC Manager. It does not
affect a PAC Control strategy, which is saved to flash via PAC Control or PAC Terminal.

CAUTION: Ifyou are using PAC Manager 9.0 or newer, firmware 9.0 or newer, and loader version 6.0 or
newer, and if a controller has a microSD card installed and the card already contains configuration data,
that data will be overwritten. See the controller user’s guide for complete information about microSD.

1. Inthe PAC Manager main window, click the Inspect button @

2. Inthe Device Name field, type the name (or IP address) of the device, or choose it from the
drop-down list. Click Status Write.

3. Inthe Operation Command list, highlight Store configuration to flash.

=¥ Inspect Opto 22 Device - x
Device Name: \ 10,192,50,11 j Options » Status: | Status Write area last read at 05/02/16 16:30:29
Status Write
Status Read |
Status Write Address | Description ‘ Value ~ | Refresh |
OxFFFF FO38 0004  Always BootP /DHCP On Powerup Mo
Wireless LAN  # OxFFFF FO38 0008 Degrees F/C Degrees F Apply
ireless 0xFFFF FO38 0010 Comm Watchdog Time (msec), 0 = Disable i
OxFFFF FO38 0014 TCP Minimum Retransmission Timeout (msec) 250
Point Config 0xFFFF FO38 0018 TCP Initial Retransmission Timeout {msec) 3000
OxFFFF FO38 001C TCP Retransmission Attempts 5
Digital Bank 0xFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000
= OxFFFF FO38 0294 Digital Feature Scan Interval (msec) 1
Digital Point OXFFFF FO33 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
Analog Bank OxFFFF FO38 0298 Out Of Range Value (16-Bit) -32768.000
9 0xFFFF FO38 02B0  Out Of Range Value (32-Bit) -2147433548.000
Analog Point 0xFFFF FO38 0054 Scanner Flaas 0x 00000000
High Density Pre o)
OptoMMP Device ~  Send Command
System . Restart Device nm pOWerup
Erase configuration from flash k
3
Saatdigad Reset to defaults and Restart Device
> microSD
By Store configuration and IP settings to microSD
Erase configuration and IF settings from microSC
PID 3 y
Erase firmware from microSD
Events » Erase strategy from micraSD
Other
L Switch to loader mode
3
Communications Clear Digital Events - Expanded configuration
Other » Clear Digital Events - Old configuration v
Help ™ AutoRefresh | 15000  msec

4. C(lick Send Command.

The configuration data is stored to flash memory and a Success message appears.

Restarting the Device

Restarting the device is just like turning the power off and then turning it back on again. This
command can be used for both 1/0 units and controllers. For an /0 unit, if configuration data has
not been saved to flash memory, restarting resets points to their defaults.

For some configurations to take effect, the device must be restarted. A SNAP PAC controller must be
restarted after you configure its secondary IP address, for example. For an I/0 unit, if you are using a
configuration file (as in most of Chapters 2, 3, and 4), you can choose to restart the unit when the file
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is loaded to the 1/0 unit and saved to flash memory. However, if you are writing configuration
directly to the I/0 unit (as in this chapter), after you store to flash, you need to follow these steps to

restart it.

1. Inthe PAC Manager main window, click the Inspect button @

2. Inthe Device Name field, type the name (or IP address) of the device, or choose it from the
dropdown list. Click Status Write.

3. Inthe Operation Command list, highlight Restart Device from powerup.

] Inspect Opto 22 Device

x

Device Name: | 10,152,50,11

j Options » Status: | Status Write area last read at 05/02/16 16:30:29

Status Write
Status Read

Status Write
Wireless LAN  »

Point Config
Digital Bank
Digital Point
Analog Bank
Anzlog Point
High Density

System 3
ScratchPad v
Data Log 3
FID 3
Events 3
Communications »
Other 3

OxFFFF FO38 02B0  Qut Of Range Value {32-Bit)
OxFFFF FO38 0054  Scanner Flaas

Operation

OptoMMP Device A~ Send Command
Restart Device from powerup
Store configuration to flash k‘

Erase configuration from flash
Reset to defaults and Restart Device

microsD
Store configuration and IP settings to microSD
Erase configuration and IP settings from microSC
Erase firmware from microSD
Erase strategy from microSD

Other
Switch to loader mode
Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration W

4, C(lick Send Command.

The device is restarted and a Success message appears.

Resetting to Defaults and Restarting

Address | Desdription ‘ Value
OxFFFF FO38 0004  Always BootP/DHCP On Powerup Mo
OxFFFF FO33 0008 Degrees F/C Degrees F
OxFFFF FO38 0010  Comm Watchdog Time (msec), 0 = Disable a

OxFFFF FO38 0014 TCP Minimum Retransmission Timeout (msec) 250
OxFFFF FO38 0018  TCP Initial Retransmission Timeout (msec) 3000
0xFFFF FO33 001C  TCP Retransmission Attempts 5

OxFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000
OxFFFF FO38 0294 Digital Feature Scan Interval (msec) 1

OxFFFF FO38 0050 Max Analog and High Density Digital Scan Interval {msec) 1000
OxFFFF FO38 0298 Out Of Range Value (16-Bit) -32768.000

-2147483648.000
0x 00000000

~ Refresh

Apply

™ AutoRefresh |15000  msec

Resetting the device to defaults erases configuration information from the device’s flash memory. (It
does not erase IP address settings nor PAC Control strategy files in a controller) Resetting also does

the following:

«  Ifthe device has firmware 9.0 or newer and loader 6.0 or newer and a microSD card is present,
erases firmware, strategy, and IP address and configuration data from the card (does not erase

other data files)

«  (lears all point configuration and features, such as offsets and gains, custom scaling, latches,
counters, and minimum/maximum data

«  Turns off digital outputs and defaults all digital points to inputs

«  Setsanalog outputs to zero scale (0 counts)

o Restarts the device

Follow these steps to reset and restart the device:
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1. Inthe PAC Manager main window, click the Inspect button @

2. Inthe Device Name field, type the name (or IP address) of the I/O unit, or choose it from the
dropdown list. Click Status Write.

3. Inthe Operation Command list, highlight Reset to defaults and Restart Device.

x

% Inspect Opto 22 Device -

Device Name: | 10,192,50, 11 ~| Optiors » Status: | Status Write area last read at 05/02/16 16:30:29

Status Write
Status Read
Status Write Address | Description ‘ Value - Refresh

OxFFFF FO38 0004  Always BootP [DHCP On Powerup No -

. OxFFFF FO38 0008 Degrees F/C Degrees F =1 Apply
LA D OXFFFF FO33 0010 Comm Watchdog Time (msec), 0 = Disable 0
OxFFFF FO38 0014  TCP Minimum Retransmission Timeout (msec) 250
Point Config OxFFFF FO38 0018 TCP Initial Retransmission Timeout {msec) 3000
OxFFFF F0O33 001C TCP Retransmission Attempts 5
Digital Bank OxFFFF FO38 0020 TCP Idle Session Timeout (msec), 0 = Disable 240000
. OxFFFF FO38 0294 Digital Feature Scan Interval (msec) 1
Digital Point OxFFFFF038 0050 Max Analog and High Density Digital Scan Interval {msec) 1000
Analog Bank OxFFFF FO38 0298 Out Of Range Value (16-Bit) -32768.000
OxFFFF FO38 02B0  Out Of Range Value (32-Bit) -2147483648.000

Analog Point OxFFFF FO38 0054  Scanner Flaas Ox 00000000
High Density Operation
OptoMMP Device A Send Command
seien »| | Sorceoniasation o feh”
SoatchPad b _ Do
m mias-t?nsr[; configuration and IP settings to microSD

) » Erase configuration and IP settings from microSC
Erase firmware from microSD

Events v Erase strategy from microsSD
Other
-~ Switch to loader mode
L4
M Clear Digital Events - Expanded configuration
Other » Clear Digital Events - Old configuration W

Help I~ AutoRefresh | 15000  msec

4. C(lick Send Command.
The I/0 unit is set to defaults and restarted. A Success message appears.

Sending a Powerup Clear

The powerup clear command clears a flag that indicates the I/O unit has lost and then regained
power. Normally a powerup clear command is automatically sent, so normally you won't need to
use this command. If you receive a powerup clear error message, however, you can use PAC
Manager to send the command. Note that a power loss means that any configuration data not
stored to the I/0 unit’s flash memory has been lost.

1. Inthe PAC Manager main window, click the Inspect button @

In the Device Name field, type the name (or IP address) of the device. Click Status Write.
In the Operation Command list, highlight Send powerup clear.
Click Send Command.

A wWN

The powerup clear is sent, and a Success message appears.
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Using microSD Commands

NOTE: These commands require PAC Manager 9.0 or newer and firmware 9.0 or newer. Use Status Read to
see the firmware version (see “Reading Basic Device Information” on page 162).

SNAP PAC S-series and R-series controllers manufactured from November 2008 to the present have
a microSD card slot that accommodates cards up to 2 GB. These cards can be used to log data, of
course, but they can also be used as a kind of boot disk for the controller, so that you can replace a
failed controller with a new one by simply putting the prepared microSD card into the new
controller, turning the controller on, and connecting it to the network. The new controller boots
from the card and configures itself; you can then use the controller's Reset button to save the data
on the card to flash memory.

Before using the card or any of these commands, be sure to read the section on microSD in the
Maintenance chapter of the controller user's guide. A few steps are repeated here for convenience,
but the user’s guide has the complete information.

Three types of information can be put on the card to use it as a boot disk: firmware, strategy, and
configuration data. Configuration data includes all current configurations (those that can be done in
PAC Manager) plus the controller's IP address and IP settings. The steps below show only how to add
configuration data; see the controller user's guide to add firmware and strategy files.

Putting Configuration Data on the microSD Card

1. Inthe PAC Manager main window, click the Inspect button @ .

2. Inthe Device Name field, type the name (or IP address) of the device, or choose it from the
dropdown list. Click Status Write.

3. Inthe Operation Command list, highlight Store configuration and IP settings to microSD card.

##| Inspect Opto 22 Device — =
Device Name: ‘ 10.182,50.11 j Options » Status: | Status Write area last read at 05/02/16 16:30:29
Status Write
Status Read |
Status Write Address | Description ‘ Value -~ Refresh
OxFFFF FO38 0004  Always BootP /DHCP On Powerup Mo Jid
Wireless LAN  # OxFFFF FO38 0008 Degrees F/C Degrees F =1 Apply
ireless 0xFFFF FO38 0010 Comm Watchdog Time (msec), 0 = Disable i
OxFFFF FO38 0014 TCP Minimum Retransmission Timeout (msec) 250
Point Config 0xFFFF FO38 0018 TCP Initial Retransmission Timeout {msec) 3000
OxFFFF FO38 001C TCP Retransmission Attempts 5
Digital Bank 0xFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000
= OxFFFF FO38 0294 Digital Feature Scan Interval (msec) 1
Digital Point OXFFFF FO33 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
Analog Bank OxFFFF FO38 0298 Out Of Range Value (16-Bit) -32768.000
9 0xFFFF FO38 02B0  Out Of Range Value (32-Bit) -2147433548.000
Analog Point 0xFFFF FO38 0054 Scanner Flaas 0x 00000000
High Density Er=ain
OptoMMP Device A  Send Command
Restart Device from powerup
3
A Store configuration to flash
Erase configuration from flash
3
Saatdigad Reset to defaults and Restart Device
Data Log 3
A ' Erase firmware from microSD
Events » Erase strategy from microSD
Other
L Switch to loader mode
3
Communications Clear Digital Events - Expanded configuration
Other » Clear Digital Events - Old configuration v
Help ™ AutoRefresh | 15000  msec
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4. C(lick Send Command.
The controller's IP settings and all current configuration data are saved to the card.

After you have replaced a controller with a new one by using the microSD card as a boot disk, you
must save the data from the card to the controller’s flash memory, so it will be available in case the
microSD card is removed. Cycling power does not do this. Instead, follow the steps in the
Maintenance chapter (microSD section) of the User's Guide for your controller.

Using Other microSD Card Commands

You can also use the following commands with a microSD card in the controller. These commands
require PAC Manager 9.0 or newer and firmware 9.0 or newer. Read microSD card information in the
controller user's guide before using the card.

1. Inthe Inspect window, type the device’s name or IP in the Device Name field, click Status Write,
and choose the command you need in the Operation Command list:

—  Erase Configuration from microSD—deletes all configuration and IP address data from the
card. Does not delete other data files, firmware, or strategy files on the card.

- FErase Firmware from microSD—deletes firmware on the card, wherever it is located; also
deletes firmware command and response files. Does not delete data files or strategy files.

- FErase Strategy from microSD—deletes only the strategy from the card. Does not delete
data files, IP address and configuration data, or firmware files.

2. C(lick Send Command.

Clearing Configurations and Data Samples

You can use PAC Manager to clear the following configurations: digital events (both old and
expanded), alarm events, email, PID loops, and PPP. You can also clear data in the data log. (Note that
some of these features do not apply to some devices. See the comparison chart on.)

1. Inthe PAC Manager main window, click the Inspect button @ .

2. Inthe Device Name field, type the name (or IP address) of the I/O unit. Click Status Write. In the
Operation Command list, scroll down to see commands listed under Other.
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##] Inspect Opto 22 Device -

~| Optiors »

x

Device Mame: ‘ 10.192.50.11 Status: | Status Write area last read at 05/02/16 16:30:29

Status Write
Status Read

Status Write Address | Description ‘ Value - Refresh

OxFFFF FO38 0004  Always BootP [DHCP On Powerup No =1
Wireless LAN b OxFFFF FO38 0008 Degrees FjC Degrees F Apply

OxFFFF FO38 0010 Comm Watchdog Time (msec), 0 = Disable 1]
OxFFFF FO38 0014  TCP Minimum Retransmission Timeout (msec) 250

Point Config OxFFFF FO38 0018 TCP Initial Retransmission Timeout {msec) 3000
OxFFFF F0O33 001C TCP Retransmission Attempts 5

Digital Bank OxFFFF F038 0020  TCP Ide Session Timeout (msec), 0 = Disable 240000

. OxFFFF FO38 0294 Digital Feature Scan Interval (msec) 1

Digital Point OxFFFFF038 0050 Max Analog and High Density Digital Scan Interval {msec) 1000

Analog Bank OxFFFF FO38 0298 Out Of Range Value (16-Bit) -32768.000
OxFFFF FO38 02B0  Out Of Range Value (32-Bit) -2147483648.000
0xFFFF FO38 0054  Scanner Flaas 0x 00000000 &7

Analog Point
High Density Operation
Store configuration and IP settings to microSD A Send Command
System > Erase configuration and IP settings from microSC
b Erase firmware from microSD
ScratchPad  # Erase strategy from micoSD
th
Data Log 3
PID 3
Events 3
Communications +
Other 4

er

Switch to loader mode

Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration

Clear Alarm Events configuration

Clear PPP configuration

Clear E-mail configuration

Clear PID Loops configuration

Clear Data Logging samples

Send powerup dear w

™ AutoRefresh | 15000  msec

3. (lickthe command you want:

- (lear "Digital Events - Expanded” configuration (Clears digital events in firmware 8.1 and
newer. For firmware 8.0 and older, clears Timers configuration.)

- Clear "Digital Events - Old” configuration (Clears digital events in firmware 8.0 and older)
- (lear Alarm Events configuration

- (lear PPP configuration

—  (Clear E-mail configuration

—  Clear PID Loops configuration

— (lear Data Logging Samples
4. With the command you want highlighted, click Send Command.

The command is sent immediately to the I/O unit, and you see a Success message.

Formatting and Interpreting Data

Data is formatted differently for different addresses in the device’s memory map. Starting memory
map addresses are shown in PAC Manager; for a complete list of memory map addresses, see
Opto 22 form 1465, OptoMMP Protocol Guide.

This section shows how to format and interpret various types of data when you are reading or
writing to @ memory-mapped device.

210 -iNg Manager User's Guide


http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=1875
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=1875
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=1875

CHAPTER 5: READING AND WRITING TO SPECIFIC DEVICES

Mask Data

Some data is in the form of a 32-bit or 64-bit mask—four or eight addresses, each holding eight bits.
Each bit in the mask contains the data for one thing in a group: one point, one module, one Scratch
Pad bit, etc.

For example, most digital bank data (as well as high-density digital module data) is in this form. To
read the state of digital points in a bank, you would read the eight bytes starting at FFFFF0400000.
Here's how the data would be returned:

At address: FFFFF0400000 _— FFFFF0400007

Thesebitnumbers:76543210—’ 7|16(5|4|3|2|1]|0

Show data for these points:| 3 | 2 (1|0 |32 110 — > 3|2(1|0|3|2|1]|0

On SNAP modules in
these positions in the rack:

15 14 — > 1 0

Therefore, at address FFFFF0400000:

This hex data: B 1
Equals this binary data:| 1 0 1 1 0 0 0 1
Showing the states:| On | Off | On | On | Off | Off | Off | On
Of these points:| 3 2 1 0 3 2 1 0

On these modules: 15 14

Data from other addresses marked as masks is formatted in a similar way.

At address: FFFFF0400000 _— > FFFFF0400007
These bitnumbers:| 7 |6 |5 |4 |3 |2|1|0| ——» |7|6|5|4[3|2]|1
Show data for these points:| - | - | - 0 |-~ |-~ |- |0| —————®» ||| -0 |- |-
On G1 or G4 modules in
these positions in the rack: 15 14 ! 0

Unsigned 32-bit Integer Data

Much of the data in the memory map is in the form of unsigned integers, either one byte, two bytes,
or four bytes. With multiple bytes, since the memory-mapped devices use a Big Endian architecture,
the high order byte is in the low order address.

For example, digital bank counter data is in 4-byte unsigned integers. It takes four bytes to contain
the data for one point. To read digital bank counter data for point 0 on module 0, you would start
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with address FFFFF0400100. The following table shows the pattern of bank counter data for the first
few points on a SNAP rack:

odaN®M| sSwoN~NlocoLd N OO0 WL|odNM| W0 O~

o O OO OO0 OO0 OO0 00| 0000 dAdddA| A d d -

Bytes at these dddd| dd dd| dd dd| dd A A A d A A Ao Ao

[oNeoNoNe) [cNoNoNolNoNoNoNolNoloNoNol NololNoNol NolNolNoNoel

addresses: | Q9 Q0| O Q00| Q0000|0000 0O0Q| 0000

| TS| S S| SIS | S S| SIS F| SIS S

[eNelNeNe) OO0 OO0 0000 O00O0| OO0OO0OO0O| OO0 OO
CCLL| || || L E@|—P

LL LWL W |y I Iy I Iy I Iy Y Iy I Iy Y I A A Iy Iy I I Iy Ny [y Yy Iy Iy

OO | b | | Wl DWW W ww

OO || | | DWW | W ww

LL L LWL WL | Iy ¥ Iy I Iy I T Iy Yy Y Iy Y Iy Y ey Iy Y I I Ny Ny [y Yy Iy Iy

Show data for 0 1 2 3 0 1

this point: >

On the module in this 0 1
position on the rack: >

The most significant byte is at the lowest address. For module 0, point 0, for example, you might
receive the following data:

At this address | This binary data Equals this hex data 16 BB 18 87
FFFF FO40 0100 0001 0110 16
FFFF F040 0101 1011 1011 BB
FFFF F040 0102 0001 1000 18
FFFF F040 0103 1000 0111 87

The 32-bit integer for this reading would be 16 BB 18 87 (most significant byte at lowest address).
This hex figure correlates to the decimal value 381,360,263.

Remember that if you are processing this data using a Little Endian computer (such as an

Intel -based PC), you must convert the data from the Big Endian format in order to use it. Little
Endian format is the opposite of Big Endian; Little Endian places the most significant byte at the
highest address.

Digital Point Data (4-Channel Modules)
NOTE: For high-density digital modules, see “Mask Data” on page 211.

For consistency in starting addresses, data for individual digital points has a length of four bytes.
However, only the least significant bit contains the data you're looking for.

For example, to read the state of point 0 on module 0, you would start with address FFFFFO800000.
Data would be returned as follows:

To read this information: Point 0 on Module 0: Point State

Use these addresses:| FFFFF0800000 FFFFF0800001 FFFFF0800002 FFFFF0800003

These bits:| 76543210 76543210 76543210 76543210

Contain this data (binary):] 00000000 000000O0O 00000000 00000001

(hex):| © 0 0 0 0 0 0 1
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T
Ignore these

Point state is ON.

IEEE Float Data

For individual analog points, values, counts, and minimum and maximum values for one point are
located next to each other in the memory map. All are four bytes and are IEEE 754 floats.

For example, individual analog point data for points 0 and 1 on module 0 appears in these

addresses:
Module Point Data Beginning Address Ending Address
Scaled units (E.U.*) FFFF F026 0000 FFFF F026 0003
Counts FFFF FO26 0004 FFFF FO26 0007
0 Minimum value (E.U.*) FFFF F026 0008 FFFF F026 000B
Maximum value (E.U.*) FFFF F026 000C FFFF F026 000F
0 Scaled units (E.U.*) FFFF F026 0040 FFFF F026 0043
Counts FFFF FO026 0044 FFFF FO26 0047
! Minimum value (E.U.*) FFFF F026 0048 FFFF F026 004B
Maximum value (E.U.*) FFFF F026 004C FFFF F026 004F

* Engineering Units

IEEE 754 float format is as follows:

1 bit
X

Sign

8 bits
XXKXXXXX

Exponent

23 bits

L OO0 000.0.00.000.0.00.0.90.0.90.04

Significand

Float calculation: (-1)9" x [1 + Significand/223] x 2 (Bxponent-127)

Example for Opto 22 memory map

At this address:
This hex data:

In these bits:| 31
Equals (in decimal);| 0

Representing:

Decimal

base address

base address + 1

base address + 2

base address + 3

In binary:| 0

41 77 33 33
100 0001 O 111 0111 0011 0011 0011 0011
30...23 22...0
130 7,811,891
Sign Exponent Significand

= 1x[1.931]x8

1)1 +7,811,891/2% x 2 (130-127)

15.45 (rounded to 2 decimal places)

For more information on floats and issues that may arise in their use, see Opto 22 form 1755, Using
Floats Technical Note, available on our website, www.opto22.com.
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Analog Bank Data

Remember that the bank area of the memory map is set up for four points per module. Analog
modules with mare than four points (channels) will show data for points 0-3 only. If the analog
modules you are using have only one or two points, the addresses for the upper two or three points
in each module will contain the following: for output modules, 0; for input modules, FFFFFFFF.

For example, to read all bank analog point values in scaled units, you would read 256 bytes starting
at address FFFFF0600000. Here's how data for two-channel input modules in positions 0 and 1

would appear:

Beginning Address Ending Address Data Format Module Point
FFFF FO60 0000 FFFF F060 0003 four bytes—IEEE float 0
FFFF FO60 0004 FFFF FO60 0007 four bytes—IEEE float 1
FFFF FO60 0008 FFFF FO60 000B FFFFFFFF ° 2
FFFF FO60 000C FFFF FO60 000F FFFFFFFF 3
FFFF FO60 0010 FFFF FO60 0013 four bytes—IEEE float 0
FFFF F060 0014 FFFF FOB0 0017 four bytes—IEEE float 1
FFFF FO60 0018 FFFF FO60 001B FFFFFFFF ! 2
FFFF FO60 001C FFFF FO60 001F FFFFFFFF 3

PAC Manager User's Guide




CHAPTER 5: READING AND WRITING TO SPECIFIC DEVICES

PAC Manager User’s Guide 215



FORMATTING AND INTERPRETING DATA

216 NG Manager User's Guide



CHAPTER 5: READING AND WRITING TO SPECIFIC DEVICES

PAC Manager User’s Guide 217



FORMATTING AND INTERPRETING DATA

218 IiNg Manager User's Guide



6: Maintaining Devices

Introduction

This chapter includes step-by-step procedures for maintaining controllers and brains, including:
«  Viewing and changing IP addresses (below)

«  Loading new firmware (See page 221.To find out the current brain firmware version, see
“Getting Device and Firmware Information—Individual Device”on page 246.)

+  Maintaining files (page 235)
For other maintenance tasks, such as resetting the device to factory defaults or handling a device

whose IP address you don’t know, see the controller or brain user’s guide.

Changing IP Addresses

If you need to change an IP address or subnet mask on an Ethernet-based device, you can do so
using PAC Manager. You must know the current IP address in order to change it. The white sticker on
the device may show the IP address. If not, see the device's user guide for instructions.

1. If PAC Manager isn't already open it, start it as follows:

- InWindows 7 and Windows Vista, press the Windows Start key i
Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

- InWindows 10 and Windows 8.1, press the Windows Start key ks
9.5 and then press the Enter key.

and then click

type PAC Manager
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The PAC Manager main window opens.

ﬂ PAC Manager — O Y
File Tools View Help 4———Menu bar

0|5|d] ¥|%w| R f| @ «——Toolbar

Ready A

2. Inthe menu bar, click Tools > Change IP Settings.

EPACManager —
File Tools View Help

0[c5|@] ¥|%ja) 6 6 o

=8| Change IP Settings for ETHERMET 1

Current IP Address: I . . . Read Current Settings

Port: 2001

Timeout {msec): I 10000

Zhange IF Settings
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3. Inthe Current IP Address field, type the IP address of the device whose address you want to
view or change. Click Read Current Settings to see the current subnet mask, gateway address,
and DNS address.

=5 Change IP Settings for ETHERMET 1 d

Current IP Address: | 0,199, 99 119 Read Current Settings

Port: 2001

Timeout {msec): 10000

New IP Address: l—
Subnet Mask: m
Gateway l—
DNS Address: l—

4. Ifyou wantto change the IP address, subnet mask, or other addresses, enter the new numbers.
Make sure you have typed everything correctly. When everything is correct, click Change IP
Settings.

After you confirm the change, a message appears stating that the change was successful and
that the device will restart. Restarting may take 10 to 20 seconds to complete. When you see
the following indicator, the device is ready for use with its new address:

—  The SNAP-PAC-51's, SNAP-PAC-R1’s, and SNAP-PAC-R1-B's STAT LED shows solid green or
solid orange when viewed from the top (green means a strategy is running; orange means
no strategy is running).

—  The SNAP-PAC-EB1’s or SNAP-PAC-EB2's STAT LED shows solid green.

Remember to write the IP address on the sticker or white area on the device.

Loading New Firmware

All SNAP PAC controllers and brains, and SNAP serial communication modules, contain firmware
(sometimes referred to as the kernel), which is similar to an operating system. If the firmware should
become damaged, or if a new version of the firmware is released, you can load new firmware to the
device using PAC Manager.

In most cases, follow the steps in “Loading Controller and Brain Firmware (Except SB Brains)” on
page 222. However, if the STAT LED on a SNAP PAC controller or brain blinks red slowly three times
after you turn it on or cycle power, the firmware has been damaged. (See the section on Blink Codes
in the device’s user guide.) In this case, follow steps in “Replacing Damaged Firmware” on page 228.

If your SNAP PAC controller has a microSD card slot, you can load firmware from the card. This
method can be easier if the PAC is not networked. For instructions, see the controller user's guide.

To load serial communication module firmware, see page 231.
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Firmware Download Effect on Data in the Device

When you load new firmware to a controller or brain, user files and point configurations that have
been saved to flash memory remain intact. Any data in volatile memory and in battery-backed RAM
is lost, because loading new firmware requires restarting the device.

After you download new firmware to a controller, a strategy that was saved to its flash memory
using older firmware will not run. Firmware versions for the controller and the strategy must match
to avoid conflicts during strategy operation. For more information, see the PAC Control User’s Guide.

Loading Controller and Brain Firmware (Except SB Brains)

These instructions apply to SNAP PAC controllers and EB brains. For an SB brain, see “Loading SB Brain
Firmware”on page 225. NOTE: For a SNAP PAC controller or brain that has damaged firmware (indicated
by three slow red blinks of the STAT LED after powerup), see page 228.

If you are using EB brains in a daisy-chain or multidrop configuration, you can load firmware
to only one brain at a time, because network communication is disrupted when the first brain in the
chain is restarted after its firmware update.

1. Make sure you have the following before beginning:
— Address information for the controller(s) and/or brain(s) that will receive the new firmware.
- Internet access to obtain new firmware from our website.
NOTE: This method of loading firmware uses FTR which cannot get through a firewall in the PC

running PAC Manager. Make sure any firewall in the computer is disabled before you load firmware.
Firewalls in a router should not be a problem.

2. Start PAC Manager:

- InWindows 7 and Windows Vista, press the Windows Start key E and then click
Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

- InWindows 10 and Windows 8.1, press the Windows Start key E type PAC Manager
9.5 and then press the Enter key.

The PAC Manager main window opens.

=8| PAC Manager - O *
File Tools View Help «——Menu bar

D|s|d] ¥|%|s| & Bl @] «——Toolbar

Ready -
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Click the Maintenance button .

## 1/0 Unit Maintenance *
r—Command

Firmware Filenam Get Latest Firmware P Addresses l Add...
Install Module Firmware I J 10.192.50.90
Install 10 Coprocessor Firmware 10.192.55.133 Modify |
Install C-"-\d RTOt CEFﬁTrEJEhE Restart Confirmation Interval (sec) : 10.192.55.67
Download File From IO Unit Rp——
Upload File To /0 Unit [1 10.192.57.187 Delete |
Delete File On IO Unit

Port: Ti t :
Read Filenames On IO Unit or TR (R —
Save Files To Flash 2001 I 1000 |
Read Files From Flash
Clear Flash Files ™ synchronize to PC Time Loa—d---l
Sync 1O Unit to PC Time

Results |

Copy |
Select Al |
Clear Completed Results |

Close | Help |

Make sure Install Firmware is highlighted in the Command list.
Click the blue Get Latest Firmware link.

The link opens your browser and takes you to the Firmware Downloads section of our website,
WWW.0pto22.com.

Choose the firmware for your part number from the list and download it to your PC.
If you have any difficulty obtaining or loading new firmware, contact Opto 22 Product Support.

Click the browse button J and locate the firmware file you downloaded from our website.
Double-click the filename.

The path and filename appear in the Filename field.
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8. Ifthe IP address(es) of the SNAP devices you want to load firmware to appear in the IP
Addresses list, skip to step 10. (Or, if you have previously saved a list of IP addresses, click Load
to load the saved list.) If the address(es) you need don't appear in the list, click Add.

@ Add IP Address *

' Add one IP Address f Host Name

G‘IPAddress:| i.0 . 0.0
" Host Mame: I

" Add a range of IP Addresses

Frarm: I - - -
To: I . - -

9. Enterthe address or a range of consecutive addresses; then click OK.

For EB brains on a daisy-chained network, choose only one address. The address(es) you enter
appear in the I/0 Unit Maintenance dialog box.

10. Inthe I/0 Unit Maintenance dialog box, highlight the IP address(es) to send firmware to.

Firmware file to load IP addresses of devices to
receive firmware file

## 1/0 Unit Maintenance *
—Command v v
Install Firmware Firmware Filenam Get Latest Firmware IP Addresses Add... |
Install Module Firmware S
C: fe skto () e 10.192.50.90
Install IO Coprocessor Firmware I \Dsers!yfemia\Desktoplsnap J 10.192.55.183 Modify |
Install CT:I R(laot Cerﬁf}omhe Restart Confirmation Interval (sec) : 10.192.55.67
Download File From IO Unit Rp——
Upload File To I/0 Unit | 1 10.192.57.187 Del—ehel
Delete File On IO Unit
Port: Ti t :
Read Filenames On IO Unit or TR (R — |
Save Files To Flash I 2001 I 1000
Read Files From Flash
Clear Flash Files ™ synchronize to PC Time Loa—d---l
Sync 1O Unit to PC Time
Results |
Copy |
Select Al |
Clear Completed Results |
Close | Help |

CAUTION: Ifyou enter the wrong IP address, you will erase the current firmware in that device. You
cannot undo the erase. Make certain you have the correct IP addresses and that you want to
download new firmware.
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11. If you have changed the OptoMMP port (see page 90), enter the correct port number. You can
also change the number of seconds PAC Manager will wait before verifying that devices have
restarted.

12. When everything is correct, click Execute.

The file is loaded to the SNAP devices, and progress is shown in the Results area. When the file
is loaded and the devices are restarted, a “Success” message appears.

NOTE: If the download fails on a controller and you have FTP'd files to the controller’s file system, there
might not be enough file space for the new firmware. To check, start PAC Terminal and make sure the
File Space Available is larger than the size of the firmware file.

To start PAC Terminal, follow these steps:

— InWindows 7 and Windows Vista, press the Windows Start key '@—"’ and then click

Programs > Opto 22 > PAC Project 9.5 > Tools > PAC Terminal.

— InWindows 10 and Windows 8.1, press the Windows Start key
9.5 and then press the Enter key.

':--5,.'-"' PAC Terminal

NOTE: Ifthe download fails on EB brains that are daisy-chained, make sure you are updating firmware
ononly one brain at a time. Updating firmware on more than one doesn’t work, because the network
momentarily fails as the first brain is restarted after the update.

Loading SB Brain Firmware
These instructions apply to SNAP PAC SB brains. For other brains and controllers, see page 222.

NOTE: For an SB brain that has damaged firmware (indicated by three slow red blinks of the STAT LED after
powerup), see page 228.

Before beginning, make sure you have an Internet connection to obtain the firmware. Also,
choose how you will connect to the SB brain (for more information, see the brain user's guide):

«  Through the S-series controller—see steps in “Installing SB Firmware Through the Controller,”
below.

«  Directly from the PC to the brain (requires a PCI-AC48 adapter card in the PC)—see “Installing
SB Firmware Directly from PC to Brain”on page 227.

Installing SB Firmware Through the Controller

1. If PAC Manager isn't already open, start it:

- InWindows 7 and Windows Vista, press the Windows Start key _ and then click

Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

- InWindows 10 and Windows 8.1, press the Windows Start key
9.5 and then press the Enter key.

_ PAC Manager
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2. Inthe PAC Manager menu bar, click Tools > Install Firmware via Ethernet,

Install Firmware via Ethernet E

% |nstall Firmware via Ethernet Connection
- SMAP PAC B- and S-zeries controllers
- SMAP PAC EB1, and EBZ brains
- SHAPLUP1-4DS, SHAP-UP1-DE4, and SMNAP-UP1-ME4 brains [firmware wersion 5.0 or newer required)
- SMAP-LCE contraller
- E1 and E2 brainboards

" Install Firrsare via Ethermet Passthrough Connection
- SMAP FPAC 5B1 and SB2 brains

ak. | Cahicel |

3. dlick Install Firmware Through Ethernet Pass-Through Connection and click OK.

Install Firmware via Ethernet Passthrough Connection g|

take zure the Opto 22 device iz connected to an Opto 22 controller through
one of the controller's serial ports.

Contraller

IF; o000 Part: [2001 Timeout, [3000

Serial Port: lm Baud: m v 24fire
Opto 22 Device

Type: [SMAPFACSEZ = | GSeraldddess(0285) [0
Firrnware: File

Get The Latest Firmware

| |

Start Update | | Dane |

4. Inthe Controller section, enter the IP address of the controller. Leave the Port at 2001 unless
you have changed it. Choose the serial port on the controller that the brain is connected to,
and make sure the baud rate matches that on the brain. Change Timeout and 2-Wire if
necessary.

5. Inthe Opto 22 device section, choose the type of SB brain and enter its serial address.
6. Click the blue Get Latest Firmware link.

The link opens your browser and takes you to the Firmware Downloads section of our website,
Wwww.opto22.com.

7. Choose the firmware for your part number from the list and download it to your PC.
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If you have any difficulty obtaining or loading new firmware, contact Opto 22 Product Support.

8. (lick the browse button J and locate the firmware file you just downloaded. Double-click
the filename.

The path and filename appear in the Filename field.
9. When all the fields are correct, click Start Update.

Progress is shown in the lower part of the window. When the process is complete, the device is
ready to use.

Installing SB Firmware Directly from PC to Brain

This method requires a serial connection from the brain to the PC, via an RS-485 converter such as
an Opto 22 PCI-AC48 adapter card.

1. If PAC Manager isn't already open, start it:

- InWindows 7 and Windows Vista, press the Windows Start key _ and then click

Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

- InWindows 10 and Windows 8.1, press the Windows Start key (&) ,type PAC Manager
9.5 and then press the Enter key.

2. Inthe PAC Manager menu bar, click Tools > Install Firmware via Serial Connection.

Install Firmware via Serial Connection

o Install wia BS-485 Connection
- SMAP-PAC-SB1 and SMAP-PAC-S5B2 brains

" Install wia BS-232 Connection

- SMAP-UFP1-AD5, SNAP-UP1-DE4, and SHAP-UF1-ME4 braing
- SMAP-LCE controller
- SNAP-B3000-EMET, SHAPEMET-DE4, and SMAP-EMET-564 brains

ak. | Cahicel
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3.

Click Install via RS-485 Connection.

Install Firmware via R5-485 Connection

tdake sure the DOpto 22 device iz connected to the computer's zenal port via a
zemial cable and an B5-485 adapter such az a PCI-AC48,

Computer

PC Senal Port: | COM1 » | Timeout [miliseconds): |3000
Baud Rate: 115200 -

Opto 22 Device
Type: | SNAP-PACSB1 | Serial Address 0-255): |0

Firmnware File

Get The Latest Firmware

| |

Start Update | | Dore |

In the Computer section, choose the COM port the brain is connected to. Make sure the baud
rate matches that on the brain. Change the Timeout if necessary.

In the Opto 22 Device section, choose the type of SB brain and enter its serial address.
Click the blue Get The Latest Firmware link.

The link opens your browser and takes you to the Firmware Downloads section of our website,
WWW.0pto22.com.

Choose the firmware for your part number from the list and download it to your PC.

If you have any difficulty obtaining or loading new firmware, contact Opto 22 Product Support.

Click the browse button J and locate the firmware file you just downloaded. Double-click
the filename.

The path and filename appear in the Filename field.
When all the fields are correct, click Start Update.

Progress is shown in the lower part of the window. When the process is complete, the device is
ready to use.

Replacing Damaged Firmware

If the STAT LED on a controller or brain blinks red slowly three times after powerup, the firmware in
the device is damaged. (See the section on Blink Codes in the device's user guide for more
information.) Follow these steps to replace the firmware.
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Make sure you have the following before beginning:
- Address information for the controller(s) and/or brain(s) that will receive the new firmware.

— Internet access to obtain new firmware from our website.

Follow instructions in the device's user guide to restart the device in failsafe bootloader mode.
Watch for the blink code to make sure the device is in this mode.

Attach the PC with PAC Manager to the controller or brain using a crossover cable or
“straight-through” Ethernet cable as required:

—  EB-series brains can be connected with either type of cable.

—  Computers with a Gigabit Ethernet network interface controller (NIC) card can use either
type of cable (because the NIC card has the ability to adapt.)

- For R-series and S-series controllers that:

- Have an SD card slot, use a straight-through Ethernet cable.

— Do not have an SD card slot, use a crossover cable.
- For SB-series brains:

—  Connect through the S-series controller;

—  Or connect directly from the PC using a serial cable and a PCI-AC48 adapter card.
For more information on connections, see the device’s user's guide.

If PAC Manager isn't already open, start it:

- InWindows 7 and Windows Vista, press the Windows Start key :5:" and then click

Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

(&)

- InWindows 10 and Windows 8.1, press the Windows Start key &, type PAC Manager
9.5 and then press the Enter key.
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5. Inthe PAC Manager menu bar, click Tools > Install Firmware via Failsafe Bootloader Mode. Click
OK at the message about products it can be used with.

u“" Loader Mode Firmware Update — ¥

Ethernet ]Eﬂ'nernet Pass-Through | Serial Direct]

Use the IP and Subnet of the Ethernet Adapter (NIC) on the computer {not the
Opto 22 device). Make sure the Opto 22 device is in loader mode and
connected to the computer via a cross-over cable,

Computer

IP Address of PC Ethernet NIC: | 0.0 .0 .0

Subnet of PC Ethernet NIC: | o .0 .0 .0
Opto 22 Device

Type: |5NAP-PA(:-R1 j Timeout (miliseconds): W
Firmware File

Get The Latest Firmware

| -

Start Update | Done

6. Choose one:
— Fora SNAP PAC controller or EB brain, click the Ethernet tab and continue with step 7.

- Foran SBbrain, if you're connecting to the brain through the S-series controller, click the
Ethernet Pass-Through tab and skip to step 8.

- Foran SBbrain, if you're connecting serially from the PC to the brain, click the Serial Direct
tab and skip to step 9.

7. Fora controller or EB brain, enter the IP address and subnet of the PC (not the controller or
brain). Choose the controller's or brain’s device type from the drop-down list. Skip to step 10.

8. Foran SB brain using Ethernet Pass-Through, do the following:
- Inthe Controller section, enter the IP address of the controller. Leave the Port at 2001

unless you have changed it. Choose the serial port on the controller that the brain is
connected to, and make sure the baud rate matches that on the brain.

- Inthe Opto 22 device section, choose the type of SB brain and enter its serial address. Skip
to step 10.
9. Foran SB brain using Serial Direct, do the following:

— In the Computer section, choose the COM port the brain is connected to. Make sure the
baud rate matches that on the brain.

- Inthe Opto 22 device section, choose the type of SB brain and enter its serial address. Go
on to step 10.
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Click the blue Get Latest Firmware link.

The link opens your browser and takes you to the Firmware Downloads section of our website,
www.opto22.com.

Choose the firmware for your part number from the list and download it to your PC.
If you have any difficulty obtaining or loading new firmware, contact Opto 22 Product Support.

Click the browse button J and locate the firmware file you just downloaded. Double-click
the filename.

The path and filename appear in the Filename field.
When all the fields are correct, click Start Update.

Progress is shown in the lower part of the window. When the process is complete, either repeat
from step 7 for another device, or click Done.

The device is now ready to use.

Loading Serial Module Firmware

If you have a SNAP PAC /0 unit, you can load new serial module firmware to a SNAP serial
communication module on the I/0 unit.

1.

2.

3.

Make sure you have an Internet connection so you can download the new serial module
firmware file.

If PAC Manager isn't already open, start it:
and then click

- InWindows 7 and Windows Vista, press the Windows Start key (&)
Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

- InWindows 10 and Windows 8.1, press the Windows Start key (&)
9.5 and then press the Enter key.

,type PAC Manager

In the PAC Manager main window, click the Maintenance button .
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4. Inthe Command list, highlight Install Module Firmware.

=5 /0 Unit Maintenance X

Command

Install Firmware Module Firmware | Get Latest Firmware | b oddresses Add...
tall Module . | | 0. 152.50.50

Install IO Coprocessor Firmware 10.192.55. 183 Modify
InstaI: CAd RTot Cerﬁt:ifcahe Module Position: 10' 192' SSIG?
Download File From IO Unit Rp——
Upload File To /0 Unit 10.152.57.187 Delete
Delete File On IO Unit
Read Filenames On IO Unit —
Save Files To Flash
Read Files From Flash
Clear Flash Files Load...
Sync 1O Unit to PC Time

Results

Close | Help |

5. Click the blue Get Latest Firmware link.

The link opens your browser and takes you to the Firmware Downloads section of our website,
Wwww.opto22.com.

6. Choose the firmware for your part number from the list and download it to your PC.

If you have any difficulty obtaining or loading new firmware, contact Opto 22 Product Support.

7. (lick the browse button J and locate the serial module firmware file you just downloaded.
Double-click the filename.
The path and filename appear in the Filename field.

8. Inthe Module Position field, type the serial module’s position on the rack (0-15).

9. InthelIP Addresses list, highlight the IP address of the I/O unit the serial module is on. (If the
correct IP address is not shown, click Add to add it.)

You can load serial module firmware to multiple 1/0 units at the same time, but only if the
modules are in identical positions on all /0 units.

10. Click Execute.

The serial module firmware file is loaded to the I/O unit and then loaded to the serial module,
and a Success message appears in the Results area.

Installing CA Root Certificates

Aninstalled security certificate is required if you want to have secure network communications using
SSL/TLS Internet protocols. A security certificate is a digital tool used by Web browsers and other
network services to validate the identity of the server your computer is connecting to. For example,

232 NG Manager User's Guide



CHAPTER 6: MAINTAINING DEVICES

before you access email or make a payment over an HTTPS Internet connection, the server and your
computer verify their identities by exchanging information about their security certificates. If
something is wrong with the certificates, your browser typically displays a warning that the
connection is not secure.

A CA certificate is a type of security certificate that is issued by a Certificate Authority, which is a
trusted entity (for example, Digicert® and GoDaddy®) that issues legitimate digital security
certificates. A root certificate is a kind of security certificate that ensures the certificate’s authenticity
by identifying the root CA (that is, the original source of the certificate’s verification). Root
certificates use a special kind of cryptography known as public key infrastructure.

PAC firmware R9.5a and higher include two of the most commonly used CA root certificates for
email: Google Gmail™ and Yahoo! Mail®. This means that if you are using PAC firmware R9.5a (or
higher) and PAC Manager R9.5a (or higher), you don't have to install Gmail's or Yahoo! Mail's CA root
certificates. However, to use a SNAP PAC device (as a client) to make a connection to other secure
devices via a TCP communication handle, or to use an HTTPS Get or HTTPS Post communication
handle, you can easily install a CA root certificate using PAC Manager.

Before you can install a CA root certificate, you must:

1. Have a CA root certificate that uses Base64 ASCII format. (Your company’s IT department
should be able to provide this, as they will know the server it needs to match. For example, if
the certificate is for email, it must match the email server.)

- You can tell a certificate file is Base64 ASCll format if:
- The file has a .PEM extension; or
- You open the file in a text editor (such as Notepad) and you see the line:

SNAP PAC controller can accept only one certificate per file. You can tell whether there is only
one certificate in a file by opening the file in a text editor and verifying there is only one line
that says, “=———- BEGIN CERTIFICATE-—--- >

2. Know where to locate the certificate on your network (that is, its path and filename).

Install a CA root certificate

To use these instructions, you must have PAC firmware R9.5a (or higher) and PAC Manager R9.5a (or
higher). If you don't, see page 234.
1. If PAC Manager isn't already open, start it:

- InWindows 7 and Windows Vista, press the Windows Start key ':5:’ and then click
Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

- InWindows 10 and Windows 8.1, press the Windows Start key ':5:’ type PAC Manager
9.5 and then press the Enter key.

El

2. Inthe PAC Manager menu bar, click Maintenance )
3. Inthe Command list, select Install CA Root Certificate.
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4. Click the Browse button | and browse to the location of the certificate. Select the certificate,
and then click OK.

Command

Install Firmware CA Root Certificate Filename: IP Addresses Add...

Install Module Firmware
Install 10 Coprocessor Firmware

|C: \Equifax_Secure_Certificate_a J 10.999,99,920

Modify...
Downloa Fie From 1/6 Unit Port: Timeout (msec) :
ownload File From ni
Upload File To IO Unit 2001 1000 Delete

Delete File On IO Unit

Read Filenames On IO Unit I Restart Device * e

aili

Clear Flash Files *Required for certificates to take effect Load...
Sync 1O Unit to PC Time

Execute
e e R S M —

5. Select the IP address of the SNAP PAC device that you want to install the certificate on.
6. (Optional) Change the Port number and the Timeout value.

7. Select Restart Device, and then click Execute to install the certificate, reboot the device, and
activate the certificate.

Foen il
Z 2001 1000
g ¥ Restart Device =

*Required for certificates to take effect

Repeat steps 3 through 7 if you have additional certificates to install.

Install a CA root certificate (PAC Firmware R9.4c and lower / PAC Manager R9.4c and lower)

To place a root certificate in the /pki/root-certs folder on your controller:
1. If PAC Managerisn't already open, start it:

\

— InWindows 7 and Windows Vista, press the Windows Start key &4, and then click
Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

- InWindows 10 and Windows 8.1, press the Windows Start key (k)
9.5 and then press the Enter key.

type PAC Manager

2. Inthe PAC Manager menu bar, click Maintenance B

3. Inthe Command list, select Upload File To I/0O Unit.
Click the Browse button =/ and browse to the location of the certificate. Select the certificate,
and then click OK.

5. Inthe Destination field, type /pki/root-certs/ and the name you want the certificate to have on
the controller; for example:

/pki/root-certs/Equifax_Secure_Certificate_Authority.cer

234 NG Manager User's Guide



CHAPTER 6: MAINTAINING DEVICES

6. Select the IP address of the SNAP PAC device that you want to install the certificate on.

=5 /0 Unit Maintenance X

Command

Filename:
| C:\Equifax_Secure_Certificate_AL J

Install Firmware

Install Module Firmware

Install 1O Coprocessor Firmware

Install CA Root Certificate

Download File From I/0 Unit
pload 0

Delete File On IO Unit

Read Filenames On IO Unit

Save Files To Flash

Read Files From Flash

Clear Flash Files

Sync 1O Unit to PC Time

g M. = e

IP Addresses Add...

99.999.98.920

Modify...
Destination: b

| fpkifroot-certs Equifax_Secure_Ce

Delete

Save...

Load...

e

7. C(lick Execute.

8. Repeat steps 2-6 if you have additional certificates to install.

9. Select the Save Files To Flash command, and then click Execute.
10. Restart the SNAP PAC device to activate the certificates.

Maintaining Files

The memory in a SNAP PAC controller or brain includes a substantial area available for file storage, as
shown below:

SNAP-PAC-S1 SNAP-PAC-S2
SNAP-PAC-S1-FM SNAP-PAC-S2-W 2.5MB
SNAP-PAC-S1-W
SNAPPACRIS  SNAPPACRZ
SNAP-PAC-R2-FM 2.0 MB

SNAP-PAC-R1-FM

SNAP-PAC-R1-W SNAP-PAC-RZ-W

Limited only by the size of
the hard drive on the com-
puter the software runs on.

SoftPAC

SNAP-PAC-EB1
SNAP-PAC-EB1-FM
SNAP-PAC-EB1-W

SNAP-PAC-EB2
SNAP-PAC-EB2-FM
SNAP-PAC-EB2-W

2.0 MB

In addition, beginning in early 2009, microSD slots were added to S-series and R-series PACs for
removable storage up to 2 GB.

In the file storage area or on a suitable removable disk, you can store any types of files. These files
can be sorted into directories or folders just as they can on a PC, and they are available for use within
a PAC Control strategy or an application you develop. For example, the SNAP device can read the
files, add data to them, and even send data from them via FTP to another device on the network.

For managing general data files on a microSD card, see instructions in the Maintenance
chapter of the controller user's guide. Do not use PAC Manager for general microSD file
management. However, you can use PAC Manager for some functions related to firmware, strategy,
and configuration files on the card. See “Using microSD Commands”on page 208.
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To use PAC Control strategy logic to create and manage files, see “Communication
Commands”in Chapter 10 of Opto 22 form 1700, the PAC Control User’s Guide.

Tools for Managing Files

There are several tools you can use to manage files. You can use FTP software or even Windows
Explorer to move files to and from the device via FTP, and you can use PAC Manager to move and
manage files on the device. Here are some additional details:

+  PAC Control lets you programmatically work with the SNAP PAC controller or 1/0 unit’s file
system, within your control strategy. You can create files and folders on the device and write to,
add data to, or read them; receive file data via FTP; send all or part of the data in a file via FTP,
and more. PAC Control works with one 1/0 unit at a time. A PAC Control strategy can also FTP
files to one or more other I/O units or controllers.

+  PACManager’s main advantage for file management over other commercially available FTP
client software is that it can work with multiple Ethernet devices at once, for example sending
data via FTP to ten I/O units at the same time, or deleting the same file from multiple I/0 units
simultaneously. However, PAC Manager can see only the folders and files at the root of the
device's file system (not the names of files within folders). For this reason, do not use PAC
Manager for working with files on a microSD card in the controller, as all of its files are in a
directory.

«  Newer versions of Windows Explorer can be used for FTP operations with a single controller
or I/0 unit. It's easy to drag and drop files and folders to the device, and you can see the
complete file structure. You may find that data isn't always refreshed correctly.

+  Other FTP software products you can download may be more reliable than Windows
Explorer; they also may give you extra features like communication details, which are useful for
debugging. Some may not support filenames with spaces or other specific characters. They
work with one device at a time.

«  Youcan also use a command prompt for FTP, again with one device at a time.

«  Note that FTP cannot be used through a firewall in the PC. Make sure any firewall in the
computer is disabled before you try to work with files. Firewalls in a router should not be a
problem, however.

Keep the following limitations in mind as you work with files on controllers and 1/0 units:

Maximum length for filenames and directory names 127 characters

All ASCII characters except *, ?, null, and /
Filename characters allowed NOTE: Some FTP client software may not allow
spaces or specific characters.

Path name component separator /

Maximum number of files and directories that can be

: 16
open simultaneously

Limited only by available memory
Maximum directory depth NOTE: PAC Manager reads only the root names;
files within folders are not listed.
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Maximum number of files

Limited only by available memory. Each file uses 516
bytes of overhead plus its number of bytes rounded
up to the nearest multiple of 516 bytes.

Maximum number of directories

Limited only by available memory. Each directory
uses 516 bytes.

Maximum amount of memory available in the
device’s file system

Approximately 2.5 MB on a SNAP PAC S-series, 2
MB on a SNAP PAC R-series or EB brain(varies
slightly depending on the device's firmware version).
Data storage on a SoftPAC controller is limited only
by the size of the hard drive on the computer the
software runs on.

Maximum amount of memory available in removable
storage (per microSD card)

2 GB (available on S-series and R-series PACS)

When using the SNAP device as an FTP server, for example with an FTP client such as CuteFTP, you
can use an anonymous login. The device ignores any user ID or password.

CAUTION: Make sure you save files to flash memory if needed. If power to the controller or [/O unit is turned
off, files are destroyed unless they have been saved to flash. (Does not apply to files in removable storage.)

Moving Files to the SNAP PAC Controller or I/0 Unit

To move files to the SNAP PAC controller or I/0 unit, use any standard FTP client software or
PAC Manager. (Do not use PAC Manager for files on a microSD card.) A maximum of five devices can
FTP files to a SNAP controller or I/0 unit simultaneously.

Follow these steps to move files to the SNAP device using PAC Manager:

1. Start PAC Manager:

- InWindows 7 and Windows Vista, press the Windows Start key _ and then click
Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

- InWindows 10 and Windows 8.1, press the Windows Start key ':5:’ type PAC Manager

9.5 and then press the Enter key.
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The PAC Manager main window opens.

=8| PAC Manager - O *
File Tools View Help

ols]E| #|aal n B o

Ready N
2. C(lick the Maintenance button ll :
## 1/0 Unit Maintenance *
r—Command
Firmware Filenam Get Latest Firmware P Addresses l Add... |
Install Module Firmware I J 10.192.50.90
Install 10 Coprocessor Firmware 10.192.55.133 Modify. |
Install CA Root Certificate Restart Confirmation Interval (sec) : 10.192.55.67
Download File From 1O Unit 10' 132'5' 1a7
Upload File To 1/0 Unit 1 -132.57. Delete |
Delete File On IO Unit . imeout {msec) :
Read Filenames On 10 Unit ROCL e i . Save
Save Files To Flash I 2001 I 1000
Read Files From Flash
Clear Flash Files ™ synchronize to PC Time LI
Sync 1O Unit to PC Time
Results |
Copy |
Select Al |
Clear Completed Results |
Coss | e

3. Inthe Command list, highlight Upload File To I/0 Unit. Click the browse button J and locate
the source file you want to load.
4. Inthe Destination field, type the filename as you want it to appear on the SNAP PAC device.
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The filename can be the same or different from the source filename. You can specify a path on
the device using the separator / For example, to place the file Product Categories.txt into the

folder Products, you would type: Products/Product Categories.txt If the folder does
not exist, it is created.

If the IP address(es) of the device(s) you want to load the file to appear in the IP Addresses list,
skip to step 7. (Or, if you have previously saved a list of IP addresses, click Load to load the saved

list.) If the address(es) you need don't appear in the list, click Add.
=5 Add IP Address *

* Add one IP Address / Host Name
" PAddess:| 8 .0 .0 .0
" Host Name:

" Add arange of IP Addresses

oK | Cancel |

Enter the address or a range of consecutive addresses, then click OK.
The address(es) you entered appear in the I/0 Unit Maintenance dialog box.

Highlight the IP addresses to load the file to.
Click Execute.
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The file is loaded to the I/0 units, and a Success message appears in the Results area.

File to upload (source)
Highlighted IP addresses

Path and filename ) L
will receive file

on I/0 unit(s)

=5 /0 Unit Maintenance X
Command
Install Firmware Filename: IP Addresses Add...
Install Module Firmware S
C: e ktoy o 10.192.50.90
Install IO Coprocessor Firmware | WsersifemiaiDesktop prody J 10,192.55. 183 Modify
Install CA Root Certificate Destination: 10' 192' 55'6? -
Download File F I/0 Unit ! e
ﬁﬁ&ﬁg&m_ | Products/Product Categories. t 10,192.57.187 Delete
Delete File On IO Unit
Read Filenames On IO Unit —
Save Files To Flash
Read Files From Flash
Clear Flash Files Load...
Sync 1O Unit to PC Time
Results
Upload File To IfO Unit
10.192.55.67 - Success
Select All
Clear Completed Results
Close Help

Moving Files from the SNAP PAC Controller or I/0 Unit

To move files from the SNAPPAC controller or I/0 unit, use any standard FTP client software or
PAC Manager (do not use PAC Manager for files on a microSD card), or use the FTP communication
handle in a PAC Control strategy. (In PAC Control, a maximum of 16 communication handles can be
used simultaneously to FTP files. See “Communication Commands”in Chapter 10 of the PAC Control
User’s Guide for more information.)

Here's how to move files from the device using PAC Manager:

1. Inthe PAC Manager main window, click the Maintenance button .
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In the Command list, highlight Download File From I/0 Unit.

=5 /0 Unit Maintenance X
Command
Install Firmware Filename: IP Addresses Add...
Install Module Firmware ) | 10.192.50.90
Install IO Coprocessor Firmware 10.192.55.183 Modify...

Install CA Root Certificate Destination: 10.192.55.67
Download File From 1jQ Unit ! '

Upload File To 1j0 Unit | o] [w19257.187 Delete
Delete File On IO Unit
Read Filenames On IO Unit
Save Files To Flash

Read Files From Flash

Clear Flash Files

Sync 1O Unit to PC Time

Save...

Load...

aali

Results
Select All
Clear Completed Results
Close | Help |

In the Filename field, enter the filename (and path, if any) of the file on the controller or I/0
unit.

For example: Products/Product Categories.txt

In the Destination field, enter the path and filename where you want the file to go (or click the

browse button J to locate the path, then type in the filename).

The filename can be the same or different from the source filename.

In the IP Addresses list, highlight the IP address of the SNAP PAC device you are downloading
the file from. (If it does not appear, click Add to add it to the list.)

Click Execute.

The file is loaded from the device, and a Success message appears in the Results area.

Reading Filenames

You can use PAC Manager to read and list the names of all files and folders in the root of the
controller or I/0 unit. Note that files located inside folders (or folders inside folders) are not listed,
even though they are there. PAC Manager will not show any files on a microSD card. You can use a
standard FTP software program to see them.

1.

2.
3.

In the PAC Manager main window, click the Maintenance button .

In the Command list, highlight Read Filenames On I/0 Unit.

In the IP Addresses list, highlight the IP address of the SNAP PAC device you are reading. (If it
does not appear, click Add to add it to the list.)

Click Execute.
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All root-level files and
folders on the device
with the IP address
10.192.55.67.

Folders are

designated as <DIR>.

The list of root file and folder names appears in the Results area.

=5 /0 Unit Maintenance X

Command

Install Firmware IP Addresses Add...

Install Module Firmware 10.192.50.90

Install IO Coprocessor Firmware "
Install CA Root Certificate ;g' ;gi' 22'33 e
Download File From 1O Unit IDI 192' 5?' 187

Upload File To 1/0 Unit -132.57. Delete
Delete File On IO Unit
Read Filenames On 10 Unit
Save Files To Flash

Read Files From Flash

Clear Flash Files Load...
Sync 1O Unit to PC Time

Save...

aali

Results

Read Filenames On IO Unit

0,192.55.67 - Succe:

Success
Products, <DIR.=, 2016/07/01 09:54:00 Select All
Clear Completed Results

Close | Help |

The listing shows the file or folder name, the file's size in bytes (or <DIR> for folders), and the
date and time it was placed there (in the format YYYY/MM/DD hh:mm:ss).

Deleting a File from a SNAP PAC Controller or I/0 Unit

You can also use PAC Manager to delete a file from one device or from several devices at once. (You
cannot use it to delete files on a microSD card.)

1. Inthe PAC Manager main window, click the Maintenance button .

2. Inthe Command list, highlight Delete File On I/O Unit.
3. Inthe Filename field, type the filename (and path, if any) of the file you want to delete.
For example: Products/Product Categories.txt

4. InthelP Addresses list, highlight the IP address(es) of the SNAP PAC device(s) you are deleting
the file from. (If the correct IP addresses are not shown, click Add to add an address or group of
addresses, or if you have saved a list of IP addresses, click Load to load the saved list.)

5. Click Execute.

The file is deleted and a Success message appears in the Results area.
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Using Flash Memory with the File System

You can use PAC Manager to move files between the controller or I/0 unit's file system and its flash
memory, which stores files so they are not lost if the device loses power. Remember that flash
memory is smaller than the memory available for file storage; check the controller's or /O unit’s data
sheet for details. (You cannot use PAC Manager with files on a microSD card.)

You can do any of the following on one or multiple devices:

«  Save all files in the file system to flash memory

+  Clearallfile system files from flash memory (does not affect firmware, strategy files, or point

configuration data)

+  lLoad files from flash memory into the device's file system, replacing all files in the file system

Follow these steps:

1. Inthe PAC Manager main window, click the Maintenance button .

2. Inthe Command list, highlight the command you want to use.

In the following example, Save Files To Flash is highlighted.

= 1/0 Unit Maintenance

Command

Install Firmware

Install Module Firmware

Install IO Coprocessor Firmware
Install CA Root Certificate
Download File From 1O Unit
Upload File To I/O Unit

Delete File On IO Unit

Read Filenames On Ii'O Unit
Save Files To Flash

Read Files From Flash

Clear Flash Files

Sync 1O Unit to PC Time

IP Addresses Ad

10.192.50.90
10.192,55.183

10.192.55.67
10.192.57.187 Delete

Save...

il

Load...

Results

Close | Help |

3. InthelP Addresses list, highlight the IP address(es) of the device(s) you want the command to
apply to. (If the correct IP addresses are not shown, click Add to add an address or group of
addresses, or if you have saved a list of IP addresses, click Load to load the saved list.)

CAUTION: Make sure you have chosen the correct command and the devices you want to affect. You

cannot undo these commands.

4. C(lick Execute.

The command is executed and a Success message appears in the Results area.
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7: Troubleshooting

Introduction

If you are having difficulty using PAC Manager, here are some suggestions that may help. In addition,
make sure to check the Troubleshooting section in the device’s user’s guide. If you cannot find the
answers you need in these guides, contact Opto 22 Product Support. For contact information, see
page 5.

PAC Manager Error Messages

When you send configurations to I/0 units in PAC Manager, you may see the following messages in
the lower part of the Send Configuration to I/0 Unit dialog box:

Message Notes
Could not open I/O unit: [IP address] or Timeout error. Check basic communication with the
An error occurred while connecting to /O Unit device (See the Troubleshooting appendix in the device’'s
[IP address]. user guide for help).
[number] points successfully configured. Success message.

Could not configure digital module [number], point

[number]. Check the point to make sure it's correct for the module

type installed.

Could not configure analog module [number], point
[number].

Module [name] exists at position [number] but was | Check configuration; an analog module is at this position

not configured but no points have been configured on it yet.

Could not configure temperature. These configurations apply to the 1/0 unit as a whole, not
to individual points. Contact Product Support for help.

Could not configure watchdog. (See page 5.)

Save to Flash—Operation Failed.

Clear Flash on I/0O Unit: [name of unit}—Operation Contact Product Support. (See page 5.)

Failed.

PAC Manager successfully connected to the device but
could not send it a PUC. Check cables and communica-
tion.

Communication could not be established with the
restarted 1/0 Unit
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Trouble Connecting to the I/O Unit or Controller

See the Troubleshooting section in the user’s guide for your device:

o SNAP PAC S-series—form #1592, the SNAP PAC S-Series Controller User's Guide
o SNAP-PAC R-series—form #1595, the SNAP PAC R-Series Controller User's Guide
«  SNAP PAC EB and SB brains—form #1690, the SNAP PAC Brains User’s Guide

Using PAC Manager to Troubleshoot Problems

PAC Manager can be useful in troubleshooting problems with 1/0 units and controllers. Before
calling Opto 22 Product Support, you can use PAC Manager to get device and firmware information
and view diagnostic messages. To help with communication problems, you can change TCP
settings. You can also check for Ethernet errors, which indicate network problems.

Getting Device and Firmware Information—Individual Device
These steps provide information for one device at a time. To get information on all devices on the
Ethernet network at once, see page 248.

If you need to contact Opto 22 Product Support for assistance in using an 1/0 unit or controller, it is
helpful to have device and firmware information at hand before you call us.

1. Start PAC Manager as follows:

- InWindows 7 and Windows Vista, press the Windows Start key, and then click Programs >
Opto 22 > PAC Project 9.5 > PAC Manager.

- InWindows 10 and Windows 8.1, press the Windows Start key, type PAC Manager 9.5
and then press the Enter key.

2. Inthe PAC Manager main window, click the Inspect button @

3. Inthe Device Name field, type the name (or IP address) of the device. Click Status Read.

This example shows a SNAP-PAC-S1; other devices are similar.
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é Inspect Opto 22 Device

Device Name: | 10.192.50.20

LI Options » Status: | Status Read area last read at 07/05/16 13:42:15

Status Read
Status Read I

Status Write | hDDRESS

DESCRIFTION

VALUE

| R 0xFFFF FO30 0004
alE | 0XFFFF FO30 0008
Point Config | 0xFFFF FO30 0018
= 0xFFFF FO30 0000
TEEELE 0xFFFF FO30 0230
Digital Paint | 0xFFFF FO30 001C
0xFFFF FO30 00RO

Analog Bank | 0xFFFF FO30 00BO
Analog Point | 0xFFFF F030 0020

i ] 0xFFFF FO30 0080
haoh. Ceristy 0xFFEF FO30 0024

R 0xFFFF FO30 0025

T | 0xFFEF FO30 0026
i ,l 0xFFFF FO30 024C
0xFFFF FO30 0028

Data Log 3 |
FID > 0xFFFF F030 002E
cers 0XFFFF FO30 0034
ven | 0xFFFF FO30 0038
e ,l 0xFFFF FO30 003C
0xFFFF FO30 0040

Other 3 |

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year)
I1/0 Coprocessor Firmware Version
Installed Ram

ETHERNET 1 Interface
MAC Address
IF Rddress
Subnet Mask
Gateway
DNS

ETHERNET 2 Interface

PUOC Receiwed (0)
[u]

R6.0a

1

Flash Memory
R9.5a
07/05/2016
07:58:52

0x0000007C
SHAP-PAC-51

00-A0-3D-01-48-FB
10.192.50.20
255.255.192.0
10.192.51.50
10.192.60.91

- Refresh I

Close | Help |

[~ Auto Refresh I 15000  msec

Keep this window open on your screen when you call Product Support.

NOTE: Because the Status Read area is used for both standalone controllers and /0 units, some items
apply to some devices and not others. The following items do not apply to standalone controllers:

Degrees F/C

Comm Watchdog Time (msec.)
Scanner Flags

4-Channel Digital Scan Count

Analog & High Density Dig Scan Count

Smart Modules Present

PID Loops Supported

Digital Modules Supported

Arcnet data

Digital resets and interrupt failures since powerup

Module X - Times Discovered

For help in interpreting Status Read data, see page 165.

Analog and Digital Scanners (msec per scan)
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Viewing Diagnostic Messages

An exclamation mark button sometimes appears in the Status Read area to help you diagnose
problems. When you click the button, diagnostic messages appear—for example, letting you know
that a port has been set to a different value or a scanner has been turned off.

Exclamation mark button

Inspect Opto 22 Device - *
P P

Device Name: |1o.192.55.s? j Options ¥ Status: | Status Read area last read at 07/01/16 12\8:04
Status Read
Status Read |
e ADDRESS DESCRIPTION VALUE = Refresh
T 5 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
Wireless LAN 0xFFFF F030 0008 Busy Flag 0
Point Config 0xFFFF F030 0018 Loader Version B5.1c

Digital Bark 0xFFFF FO30 0000 Memory Map Version 1

0xFFFF F030 0230 Current Boot Device Flash Memory
Digital Point O0xFFFF FO30 001C Firmware Version A9.5a

0xFFFF FO30 00R0 Firmware Version Date 05/03/2016

Analog Bank 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A

High Density 0xFFFF FO30 0080 Unit Deacription SHNAE-FAC-R1
0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
Hegw D 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
ScratchPad ¥ 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432
Data Log 3
ETHERNET 1 Interface
PID * 0xFFFF FO30 002E MAC Rddress 00-A0-30-01-85-9C
F— . 0xFFFF FO30 0034 IF Rddress 10.192.55.67
0xFFFF FO30 0038 Subnet Mask 255.255.192.0
oo P 0xFFFF FO30 003C Gateway 10.192.51.51
0xFFFF FO30 0040 DHS 10.192.60.31
Other 3 ETHERNET 2 Interface W
Close | Help | [~ AutoRefresh | 15000  msec

If you see the button, click it and read the diagnostic messages. They may help you solve problems
or provide useful information when you call Product Support.

Getting Device and Firmware Information—Multiple Devices

You can get device type, IP address, and firmware information for all Opto 22 Ethernet-based
devices on one network, all at one time. This method is especially useful for making sure firmware is
up to date on all devices. Note that SNAP PAC SB brains are not included, since they are on a serial,
not an Ethernet, network.

1. If PAC Manager isn't already open, start it:

— InWindows 7 and Windows Vista, press the Windows Start key & ,and then click

Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

)

— InWindows 10 and Windows 8.1, press the Windows Start key &
9.5 and then press the Enter key.

type PAC Manager
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2. Inthe PAC Manager menu bar, click Tools > Find Opto 22 MMP Devices.

| Find Opto 22 MMP Devices

MMP Port;

2001

Timeout; | 3000 ms

=8O =55
Devices Found: 0

MAL Address | IP Addiess

| Firrnware: | Unit Type |

Find |

Help

3. (lickFind.

PAC Manager discovers all Ethernet-based Opto 22 memory-mapped devices on the network
and lists their MAC addresses, IP addresses, firmware versions, and unit types.

| Find Opto 22 MMP Devices o -E | ]
MMP Port: | 2001 Timeout: | 3000 ms  Devices Found: 114
MAC Address | IP Address | Firmware | Unit Type -
00-A0-3D-02-07-58 10.192.50.100 R9.2b 0x56 OPTOEMU-SMR-DR 1 |_|

4|

00-20-0C-30-B6-E0 10,192,144  Ad.0a 053
00-A0-3D-01F8-48 10.192.55.178 R9.1a Ox5A OPTOEMU-SMR-3V
00-A0-3D-01-24-58  10.192.57.80 R9.2a 0x75 SNAP-PAC-EBL
00-A0-3D-01-09-76  10.192.50.11 R9.2b 0x75 SNAP-PAC-EBL
00-A0-3D-00-44-D2  10.192.54.243 R6.1c 0x23 SNAP-UP1-ADS
00-A0-3D-01-7B-7F 10.192.50.84 R&.2a 0x75 SNAP-PAC-EBL
00-A0-3D-00-0C-04  10.192.56.211 R7.0a Ox28 SNAP-B3000-ENET
00-A0-3D-00-FB-C2  10.192.56.213 R7.0a Ox28 SNAP-B3000-ENET
00-A0-3D-00-0C-60  10.192.56,215 R7.0a Ox28 SNAP-B3000-ENET
00-A0-3D-00-FB-A2 10.192.56.214 R7.0a Ox28 SNAP-B3000-ENET
00-A0-3D-00-0C-58  10.192.56.216 R7.0a Ox28 SNAP-B3000-ENET -

e

Help
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TCP Settings

Retransmit timeout (RTO) refers to the length of time the controller or I/0 unit waits while
communicating before timing out. The RTO is determined by the controller or brain’s TCP/IP stack,
and the stack continually recalculates the RTO based on recent network traffic. If the network
becomes busier, for example, the stack automatically adjusts the RTO to a higher value.

If the TCP/IP stack times out while trying to transmit data, it doubles the current RTO and tries again.
This process continues for five retries; after that, the device stops trying and sends a timeout

message.

If you are receiving frequent timeout messages from the device, you can change the TCP parameters

in PAC Manager.

1. Start PAC Manager as follows:

— InWindows 7 and Windows Vista, press the Windows Start key, and then click Programs >
Opto 22 > PAC Project 9.5 > PAC Manager.

— InWindows 10 and Windows 8.1, press the Windows Start key, type PAC Manager 9.5
and then press the Enter key.

2. Inthe PAC Manager main window, click the Inspect icon @

3. Inthe Device Name field, type the name (or IP address) of the controller or I/O unit. Click Status

Write.

= Inspect Opto 22 Device

= e S|

Status Write
Wireless LAN  »

Point Config
Digital Bank
Digital Point
Analog Bank
Analog Point
High Density

System 3
Scratch Pad  »
Data Log 3
PID 3
Events 3
Communications ¥
Other 3

Device Name: | 10,192,50.45

Status:

j Options »

Status Write area last read at 02/19/15 14:45:45

Status Write
Status Read

OxFFFF FO38 0154

Operation

Address | Description | Value - Refresh
OxFFFF FO38 0004 Always BootP/DHCP On Powerup No 1=

OxFFFF FO38 0008 Degrees FjC Degrees C | Apply
OxFFFF FO38 0010  Comm Watchdog Time {msec), 0 = Disable 0 =

OxFFFF FO38 0014  TCP Minimum Retransmission Timeout {msec) 250 7

OxFFFF FO38 0018 TCP Initial Retransmission Timeout {msec) 3000

OxFFFF FO38 001C TCP Retransmission Attempts 5

OxFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000

OxFFFF FO33 0294 Digital Feature Scan Interval (msec) 1

OxFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec) 1000

OxFFFF FO38 0298 Qut Of Range Value -32758.000

OxFFFF FO33 0054 Scanner Flags 0> 00000000

Host Name

OptoMMP Device
Restart Device from powerup
Store configuration to flash
Erase configuration from flash
Reset to defaults and Restart Device
microSD
Store configuration and IP settings to micraSD
Erase configuration and IP settings from microSC!
Erase firmware from microsD
Erase strategy from microSD
Other
Switch to loader mode
Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration

Close Help

-~ Send Command

™ AutoRefresh | 15000  msec

CAUTION: Note the following recommended settings:

TCP Minimum Retransmission Timeout (msec):

TCP Initial Retransmission Timeout (msec):
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TCP Retransmission Attempts: 5

TCP Idle Session Timeout (msec): 240,000

If you set these fields too low, you may not be able to communicate with the device at all, even
through PAC Manager, to fix the settings. Then you would have to reset the controller or /0 unit to
factory defaults (see the device’s user guide for instructions).

Change these four fields as necessary:

Minimum RTO sets an absolute minimum value for the RTO. The device’s calculated RTO will
never go below this value.

Initial RTO sets the RTO for the first communication try. Be careful: since all future tries are
based on this value, if you set it too low for network conditions, a connection will never be
made.

TCP Retransmits sets the number of times the device retries communication. Larger, busier
networks need a higher number of retransmits than smaller networks with less traffic.

TCP idle session timeout sets how long (in milliseconds) the device allows a session to
remain open without any activity. After this time, the device checks the session to make sure it
is still good, and closes it if it is not. The default is 240,000 milliseconds, or four minutes.

Click the Apply button to write your changes to the controller or I/0 unit.
In the Operation Commands list, highlight Store configuration to flash. Click Send Command.
In the Operation Commands list, highlight Restart brain from powerup. Click Send Command.

The new TCP parameters are set.

Checking Ethernet Errors

If you are having problems communicating with the controller or I/0 unit, follow troubleshooting
suggestions in the user’s guide for the device.

You can use PAC Manager to check Ethernet errors reported by the SNAP PAC device. These errors
indicate network problems. You will need to know the device's IP address.

1.

Start PAC Manager:

- InWindows 7 and Windows Vista, press the Windows Start key :5/" and then click
Programs > Opto 22 > PAC Project 9.5 > PAC Manager.

- InWindows 10 and Windows 8.1, press the Windows Start key (&)
9.5 and then press the Enter key.

type PAC Manager

In the PAC Manager main window, click the Inspect button  [gy, |

In the Device Name field, type the name (or IP address) of the controller or I/0 unit. Click Status
Read.
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4. Scroll down until you see these items:

Ethernet Errors: Late Collisions

Ethernet Errors: Excessive Collisions
Ethernet Errors: Others

| Inspect Opto 22 Device

- X

Device Name: | 10.192.55.67

Status Read
Status Read |

j Options ¥ Status: | Status Read area last read at 07/01/16 12:25:23

A Refresh |

m 0xFFFF F030 0068 TCP Retransmits L
0xFFFF F030 006C TCP Idle Session Timeout (msec.) 240000
. 0xFFFF F030 0108 TCP Idle Session Timeout Count a
Fthernet Errors rdess AN |
OxFFFF F030 0070 Ethernet Errors: Late Collisions 1]
Point Config O0xFFFF FO030 0074 Ethernet Errors: Excessive Collisions 0
- OxFFFF F030 0078 Ethernet Errors: Others 1]
Digital Bank
Digital Point 0xFFFF F030 007C Smart Modules Present 0x003C
{analog, serial, etc.)
Analog Bank 0xFFFF F030 011C PID Loops Supported EL
0xFFFF F030 0148 Digital Modules Supported 16
Analog Paint
High Density 0xFFFF F030 0100 Arcnet Reconfigs Detected 1]
0xFFFF F030 0104 Arcnet Reconfigs Initiated by I/0 Unit 0
0xFFFF F030 0120 Arcnet Transmit Attempts Since Powerup 1696606351
EEr D 0xFFFF F030 0128 Arcnet ACKs 1696606339
ScatchPad 0xFFFF F030 0134 Arcnet Timeouts (i)
OxFFFF F030 0124 Arcnet Other (node not found, etc) 12
Data Log 3 0xFFFF F030 0130 Arcnet Timeout Value (msec.) 1]
— R 0xFFFF F030 0138 Arcnet Receiwve Interrupts 1696606339
Events D 0xFFFF F030 0110 Ethernet MAC Resets Since Powerup a
0xFFFF F030 0114 Dig. Output Point Resets Since Powerup 0
Communications ¥ 0xFFFF F030 0118 Dig. Interrupt Failures Since Powerup 0
Other L3 0xFFFF F030 0140 Analog & High Density Digital Scanner 6.070 msec/scan W

Close | Help ‘

™ Auto Refresh | 15000  msec

All three of these items should have a value of zero. If any of these items has a value other than
zero, you may have a network problem.

Troubleshooting Serial Communication

If you need to troubleshoot serial communication over PPP, you can turn on logging for the port the
modem uses. Any data received or transmitted on the port is logged to a file on the controller,
which you can retrieve using FTP and analyze for problems.

You can also log communication with a serial device or I/O unit for troubleshooting, but since the
log file logs serial data sent only between PAC Control and the serial device or I/0 unit, it is easier to
log communication in your PAC Control strategy in these cases.

CAUTION: Logging adds significant overhead to serial communication. Do not enable logging unless you

are troubleshooting.

Creating the Log File

1. Inthe PAC Manager main window, click the Inspect button @

The Inspect window opens.
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In the Device Name field, type the name (or IP address) of the controller (or choose it from the
drop-down list). Click Communications and choose Communication Port Control from the
submenu.

The Inspect window shows the ports and features that apply to the controller you're
inspecting.

#=#| Inspect Opto 22 Device — X

Device Name: | 10.192.50.21 j Options ¥ Status: | Comm Port Control area last read at 07/05/16 12:04:58

Communication Port Control
Status Read
Status Write Address | Desaription | value
COMMUNICATION PORT O
WirelessLAN » 0xFFFF FO31 0400 Control Function For Communication Port 0 PPP
g 0xFFFF FO31 0404 Logging For Communication Port 0 Disabled
COMMUNICATION PORT 1

Point Config 0xFFFF FO31 0408 Control Function For Communication Port 1 Mone

— 0xFFFF FO31 040C Logging For Communication Port 1 Disabled
Digital Bank COMMUNICATION PORT 2

e 0xFFFF FO31 0410 Control Function For Communication Port 2 Mone
LEIEIFTE OxFFFFF0310414  Logging For Communication Port 2 Disabled
Analog Bank
Analog Point
High Density

System 3
ScratchPad  »
Data Log 3
FID 3
Events 3
Communications »
Other 3

Close | Help | I™ Auto Refresh | 15000  msec

Refresh |
Apply

Bl EE EE

Find the port you're troubleshooting. In its Logging For Communication Port # field, click
Disabled and change it to Enabled.

Logging begins immediately.

Retrieving the Log File

1.

Before retrieving the log file, go back to the PAC Manager Inspect window and set Logging For
Communication Port # back to Disabled (see steps in the previous section).

When you disable logging, all data is flushed to the file.

Use an FTP client to retrieve the log file, which is located in the root directory of the controller's
file system and named Comm<x>.log (where <x> is the physical serial port number).

See "Maintaining Files”on page 235 for information on FTP clients, and “Moving Files from the
SNAP PAC Controller or I/0 Unit”on page 240 for how to retrieve the file.

Reading the Log File

In the log file, full duplex serial communication is transformed into a single stream using these rules:

Data bytes are not transformed in any way. The binary data byte is logged.
A direction byte is prepended to every data byte: 0 = outgoing, 1 = incoming.
The data stream is terminated by a null character (ASCII 0x00).
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The maximum log file size is 16 kb. When it reaches the end, the log stream wraps to the beginning
of the file. To locate the oldest data in a wrapped file, search for a null character in place of a 1 or ;
since the null terminates the log data stream, the next logged data byte is the oldest data byte in
the file. If the null character is at the end of the file, the file has not wrapped.

Troubleshooting Wireless LAN Communication

If you are having difficulty with wireless LAN communication on a Wired+Wireless controller or brain
(part number ending in -W), Opto 22 Product Support may ask you to log WLAN data.

1. (SNAP PAC controllers only) Make sure there is a microSD card to receive the log file.

If no card is in the microSD slot, no log file is created. (A card is not required for a SNAP PAC
EB-W brain, which has no card slot.)

2. Inthe PAC Manager main window, click the Inspect button @

The Inspect window opens.

3. Inthe Device Name field, type the name (or IP address) of the controller (or choose it from the
drop-down list). Click Wireless LAN and choose Wireless LAN Configure.

4. (hange the WLAN Logging value as Product Support directs.

5. Enter the Network Key.

6. Click Apply. When asked to restart the device, click Yes.

The log is always written to the same file; path and filename on both controllers and brains is:

/sdcard0/ATHO.LOG

If the file already exists, new data is appended to the end of it.

The log file looks similar to this:

! ATHO.LOG - Notepad 9[i=](E3
File Edit Format View Help

00007d15 sdwrkr wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDZ00007d1l5 sdwrkr
wmi_statsEvent_rx() : EnterZ00007dl5 sdwrkr  ARG000 updating target statsC00008549 sdwrkr
wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDZ00008549 sdwrkr wmi_statsevent_rx{) : Enter:
00008549 sdwrkr ARG6000 updating target statsZ00008d7d sdwrkr wmi_control_rx() :
WMI_REPORT_STATISTICS_EVENTIDZ00008d7d sdwrkr wmi_statseEvent_rx{) : EnterZ00008d7d sdwrkr
ARG6000 updating target statsIZ000095bl sdwrkr  wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDC
000095b1 sdwrkr  wmi_statsevent_rx() : EnterZ000095bl sdwrkr  ARG000 updating target statsC
00009de5 sdwrkr wmi_control_rx({) : WMI_REPORT_STATISTICS_EVENTIDZ00009de5 sdwrkr
wmi_statsEvent_rx() : EnterZ00009de5 sdwrkr  ARG000 updating target stats-0000a6l9 sdwrkr
wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDZ0000a6l19 sdwrkr wmi_statsevent_rx{) : Enter:
0000a619 sdwrkr ARG6000 updating target statsZ0000aed4d sdwrkr wmi_control_rx() :
WMI_REPORT_STATISTICS_EVENTIDZ0000aed4d sdwrkr wmi_statseEvent_rx{) : EnterZ0000aed4d sdwrkr
ARG6000 updating target statsIZ0000b681 sdwrkr  wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDC
0000b681 sdwrkr  wmi_statsevent_rx() : EnterZ0000b681 sdwrkr  ARG000 updating target stats:C
0000beb5 sdwrkr wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDZ0000bebS sdwrkr
wmi_statsEvent_rx() : EnterZ0000beb5 sdwrkr  ARG000 updating target stats-0000c6e9 sdwrkr
wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDZ0000c6e9 sdwrkr wmi_statsevent_rx{) : Enter:
0000c6e9 sdwrkr ARG6000 updating target statsZ0000cfld sdwrkr wmi_control_rx() :
WMI_REPORT_STATISTICS_EVENTIDZ0000cf1ld sdwrkr wmi_statsevent_rx{) : EnterZ0000cfld sdwrkr
ARG6000 updating target statsIZ0000d751 sdwrkr  wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDC
0000d751 sdwrkr wmi_statseEvent_rx{) : Enterz0000d751 sdwrkr ARG000 updating target stats:
 poannnibm 5wl g™ 4= G 03T £, DAFLAWN. LA S Pt na e St am, gand s N b vl 2ESIANANARRS, g

| >

Product Support will interpret the log file.
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File Menu

Edit Menu

New. Displays the Create New Tag Database dialog, allowing you to specify the name and location
of a new tag database. If changes to the current configuration have not been saved, you will be
asked if you wish to save those changes before proceeding. Only one configuration may be open at
atime.

Open. Displays the Open Tag Database dialog, allowing you to open a previously created tag
database. If changes to the current configuration have not been saved, you will be asked if you wish

to save those changes before proceeding. Note that only one configuration may be open at a time.

Close. Closes the current configuration. If changes to the configuration have not been saved, you
will be asked if you wish to save those changes.

Save. Displays the Save Tag Database dialog, allowing you to save your configuration to disk.

Save As. Displays the Save Tag Database As dialog, allowing you to define a new name and/or
location for the current configuration.

(Recent Tag Databases). The four most recently opened Tag Databases are listed below Save
As on the File menu. Selecting any of them is equivalent to choosing Open Tag Database from the
File menu and entering the tag database name.

Exit. Closes the current configuration file and exits PAC Manager. If changes to the current

configuration have not been saved, you will be asked if you wish to save those changes before
exiting PAC Manager.

Cut. Has no current functionality.

Copy. Available when an I/0 Unit is highlighted in the tree view. When selected, the highlighted
170 Unit will be copied to the clipboard.
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Paste. Pastes an I/0 Unit from the clipboard into the strategy tree. This item is enabled only when
an 1/0 Unit has been previously copied to the clipboard.

Tools Menu

Select menu items in the Tools menu to inspect and manage SNAP PAC controllers and brains,
including configuring IP addresses, installing firmware, and exchanging files.

Send Configuration to I/0 Unit. After you have finished configuring I/0 units and saved the
configuration file, you must load the configuration file into the I/O unit's memory. This menu item
opens the Send Configuration To I/0 Unit dialog box.

Inspect. Opens the Inspect I/0 Unit window. Select this menu item to view and change I/0 and
other configuration settings for a specific SNAP PAC controller or brain.

IMPORTANT: Configuration changes made to the I/0 Unit in the Inspect window are not saved in the PAC
Manager configuration file.

Maintenance. Displays the /0 Unit Maintenance window. Select this menu item to upgrade
firmware, exchange files, and manage items in flash memory.

Assign IP Address. Displays the Assign IP Address dialog. Select this menu item to see all Opto
22 Ethernet devices that are broadcasting DHCP or BootP requests. You can then assign IP addresses
to these devices and test the addresses to confirm proper communication.

Change IP Settings. Displays the Change IP Settings dialog box. Select this menu item to
change the IP address and related network settings on a SNAP PAC controller or brain.

Install Firmware via Ethernet. Opens the Maintenance dialog box, which is used to
download new firmware to SNAP PAC controllers and brains.

Install Firmware via Serial Connection. Launches the application OptoFlash-ENET, which is
used to download new firmware to SNAP Ethernet and SNAP Simple brains via a serial connection.
See the online help included with OptoFlash-ENET for more information.

Install Firmware via Failsafe Bootloader Mode. Provides a way to install firmware when
the firmware in the device is damaged. See “Replacing Damaged Firmware” on page 228.

Import/Copy 1/0 Unit. Displays the Inspect /0O Unit dialog. This dialog enables you to save an
/0 unit's flash memory image to a file on your hard disk. This image file can then be used to
configure another 1/0 unit. Configuration information can also be read directly from an I/0 unit and
sent directly to another I/0 unit, or imported into PAC Manager to create a new /0 unit
configuration that can be expanded upon.

Modbus Calculator. Converts an 1/0 unit memory map address to a Modbus Unit ID and
Register Address. See “Determining Modbus Unit ID and Register Address”on page 127.
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Find Opto 22 MMP Devices. Displays a dialog box you can use to find the MAC and IP
addresses (see “Find Opto 22 MMP Devices”on page 278) of all Opto 22 memory-mapped devices
on the Ethernet network.

View Menu

Toolbar. Toggles the display of the toolbar.

Status Bar. Toggles the display of the Status Bar.

Help Menu

Help Topics. Opens the PAC Manager Help file's index of topics.
Manuals. Provides the PAC Manager User’s Guides in PDF format.
Opto 22 on the Web. Provides links to downloads, product support, and the Opto 22 website.

About PAC Manager. Provides general information about PAC Manager, including the version
number and copyright information.
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Add/Edit Analog Point

Use this dialog box to add analog points or edit the configuration of existing analog points.

Name. Type in a name for the I/O point. The name must start with a letter and may contain letters,
numbers, and underscores (spaces are converted to underscores).

Description (optional). Enter a description of the point.

Type. When the channel can be configured as either an input or an output, select the type from
the drop-down list.

Module. Select the 1/0 module or point type from the drop-down list. All available modules of the
type specified will be included.

Units. Each analog module has a default set of units. These units are displayed in this field. If you
assign custom units to the module (by clicking the Custom button), the custom units will appear
here instead.

Zero Scale. The module’s default zero-scale value appears here. This can be changed to a custom
value (by clicking the Custom button).

Full Scale. The module’s default full-scale value appears here. This can be changed to a custom
value (by clicking the Custom button).

Default button. Click here to return the units, zero-scale value, and full-scale value to the
defaults for the module. This is useful if you have assigned custom units and values through the
Custom button that you now wish to ignore.

Custom button. Click here to display the Scale Analog Readings to assign custom units,
zero-scale, and/or full-scale values to the module. For example, you could change the voltage range
of a 010 VDC module to be interpreted instead as a pressure range of 20-200 psia.

Watchdog. Click No (the default) to disable a watchdog on this point, or click Yes to enable the
watchdog (available for outputs only). If you select Yes, a new field will appear to allow you to define
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the value to be assigned to the output should the watchdog be triggered. Enter a value between
the zero-scale and full-scale values (described above).

A watchdog is triggered if no communication activity is detected on the bus for the amount of time
specified in the Watchdog field of this point’s I/0 unit.

Add/Edit Digital Point

Use this dialog box to configure a digital point for an 1/0 unit.

Name. Type in a name for the I/0 point. The name must start with a letter and may contain letters,
numbers, and underscores (spaces are converted to underscores).

Description (optional). Enter a description of the point.

Type. When the channel can be configured as either an input or an output, select the type from
the drop-down list.

Module. Select the I/0 module or point type from the drop-down list. All available modules of the
type specified will be included.

Features. Click here to view and select from the available features for the I/0 point you are
configuring. Features are available only if you are adding a point to a multifunction 1/0 unit. By
default no feature is selected.

For inputs, depending on the module and 1/0 unit, you may be able to configure the module as a
counter, on-pulse, off-pulse, frequency, period, on-time totalizer, off-time totalizer, or quadrature
counter feature. You may be able to configure an output module as a time-proportional output
(TPO).

Watchdog. This field, which appears only if you enable the watchdog, also has only two values.
Click the field and select On or Off from the drop-down list. Remember, watchdogs are available
only for output modules.

Add/Edit Event Message

260

Use this dialog box to add a new event message or edit an existing event message.

Message Name. Type in a descriptive name for this event message. The message name is not
sent to the 1/0 Unit. It is used only within PAC Manager to differentiate event messages from one
another.

Message Text. For e-mail, serial, and SNMP event messages, type in the text to be sent as the
message. For MemMap Copying, this field holds the Source Memory Map address or the Source
Data. Plugins can be used in the message text. The text limit is 127 characters.
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Streaming. To have the |/0 Unit periodically stream data back to a PC, select Enabled from the
drop-down list. You must first use Configure Streaming to set the host(s) to receive the streamed
data.

Period (sec). Enter the interval in seconds at which streaming should take place. A value of 0
means that data will be streamed only once.

E-mail. To have the I/0 Unit send the Message Text using e-mail, select Enabled from the
drop-down list. You must first use Configure E-mail to set the e-mail address that will receive the
Message Text.

Period (sec). Enter the interval in seconds at which the e-mail should be sent. A value of 0
means that the e-mail message will be sent only once.

Serial Module. To have the I/0 Unit send the Message Text as a string through a serial
communication module, select Enabled or Disabled from the drop-down list and enter the string to
send in the Message Text area. You must first use Configure Serial Modules to set serial modules and
their ports.

Serial Ports Mask. Enter a mask representing the serial modules and ports to send the
message through. Bits 0-31 correspond to ports 0-31.

SNMP Trap. To have the I/0 Unit send the Message Text as an SNMP trap, select Enabled from the
drop-down list. You must first use Configure SNMP Agent to set up SNMP system variables,
community groups, and management hosts.

Period (sec). Enter the interval in seconds at which to send the SNMP trap. A value of 0 means
that the trap will be sent only once.

Trap Type. Enter the trap type required by your SNMP management software. Refer to the
documentation for your SNMP management software for information on determining the
required SNMP trap type.

Priority. If you are using SNMP with an outgoing PPP (modem) connection and want the
SNMP trap stored in the I/O Unit until the next communication, set Priority to Low. If you want
the I/0 Unit to immediately dial out and send the trap, set Priority to High.

MemMap Copy Destination. To change the state of a digital point on a different I/0 Unit, or to
copy data from one memory map address to another, select Enabled from the drop-down list and
complete the MemMap Address, IP Address, Period (msec), and IP Port fields for the location the
data is being copied fo. In the Message Text area, enter the source data or memory map location
data is being copied from.

MemMap Address. Enter the destination memory map address in hexadecimal. You do not
have to include the leading FFFF.

Period (msec). Enter the interval in milliseconds at which the MemMap copy should take
place. A value of 0 means that the copy will be done only once.

IP Address. Enter the IP address of the destination I/O Unit. Use 0.0.0.0 if copying to an address
on the same I/0 Unit.

IP Port. Enter the IP port of the destination I/0 Unit. This field is ignored if copying to the same
/0 Unit.
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Add/Edit 1/0 Unit

Use this dialog box to add a new /0 Unit or edit an existing I/0 Unit.

1.

ik whn

N o

Enter a name for the 1/0 unit. The name must start with a letter and may contain letters,
numbers, and underscores. Spaces are converted to underscores.

(Optional) Enter a description of the unit.

Select the type of I/0 unit from the drop-down list.

Choose whether temperatures will be handled in Fahrenheit or Celsius.

Specify the communication port to use (2001, unless you have changed it for security
pUrposes).

Enter the I/0 unit’s IP address.

The Address List area shows IP addresses of the I/0 units that should receive this
configuration. If you have I/O units that are exactly alike, list all of them here. That way you can
download the configuration file to all the I/O units at once. To list them, click Add and enter a
single IP address or a range of addresses.

Select whether you want a Watchdog on the unit. The default is No (disabled). If you select

Yes, a new field appears; enter the Watchdog timeout value in seconds. The default timeout is
0.5 seconds.

When a watchdog is enabled, the I/0 unit monitors activity on the port. If no communication is
received for the specified interval, the unit automatically sets designated digital and analog I/0
points to values you have set in the Watchdog field of the Add/Edit Analog Point or Add/Edit
Digital Point.

Add/Edit IP Address

Use this dialog box to add an IP Address or a range of IP Addresses that will all receive this I/0 unit
configuration. Usually these are I/0 units that are exactly alike. Also use this dialog box to modify a
single IP address.

1.
2.
3.

Click either Add one IP Address or Add a range of IP Addresses.
For a single IP address, enter or change the address and click OK.

To add a range of IP addresses, enter the first address in the range in the From field. Enter the
last IP address in the To field. Then click OK.

Add/Edit Memory Map Values

Use this dialog box to add a new Memory Map Value or edit an existing Memory Map Value.

pIY;

Address. Type in a valid Memory Map Address. The address must be in hexadecimal and
correspond to a valid write area in the device’s Memory Map. Use Opto 22 form 1465, the OptoMMP
Protocol Guide, as a reference.

Value. Type in the value to send to the above address. The value may be in hexadecimal (integer
types only) or decimal. For hex, precede the value with 0x. (Based on this convention, PAC Manager
will remember if your value is in hex or decimal.)
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Type. Select the type of Memory Map Value.

Add/Edit PID Loops

Use this dialog box to add or change PID loops on SNAP PAC brains, and R-series controllers. You can
configure up to 96 PID loops. Four algorithms are available to choose from.

Also see “Configuring PID Loops”on page 69.

1.
2.
3.

10.

Enter a unique, descriptive name for the PID.
(Optional) Enter a description of the PID.
Select the type of input: I/0 Point, Host, or PID Output.

- Ifthe PID’s process variable comes from an 1/0 point on the same unit, select /0 Point.
Choose the point from the drop-down list or type a point name to configure a new point.

— Ifthe PID’s process variable comes from an PAC Control strategy, select Host. Enter an initial
value for the input.

— Ifthe PID’s process variable is the output of another PID on this brain (a cascading control
loop), select PID Output. Choose the PID from the drop-down list.

(Optional) If you chose I/O Point or PID, check the Square Root box if the error should be
calculated based on the square root of the process variable (applies to flow control systems
where volumetric flow is proportional to the square root of a signal from a flow transducer).

Set the valid range of the process variable by entering the low range and the high range. (See
below for optional responses to out-of-range input.)

Choose the source for the setpoint: /O Point, Host, or PID Output.

— To control the setpoint using a device such as a potentiometer, select 1/0 Point; choose an
/0 point from the drop-down list or type a new point name.

— To control setpoint using PAC Control or PAC Display, select Host and enter an initial value.

— Ifanother PID loop will control the setpoint, select PID Output and choose the PID from the
drop-down list.

Choose the destination for the PID output: |/0 Point or Host. (To use the output for controlling
the setpoint or input of another PID, choose Host.)

Enter upper and lower clamp values to prevent the output from exceeding a desirable range.
These values should equal the range of the output point, if used. Or choose values to make sure
that the output device doesn't shut off (for example, keeping a circulation pump running
regardless of the PID output) or that the output never reaches a destructively high setting (for
example, keeping a motor below maximum).

(Optional) Enter minimum and maximum change values. The output won't respond until
the minimum change is reached (for example, you may not want a heater to turn on to correct
a 1 degree error). Maximum change prevents too drastic a change in output (for example, you
could limit the increase in a pump's output to prevent pipe breakage). The default for both
minimum and maximum is zero, which disables the feature.

Choose how the PID should respond (output options) if the input goes out of range. If no
boxes are checked, the PID will freeze output at the current value. To have PAC Control logic or
an operator respond, check Switch to manual mode. To force the output to a specific value,
check Force output and type the output values. NOTE: If both boxes are checked (forced output
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and manual mode), the output will be forced and the PID put into manual mode; but if the PID is
already in manual mode, the output will not be forced.

11. Choose algorithm: Velocity, ISA, Parallel, Interacting. Also see “Algorithm Choices” on page 69.

12. Choose mode. Auto activates the PID. Manual requires that PAC Control logic or an operator
control the PID output.

13. Enter a scan rate to determine how often the input is scanned and the controller output is
calculated. Minimum value is 0.001 (1 millisecond). Scan time should be greater than system
lag (the time it takes for the controller output to have a measurable effect on the system). Also
consider other PIDs and tasks on the brain competing for processing power.

14. Enter a positive or negative value for Gain. Heating systems usually require a negative value
and cooling systems a positive value. NOTE: Gain is usually refined during the tuning process.

15. (Optional) Enter Feed Forward Initial and Feed Forward Gain values if you need to offset
the controller output in your application. These values are constants that are multiplied and
added to the controller output; often they are not used in PIDs.

16. (Optional) Enter Integral (Tune I) and Derivative (Tune D) settings if you know the desirable
settings. However, Integral and Derivative are not essential to basic configuration and are better
determined in the tuning process.

17. Click OK.

Add/Modify New Device

To add a new I/0 Unit Name, click Options to open the Add New Device dialog box.

Device Name: Enter a name for the I/0 unit. You can use the IP address or any unique name.
Change the timeout if necessary.

Direct Connection to Ethernet Device: Use this option if there is a direct connection to the brain
via an Ethernet cable.

o [PAddress or Hostname: Enter the IP address or hostname of an Ethernet /O unit, such as a
PAC EB-series or PAC R-series device.

«  Fthernet Port: Use the default of 2001 for Ethernet Port unless you have changed the port.

Direct Connection to Serial Device: Use this option if the I/O unit is connected directly to the PC
using a serial cable and a PCI-AC48 adapter card.

«  PCSerial Port: Enter the serial port on the PC where the brain is connected.
o PCBaud Rate: The baud rate on the PC must match the rate set on the brain.
o Serial Device Address: Enter the serial address of the brain.

Pass-Through Ethernet Controller to Serial Device: Use this option for SNAP-PAC-SB1 and SB2
brains connected to a SNAP-PAC-S1 or S2 controller.

o [PAddress or Hostname: Enter the IP address or hostname of the S-series controller.
«  FEthernet Port: Use the default of 2001 for Ethernet Port unless you have changed it.

«  Controller Serial Port: Enter the controller’s serial port where the brain is connected. On a
SNAP-PAC-S1, it's Serial 2. On a SNAP-PAC-S2, it could be any port.

«  Controller Baud Rate: The baud rate on the controller must match the rate set on the brain.

PAC Manager User's Guide



APPENDIX B: DIALOG BOXES

o Serial Device Address: Enter the serial address of the brain.

o 2-Wire RS-485: Check this box for a 2-wire RS-485 connection. SNAP-PAC-S1 controllers support
only 2-wire RS-485. SNAP-PAC-S2 controllers support 2-wire or 4-wire RS-485.

Assign IP Address

Use this dialog box to assign IP addresses to Opto 22 devices, either by listening for devices sending
DHCP or BootP broadcasts, or by first creating a list of mappings.

NOTE: In order to assign IP addresses, you must be logged in with administrative rights.

Also see “Assigning an IP Address” on page 10.

Each device ships from the factory with a unique MAC address (printed on a label on the device) and
a default IP address of 0.0.0.0, which is invalid. SNAP PAC, SNAP-LCE, SNAP Ultimate, SNAP Ethernet,
and SNAP Simple I/0 send out a BootP broadcast when first turned on. E1s and E2s send out a DHCP
broadcast. In most cases, you must give each of these devices a fixed, static IP address. Also see
“Assigning IP Addresses to SNAP PAC"on page 10.

Assigning IP Addresses to SNAP PAC

If your network has a DHCP server, either assign a static IP address before connecting the device to
the network (preferred), or disable the server. Note the MAC address of each device that needs an IP
address, and turn on the device(s).

NOTE: SNAP PACs each have two separate Ethernet network interfaces. Each interface has a separate MAC
address and therefore takes a separate IP address. Only ENETT sends a BootP request. Once you have
assigned this primary IP address, you can assign the secondary address using the Inspect I/O Unit window.

1. Double-click the MAC address of the device in the upper list.

2. Inthe Mapping dialog box, enter the IP Address and Subnet Mask for the device. If it will be
talking to a device on another subnet, enter the Gateway (router) address. If it will talk only on
the local subnet, leave the gateway address all zeros (0.0.0.0). Leave the DNS address at 0.0.0.0
and the Host Name field blank. Click OK.

3. Thenew IP address information appears in the upper list in the dialog box, and the device’s
status changes to Mapped. The address information also appears in the lower list to show that
this device has been mapped to this address.

4, \With the device still highlighted, click Assign. The address is saved to flash memory and the
status changes to Static IP. To verify that the IP address has been successfully assigned,
highlight the device in the upper list and click Test. A DOS window opens and the IP address is
pinged.

5. Forfuture reference, write the IP address next to the MAC address on the white sticker provided
on the device.

6. To save the list of IP address and MAC address mappings (the lower list in the dialog box), click
Save List.

NOTE: If you have a large number of devices or are on a separate network, you can create the mappings
list first, save it, and then load it into PAC Manager later. Devices that match the mappings receive their IP
addresses as soon as they appear in the upper list. Click Assign All to save them.
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Assign Secondary IP Address

SNAP PAC controllers each have two, independent Ethernet network interfaces. With PAC Project
Professional, you can use these interfaces to segment the control network from the company
network or for Ethernet link redundancy. For more information, see Opto 22 forms 1702, 1702, and
1439: the PAC Control User’s Guide, PAC Display User’s Guide, and OptoOPCServer User’s Guide.

IMPORTANT: The two Ethernet interfaces will work only if they are on separate network segments, so the
control engine can clearly determine where to direct communication. For example:

ENETT ENET2

|P Address: 192.168.0.12 10.0.05

Subnet Mask: | 255.255.255.0 | 255.255.255.0

The first Ethernet interface, ENETT, sends a BootP broadcast and is assigned an IP address just like

other Opto 22 devices (see “Assign IP Address”on page 265).

To assign an IP address to ENET2, follow these steps:

1. Make sure that ENET1 has already received an IP address.

2. Inthe PAC Manager main window, click the Inspect button.

3. IntheInspect window, enter the IP address for ENETT and click Status Read. Status information
for the controller appears in the window. If the secondary IP address has not been assigned yet,
the secondary IP address information will show all zeros.

4, C(lick Status Write. Enter the IP address information for ENET2 in the Value column in the
Secondary IP Address, Secondary Subnet Mask, and (if necessary) Secondary Default Gateway
fields. Click Apply. The information is sent to the SNAP PAC, but it cannot communicate on the
secondary interface until it is restarted.

5. Inthe Operation Commands section, highlight Restart I/O Unit from powerup. Then click Send
Command.

The SNAP PAC controller is restarted. You can check to make sure the controller is back on line by
clicking Status Read again and making sure the secondary IP address information is shown. To verify
communication, open PAC Manager on a PC that is on the same network segment as the secondary
IP address, and use the Inspect window to check status.

Configure E-Mail

266

You can send an email message or page someone in response to an event. Use this dialog box to set
up email parameters. See “Configure Event Messages”on page 267 to set up the message itself.

IP Address and Port. Enter the IP address and port number of the Simple Mail Transfer Protocol
(SMTP) server the 1/O unit will use to send email. You should be able to get this information from
your network administrator.

PAC Manager User's Guide


http://www.opto22.com/site/documents/drilldown.aspx?aid=3165
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3163

APPENDIX B: DIALOG BOXES

Timeout. nter the length of time in milliseconds the I/O unit should wait for a response from the
email server. The default is 30,000.

From. Enter a valid email address that will identify the I/O unit to the person who receives the
email.

To. Enter the email address of the person who will receive the email.

Subject. Enter a phrase that will indicate the purpose of the email to the person receiving it. Note
that this subject line applies to all email messages sent by this I/O unit. Plugins can be used in this
field. For example, if a similar email will be sent at intervals (such as an email of the data log), you can
use the seqid plugin to put a sequence number at the end of each subject line. This plugin is in the
format:

SI_seqid_

So, for example, if you enter Ultimate Data Log $!_seqid_ in the subject field, the first email message
will have a subject line of Ultimate Data Log 0, the next message will have a subject line of Ultimate
Data Log 1, and so on. For information on other plugins, see “Using Plugins”on page 108.

IMPORTANT: For the configuration to take effect, you must upload the configuration file to the brain, save
it to flash memory, and restart the brain.

Configure Event Messages

See “Configuring Event Messages” on page 157.

Configure I/0O Points

SNAP I/0 units are configured by first adding a SNAP module, then configuring each point on that
module. SNAP modules and points are listed in an expandable, tree-like view. The window is
resizable.

1/0 Unit. Displays the I/0 unit on which I/0 points are being configured.

Type. Displays the type of /0 Unit for which points are going to be added. This field is for display
purposes only and cannot be modified.

Add. To add I/0 points to a SNAP I/0 Unit, you must first add a SNAP module to the 1/0 Unit, then
add 1/0 points to that module.

To add a SNAP module to an I/0 Unit

Highlight the location where the module will be added and click the Add button. In the Add
Module dialog that appears, select the type of module (Analog Input/Output or Digital
Input/Output) and the name of the SNAP module you are configuring. Click OK.

To add an /0 point to a SNAP module
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Double-click a SNAP module in the list to see the point locations it contains. Highlight the
location where the point will be added and click the Add button. Depending on whether the
I/0 point being added is analog or digital, enter configuration information for the new 1/0
point in either the Add/Edit Analog Point or Add/Edit Digital Point.

Modify. To change an existing SNAP module or I/0 point, highlight the item in the list and click
the Modify button. Change configuration information for the SNAP module or I/0 point in the Add
Module dialog, the Add/Edit Analog Point or the Add/Edit Digital Point as necessary.

Delete. To delete an existing SNAP module or I/0 point, highlight the item in the list and click
Delete. Before deleting a SNAP module, you must first delete all I/0 points associated with that
module. When deleting I/0 points, note that only points having a reference count of zero can be
deleted.

Move To. To move an I/0 point to an empty channel on another (or the same) I/0 Unit, highlight
the point, click Move To, and use the Move Point To to move the point. If the I/O point is referenced
in a PID loop or event/reaction, you can move the point only within the same I/0 unit, not to
another unit.

Expand All/Collapse All. To view or hide all /O points in a SNAP I/0 unit, click the Expand All
button or the Collapse All button.

Configure /0 Points (G4EB2)

268

G4EB2 1/0 units are configured by adding a point for each G4 module.
1/0 Unit. Displays the I/0 unit on which I/0 points are being configured.

Type. Displays the type of I/0 Unit for which points are going to be added. This field is for display
purposes only and cannot be modified.

Add. Points that have not been configured yet show as Not Used. Double-click the channel
number for the point you want to add. Enter configuration information for the new I/0 point. See
“Configuring Digital Points for a G4EB2" on page 43.

Modify . To change an existing point, highlight the item in the list and click the Modify button. See
“Configuring Digital Points for a G4EB2" on page 43.

Delete. To delete an existing point, highlight the item in the list and click Delete. When deleting
I/0 points, note that only points having a reference count of zero can be deleted.

Move To. To move an I/0 point to an empty channel on another (or the same) I/0 Unit, highlight
the point, click Move To, and use the Move Point To to move the point. If the I/O point is referenced
ina PID loop or event/reaction, you can move the point only within the same I/0 unit, not to
another unit.
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Configure I/0 Units

This dialog box shows all the I/0 units in the current configuration and is the “home base” for
configuring I/0. For more details on configuring 1/0 and features, see Chapter 2: Configuring
Devices.

To resize the dialog box, move the mouse near any edge until the pointer turns into a two-way
arrow, then click and drag the border in any direction. To resize a column, click and drag the column
dividers in the list header, or double click the divider to expand the column just wide enough to
display the longest item in the column.

To configure a new I/0 unit, click Add or double-click anywhere in the list box below any
configured units. The Add/Edit I/O Unit dialog box will appear.

To change an I/0 unit in the list, highlight it and click Modify and change the unit's settings in the
Add/Edit I/0 Unit dialog box.

To remove an I/0 unit in the list, highlight it and click Delete. Only I/0 units with a reference count
of zero can be deleted.

To add or modify I/0 points for the highlighted I/0 unit, click I/O Points. The Configure I/0 Points
dialog box will appear.

To copy and save I/0 Unit configurations, click Import/Copy and select I/0 units in the I/0 Unit
Import/Copy dialog box that appears.

To configure additional items, click the buttons shown below:

Click PID Loops to configure proportional-integral derivative (PID) loops on SNAP PAC brains or
R-series controllers.

+  (lick Modules and select a module type:

- Serial Modules
(see "Configuring RS-232 and RS-485/422 Serial Communication Modules” on page 52)
- Wiegand Modules
(see "Configuring Wiegand Modules”on page 56)
- Profibus Modules
(see "Configuring Profibus Modules”on page 58)
- Motion Modules
(see Opto 22 form 1673, the SNAP PAC Motion Control User’s Guide)
- SSIModules
(see "Configuring SSI (Serial Synchronous Interface) Modules” on page 59)
- CAN Modules
(see "Configuring CAN Modules” on page 61)
— HART Modules
(see "Configuring HART Modules” on page 65)

«  Click Events and select an event to define or an event message to send as a reaction to an
event.

+  (lick Scratch Pad to view and configure bitmask, integer, float, and string memory areas of a
SNAP PAC controller or brain.
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NOTE: If you are using the Scratch Pad on a SNAP PAC S-series controller, you must first configure an
1/0 unit to represent the controller. Configure this I/0 unit as a Generic OptoMMP Device, using the IP
address for the controller. (Do not add any points or configure other features.)

+  (lick Communications and select the type of communication to configure, for example, PPP,
Modbus, Security, Streaming, and so on.

+  (lick Others to configure date and time, data logging, or I/0 unit options you want to have
saved in the configuration file.

Configure Memory Map Values

Use this dialog box to assign values to specific memory map locations that are not otherwise
included in configuration files. These values will be sent to the I/O unit or controller when you send
the configuration file. For memory map addresses and valid values, see Opto 22 form 1465, the
OptoMMP Protocol Guide.

NOTE: If you are using a SNAP PAC S-series controller, you must first configure an I/O unit to represent the
controller. Configure this /0 unit as a Generic OptoMMP Device, using the IP address for the controller. (Do
not add any points or configure other features.)

The Memory Map Values List displays the Address, Value and Type of each Memory Map Value. The
Address is always represented in hexadecimal (hex). The Value field can contain hex or decimal
values (integer types only). If the value is in hex it is preceded by 0x. The Type field can be either
4-byte Int, 8-byte Int, Float, or String.

+  Toadd a new Memory Map Value, click Add to open the Add/Edit Memory Map Values dialog
box.

«  Tochange an existing Memory Map Value, highlight it and click Modify.

+  Todelete an existing Memory Map Value, highlight it and click Delete. To highlight more than
one, hold down the Ctrl key and click additional items in the list.

Configure PID Loops

270

Use this dialog box to configure proportional integral derivative (PID) loops on SNAP PAC brains, and
R-series controllers. You can configure up to 96 PID loops. Four algorithms are available to choose
from. Also see “Configuring PID Loops” on page 69.

« Toadd a PID, highlight the lowest available number in the list and click Add to open the
Add/Edit PID dialog box.

« Tochange an existing PID, highlight it in the list and click Modify.
«  Todelete a PID, highlight it and click Delete.

Each PID must be configured with essential parameters and then individually tuned for efficiency.
You can configure PIDs through either PAC Manager or PAC Control, but for tuning PIDs, it's easier to
use the graphic tuning tools in PAC Control (see Opto 22 form 1700, the PAC Control User’s Guide).
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Configure PPP

Local IP Address. Enter the Local IP Address for the PPP interface on the 1/0 unit. Enter the local
Subnet Mask only if you are using classless IP addressing. If you are not using classless IP addressing,
leave the Subnet Mask at zero, and the I/0 unit will calculate the subnet mask.

IMPORTANT: The network address for the PPP interface must be different from the network ID for the
Ethernet interface. (The network address is obtained by ANDing the IP address and the subnet mask.)

Max Authentication Retries. Enter the maximum number of times a login/password
combination can be retried.

PPP Link Always Connected. If you want outgoing PPP to always be connected, so there is no
need for the I/0 unit to dial out, check this box.

Modem Initialization String. Change the modem initialization string and modem hangup
string if necessary. Make sure you use the setting to ignore DTR signal in the modem initialization
string:

The default modem initialization string is AT&DOM~~~~

Consult the command reference that came with your modem to determine the correct initialization
command strings. A sample modem initialization string might look like this:
AT&FMM~~AT&DO&KOMM~~ATEWOMM~~AT&Y O M~~

The &F command sets the modem back to factory defaults. The AM tells the Ethernet I/O unit to
insert a carriage return. The ~ tells it to insert a 500ms pause. The &WO0 writes the current settings to
NVRAM profile 0 on the modem. The &Y0 instructs the modem to use NVRAM profile 0 after
resetting.

This initialization string is just a sample; command strings for your modem may differ.

Outgoing PPP. If the |/0 unit will send outgoing calls, complete the Outgoing PPP section:
Choose Enabled from the drop-down list.

In the Use Local IP Address field, choose Yes to have the I/O unit use the Local IP Address you
entered for the PPP link; choose No to have the remote device assign the I/O unit an IP address for
the PPP link. The default is No.

If you want the I/0 unit to use the device the I/O unit is calling as the default gateway for all
communication, choose Yes for Set As Default Gateway. The default is No.

Enter the Login and Password the I/0 unit should use for authentication when it calls the remote
device.

In the Phone number field, enter the number the modem should dial for outgoing calls from the I/0
unit.

Change the following fields if necessary:

« Inactivity Timeout—If the I/O unit sends no packets and receives no packets for this number of
seconds after the PPP session is negotiated, the modem will hang up. The default is 30.

«  Max Connect Time—The maximum amount of time in seconds an outgoing PPP connection
can stay connected after successful negotiation. Default is zero, which disables the timer.
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«  Max Dial Retries—The number of times the I/O unit will redial if the first attempt fails. Default is
zero.

+  Retry Interval—The number of seconds the I/0 unit will wait before trying to redial after the
first attempt fails. Default is zero.

o Disable Time—If the maximum connect time or maximum number of retries has been
reached, the outgoing PPP dialer waits this number of seconds before doing anything. Default
is zero.

Incoming PPP. [f the I/0 unit will receive incoming calls via modem, complete the Incoming PPP
section:

Choose Enabled from the drop-down list so the modem will listen for incoming calls.

If you want the I/0 unit to use the device calling the I/0 unit as the default gateway for all
communication, choose Yes for Set As Default Gateway. The default is No.

Change the Inactivity Timeout if necessary. The default is 30.
Enter the Login and Password the I/O unit should accept for incoming calls.

In the Remote IP Address field, enter the IP address the I/0 unit should give to devices that dial into
the I/0 unit and ask for an address. This address must be on the same subnet as the local IP address.

Enter a modem listen string to make sure the modem automatically answers calls. The default
modem listen string is ATSO=1~M~ , which instructs the modem to answer any incoming calls on
the first ring. Again, refer to your modem’s command reference for the correct listen string.

Configure Profibus Modules

272

(Not applicable to SB brains) Profibus modules (part number SNAP-SCM-PROFI) are a type of serial
module. Before configuring a Profibus module, see Opto 22 form 1191, the SNAP Serial
Communication Module User’s Guide, for more information about these modules.

1. With the configuration file open, right-click the name of the I/0 unit the Profibus module is on.
From the pop-up menu, choose Configure.

PAC Manager User's Guide


http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=1751
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=1751

APPENDIX B: DIALOG BOXES

The Configure I/0 Units dialog box opens.

=»| Configure I/O Units

==l

Type
SHAP-PAC...

Part Address
10.192.54.110

Ethernet

‘Wwatchdog
Enabled

al

Cloze |

Help

I

De Add...

Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...

Modules :,—— Modules

Events 3

Scratch Pad  »

: Communications »
Others 3

button

2. Make sure the correct I/0 unit is highlighted. Click the Modules button and choose Profibus

3.

Modules from the pop-up menu.

] Configure Profibus Modules @
Frofibus Module
Mumber: |0 | [ Used
Address | D escription | Walue
MODULE INFORMATION
O«FFFF FOCO 0000 Module Type Diig/more [0x00]
O«FFFF FOZA FFOO todule Subtype i]
0=FFFF FO3& 7FO2 Hardware Revision Date REC
0=FFFF FO3& 7FOG Loader WVersion REC
0xFFFF FO3& 7FO& Firrmwware Version REC
PORT &
0xFFFF FO3& 8000 IP Port Number 22500
0=FFFF FO3& 8004 Baud Rate 15200 |
(«FFFF FOZA 2003 Parity Ewven
0xFFFF FO3& 8009 Data Bits a
0=<FFFF FO3& 8002, Stop Bits 1
(0=FFFF FO3& 800B Hardware Flow Contral? Mo
(wFFFF FOZA 2000 Poveer-up Test Meszage? es =1
0=FFFF FO3& 8200 EOM Character List (= 0D Q0000
Cancel | Help |

In the Number field, choose the Profibus module’s position from the drop-down list. Click to
put a check mark in the Used box.

If you need to change port numbers, enter the new numbers for each port in the TCP port

Number field.

Change the Baud Rate and EOM Character List fields if necessary to match your Profibus
devices. Choose whether to have the module automatically send a Test Message when turned
on (the default is Yes).
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6. When data is correct, repeat from step 3 for additional Profibus modules.

7. When all Profibus modules are configured, click OK to close the dialog box and return to
configuring I/0 units.

IMPORTANT: If you have changed a TCP port number, you must save the change to flash and restart the
I/0 unit when you send the configuration data to the I/0 unit (see page 75).

Configure Serial Modules

This dialog allows you to configure SNAP serial communication modules (part numbers
SNAP-SCM-232 and SNAP-SCM-485) for use with the I/O unit. For each serial module port you want
to use, click the corresponding row and then enter or modify the values in the columns listed below.
Most values can be changed by selecting a new value from a drop-down list.

Status. To enable a port on a serial module, select the appropriate row and click the Status
column. A drop-down list is displayed with the choices Enabled, Disabled, and Clear. Choosing
Enabled activates the entire row and assigns default values to each column. Choosing Disabled
deactivates the row but doesn't change any values in the other columns. Choosing Clear deactivates
the row and clears all the other columns. Only the columns that are Enabled will be sent to the I/0
unit.

Module. The module location on the SNAP I/0 rack. This value cannot be changed.

Port. The serial module port being configured. Each serial module has two ports, A and B. This
value cannot be changed.

IP Port. The IP Port number for access to the serial port. The default value that appears should
work for most IP communication, and changing this value shouldn’t be necessary. If the IP port
number is changed, however, the I/0 unit must be restarted for the change to take effect.

Baud Rate. Choose the baud rate. The default is 9600.

Parity. Choose None, Odd, Even, Mark or Space from the drop-down list. The default is None.
Data Bits. Choose 8 or 7 from the drop-down list. The default is 8.

Stop Bits. Choose 1 or 2 from the drop-down list. The default is 1.

EOM Chatrs. Enter hexadecimal values representing the End Of Message characters that the I/0
Unit should be looking for. The default is 0DOA, which is the ASClI representation for carriage return

and linefeed. A maximum of eight hexadecimal digits may be entered.

Test Message. Select Yes in the drop-down list if you want the 1/0 Unit to send a test message on
powerup. Select No if no test message is desired. The default value is Yes.
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Configure SNMP Agent

SysName. Enter the name assigned to the I/0 unit as a managed node within the SNMP
management system.

SysLocation. Enter the physical location of the I/0 unit.
SysContact. Enter the ID of the contact person for the I/0 unit.

Community Groups. To set up the Community Groups you need, highlight a line in the list. Click
the String cell within the line and type the name of the group. Then click in the Read, Write, and Trap
cells and choose Yes or No from the drop-down list to indicate whether that group has privileges to
read, write, and receive traps.

Management Hosts. To set up Management Hosts, highlight a line in the list. Start with hosts
on the local network first, because the system sends messages to hosts in numeric order, and it
stops sending messages when it finds a host that it cannot connect to. Click the Community String
cell and enter the name of the community group the host belongs to. Click the Host IP Address cell
and enter its IP address, including the dots (for example, 10.192.55.60).

Version. From the drop-down list, choose the version of SNMP you are using.

Destination Port. 161 is the default port for SNMP communications. If you know that your
application will use a different port, enter the number of that port here.

Authentication/Cold Start Trap. To enable authentication or cold start traps, click the box to
check it.

Configure Streaming

Enable Streaming. To enable streaming, choose Yes from the drop-down list.

Enable I/0 Mirroring. /0 mirroring is a separate function. It's generally not a good idea to use
both streaming and mirroring on the same I/0 unit. See “Mirroring I/0 Point Data”on page 120 for
more information.

Interval. Enter how often in milliseconds you want the 1/0 unit to send the streamed data. If you
are configuring streaming to use only as an event message, set the streaming interval to 0. Zero
means that the stream will be sent only once.

Use Default Streaming Area. To stream all addresses in the Streaming section of the I/0 unit's
memory map, click Use Default Streaming Area. See the memory map appendix in Opto 22

form 1465, the OptoMMP Protocol Guide, for more information. (Note that the Streaming section
does not include data from high-density digital modules.)
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To stream only part of the Streaming section, or to stream a different part of the memory map, click
Specify Streaming Area. Enter the starting address in the Memory Map Address field (the address
must be entered in hex), and enter the size in bytes of the data to stream in the Size Of Data field.

IP Port. Enter the IP port on the PCs or devices that receive the streamed data. Your application
must refer to this port number. Use the default of 5001 unless you know it is already being used for

another purpose.

Stream Target. Enter the IP addresses of up to eight devices to receive the streamed data.

Configure Wiegand Modules

(Not applicable to SB brains) Wiegand modules are a type of serial module. Before configuring a
Wiegand module, see Opto 22 form 1191, the SNAP Serial Communication Module User's Guide, for
more information about these modules.

1. With the configuration file open, right-click the name of the I/0 unit the Wiegand module is on.
From the pop-up menu, choose Configure.

276

The Configure /0 Units dialog box opens.

=»| Configure I/O Units

Type

Part
Ethernet

Address ‘Wwatchdog De Add...

10.192.54.110 Enabled

<

Cloze | Help

[ | +

==l

Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules :,—
Events 3
Scratch Pad  »
Communications »
Others 3

—— Modules
button

2. Make sure the correct I/0 unit is highlighted. Click the Modules button and choose Wiegand
Modules from the pop-up menu.
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| Configure Wiegand Modules @
WWiegand Maodule
Mumber: |0 | [ Used
Address | Description | W alue
FMODULE INFORMATION
0«FFFF FOCO 0000 todule Type Digdnome [0=00]
0«FFFF FO3A 8501 todule Subtype 0
(«FFFF FO34 3502 Hardware Revizion D ate KB
(«FFFF FO3A 3508 Loader Wersion KB
(«FFFF FO3A 3504, Firrare Verzion KB
PORT &
(=FFFF FO3& BEO00 IP Part Mumber 22500
(=FFFF FO3& BE04 Farrat ] =1
(=FFFF FO3& BE0E Data Length v
(0=FFFF FO3& BEOC Site Position g
(=FFFF FO3& BE10 Site Length g
0«FFFF FO3& 86714 Badge Position 18
(=FFFF FO34 BE18 Badge Length 19
(=FFFF FO3& BE1C Parity Check Mo
0«FFFF FO3& 8620 Even Parity Paozition 0
(=FFFF FO3& BE24 0dd Parity Pasition 0
PORT B
(=FFFF FO3& 8B40 IP Part Mumber 22501
(=FFFF FO3& BE44 Farrat ] =1
(=FFFF FO34 BE48 Data Length v
(=FFFF FO3& BE4C Site Position g
(=FFFF FO3& BES0 Site Length g
0«FFFF FO3& 8654 Badge Position 18
(=FFFF FO3& BERE Badge Length 19
(=FFFF FO3& BERC Parity Check Mo
0«FFFF FO3& 8660 Even Parity Paozition 0
(=FFFF FO3& BEE4 0dd Parity Pasition 0
] | Cancel | Help |

In the Number field, choose the Wiegand module’s position from the drop-down list. Click to
put a check mark in the Used box.

If you need to change port numbers, enter the new numbers for each port in the TCP port

Number fields.

Click the Format/Value cell, and from the drop-down list, choose a standard data format
(shown by its total data length) or choose C for custom.

NOTE: O is the 37-bit Opto 22 format used in a sample PAC Control strategy available for use with
Wiegand modules. See the Serial Communication Module User’s Guide for more information.

Change the following fields if necessary to match your Wiegand hardware device:

Data Length—total length of data in the transmission

Site Position—first bit of the site code

Site Length—Iength of the site code, in bits

Badge Position—first bit of the badge code (should be the next bit after the site code)
Badge Length—Ilength of the badge code, in bits

When data for both ports is correct, repeat from step 3 for additional Wiegand modules.

When all Wiegand modules are configured, click OK to close the dialog box and return to
configuring I/0 units.
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IMPORTANT: If you have changed a TCP port number, you must save the change to flash and restart the
1/0 unit when you send the configuration data to the I/O unit (see page 75).

9. When you are ready to send all configuration data to the I/O unit, see “Sending Configuration
Data to the I/0 Unit"on page 75.

Find Opto 22 MMP Devices

Use this dialog box to find out the MAC addresses, IP addresses, firmware versions, and/or unit types
of all Opto 22 memory-mapped devices on the network. Opto 22 memory-mapped devices include
SNAP PAC and SNAP-LCE controllers, SNAP Ethernet, SNAP Ultimate, and SNAP Simple 1/0 units, and
E1and E21/0 units. (Opto 22 M4-series controllers with Ethernet cards are not included.)

CAUTION: You may have problems if your network includes old Opto 22 SNAP Ethernet brains with
firmware version R1.3m or earlier, or controllers with M4SENET-100 adapter cards at firmware version
R1.3k or earlier (these may be affected by the Find feature even though it does not report them). These
brains and adapter cards may have to be rebooted if you use the Find feature. To avoid this problem,
update the older devices to newer firmware first.

1. Leave the MMP Port at 2001 unless you have changed it for security purposes.
2. Adjust the Timeout if necessary for your network. Timeout is in milliseconds.

3. (lick Find. All the Opto 22 MMP devices on your network are listed. The total number of
devices is shown in the Devices Found field.

4. If you want to copy device information to the clipboard, click Copy.

Inspect I/0 Unit

278

When you use the Inspect I/0 Unit window, you are reading and writing directly to a specific SNAP
PAC controller or brain. You must have its IP address in order to do so. The type of device determines
which areas are supported.

CAUTION: Any configuration changes you make here are not saved in a configuration file.

To use the Inspect I/0 Unit window, enter the IP address of the device (or choose it from the
drop-down list). Then click the button on the left that corresponds to what you want to do:

Status Read. See basic information about a SNAP PAC controller or brain. See “Interpreting Status
Data”on page 165.

Status Write. Send commands to a device (such as Store configuration to flash), change the unit’s
basic configuration (such as whether degrees are shown in F or C), or assign the second IP address
on a SNAP PAC controller (see “Assign Secondary IP Address”on page 266).

Wireless LAN. Choose to configure a wireless LAN or view a wireless LAN's status. See
“Configuring Wireless LAN Communication (Wired+Wireless Models Only)” on page 26.
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Point Config. Configure 1/0 points. See “Configuring Analog and Digital Points and Features” on
page 174.

Digital Bank, Analog Bank. Read 1/0 points. See “Reading Analog and Digital Banks” on
page 195.

Digital Point, Analog Point. Read or write to individual 1/0 points. See “Reading and Writing
to Points”on page 187.

High Density. Read or write to SNAP high-density digital points. See “Reading and Writing to
SNAP High-Density Digital Points”on page 198.

System. Read or change the date and time. See “Reading System Date and Time” on page 200.

Scratch Pad. Read or write to Scratch Pad Bits, Integers, Floats, and Strings. See “Reading and
Writing to the Scratch Pad Area” on page 200.

Data Log. Configure data logging and read the log. See “Data Logging” on page 203.
PID. Configure PID loops. See “Configuring, Viewing, or Changing PID Loops”on page 184.

Events. Read current events and change events; configure event messages. See “Configuring
Event Messages”on page 157.

Communications. Display information about and configure security, protocols, communication
ports, and a variety modules including serial modules (RS-232, RS-485/422, Wiegand, Profibus,
Motion, SSI, CAN, and HART modules). For information on how to configure these modules, see
“Configuring I/0 Modules and Points” on page 40.

Other. Read or write to any address in the device's memory map. For a complete list of memory
map addresses, see Opto 22 form 1465, the OptoMMP Protocol Guide.

I/0 Unit Import/Copy

Use this dialog box to import and copy I/0 unit flash memory images. An /0 unit's flash memory
contains information about any settings that have been explicitly configured for that unit. A flash
memory image saves this information so it can be stored in a file or copied to another I/O unit. The
dialog box contains the following elements:

Existing I/0 Unit Flash Memory. Choose an existing I/0 unit. If you want to add or modify an
/0 unit, click Options. For help, see “Add/Modify New Device” on page 264.

Previously Saved 1/0 Unit Image File. Select this option and enter the filename of a flash

memory image file that you want to copy to another 1/0 unit. You can also click the Browse button
at the end of the filename field and locate the image file using the standard File Open dialog box.
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Read. After selecting an Image Source option, click Read to read a flash memory image from an 1/0
unit or an existing flash memory image file. Note that the dialog box does not close when you click
this button.

Send Image To I/0 Unit Flash Memory. Select this option and enter an I/0 unit's IP address
to copy the selected flash memory image source to that unit.

Save To I/0 Unit Image File. Select this option and enter the name of a file that will store the
flash memory image. You can also click the Browse button at the end of the filename field and
specify the name and location of the image file using the standard File Save dialog box.

Create New I/0 Unit. Select this option to create a new I/0 unit in PAC Manager using the
selected flash memory image source. Since the source image does not contain an I/0 unit name,
you will be prompted to enter one. For more information, see “Creating a New I/0 Unit from an
Existing One”on page 32.

Send/Save/Create. After selecting an Image Destination option, click this button to copy the
image source to an I/0 unit, save the image source to a file, or create a new I/0 unit in PAC Manager.
Note that the dialog box does not close when you click this button, so you can repeat the
Read-Send/Save/Create cycle as needed.

I/0 Unit Maintenance

To use 1/0 Unit Maintenance dialog box, see one of the following topics:
“Changing IP Addresses”on page 219

“Loading New Firmware” on page 221

“Maintaining Files”on page 235

For other maintenance tasks, such as resetting the device to factory defaults or handling a device
whose IP address you don't know, see the controller or brain user’s guide.

Move Point To
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Use this dialog to move an I/0 point from one I/0 unit to a location on another (or the same) 1/0
unit.

The 1/0 Units list displays all I/0 units that are compatible with the point being moved. The current

I/0 unit is highlighted. The Points list displays all I/O points on the highlighted I/0 unit. Currently

configured I/0 points are in gray text, and open channels are marked Unused.

1. Selectan open channel on the current I/0 unit or select another I/0 unit (if available) from the
/0 units list and select one of its channels as the destination channel.

2. (lick OK to move the I/O point to the specified channel.
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Scale Analog Readings
This dialog box is used to specify a custom scale factor that will convert from the “real” units of a

module to some engineering units which describe the process parameter being measured.

Scaled Units. Supply the new engineering units for the module here. As soon as you press Tab or
click outside this field, the new scaled units appear in the scaled units fields.

Actual Lower Value. Provide the actual real-world lower value that you wish the scaled lower
value to correspond to. By default the zero-scale value appears.

Note that inputs typically have under-range capability, which means you can specify a lower actual
value less than the zero-scale value. Outputs do not have under-range capability.

Actual Units. The actual units of the module appear here. They are displayed for reference only
and cannot be changed.

Scaled Lower Value. Type in the new scaled lower value here. This can be any floating point
value.

Scaled Units. The new units you provided in Scaled Units (above) appear here.

Actual Upper Value. Provide the actual real-world upper value that you wish the scaled upper
value to correspond to. By default the full-scale value appears.

Note that inputs typically have over-range capability, which means you can specify an upper actual
value greater than the full-scale value. Outputs do not have over-range capability.

Actual Units. The actual units of the module appear here. They are displayed for reference only
and cannot be changed.

Scaled Upper Value. Type in the new scaled upper value here. This can be any floating point
value, as long as it is greater than the scaled lower value.

Scaled Units. The new units you provided in Scaled Units (above) appear here.

Send Configuration To I/O Unit

Use this dialog box to send configuration information to one or more I/0 Units.

I/0 Units List. The list on the left shows all the I/O units in this configuration file. When you click a
unit, the Address List shows all the IP addresses associated with the highlighted unit. This is the
address list you set up in the Add/Edit I/O Unit.

Sending Configuration Information

1. Highlight the I/O unit configuration(s) you want to send.
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2. Highlight the IP addresses to receive the I/O unit configuration. If you don't highlight any
addresses, the configuration will be sent to the entire list. If you highlight more than one I/0
unit configuration, each unit configuration will automatically be sent to all the IP addresses
associated with it.

3. Ifnecessary, change the Timeout field. The timeout field shows how long, in milliseconds, PAC
Manager will try to communicate with the I/0 unit before returning a timeout error.

4, To save the configuration file to flash memory as well as to RAM, check Save to Flash. To also
restart the unit, check Restart I/O Unit.

IMPORTANT: For the following configurations, you must save to flash and restart the I/O unit in order
any changes to the configuration to take effect:

— Changes in IP port for serial modules

- SNMP configuration

- Email configuration

- PPP configuration

- Datalogging interval

Clearing Flash. To erase the flash memory of all highlighted 1/0 units in the list, click Clear Flash.

Click Details to show or hide the Status Area, which displays the results of the last Send or Clear
Flash operation.
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Index

A

accessing data log, 102
address, assigning IP address, 10
to multiple devices, 17
alarm
clearing configuration, 209
configuring, 153, 203
description, 151
trigger, 152
types, 151
algorithms for PIDs, 69
analog bank
data format, 213
reading, 195
analog module data format, 214
analog point
average filter weight, 78, 81
bipolar, 80
calibrating, 50, 190
clamping, 78, 81
configuring, 45, 173
features, 80
gain, 78
maximum value, 77
minimum value, 77
minimum/maximum value, 81
offset, 78
offset and gain, 50, 81, 190
reading, 190
scaling, 48, 77, 80
unipolar, 80
viewing data, 173
watchdog, 77, 80
writing to, 190
assigning IP address, 10, 17
average filter weight, 78, 81

B

bootloader mode, for loading firmware, 228

C

CA root certificate, 232
calibrating analog point, 50, 78, 190
CAN modules

configuring, 61
cascading events and reactions, 142
certificate, 232
changing

/0 points automatically, 120

IP address, 219
clamping analog output point, 78, 81
clearing

configuration, 209

configuration data from flash memory, 76

datalog, 103

file from 1/O unit, 242

files from flash memory, 243

resetting to defaults, 206
communicating with 1/0 unit

assigning IP address, 10

monitoring communication, 80
communicating with processor

IP address, 10
communication

dial-up, 137

modem, 137

PPP, 137

serial, 131

wireless, 26
community groups, 109
configuration data on microSD card, 208
configuration file, 29

adding analog point, 45

adding digital point, 40
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adding 1/0 unit, 36
copying, 68
creating, 30
creating from a PAC Control strategy, 35
custom scaling, 48
loading to brain, 75
moving I/0 point, 67
configuration, clearing, 209
configuring
alarm events and reactions, 151
alarms, 153
CAN modules, 61
communications port, 131
copying I/0 configuration, 31
data logging, 100
data streaming, 117
date and time, 129
delayed reactions to events, 147
digital event/reactions, 145
email, 112
event messages, 104
event/reactions, 144
/0, 29,173
I/0 unit, 36
PID loops, 69, 184
PPP, 137
Profibus modules, 58
RS-232 and RS-485/422 serial modules, 52
Scratch Pad, 115
serial event/reactions, 154
serial modules, 183
serial ports on brain or controller, 131
serial synchronous interface (SSI) modules, 59
SNMP, 109
Wiegand event/reactions, 154
Wiegand modules, 56
wired network security, 90
wireless LAN, 26
control engine port, changing, 93, 97
controller
assigning IP address, 10
changing IP address, 219
control engine port, 93
restarting, 205
converting IEEE float, 213
copying
/0 configuration, 31
memory map data, 122
counter
description, 77, 79
quadrature, 79
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data
copying from memory map, 122
formatting and interpreting, 210
IEEE float format, 213
streaming, 104, 117
data format
2-channel analog modules, 214
digital bank counters, 211
digital point, 212
IEEE float, 213
mask, 211
data logging
accessing data, 102
clearing data log, 103
configuring, 100, 203
values from memory map addresses, 100
date and time
configuring, 129
reading, 200
deadband, 154
deleting
configuration data from flash memory, 76
file from 1/O unit, 242
deviation alarm, 151
diagnostic messages, 248
dial-up networking, 137
digital bank
counter data format, 211
reading, 195
digital event/reactions
clearing, 209
configuring, 145, 203
description, 145
examples, 147
trigger, 147
digital point
configuring, 40, 173
counter, 77,79
data format, 212
features, /76
latching, 76, 78
on high-density module, 198
quadrature counter, /7, 79
reading, 188
state, 76, /8
viewing data, 173
watchdog, 77, 80
writing to, 188
disable host communication, 93
DNS Resolver, 112
downloading



see loading

E

edge trigger, 152
email
clearing configuration, 209
configure DNS server, 112
configuring, 112, 204
message, 104
erase
configuration from microSD, 209
firmware from microSD, 209
strategy from microSD, 209
error messages, 245
Ethernet 2 IP address, assigning, 21
Ethernet errors, 251
EtherNet/IP
turning off protocol, 93
event message
configuring, 104, 203
plugins, 108
event/reaction, 145, 147,203
cascading, 142
configuration steps (table), 144
configuring digital, 145
delayed, 147
Scratch Pad, 142
serial, 154
types, 143
Wiegand, 154
exclamation mark button, 248

F

failsafe bootloader mode, 228

file
clearing from flash memory, 243
deleting from file system, 242
loading from flash memory to file system, 243
reading filenames, 241
sending from 1/0 unit, 240
sending to /0 unit, 237

file storage, removable, 235

file system on brain or controller, 235

filter address, 97, 99

filter mask, 97, 99

filter weight, 81

find Opto 22 MMP devices, 248

firmware
effect on device data, 222
failsafe bootloader, 228

for serial module, 231
getting data about, 246, 248
loading to controller, 221
loading to 1/0 unit, 221
replacing damaged, 228
flash memory, 76
clearing files, 243
loading files from, 243
saving configuration data to, 75, 204
saving file system files, 243
float
format, 213
IEEE, 213
Modbus, 125
flow control, 53
format
IEEE float, 213
Modbus float, 125
of counter data, 211
of data, 210
of data for 2-channel analog modules, 214
of digital point data, 212
FTP
client software comparison, 235
default port, 90
limiting access to, 90
login, 93
password, 93
reading filenames, 241
sending files to and from I/O unit or controller,

235

G

G4EB2
configuring points, 43
gain, 50, 81, 190
definition, /8
gateway address, 14

H

hardware, getting data about, 246, 248
help

troubleshooting, 245
high limit alarm, 152
high-density digital modules

reading or writing to points, 198
host communication, disabling, 93
host name

configure DNS server, 112
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I/0 modules
configuring analog and digital, 29

configuring RS-232 and RS-485/422 serial mod-

ules, 52

viewing, 173

1/0 point
clearing configuration, 209
configuring, 40, 173
features, 76
logging data, 100
mirroring, 120
reading, 187
reset points to defaults, 206
writing to, 187

/O racks, 172

/0 unit
adding, 36
changing IP address, 219
clearing files from flash memory, 243

copying between configuration files, 68

deleting file, 242
file system, 235
getting files via FTP, 240
hardware commands, 204
loading files from flash memory, 243
reading basic information, 162
restarting, 205
saving files to flash memory, 243
sending files via FTP, 237
IEEE float, 213
initializing Scratch Pad values, 115
interacting algorithm for PID, 69
IP address
assigning, 10
assigning IP address to Ethernet 2, 21
assigning to multiple devices, 17
assigning wireless, 26
changing, 219
mapping, 17
ISA algorithm for PID, 69

K

kernel, see firmware

L

latch, 78

definition, 76
level trigger, 147
loading
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configuration file, 75
files from flash memory, 243
firmware

effect on device data, 222

new firmware to I/0 unit or controller, 221

new firmware to serial module, 231
logging

data, 100

serial port data, 252

wireless data, 254
login for FTP, 93
low limit alarm, 152

M

MAC address, 10
management hosts, 109
map file, 17
mapping IP addresses, 17
mask

data format, 211

digital point, 146

Scratch Pad, 146
maximum value, 77, 81
memory

saving configuration to, 204

saving files, 243
memory map

copying data, 122

logging data from, 100
message, 104

plugins, 108
microSD card, 235
microSD commands, 208, 209
minimum value, 77, 81
mirroring /0 point data, 120
MMP devices, finding, 248
Modbus/TCP

changing float format, 125

configuring, 204

default port, 90

limiting access to, 90

memory map address conversion, 127

modem, 137
module types, 176
MOMO, 145
mounting rack, 172
moving

files from 1/0 unit, 240

files to 1/0 unit, 237

/0 point in configuration file, 67
must-on, must-off, 145



N

network
find OptoMMP devices, 248
security on wired network, 90
security on wireless LAN, 26

0]

off, 78
off-latch, 76, 78
offset, 50, 81, 190
definition, 78
offset, definition, 192
on, 78
on-latch, 76, 78
operation commands, 204
OptoMMP
default port, 90
find devices, 248
limiting access to, 90
OptoMMP device commands, 204

P

PAC Control, 141, 161
and direct reads and writes, 161
and event/reactions, 141
copying configuration files from, 35
managing files on I/0 unit or controller, 235
protecting strategy, 93
parallel algorithm for PID, 69
password
for FTP, 93
peak, 77
PID loops
algorithms, 69
configuring, 69, 184
plugins, 108
point types, 176
port
changing, for security, 90
serial, on brain or controller, 131
ports for serial modules, 172
power
powerup clear, 207
restarting controller, 205
restarting I/0 unit, 205
powerup clear, 207
PPP
clearing configuration, 209
configuring, 137, 204
troubleshooting serial communication, 252

primary IP address, assigning, 10
problems, troubleshooting, 245
processor

assigning IP address, 10
Product Support

getting device and firmware data, 246, 248
Profibus

configuring modules, 58
protecting PAC Control strategy, 93
protocol

default ports, 90

limiting access to, 90

turning off EtherNet/IP, 93

Q

quadrature counter, 77, 79

R

racks for mounting 1/0, 172
reaction

delayed, 147

digital, 145

example, 147

Scratch Pad, 142

trigger

analog, 152
digital, 147

reading

analog bank, 195

analog point, 190

datalog, 102

digital bank, 195

digital point, 188

digital points on high-density modules, 198

filenames on file system, 241

/0 points, 187

/0 unit information, 162

Scratch Pad, 200

system date and time, 200
registered management hosts, 109
removable storage, 235
reset points to defaults, 206
reset to defaults and restart device, 206
Restart device from powerup, 205
retransmit timeout (RTO), 250
root certificate, 232

S

saving
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configuration to flash memory, 75, 204 trap types, 109

file system files to flash memory, 243 SSI modules
scaling configuring, 59
analog point, 48 state of digital point, /6, 78
description, 77, 80 Status Read information, 165
scanner flags, 171 store configuration and IP settings to microSD, 208
Scratch Pad, 142 store configuration to flash, 204
masks, 146 strategy
reading, 200 effect of firmware download, 222
setting initial values, 115 protecting, 93
writing to, 200 streaming data, 104, 117, 204
secondary IP address, assigning, 21 subnet mask, 10
security, 26, 90, 204
FTP login, 93
security certificate, 232 T
send powerup clear, 207 TCP/IP
serial settings, 250
communication, troubleshooting, 252 stack 250
event/reactions, 154, 203 time, systlem, 129, 200
message, 104 timed events, 149
ports on brain or controller, configuring, 131 timeout, 250
serial modules timer, configuring, 209
2-wire or 4-wire mode, 53 traps, 109
CAN, 61 troubleshooting, 245
flow control, 53 diagnostic messages, 248
loading firmware, 231 Ethernet errors, 251
port numbers, 172 getting device and firmware data, 246, 248
Profibus, 58 serial communication, 252
serial synchronous interface, 59 Status Read data, 165
Wiegand, 56 TCP settings, 250
serial modules (RS-232, RS-485/422) wireless communication, 254

configuring, 52
serial synchronous interface

configuring modules, 59 U
;i;‘tTlgg offsetand gain, 50, 190 UDP and streaming data, 117
Configure DNS server, 112
SNAP PAC controller VvV
assigning IP address
Ethernet 2, 21 valley, /7
primary, 10 velocity algorithm for PID, 69
file system, 235 viewing module and point data, 173
SNAP PAC racks, 172
SNAP PACREST API, 3, 91
SNMP W
access privileges, 109 watchdog, 80
agent, 109 definition, 77
community groups, 109 Wiegand
configuring, 109, 204 configuring modules, 56
default port, 90 event/reactions, 154, 203
limiting access to, 90 wireless LAN
management hosts, 109 configuring, 26
message, 104 troubleshooting, 254
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to analog point, 190 to 1/0 points, 187
to digital point, 188 to Scratch Pad, 200

PAC Manager User’s Guide



Al PAC Manager User's Guide



	Table of Contents
	1: Introduction
	About this Guide
	Contents
	Related Documentation

	For Developers: SNAP PAC REST API
	Product Support
	Opto 22 Processor Comparison Chart

	2: Configuring Devices
	Introduction
	When to Use PAC Manager and PAC Control
	Configuring I/O

	Assigning an IP Address
	About IP Addresses
	Assigning IP Addresses to SNAP PAC
	Assigning IP Addresses to Multiple Devices
	Creating the Map File
	Assigning Addresses from the Map File

	Assigning an IP Address to Ethernet 2 (SNAP PAC Controller Only)
	Configuring Wireless LAN Communication (Wired+Wireless Models Only)

	Connecting with a SNAP PAC SB Brain
	Creating an I/O Unit Configuration File
	Creating a New Configuration File
	Copying an I/O Unit Configuration
	Creating a New I/O Unit from an Existing One

	Creating a Configuration File from Another Strategy

	Adding an I/O Unit
	Configuring I/O Modules and Points
	Configuring SNAP Digital Points
	Configuring Digital Points for a G4EB2

	Configuring Analog Points
	Using Custom Scaling
	Calibrating Offset and Gain

	Configuring RS-232 and RS-485/422 Serial Communication Modules
	Configuring Flow Control and 2- or 4-Wire Mode

	Configuring Wiegand Modules
	Configuring Profibus Modules
	Configuring SSI (Serial Synchronous Interface) Modules
	Configuring CAN Modules
	SNAP-SCM-CAN2B Filters and Data Masks
	Example 1
	Example 2

	Configuring HART Modules
	Moving a Configured I/O Point

	Copying and Pasting I/O Units
	Configuring PID Loops
	What is a PID?
	Algorithm Choices
	Steps for Configuring PIDs

	Sending Configuration Data to the I/O Unit
	Using PAC Manager to Clear Flash Memory

	Using I/O Point Features
	States (Digital Points)
	Latches (Digital Points)
	Counters (Digital Points)
	Quadrature Counters (Digital Inputs)
	Watchdog (Digital and Analog Points)
	Scaling (Analog Points)
	Minimum and Maximum Values (Analog Points)
	Offset and Gain (Analog Points)
	Clamping (Analog Points)
	Average Filter Weight (Analog Points)


	3: Configuring Optional Functions
	Introduction
	Setting Up Network Security (Wired Network)
	Limiting Access to Specific Computers
	Limiting Access to Specific Protocols
	Reserved Port Numbers

	Configuring the PAC as an HTTP/HTTPS Server
	Requiring a Password for FTP
	Protecting a PAC Control Strategy from Interference
	Turning Off EtherNet/IP
	Configuring Ethernet Security on an I/O Unit
	Configuring Ethernet Security on a Standalone Controller

	Logging Data from Memory Map Addresses
	Configuring Data Logging
	Reading the Data Log
	Clearing All Data from the Log

	Configuring Event Messages
	Using Plugins
	Examples: Including Data from Memory Map Addresses
	Sending Binary Data in Event Messages

	Configuring SNMP
	SNMP Traps
	SNMP Access Privileges
	Configuring the SNMP Agent

	Configuring DNS Servers
	Configuring Email
	Setting Up Initial Values in the Scratch Pad Area
	Scratch Pad Bits
	Scratch Pad Integers, Floats, or Strings

	Configuring Streaming
	Mirroring I/O Point Data
	Copying Memory Map Data
	Copying Binary or Memory Map Data on the Same I/O Unit
	Copying Binary or Memory Map Data to a Different I/O Unit

	Configuring Modbus Options
	Changing Modbus Float Format
	Determining Modbus Unit ID and Register Address

	Setting Up System Date and Time
	Configuring Direct Communication to Serial Devices
	Configuring Serial Ports on an On-the-Rack Controller
	Configuring Serial Ports on a Standalone Controller

	Configuring PPP
	Configuring PPP on the I/O Unit


	4: Setting Up Events and Reactions
	Introduction
	Event/Reaction Concepts
	The Scratch Pad
	Using Scratch Pad Bits for Events and Alarms
	Cascading Events, Alarms, and Reactions

	Types of Events, Alarms, and Reactions

	Configuring Digital Events and Reactions
	Digital Point and Scratch Pad Masks
	How Digital Events Trigger Reactions
	Example: Digital Event/Reaction

	Configuring Alarms and Reactions
	How Alarms Trigger Reactions
	Example: Alarms Event/Reaction

	Configuring Serial or Wiegand Events and Reactions
	Configuring Event Messages

	5: Reading and Writing to Specific Devices
	Introduction
	Reading Basic Device Information
	Interpreting Status Data
	Changing Status Data

	Referencing I/O Points
	SNAP PAC Racks
	Serial Modules

	Configuring I/O Modules, Points, and Features
	Point Types Requiring Configuration
	Point Features Requiring Configuration
	Configuring Analog and Digital Points and Features
	Point Type Configuration Tables
	Digital Input and Output Modules
	Analog Input Modules
	Analog Output Modules

	Configuring Serial Modules in the Inspect Window
	Configuring, Viewing, or Changing PID Loops

	Reading and Writing to Points
	Reading and Writing to Digital Points
	Digital Input Points
	Digital Output Points

	Reading and Writing to Analog Points
	Analog Input Points
	Calibrating Offset and Gain Using the Default Method
	Calculating Offset and Gain Using the Two-Point Method
	Analog Output Points

	Reading Analog and Digital Banks
	Digital Bank Window
	Analog Bank Window

	Reading and Writing to SNAP High-Density Digital Points
	SNAP High-Density Digital Input
	SNAP High-Density Digital Output

	Reading System Date and Time
	Reading and Writing to the Scratch Pad Area
	Scratch Pad Bits
	Scratch Pad Integers, Floats, and Strings

	Data Logging
	Reading or Changing PID Loops
	Reading or Changing Events and Event Messages
	Reading or Changing Communications and Other Data

	Writing Commands to the Device
	Using OptoMMP Device Commands
	Saving Configuration to a Device’s Flash Memory
	Restarting the Device
	Resetting to Defaults and Restarting
	Sending a Powerup Clear

	Using microSD Commands
	Putting Configuration Data on the microSD Card

	Using Other microSD Card Commands
	Clearing Configurations and Data Samples

	Formatting and Interpreting Data
	Mask Data
	Unsigned 32-bit Integer Data
	Digital Point Data (4-Channel Modules)
	IEEE Float Data
	Analog Bank Data


	6: Maintaining Devices
	Introduction
	Changing IP Addresses
	Loading New Firmware
	Firmware Download Effect on Data in the Device
	Loading Controller and Brain Firmware (Except SB Brains)
	Loading SB Brain Firmware
	Installing SB Firmware Through the Controller
	Installing SB Firmware Directly from PC to Brain

	Replacing Damaged Firmware
	Loading Serial Module Firmware
	Installing CA Root Certificates
	Maintaining Files
	Tools for Managing Files
	Moving Files to the SNAP PAC Controller or I/O Unit
	Moving Files from the SNAP PAC Controller or I/O Unit
	Reading Filenames
	Deleting a File from a SNAP PAC Controller or I/O Unit
	Using Flash Memory with the File System


	7: Troubleshooting
	Introduction
	PAC Manager Error Messages
	Trouble Connecting to the I/O Unit or Controller
	Using PAC Manager to Troubleshoot Problems
	Getting Device and Firmware Information—Individual Device
	Viewing Diagnostic Messages

	Getting Device and Firmware Information—Multiple Devices
	TCP Settings
	Checking Ethernet Errors
	Troubleshooting Serial Communication
	Creating the Log File
	Retrieving the Log File
	Reading the Log File

	Troubleshooting Wireless LAN Communication


	A: Menus
	File Menu
	Edit Menu
	Tools Menu
	View Menu
	Help Menu

	B: Dialog Boxes
	Add/Edit Analog Point
	Add/Edit Digital Point
	Add/Edit Event Message
	Add/Edit I/O Unit
	Add/Edit IP Address
	Add/Edit Memory Map Values
	Add/Edit PID Loops
	Add/Modify New Device
	Assign IP Address
	Assign Secondary IP Address
	Configure E-Mail
	Configure Event Messages
	Configure I/O Points
	Configure I/O Points (G4EB2)
	Configure I/O Units
	Configure Memory Map Values
	Configure PID Loops
	Configure PPP
	Configure Profibus Modules
	Configure Serial Modules
	Configure SNMP Agent
	Configure Streaming
	Configure Wiegand Modules
	Find Opto 22 MMP Devices
	Inspect I/O Unit
	I/O Unit Import/Copy
	I/O Unit Maintenance
	Move Point To
	Scale Analog Readings
	Send Configuration To I/O Unit
	Sending Configuration Information


	Index

